
No related topics were found.



No procedure topics were found.



To view system information
1. Click Help, About Corel PRESENTS.
2. Click the System Info button.
3. Click a category from the Category list box.
Tip

Use the Save button to store system information for printing. System information is saved as SYSINFO.TXT. 
A message box lets you know where the file is saved.
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To view program information
Click Help, About Corel PRESENTS.

Tip
Click the System Info button to get information about your system, display, printing, Corel EXEs and DLLs 

and system DLLs 
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Opens the System Info dialog box where you can get information about your system, display,    printing, Corel 
EXEs & DLLs and system DLLs.



Displays the disk space available on the drive where the program is installed. 



Displays the name of the registered user and the serial number.



Displays copyright information.



Displays the version of the product currently installed. 



Displays the name of the product.



Double-click to open the credits window. To exit the credits and return to your program, click the ESC button.



Provides a list of system information categories. Click one of the following:

System Displays information about your computer For example, Windows version or 
processor.

Display Displays information about your monitor. For example, driver,or driver version.
Printing Displays information about installed printers.
Corel EXEs 
and DLLs

Displays information all of the Corel EXEs and DLLs.

System 
DLLs:

Displays all of the system DLLs.

Displays the system information for the chosen category.



Saves all system information as SYSINFO.TXT. Once it's saved, a message box appears informing you of the 
location of the saved file.



Double-click to open the credits window. To exit the credits and return to your program, click the ESC button.



Displays information about the contents of the file.



Dublin: This rtf is new in ver. 6. Source doc IPRP012.DOC from InfoSoft, the vendor
Formatting and editing for Corel: Gordon Brown



Using the International Proofreader
The proofreading system, International Proofreader, provided with your Corel program is a powerful proofreading 
system that addresses complex writing errors and style issues. 
The International Proofreader's three checking modes Spelling, Quick Proofreading, and Full Proofreading
serve users with varying needs. For example, you might do a quick check for spelling errors only, a check for 

spelling and mechanical errors, or a detailed check for stylistic problems, depending on the context and time 
constraints of your project.

The International Proofreader works as uniformly as possible across all supported languages. It follows the 
conventions prescribed by accepted grammar and style manuals for each language, and it handles language 
variants appropriately.
Grammar and spelling correction is divided into three checking modes:

Spelling mode
Quick Proofreading mode
Full Proofreading mode
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Spelling mode overview
The International Proofreader's Spelling mode detects and corrects numerous types of spelling errors, including 
those related to language-specific phenomena such as compound words in the Germanic languages. Spelling 
mode corrects errors involving the following categories of writing elements:

A/An use (English)
Capitalization
Spelling (abbreviation errors, apostrophe errors, cognitive misspellings, and typographic errors)
Clitics (Romance languages)
Compounding (English and the other Germanic languages)
Doubled words
Hyphenation (including soft-hyphen errors and hyphenation-dependent spelling errors)
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Quick Proofreading mode overview
Quick Proofreading mode provides all the functionality of Spelling mode, in addition to correcting errors involving
the following categories of writing elements:

Confused words
Double negatives
Format
Homonyms
Inappropriate prepositions
Misspelled expressions
Misspelled foreign expressions
Noun-phrase agreement (Romance languages)
Punctuation
Spacing between words and sentences 
Ungrammatical expressions
Uppercase/lowercase spellings of words, depending on their function or context (German)
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Full Proofreading mode overview
Full Proofreading mode provides the functionality of Spelling mode and Quick Proofreading mode, identifies many
categories of stylistically questionable expressions, and offers assistance in eliminating them. The words and 
expressions flagged in Full Proofreading mode are not grammatically incorrect, but style and grammar guides 
suggest that they be avoided in most contexts or used only for intentional effect. The error messages displayed 
in Full Proofreading mode are designed to provide you with the stylistic guidelines you need to make a subjective
decision about including or omitting such words and expressions. The flagged categories include the following:

Archaic expressions
Clichés
Contractions
Gender-specific expressions
Informal expressions
Jargon expressions
Overused phrases
Pretentious words
Redundant expressions
Sexist expressions
Stock phrases
Unnecessary prepositions
Vague quantifiers
Wordy expressions
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Rule Manager overview
As International Proofreader processes text, it distinguishes between sentence text and non-sentence text and 
uses appropriate rules to check each type. With the Rule Manager, you can customize your proofreading 
environments by turning off rule types.
The Rule Manager gives you the ability to turn off rule types and to use different combinations of rule types when
writing for different readers. It keeps track of which rule types you have turned off, and of whether you want to 
do this for the current writing session and/or for future writing sessions. If you turn off rule types for future 
sessions, the Rule Manager maintains a list of these in a user profile and reloads it when the next writing session 
starts. If you turn off a rule type for the current session only, the Rule Manager discards the information at the 
end of that session.
The Rule Manager displays a description of each Rule Type when highlighted in the Rule Manager dialog box or 
when an error is found during proofreading.
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A/An use (English) (Spelling mode)
an European country a European country
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Capitalization errors (Spelling mode)
In addition to flagging all capitalization errors flagged during a spelling check (including errors in proper nouns), 
the International Proofreader flags errors in the following categories:
Compass points

English in the South of in the south of France

in the north in the North
First word in a sentence
Because the International Proofreader processes text sentence by sentence, it recognizes the first word in each 
sentence and flags it if it is not capitalized.
Language-specific capitalization

English Summer summer
French Mardi mardi

Janvier janvier
German Montags montags
Word groups
English mount Everest Mount Everest

New Year’s day New Year’s Day
New York state New York State
State of New York state of New York

Portugues dia das mões Dia das mões
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The following text was removed from the next topic--CorrectSpell is not part of the package. 
International Proof Reader incorporates International CorrectSpell's algorithms, which reflect the cliticizing rules 
of each language. International Proof Reader uses International CorrectSpell to draw on grammatical information 
in the language databases and verify that clitics and stems are correctly paired.



Clitic errors (Romance languages) (Spelling mode)
Clitics are articles, pronouns, or prepositions that are attached to other words (called stems when clitics are 
attached) for grammatical reasons. The use of clitics in the Romance languages supported by the International 
Proofreader involves language-specific changes in spelling and accents.
In French, for example, certain grammatical constructions require that articles or pronouns called preclitics be 
attached to the beginnings of words in specific ways, while other constructions require that pronouns or other 
forms called postclitics be attached to the ends of words. The French words le 'the' and enfant 'child', for 
example, are combined in the cliticized form l'enfant 'the child', and donnez-le-moi 'give it to me' has two 
postclitics, -le 'it' and -moi 'me'. In Spanish, equivocarse 'to be mistaken' combines the verb equivocar 'to 
mistake' with the pronoun se 'oneself'. In Italian, ciascun'amica 'each (girl) friend' combines the adjective 
ciascuna 'each' with the noun amica '(girl) friend'.
Strict and complex rules govern the combination of stems and clitics in each Romance language. These rules 
take into consideration the part of speech of the clitic (article, pronoun, or preposition); its position (preceding or 
following the stem); the phonetic value (vowel or consonant) of the initial or final letter of the stem; and the 
gender, number, and grammatical role of the stem. Consequently, spelling verification for these languages 
requires special checking. International Proofreader can do the following:
Verify correct clitics
All of the following are correct and are verified as such by the International Proofreader: 

French envoyez-les-lui [envoyez + les + lui] 
l’ordinateur [le + ordinateur] 

Italian portarglielo [portare + glie + lo]    
senz’alzarsi [senza + alzare + si] 

Portugues aprendê-lo-ei [aprenderei + o]    

Spanish dámela [da + me + la]    
Flag incorrect clitics
In these examples, the stem is correct, but the attached clitic is not. The International Proofreader detects these 
errors:

French s’ordinateur (an error for l’ordinateur) is flagged as having an inappropriate preclitic
veut-t-il (an error for veut-il) is flagged as having an inappropriate postclitic

Flag and correct unmodified stems
In these examples, the stems should have been modified when the clitic was attached: 
Italian senz’alzaresi senz’alzarsi 
Portuguese dás-lo dá-lo 
Spanish mostrémossela mostrémoselas 

aislémosnos aislémonos 
Flag and correct apostrophe errors
In these examples, an apostrophe should have been inserted or omitted: 
French lenfant l’enfant 

l’ettre    lettre 
Italian lormai l’ormai 

l’aureato    laureato 
Flag and correct accent errors In these examples, an accent should have been inserted or omitted:
Portuguese faz-lo    fá-lo 
Spanish aíslemonos    aislémonos 
Flag and correct stems with clitics These examples contain errors in the stems:
French n’appèl    n’appelle 
 appellez-vous    appelez-vous 
Italian t’arabiare    t’arrabbiare
Portuguese escreber-nos    escrever-nos 
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Compounding errors (English and the other Germanic languages) 
(Spelling mode)
In English, International Proofreader flags and corrects errors that occur when writers mistakenly hyphenate a 
word, as in the following example:
blue-prints blueprints

In the other Germanic languages supported by the International Proofreader (Dutch and German), two or more 
words can be joined to form a single word, or compound. German Lebensfreude 'joy of living', for example, is a 
compound of Leben and Freude. 
Some compounds are well established and commonly used; however, new compounds that follow language-
specific rules are constantly formed. Spelling software for Germanic languages must account for this productive 
and rule-governed process. The International Proofreader lists the most frequently used compounds in its 
databases. Less frequently used compounds are verified by confirming that they consist of grammatically valid 
elements. This processenables the International Proofreader to verify most two-part compound words. Also, 
because the database stores many common two-part compound words as valid compound components, the 
International Proofreader can also verify many three-part compounds. The International Proofreader can do the 
following:
Verify newly formed compounds
Dutch bondsbureau financieringsondernemingen
German Textverarbeitung Computerrevolution
Verify compounds formed with acronyms
Dutch KLM-piloten    
German ASCII-Format
Flag and correct misspellings of compounds
Dutch bondsgenootscha bondgenootschap 
             Mietkasernen Mietskasernen
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Doubled-word errors (Spelling mode)
Dutch flags doubled words other than dat dat, die die, je je, and other personal pronouns
English flags doubled words other than that that and had had
French flags doubled words other than vous vous, nous nous, and en en
German flags doubled words other than der der, die die, das das, and sie sie
Italian flags doubled words other than via via, passo passo, and sotto sotto
Portugue flags doubled words other than se se and agora agora
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Hyphenation errors (Spelling mode)
International Proofreader's hyphenation processing enables it to detect the following types of hyphenation errors:
Soft-hyphen errors
A soft hyphen is a hyphen that is not part of the spelling of a word but is used only to divide the word onto two 
lines. (A hard hyphen, in contrast, is part of the word's spelling and is therefore always used.) The International 
Proofreader generates hyphenation points by using pattern-matching technology (rather than retrieving stored 
hyphenation points from a database) to ensure that soft hyphens divide words correctly into syllables, as in the 
following example:

Entry The musician who played the last piano concerto is a child pro-
digy.

Compound The musician who played the last piano concerto is a child prod-
igy.

Hyphenation-dependent spelling errors (Germanic languages)
The use of a soft hyphen to divide a word onto two lines sometimes results in spelling changes in Dutch and 
German. For example, when a German compound formed by linking two or more words would contain the same 
consonant three times in succession, the third consonant is omitted if the letter immediately following it is a 
vowel and the compound appears on one line. However, when such a compound is divided by an end-of-line 
hyphen at the point where the compound words are joined, German spelling rules mandate a spelling change: 
the word is then spelled with all three consonants. 
In addition, when words containing certain combinations of letters (such as ck in the German word backen) are 
divided by soft hyphens, their spelling may change (backen becomes bak-ken).
The International Proofreader detects and corrects errors in these two types of hyphenation-dependent spelling 
changes as shown below:
Languag Word Incorrect Soft-Hyphen Correct Soft-Hyphen 

Dutch speculatieïnstellin speculatie-ïnstelling speculatie-instelling

autootje autoo-tje auto-tje
German Schiffahrt Schif-fahrt Schiff-fahrt

Glocken Gloc-ken Glok-ken
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Spelling errors
International Proofreader corrects the following types of spelling errors:

Abbreviation errors
English O.C.R. OCR
German us.w. usw.
Spanish Sr Sr.
Portugue Ltda Ltda.

Apostrophe errors
English wo’nt won’t
Cognitive misspellings
These occur when the writer does not know the standard spelling of a word. Cognitive misspellings may be 
phonetic, such as seekwell for sequel in English or étudiet for étudié in French, or they may be morphological 
(wrong ending attached to a stem). The International Proofreader corrects language-specific, cognitive 
misspellings such as the following:
English effishent efficient
French émisfere hémisphère 

achetrice acheteuse
German Säson Saison 

Filosofie Philosophie 
Kinden Kindern

Portugue cabeleirero cabeleireiro

atráz atrás
Spanish peremne perenne

lagrimógeno lacrimógeno
Open vs. closed spelling errors
Dutch dank zij dankzij
English anyone of any one of
French avoir à faire à avoir affaire à
German ab zu sein abzusein

abist ab ist
Portugue rosa claro rosa-claro

alto relevo alto-relevo
pré-concebido preconcebido

Spanish al pormenor al por menor
Typographic errors
These are the most common variety of spelling errors. In typed text, most misspellings result from errors such as
transposing characters (hte instead of the), pressing the wrong key, inserting an unnecessary character, or 
omitting a character. The International Proofreader corrects typographic errors in all supported languages. It 
handles errors of transposition, substitution, insertion, and omission regardless of their position in a word. The 
International Proofreader’s correction technology enables it to correct words that contain multiple errors and 
words that start with the wrong letter or letters. For example 
English hsa has

unessecery unnecessary
dvantage advantage

French prnd prend 
kivre ivre 



German bneutzt benutzt 
rurmstichig wurmstichig
geraschvlol geräuschvoll 

Portugue mieo meio

caresentar acrescentar 
Spanish msi mis

ortogáfico ortográfico
auotmático automático 
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Confused words (Quick Proofreading mode)
English uninterested vs. disinterested

semimonthly vs. bimonthly
Portugue compreensivo vs. compreensível

comprimento vs. cumprimento
Spanish apóstrofe vs. apóstrofo

bimensual vs. bimestral
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Double negatives (Quick Proofreading mode)
Englis can’t help but can’t help

French il n’y a pas personne il n’y a personne 
Spanis tampoco no tampoco
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Format errors (Quick Proofreading mode)
International Proofreader checks for consistent and correct use of formatting conventions in all supported 
languages. Its rules handle formatting for the following types of material:
Closings and salutations in letters
English dear mr. Doe: Dear Mr. Doe: 

sincerely yours, Sincerely yours, 
Yours sincerely Yours sincerely, 

Portuguese Estimada doutora Estimada Doutora: or Estimada Doutora,
Spanish estimada Sra. López: Estimada Sra. López: 

Atentamente Atentamente, 
Time and date notation
English (US) May 10 1993 May 10, 1993
French 3 h. 15 3 h 15
Portuguese 4, Julho de 1776 4 de Julho de 1776 (European)

 4 de julho de 1776 (Brazilian)
Spanish 10 de mayo 1993 10 de mayo de 1993

Cardinal and ordinal numbers
English 3nd in line 3rd in line
French soixante-onze soixante et onze
German 5,000,000.00 5 000 000,00
Portuguese trezentos e trinta nove trezentos e trinta e nove
Spanish treintiuno treinta y uno
Fractions
English 1 and ¼ 1¼
French 3½ l de vin blanc 3,5 l de vin blanc
Portuguese 1e ¼ 1¼
Spanish 3 y ½ 3½
Currency notation
English 45,000 £ £ 45,000
German DM 20.50 20,50 DM
Spanish 500ptas. 500 ptas. 
Postal addresses
English Portland, ME, 04321 Portland, ME 04321
French 23 avenue Louise 23, avenue Louise
Portuguese Rua Santa Helena 31 Rua Santa Helena, 31
Units of measure
English 34 ° 34°
Portuguese 34 ° 34°
Spanish 34°C 34 °C

{button ,AL(`text_overview;quick_proof_mode;;;',0,"Defaultoverview",`main')} Related Topics



Homonyms (Quick Proofreading mode)
English acclimation vs acclamation

assent vs ascent

Portugue assento vs acento

Spanish basto vs vasto

 brasa vs braza

Inappropriate prepositions (Quick Proofreading mode)
English accompanied with accompanied by
Portugue defronte a defronte de

Spanish a vapor de vapor

Misspelled expressions
English baited breath bated breath

slight of hand sleight of hand
spinal chord spinal cord

French de plein-pied de plain-pied 
Portugue dar a luz a dar à luz

Spanish a campo través a campo traviesa

Misspelled foreign expressions (Quick Proofreading mode)
English a dente al dente

en mass en masse
Portugue sin qua non sine qua non

      curriculum vita curriculum vitae

Noun-phrase agreement errors (Romance languages) (Quick 
Proofreading mode)
International Proofreader flags errors of number and gender agreement between nouns, adjectives, and articles 
in the Romance languages:
French Je déclare la séance ouvert. Je déclare la séance ouverte.

Ce sont les voitures les plus grande qu’on 
n’ait jamais vues.

Ce sont les voitures les plus grandes qu’on 
n’ait jamais vues.

Elle s’est toujours méfié de ces gens-là. Elle s’est toujours méfiée de ces gens-là.
Italian un grande casa una grande casa
Portugue as estradas sobre os quais as estradas sobre as quais



Spanish la agua el agua
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Punctuation errors (Quick Proofreading mode)
The correct placement of quotation marks and other punctuation varies from language to language. International
Proofreader flags errors in the following uses of punctuation and explains the correct punctuation with examples 
and tutorials:
Paired punctuation
English May I borrow the "Wall Street 

Journal from you?
May I borrow the "Wall Street 
Journal" from you?

Ellipsis and suspended discourse
English The brave men .... have 

consecrated it, far above our 
poor power to add or detract.

The brave men ... have consecrated 
it, far above our poor power to add or
detract.

Portugues
e

E tudo muito belo e bem feito, 
mas....

E tudo muito belo e bem feito, mas...

Spanish "Su gestión diplomática (...) se
vio recompensada con el 
tratado de 1679."

"Su gestión diplomática [...] se vio 
recompensada con el tratado de 
1679."

Order of punctuation
English Marie asked, "Was anyone 

there that day"?
Marie asked, "Was anyone 
there that day?"

Portugues
e

Maria perguntou: "Tinha 
alguém em casa"?

Maria perguntou: "Tinha 
alguém em casa?"

Spanish La agencia estará cerrada el 
próximo lunes (25 de 
diciembre.)

La agencia estará cerrada el 
próximo lunes (25 de 
diciembre).

Punctuation combinations 
English Our manager will be at a 

conference on her birthday 
(May 1.).

Our manager will be at a 
conference on her birthday 
(May 1).

Portugues
e

Ela repetiu: "Eu disse a ele: 
‘Você está com a rozão!"

Ela repetiu: "Eu disse a ele: 
‘Você está com a rozão!’"

Punctuation in combination with certain words
English i.e., , i.e.,
             daß , daß

Spanish etc. , etc.
Punctuation in abbreviations
English She completed her B.A. degree

last year.
She completed her BA degree 
last year.
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Stock phrases(Quick Proofreading mode)
These rules flag stock phrases that can often be deleted without changing the meaning or emphasis of a 
sentence.    Unlike clichés, these expressions are not worn-out metaphors or conventional descriptive phrases.    
Instead they are introductory or parenthetical expressions often used as "filler:"

it goes without saying that
in fact
Use sparingly
Consider omitting or rephrase with
of course
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Ungrammatical expressions (Quick Proofreading mode)
English anyways anyway

irregardless regardless
Portugue abridas abertas

Spanish celebrísimo celebérrimo
hubieron conciertos hubo conciertos
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Archaic expressions (Full Proofreading mode)
Englis oftentimes often
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Clichés (Full Proofreading mode)
English a far cry from very different from
      blutjung sehr jung

Spanish perder los estribos enfadarse or encolerizarse
Portugue De cabo a rabo Do princípio ao fim
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Contractions (Full Proofreading mode)
English Everyone’s happy. Everyone is happy.
Portugue procê para você

{button ,AL(`text_overview;quick_proof_mode;;;',0,"Defaultoverview",`main')} Related Topics



Gender-specific expressions (Full Proofreading mode)
Englis manpower personnel or work force or staff 

anchorman or anchor or newscaster or
anchorwoman commentator
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Informal expressions (Full Proofreading mode)
English still and all still
French des fois parfois or quelquefois
German ein Haufen viele
Spanish un montón de muchos, muchas
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Jargon expressions (Full Proofreading mode)
Englis to eyeball to look over
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Overused phrases (Full Proofreading mode)
English bare essentials essentials
Portugue apoio incondicional apoio total

Spanish altamente improbable muy improbable
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Pretentious words (Full Proofreading mode)
Englis author a report write a report

{button ,AL(`text_overview;quick_proof_mode;;;',0,"Defaultoverview",`main')} Related Topics



Redundant expressions (Full Proofreading mode)
English ask a question about ask about
             acabamento final acabamento

Spanish regalo gratis regalo
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Sexist expressions (Full Proofreading mode)
Englis the little spouse or partner or wife
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Unnecessary prepositions (Full Proofreading mode)
English divide up divide
Portugue comentar sobre comentar

Spanish opinar de que opinar que
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Vague quantifiers (Full Proofreading mode)
Englis a lot of many
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Wordy expressions (Full Proofreading mode)
English a sufficient number enough
French arriver à une décision décider
German angeblich soll angeblich or soll
Portugue fazer uma chamada pelo 

tel
ef
on
e

telefonar

Spanish dar comienzo a comenzar
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Formality levels
Documents and writing styles vary in degree of formality. Because informal documents may not require 
adherence to such stringent rules as formal documents, International Proofreader’s Rule Manager allows you to 
choose from three levels of formality. You can set the formality level for the current session only or customize it, 
save it in a user profile, and load the user profile in future sessions. The Table below summarizes the features 
and suggested uses of the three formality levels.
Formality On/Off Status of Rules Types of Documents

Formal All rules are on. Contracts
Job applications
Doctoral dissertations
Correspondence to a board of directors
Correspondence to a head of state

Standard Some rules are off (in English, 
for example, rules that 
flag contractions). Most business correspondence
Press releases

Informal The following rule types are off: Personal letters
Archaic expressions Informal memos between 

colleagues
Clichés
Contractions
Gender-specific expressions
Informal expressions
Jargon expressions
Overused phrases
Pretentious words
Stock phrases
Vague terms
Weak modifiers and quantifiers
Wordy expressions

The Rule Manager can display the on/off status of each rule type for the chosen formality level at any time.
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Languages supported by the International Proofreader
The International Proofreader, Hyphenator, and Thesaurus support the languages indicated below.
With the exception of Spanish and Portuguese, you can display error messages in the language of the current 
dictionary or U.S. English.
Languages supported Database file names
Proofreader
Danish PDN2S152.DAT
Dutch PDU1M111.DAT
U.K. and U.S. English PEN3M111.DAT
Finnish PFN2S111.DAT
French PFR1M111.DAT
German PGR1M111.DAT
Italian PIT1M140.DAT
Norwegian PNO2S120.DAT
European and 
Brazilian Portuguese PPO3M140.DAT
Spanish PSP3M150.DAT
Swedish PSW2S131.DAT
Hyphenator
Danish HDANIS10.DAT
Dutch HDUTCH11.DAT
English HENGLI16.DAT
Finnish HFINNI14.DAT
French HFRENC05.DAT
German HGERMA06.DAT
Italian HITALI09.DAT
Norwegian HNORWE13.DAT
European and
Brazilian Portuguese HPORTU12.DAT
Spanish HSPANI08.DAT
Swedish HSWEDI07.DAT
Thesaurus
Danish RDNTF300.DAT
Dutch RDUTF300.DAT
English U.K. REKTF400.DAT
English U.S. REUTF410.DAT
Finnish RFNTF400.DAT
French RFRTF300.DAT
German RGRTF400.DAT
Italian RITTF310.DAT
Norwegian RNOTF313.DAT
Brazilian Portuguese RPBTF331.DAT*
Spanish RSPTF302.DAT
Swedish RSWTF300.DAT
Note

Thesaurus support for Portuguese is available in Brazilian Portuguese only.



Personal Dictionary
To check the spelling in your document, International Proofreader compares each word in the document with the 
words in the database and returns an error message when a word is not found there. For users who want to save 
specialized terms that are not in the database, the International Proofreader provides the Personal Dictionary. If 
you select a personal database before or during proofreading, the International Proofreader compares each word 
in your document with the words in that personal database. If the word is found in the personal database or 
International Proofreader database, the International Proofreader accepts the word as correctly spelled.
The International Proofreader’s Personal Dictionary component also allows you to do the following:

Add words to a personal database.
Specify whether a given personal database should be opened for the current language only or for all 

languages.

{button ,AL(`text_overview;text_proof_concepts;;;',0,"Defaultoverview",`main')} Related Topics



Language and dialect options
The International Proofreader includes rules, error messages, and descriptions specific to each dialect of English 

U.S. and U.K. and Portuguese 
 European and Brazillian.

{button ,AL(`text_overview;text_proof_concepts;languages;;',0,"Defaultoverview",`main')} Related 
Topics



Spelling correction options
For each language that you initialize, you can specify whether you want International Proofreader to retrieve and 
display all possible corrections for words not found in the spelling database. You can also specify whether you 
want The International Proofreader to compare each word in your document with the words in any initialized 
personal databases during proofreading. If the word is found in the personal database, the International 
Proofreader accepts the word as correctly spelled (unless the word has been assigned a negative flag).

{button ,AL(`text_overview;text_proof_concepts;;;',0,"Defaultoverview",`main')} Related Topics



Error language
For all languages except Portuguese and Spanish, you can display error messages in either the current language 
or in US English. 

{button ,AL(`text_overview;text_proof_concepts;languages;;',0,"Defaultoverview",`main')} Related 
Topics



Rule language
For all languages except Portuguese, and Spanish, you can display the descriptions of rule types in either the 
current language or in US English. 

{button ,AL(`text_overview;text_proof_concepts;languages;;',0,"Defaultoverview",`main')} Related 
Topics



Maximum sentence elements
You can set the maximum number of sentence elements for each language that you initialize. Sentence 
elements are words or punctuation that International Proofreader treats as units. The default setting for each 
language should be acceptable for most text; you should not change the default unless you need to reduce the 
memory overhead required by the buffer-processing function. 
Language-Specific Options
You can choose options that customize the International Proofreader’s processing to reflect your preferences for 
specific languages.

{button ,AL(`text_overview;text_proof_concepts;;;',0,"Defaultoverview",`main')} Related Topics



Introduction to Corel PRESENTS
Welcome to Corel PRESENTS, the newest addition to the CorelDRAW suite of applications. PRESENTS combines 
ease of use, and flexibility to allow you to efficiently create and show eye-catching presentations.
No matter what your presentation needs: from providing several overheads for a team briefing to creating a 
sophisticated multimedia presentation, PRESENTS allows you to meet them quickly and easily; Wizards, 
templates, and background and layout libraries all provide quick ways to create stunning slides. Corel’s powerful 
drawing tools help you to customize your presentation with stylized text and graphic objects. There’s even a 
chart function for you to include bar, pie, gantt, and many other custom charts!
A tutorial is provided so that you can follow along either online or in the CorelDRAW book and quickly learn how 
to create professional-looking presentations.
With PRESENTS you can:

create overhead, paper, 35mm slide, or on-screen presentations
provide speaker notes, outline pages, and audience handouts
create your own animation sequences
incorporate Motion 3D and video clips
incorporate and edit sound files
insert charts, maps, and graphic objects
assign transition effects to bullets, text, objects, and slides

Use your imagination, and PRESENTS does the rest!



The Corel PRESENTS workplace
Documents created in Corel PRESENTS are called presentations. A presentation is a collection of slides, speaker 
notes, handouts, and an outline saved together in a file.
You can have multiple presentations open and switch between them at any time. You can even copy objects 
between presentations and look at the same presentation in different views.
As you work, you can resize windows, move them around your presentation, and customize your workspace. 
When you quit, Corel PRESENTS remembers your settings and uses them the next time you launch the program. 
If you like, you can use the Customize command on the Tools menu to save different workspace options for the 
next time you open the program.



Managing files
Corel PRESENTS provides you with the same file creation and management flexibility as other Windows 95 
products. You can create, save, save to different locations, open existing, and close files.
When you create a presentation in PRESENTS, all of your slide elements are saved in one file: slides, outline, 
speaker notes, audience handouts, multimedia clips, and the presentation format.
You can save a Runtime Player version of your presentation so that you can play it on any sufficiently powerful 
computer; you don’t have to have PRESENTS installed.



Setting up presentation pages
With Corel PRESENTS, you can set the kind of presentation page you want to create. When you start a new 
PRESENTS file, default settings are applied to the page setup, which you can modify. If you choose to start a file 
from a template, a page setup that is appropriate for the type of presentation you selected is applied.
You can modify any aspect of the page setup: selecting page options for any slide; overhead transparencies; 
computer screen or monitor; tabloid, letter or legal pages; or you can customize your own page size.
You can create headers and footers, select between landscape or portrait page orientation, and set page 
margins.



Adding, deleting, and arranging slides
The order in which you present slides to your audience is an integral part of your presentation. To help you 
develop a strong structure that supports the message you’re conveying, PRESENTS makes it easy for you to re-
arrange slides within the presentation, to insert new slides anywhere in the presentation file, and to delete slides
that you decide are unnecessary.
You can move slides around in the Slide Sorter view, which gives you a thumbnail representation of every slide in
your file. With this ‘big picture’ view of the presentation structure, you are able to switch the location of any slide
within the presentation. You can also use the Outline view to change the order of slides.
The Insert Slide Wizard guides you through the process of choosing where you want to insert a slide, how many 
slides to insert, what background you want to apply, and what layout to select.
You can delete slides from any point in the presentation. If, immediately after you’ve deleted the slide, you 
decide that you want to re-insert it into the presentation, you can use the Undo command.



Importing files
Corel applications support various file formats, but only some of them are native to the application. If you want 
to read a file that has a non-native format, you must import that file.
The Import command is located in the File menu. When you choose the command, a dialog box appears where 
you can choose the drive and folder where the file is saved. If you know the format of the file you want, you can 
choose it from the File As Type list to display only the files with that extension. To choose the file to import, 
double-click the filename in the display window.



Viewing presentations
Corel PRESENTS offers you eight different views of your presentation as you create it. Each view provides a 
different perspective of your work in progress and offers different editing capabilities. You can switch between 
views by choosing from the View menu or clicking the appropriate view button.
You can also preview a slide as it will appear during the presentation by clicking the Preview button.
The views are:
Slide Includes a slide and any objects used to create the slide contents, such as 

graphics, text, animations, and sound. From Slide View you use all the other views 
to help build your presentation.

Slide Sorter Displays all slides in the presentation as thumbnails. From Slide Sorter view, you 
can: rearrange the order of slides in the presentation; add or delete slides; apply 
layouts or backgrounds to groups of slides; assign transition effects; and show or 
hide the frame or jacket.

Outline Displays the text of all presentation slides. You can: arrange the text of a slide in 
hierarchical order; rearrange the order of slides or bullets; choose the type of text, 
font or style; select basic effects such as bold, italic and underline; and display 
text in draft or preview mode.

Handout Allows you to create handouts of the presentation for the audience. It provides you
with a thumbnail of each slide to which you can add accompanying text.

Background Displays the background elements common to all slides with the same background
number in the current document, omitting all other objects. Use this command 
when you want to make changes to the background.

Master Layout Allows you to view the master layout; change text attributes; change bullet styles; 
and move or size the frames.

Speaker Note Provides a thumbnail representation of the current slide. The extra space on the 
page is for writing speaker notes. The page selection tabs located at the bottom of
the presentation window can be used to navigate among your speaker notes.

Animation Allows you to animate objects by defining a path along which objects can travel. 
Animation view includes VCR buttons that allow you to set and manage the display
of animated objects and control the play and playback of animations when editing 
them.



Creating backgrounds
Presentation backgrounds are graphics applied to the underlying layer of a slide. Think of them as the canvas of 
the slides; on the canvas, you add and organize the information you want to present. You can have a blank 
background, leaving the canvas white. You can create more elaborate backgrounds by applying fills and 
including objects such as shapes, clipart, bitmaps created in other applications, and text. For example, a 
background could include your organization’s logo.
In most presentations, one background is selected and is applied to all slides. This gives a consistent look to the 
presentation. However, Corel PRESENTS gives you the added flexibility to choose different backgrounds for 
slides. There are many sample backgrounds in the background libraries. You can also design and save groups of 
backgrounds to create your own libraries.



Working with layouts
Layouts are one of the key elements to building your presentation. Master layouts are predefined frames that 
provide consistent styles for all slides that follow the master. The master also dictates the sizing and positioning 
of objects such as title, body text, and charts. For example, if you move the body in the ‘Slide master’, the 
bodies of all slides following the master will move whether it be a text, map, OLE object, or chart body.
As you create a presentation, you may want to change the look of a master layout. You don't lose any text or 
graphics when a slide adopts a modified master layout and the changes that you make apply to all slides with 
the same master.
You can select different layouts for slides, speaker notes, and audience handouts from the layout library.



Adding objects
Corel PRESENTS presentations are created by adding objects to slides. The objects can be text, shapes, curves, 
charts and chart annotations, bitmap images, animation sequences, and even sound or video files. You can 
create them directly in PRESENTS using various drawing tools. You can also use other applications to create 
objects and bring them into your presentation using the Import command, the Paste command, or Object Linking
and Embedding (OLE).
PRESENTS is an OLE client,    which means that it can receive objects created in any OLE serverapplication.    
Many Windows-based software packages are OLE servers, including CorelDRAW and Corel PHOTO-PAINT.
Objects can be embedded or linked in a Corel PRESENTS presentation.
Text can be dragged from your favorite word processor and dropped directly in PRESENTS’ Outline view.
When working in background view, any text or    object added to a slide becomes part of the background.

{button ,AL(`obj_over;;;;;',0,"Defaultoverview",)} Related Topics



Creating basic objects
Corel PRESENTS provides a variety of tools that you can use to create shapes. The Freehand and Bezier tools 
allow you to create shapes line by line, or curve by curve. For example, you can draw irregular shapes or sign 
your name with these tools. The Rectangle, Ellipse, and Star tools allow you to create shapes by clicking and 
dragging. For example, you can create a circle with the Ellipse tool or a ten-sided star with the Star tool.

{button ,AL(`obj_over;;;;;',0,"Defaultoverview",)} Related Topics



Linking and embedding objects
Windows' Object Linking and Embedding (OLE) offers two ways to connect files from separate programs: linking 
and embedding. As the name implies, linked objects are data, text, or graphic objects created in one application 
(the server), which remains linked to a file created in another application (the client). When you update the 
original linked file, it can be updated in both client and server applications. Double-clicking a linked or embedded
object switches you back to the original file in a special session of the server application where you can make 
your changes. Your computer must have enough Random Access Memory and system resources to run 
PRESENTS and the other applications you are using at the same time.
Embedded Objects
Embedded objects are placed, or embedded, in the presentation file you're working on. Double-click the 
embedded object to edit it; this activates the server program from within your file. The difference 
between embedded and linked objects is that for embedded objects, OLE makes a copy of the original 
file. No link is maintained between an embedded object and the original file; the original file does not 
update when you edit the embedded object, nor does the embedded object change if the original file is 
changed.
Embedded objects are more portable than linked objects. If you are moving files between systems, the 
only requirement is that the new system have both the server and client programs.
Linked Objects
Linked object files can be updated when the original file changes in the server application. Linked objects 
are not as portable as embedded objects. If you are moving files between computer systems, to preserve 
the link you must copy both source and destination files to the new system, which must have both server 
and client programs installed. 
Drag and Drop
Drag and Drop is a popular feature of OLE. Drag and Drop allows you to select and drag information from 
one application and drop it into another. When used from an OLE server to an OLE client application, Drag
and Drop creates embedded objects. If the application you are dragging from is not a server, Drag and 
Drop acts like cut and paste, moving the selected data from place to place.
Linking and embedding procedures vary somewhat between applications. Check the server application's 
documentation for additional information.

{button ,AL(`obj_over;;;;;',0,"Defaultoverview",)} Related Topics



Shaping objects
Objects are constructed from basic elements called paths. A line, for example, is a path drawn between a start 
point and an end point. Each point is called a node. A line is an open path that cannot be filled. A closed path 
(e.g., a circle) can be filled. A path must have at least two nodes, and can have a virtually unlimited number of 
nodes. An object can consist of several separate paths, called subpaths (e.g., a donut created from a circle within
a circle).
The Shape tool and Node Edit Roll-Up allow you to change the characteristics of a path and its nodes. Doing this 
allows you to reshape an object. To edit the paths and nodes of an object, convert the object to curves using the 
Convert to Curves command in the Arrange menu. This step isn't necessary for objects drawn with the Pencil tool
or Bezier tool because they are already curve objects.
Three special types of shaping don't require converting the object to curves:

rounding the corners of rectangles and squares
creating arcs and pie wedges from ellipses and circles

Note
You cannot edit text after you convert it to curves.
You cannot convert groups of objects to curves.









Arranging objects
To change the stacking order of objects in a layer, use the commands in the Arrange menu (To Front, To Back, 
Forward One, and Back One). 

{button ,AL(`obj_over;;;;;',0,"Defaultoverview",)} Related Topics



Creating charts
The chart-building feature of Corel PRESENTS contains two principal tools to help you create impressive charts 
and spreadsheets: the chart-building screen, called Chart View, and an underlying spreadsheet program called 
the Datasheet.
The chart feature allows you to simply and quickly produce complex and colorful charts and datasheets, add 
sizzle to your presentations, and compute a multitude of mathematical formulas. Available chart types include 
line, bar, area and pie charts, histograms, scatter and 3D charts, bubble charts, Gantt charts, Polar charts, and 
Radar charts.
The Datasheet is the powerful spreadsheet program underlying your charts. Whether you're building a new chart
or changing an existing one, the Datasheet is a valuable data analysis tool. You are able to create and analyze 
your own data or bring in chart data using OLE 2.0.



Assigning transitions
Transitions add a dynamic sense of movement to your presentation; you can assign transitions to bullets, text, 
objects, and slides.
From the Transitions command, you can select the style of movement, direction, and duration and number of 
steps for the text, object, or slide that you choose. 
From the Path command, you can also set a path that the transition will follow.
Tip

You can set the transitions for all the slides at once by selecting all the slides in Slide Sorter view, then 
choosing a transition. The transition is applied to all the slides in your presentation.



Adding sound, video, and animation
Adding multimedia effects such as sound, video, and animation add variety to your presentation and enhance its
message. Corel PRESENTS offers many features to incorporate multimedia effects into your presentation:
Sound You can insert sound clips into your presentation, edit the sounds (called 

waveforms), sequence cels, select mono or stereo output, and create special 
sound effects.

Animation Using the Animation menu, you can animate objects that you create in PRESENTS. 
You can create a multiple cel actor, sequence cels, set a path, and play the 
animation with VCR tools. You can also create animated objects that change size 
as they move along the animation path.

Video You can insert, move, resize, and delete video clips (.AVI) within your file. You 
cannot edit video.



Multiple-cel actors overview
The actor's cycle speed depends on the number of cels and the actor's size in each cel. The cycle speed is the 
flow or smoothness of movement and the speed at which the actor moves through the entire number of cels. A 
high number of cels causes the actor's speed to decrease, because the actor's position changes little in each cel 
and it takes longer to cycle through all of the cels. If you want to make an actor move more rapidly and more 
abruptly, lower the number of cels.



Wave Editor overview
Sounds are displayed as waveforms in the Wave Editor. A waveform is a graphic representation of a sound. Time 
is displayed along the horizontal axis, and volume along the vertical axis. The Wave Editor lets you edit sounds 
you have created or imported using the menus at the top of the window. You can cut, copy, paste, and delete 
portions of the sound, as well as apply various sound processing effects. 
If you have selected stereo sound in the Output Devices dialog box, the sound is played through two channels: 
left and right. The sound that goes through each of the channels is usually different (unless the sound was 
recorded as mono), therefore, the left and right waveforms are visually different. You can edit either channel. 
PRESENTS offers many controls to customize and add effects to your sound files:
Output Devices dialog box changes the Channels (mono or stereo), the Sample Size (8 Bits or 16 Bits), and 

the Sample Rate (44.1 kHz, 22.05 kHz, or 11.025 kHz). Channel controls whether 
the sound is played in stereo or mono. The Sample Size of a recording controls the 
dynamic range of sounds recorded, and therefore has an impact on the file size. 
For example, the 16-Bit option records a greater dynamic sound range, and as a 
result the quality of the recording is higher. However, the file size is much larger 
because of the number of bits used. Sample Rate controls the number of times per
second that the recorder takes a sample of the sound when it is being recorded. 
The final quality of the recorded sound also depends on this Sampling Rate, where:
44.1 kHz is CD quality, 22.05 kHz is close to FM radio or analog tape quality, and 
11.025 is AM radio quality.

Change Characteristics command
Silence visually “flattens” the selected portion of sound wave and therefore effectively 

silences the sound. 
Fade Up opens the Fade In Wave dialog box. Enter a percentage in the Fade In to % field. 

Fade In makes the current selection (or entire sound) start at a percentage of the 
original level and increase 100%.

Fade Out opens the Fade Out Wave dialog box. Enter a percentage in the Fade Out field. 
Fade Out makes the current selection (or entire sound) start at its current volume 
level and decrease to a percentage of the level at the end of the selected portion 
before the command was applied.

Amplify enters a percentage in the Amplitude % field. The percentage entered in this field 
either decreases the sound's volume (for values from 1% to 99%), making the 
sound quieter when it is played back, or increases it, (for values from 101% to 
9999%), making the sound louder. A value of 100% has no effect on the volume. 
Setting this value to 0% silences the selected portion of the sound.

Reverse reverses the entire waveform or the selected portion of it. When played back, the 
sound plays in reverse.

Echo echoes or repeats the entire waveform or the selected portion, but with a decrease
in volume. The repeated sound is also shifted forward in time. The overall result is 
that, as in real life, you hear the original sound first, then following a short delay, 
you here the echo at a diminished volume. Select Echo a number of times to 
increase the echo effect.



Creating speaker notes and audience handouts
When you create a presentation in PRESENTS, speaker notes and audience handouts are saved in the same file 
as your slide presentation.
Speaker notes are an effective presentation aid for the person speaking to the audience. Each slide is 
represented in thumbnail form on a notes page, along with room for you to type key notes that you want to 
remember.
You can also print handout pages for your audience, so they can follow along as you make your presentation. 
Handouts make it easy for the audience to make notes during your presentation, and to remember points later; 
they have thumbnail representations of two slides per page, with room for you to add relevant text.
You can change the layout of the speaker notes or handouts to suit your needs, by selecting a new master layout
or modifying the existing layout. 



Creating the screen show
Putting the finishing touches on your presentation has never been easier. PRESENTS provides you with an 
Options command from which you can set the controls for your screen show features. You can choose to 
automatically advance slides, run the show continuously, and display the mouse pointer on-screen during the 
screen show.
You can set timelines that determine the time on screen for slides, transitions, animations, text, and objects. You 
can use timelines to add movement to your presentation.
You can also create a portable screen show. This allows you to take your presentation on the road and play it on 
computers that do not have Corel PRESENTS installed, using the Corel Runtime Player.
Tip
Don’t forget to practice your presentation several times before you give it to an audience. Timing is critical!



Transitions command (Animation menu)
Opens the Transitions tab in the Properties dialog box, which allows you to choose opening and closing 
transitions for the selected item, including the transition type, direction, duration and number of steps to use for 
the transition.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Path command (Animation menu)
Opens the Path tab in the Properties dialog box, which allows you to choose a preset path for the object to travel.
{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Create/Edit Actor command (Animation menu)

Opens the Create/Edit Actor dialog box, from which you can choose the objects on the slide that you want to use 
as cels in the actor you create.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Create/Edit Actor dialog box
Allows you to create actors from any number of objects on a slide and then name the actor. The objects you add 
to the actor each inhabit a cel of the actor. When the animation runs, each cel in the actor displays according to 
the order you give them using the Cel Sequence command.



Lists the graphic and text objects in the slide. You can use these objects to build actors.



Click to move selected objects from the Objects in slide list box and add them to the cels in actor list box to 
create an actor. Objects display in the order listed. You can drag the objects to reorder them in the list.



Allows you to modify the actor by removing objects from it. Click to remove selected objects from the Cels in 
actor list box to the Objects in slide list box.



Lists the objects you identify as cels to be used in the actor. You can drag objects to reorder their place in the 
list.



Type the name you want to give the actor. You can use any alphanumeric character the keyboard can type.



Cel Sequence command (Animation menu)

Opens the Cel Sequence dialog box, which allows you to create the effects and set the speed for the play of an 
actors cels.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Cel Sequence dialog box
Creates the effects, speed and cel number for the multicel actor.



Select the effect to apply to the actor, from the list box.



Enable the appropriate button to select how fast the actor moves.



Type which cel number the displayed object will be assigned in the sequence.



Custom Path command (Animation menu)
Turns the mouse pointer into a pencil, allowing you to draw a freehand path along which the selected items 
move.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



First Frame command (Animation menu)
Returns to the first frame of the animation file.
The command is also available on the VCR toolbar, located at the bottom of the presentation page.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Previous Frame command (Animation menu)
Backs up one frame from the current point in the animation file.
The command is also available on the VCR toolbar, located at the bottom of the presentation page.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Play Reverse command (Animation menu)
Plays the animation backward, from the current point in the animation file.
The command is also available on the VCR toolbar, located at the bottom of the presentation page.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Stop command (Animation menu)
Stops playing the animation file.
The command is also available on the VCR toolbar, located at the bottom of the presentation page.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Play command (Animation menu)
Plays the animation from the current point in the animation file.
The command is also available on the VCR toolbar, located at the bottom of the presentation page.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Next Frame command (Animation menu)
Moves forward one frame from the current point in the animation file.
The command is also available on the VCR toolbar, located at the bottom of the presentation page.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Last Frame command (Animation menu)
Moves forward to the last frame of the animation file.
The command is also available on the VCR toolbar, located at the bottom of the presentation page.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Advance to Next Key Frame command (Animation menu)
Snaps the object to the next key frame of the animation path.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Advance to Previous Key Frame command (Animation menu)
Snaps the object to the previous key frame of the animation path.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



Advance Time command (Animation menu)
Advances the time based on the time set in the Tools, Options, Animation option. You can use the Advance Time 
command as a quick way of creating a uniform time flow along a path, instead of using the Animation Trackbar.

{button ,AL(`anim_proc;animation_proc;;;;',0,"Defaultoverview",)} Related Topics



To Front command (Arrange menu)
Moves the selected object in front of all others on the page.

{button ,AL(`layer_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To Back command (Arrange menu)
Moves the selected object behind all others on the page but still in front of the slide’s background.

{button ,AL(`layer_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Forward One command (Arrange menu)
Moves the selected object on top of the object that's in front of it.

{button ,AL(`layer_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Backward One command (Arrange menu)
Moves the selected object in back of the object that's behind it.

{button ,AL(`layer_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Group command (Arrange menu)
Groups all selected objects together so that they can be selected and manipulated as a single object.
When an object in a group is selected, a single highlighting box appears around the entire group. Any command 
or operation applied to the group affects all objects in the group except for those listed below:

Combine (Arrange menu)
Break Apart (Arrange menu)
Fit Text to Path (Format menu)
Any operations using the Shape Tool

You can also collect groups into larger groups with other objects and/or groups. A single group can have as many 
as 10 sub-levels of grouping.
To break a group apart, use the Ungroup command.

{button ,AL(`groupobj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Ungroup command (Arrange menu)
Breaks up the selected group into its individual objects. If you have groups of objects grouped together, Ungroup
breaks up one level of grouping at a time.

{button ,AL(`groupobj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Combine command (Arrange menu)
Combines the selected curve/line segments into a single curve object. If you use Combine on rectangles, ellipses
or text objects, Corel PRESENTS converts them to curves before converting them into a single curve object.
Use Combine when you want to:

save time when editing many nodes or curve/line segments in different curve objects
join nodes on two different curve objects
create clipping holes or masks
conserve memory when working with slides which contain many lines and curves that share the same 

outline attributes

{button ,AL(`groupobj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Break Apart command (Arrange menu)
Converts an object made up of multiple subpaths into individual curve objects. Use Break Apart when you want 
to:

change an object that you previously combined with others using the Combine command in the Arrange 
menu

assign different fill or outline attributes to individual characters in a text object previously converted to 
curves

fill transparent regions that occur when you combine overlapping objects

{button ,AL(`groupobj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Convert to Curve command (Arrange menu)
Converts the selected rectangle, ellipse or text object to a series of curves and/or lines that you can shape with 
the Shape tool. Objects converted to curves are called curve objects.
Note

Once an object is converted to curves, it is not possible to return it to its original object type, except with 
the Undo command in the Edit menu.

Text converted to curves cannot be edited using the Text tool or any of the text editing commands.
If you convert text with overlapping characters to curves, the overlapping areas will be transparent.
If you applied different outlines and/or fills to individual characters in a string of Artistic text, converting 

the string to curves creates a group of objects (one object for each different fill/outline combination).

{button ,AL(`groupobj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Fit Object To Slide command (Arrange menu)
Scales the selected object to fit the dimensions of the slide. Applying this command to the background object in 
your presentation prevents white gaps from showing around the edges of your slides.
The Fit Object To Slide command changes the aspect ratio of the selected object, if necessary, to fit it to the 
slide.
Note

Corel PRESENTS animation files cannot be fitted to the slide. Other animation file formats may be fitted to 
the slide.

{button ,AL(`groupobj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Clear Transformations (Arrange menu)
Reverses the following transformations and effects, allowing you to restore an object to its original size and 
orientation:

resets all rotation and skew transformations to zero
returns the center of rotation to the object's center
resets to 100% any scaling or stretching

When applied to a group of objects, only transformations made to the group are cleared. Those made to objects 
before they were grouped are not cleared.
Note

The Clear Transformations command does not clear Move, Size or Scale operations.

{button ,AL(`groupobj_proc;;;;;',0,"Defaultoverview",)} Related Topics



Undo command (Edit menu)
Reverses actions performed during the current session. Use Undo after making a change that you do not want to 
implement. Immediately after choosing Undo, the Redo command becomes available, allowing you to restore 
what you just undid. The command name changes to Can't Undo when the last action taken cannot be undone. 
You cannot Undo the following actions:

Any change of view (Zoom-in, Zoom-out, etc.)
Any file operations (Open, Save, Import, etc.)

 Any selection operations (Marquee select, node select, etc.)
The name of the Undo command changes depending on the last action; for example, Undo Fill or Undo Rotate.

{button ,AL(`clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Redo command (Edit menu)
Restores the action just undone. The Redo command only becomes available immediately after you have used 
the Undo command. The name of the Redo command changes depending on the last action {emdash} for 
example, Redo Fill or Redo Rotate.

{button ,AL(`clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Repeat command (Edit menu)
Applies, when possible, the most recent command or action to the currently selected object. Useful when 
performing actions such as rotating objects to the same angle.

{button ,AL(`clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Cut command/button
Removes an object from the current slide and places it on the Clipboard. Once on the Clipboard, you can paste 
the object onto another slide or another Windows application.
Notes

In Slide Sorter view, the Cut command can be used to cut entire slides.
Objects cut from other programs and pasted into Corel PRESENTS usually appear in the center of the slide.
To permanently remove the selected object, use the Delete command in the Edit menu.

{button ,AL(`clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Copy command/button
Places a copy of an object onto the Clipboard. Once it is on the Clipboard, you can paste the object into another 
Windows application or Corel PRESENTS presentation.
Notes

In Slide Sorter view, the Copy command can be used to copy entire slides.
Objects copied between PRESENTS slides are pasted onto the current slide at the same size and location 

as the original.
Objects copied from other programs are usually pasted onto the center of the slide.

{button ,AL(`clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Paste command/button
Places a copy of the object currently on the Clipboard onto the active slide. The object remains on the Clipboard 
until you copy or cut another object or end the current Windows session.
Notes

When objects that are cut or copied from another Corel PRESENTS slide are pasted onto the current slide, 
they are the same size and occupy the same coordinate position as the original.

When objects that are cut or copied from other programs are pasted into the active slide they are placed in
the center of the slide.

Pasting slides that are cut or copied in Slide Sorter view automatically places them after the selected slide.

{button ,AL(`clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Paste Special command (Edit menu)

Inserts information from the Clipboard into your drawing. You can specify the format the information will be in 
and, optionally, create a link to the source file.

{button ,AL(`clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Delete command (Edit menu)
Deletes the selected object. If no subsequent action has been performed, you can restore a deleted object by 
choosing the Undo command.

{button ,AL(`how_delete_obj;clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Duplicate command (Edit menu)
Adds a copy of the selected object to current slide. By default, the copy is placed on top of the original and offset
down and to the right. It is also selected automatically.

{button ,AL(`select_obj_proc;clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



Select All command (Edit menu)
Selects all objects on the slide in Slide view or all slides in the presentation in Slide sorter view. When all objects 
or slides are selected, you can apply an action universally.
For example, you can use the Background command from the Edit menu and omit the background for all pages 
in the current presentation.

{button ,AL(`select_obj_proc;clipboard_proc;;;;;',0,"Defaultoverview",)} Related Topics



 Edit Background command (Edit menu)
Opens a flyout menu, which allows you to choose an existing background to edit. You can choose from the Blank,
Uniform Fill, Outline Fill, Image, Texture fill or From Library commands.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Blank command (Edit menu)
Choose the command to not apply any background to the selected slides.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Uniform Fill command (Edit menu)
Opens the Uniform Fill dialog box, which allows you to select Color modes, palettes, or mixers to use; modify 
color and palette options; or create a custom palette. Uniform fills are solid colors; the fill is applied to the entire 
slide, as a background layer.
You do not have to already have a uniform fill background applied to the slide to use this command.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics





Background, Fountain Fill command (Edit menu)
Opens the Fountain fill dialog box, which allows you to choose the fountain type, angle. steps and color blend or 
to apply to the background. A Fountain fill is a progression of colors following a circular, square, straight, or radial
path. You can have a direct blend from one color to another, or a cascade of different colors. The fill is applied to 
the entire slide, as a background layer.
You do not have to already have a Fountain fill background applied to the slide to use this command.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics





Background, Two-Color Bitmap Pattern command (Edit menu)
Opens the Two-Color Bitmap Pattern dialog box, which allows you to choose two-color pattern fills, select the 
colors, change the pattern size and tile the pattern. The fill is applied to the entire slide, as a background layer.
You do not have to already have a background pattern applied to the slide to use this command.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics





Background, Full Color Bitmap Pattern command (Edit menu)
Opens the Full Color Bitmap Pattern dialog box, which allows you to import bitmap images to use as fills. You can 
choose the pattern size, and tile the pattern. The fill is applied to the entire slide, as a background layer.
You do not have to already have a background pattern applied to the slide to use this command.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics





Background, Texture Fill command (Edit menu)
Opens the Texture fill dialog box, which allows you to choose a texture from the library, and modify it to apply as 
a background. A Texture fill is a factually-generated picture that you can use to give your object the appearance 
of natural materials. You can choose from a series of pre-generated textures, or randomly generate variations.
You do not have to already have a Texture fill background applied to the slide to use this command.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics





Background, Vector Pattern command (Edit menu)
Opens the Vector Pattern dialog box, which allows you to import vector images to use as fills. You can choose the
pattern size, and tile the pattern. The fill is applied to the entire slide, as a background layer.
You do not have to already have a background pattern applied to the slide to use this command.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



# IDH_Format_BKGND_fromlib$ Background, From Library command (Edit menu)> proc4



Find command (Edit menu)
Searches for specified text in the current slide, speaker note or handout.

{button ,AL(`edit_text_proc;;;;;',0,"Defaultoverview",)} Related Topics



Replace command (Edit menu)
Searches for and replaces specified text in the current slide, speaker note or handout.

{button ,AL(`edit_text_proc;;;;;',0,"Defaultoverview",)} Related Topics



Go To command (Edit menu)
Opens a flyout menu from which you can choose either Slide, Handout or Speaker Note. The Go To dialog box 
shows the current page number.



Go To Slide command (Edit menu)
Opens the Go To Slide dialog box, which allows you to choose a slide to move to directly. You can also click on the
tab scrolling buttons, located at the bottom left of PRESENTS.



Go To Handout command (Edit menu)
Opens the Go To Handout dialog box, which allows you to choose a handout page to go to directly.



Go To Speaker Note command (Edit menu)
Opens the Go To Speaker Note dialog box, which allows you to choose a speaker note page to go to directly.



Go To Slide, Handout or Speaker Note dialog box
Moves directly to the slide, handout or speaker note you choose.



Choose a slide, handout or speaker note to move to.



Links command (Edit menu)

Lists all the links in the current file. This list includes internal links to other Corel PRESENTS files and external 
links to other Windows applications.





Object, Open command (Edit menu)
Opens the objectwithin its server application.



Object, Convert command (Edit menu)
Converts the selected object to a different object type.



Object, Edit command (Edit menu)
Allows you to edit the information stored in the server application, while remaining within the PRESENTS window.
You can also double-click inside the object to open the server.



Properties command (Edit menu)
Opens the Properties dialog box for the chosen item (slide, object, text).



Slide Properties dialog box
Opens the Transitions, Slide, and Header/Footer tabs, from which you can set the slide opening and closing 
transitions, create headers and footers, type a slide name, and choose show/hide options for the slide.

{button ,AL(`transitions_proc;page_setup_proc;;;;',0,"Defaultoverview",)} Related Topics



 

Transitions page
Sets the opening and closing transitions for the selected item, including the transition type, direction, duration 
and steps.



Choose the route the opening transition follows.



Choose the direction in which the opening transition moves.



Choose how long (in seconds) it takes for the opening transition to follow the route.



Choose the number of movements (in seconds/frame) the opening transition makes, based on the duration.



Choose the route the closing transition follows.



Choose the direction in which the closing transition moves.



Choose how long (in seconds) it takes for the closing transition to follow the route.



Choose the number of movements (in seconds/frame) the closing transition makes, based on the duration.



 

Slide page
Sets the slide properties, including naming the slide, hiding the slide, setting the slide duration, displaying the 
header, footer and margins. The name of the slide appears on its tab at the bottom on the presentation window 
and in the Object Manager.



Type the name you want to give to the slide.



Enable the check box to hide the slide.



Type the number of seconds which you want the slide to appear on-screen.



Enable the check box to display the margins set in the Page Setup dialog box.



Enable the check box to display the header created in the Page Setup dialog box, if applicable.



Enable the check box to display the footer created in the Page Setup dialog box, if applicable.



 

Header/Footer page
Creates headers and footers in the presentation slides, handouts and speaker notes.



Object Properties dialog box
Opens the Transitions, Path, and Attributes tabs, from which you can set the object opening and closing 
transitions, set a transition path, and create links to the master layout for the selected object.
If you selected a text object, the Text Effects tab is also displayed.



 

Transitions page
Sets the opening and closing transitions for the selected object, including the transition type, direction, duration 
and steps.



 

Path page
Sets the path along which the selected item’s transition moves.



Choose the path along which the transition moves.



 Attributes page
Links the fill, outline, position, size, font style, font size, and deletion attributes from the layout and text frames 
to the master layout.



Enable the check box to link the object’s fill with the master layout frame.



Enable the check box to link the object’s outline with the master layout frame.



Enable the check box to link the object’s position with the master layout frame.



Enable the check box to link the object’s size with the master layout frame.



Enable the check box to link the object’s font style and size with the master layout frame, if applicable.



Enable the check box to delete links between the object and the master layout frame.



Text Effects page
Sets the effects for the selected Paragraph text grouping, including the transition type, direction, duration and 
steps that the text will enter and exit the screen. Also enables the option to separate bullets from text.



Choose either Paragraph or line as the text to which the transition is applied.



Enable the check box to separate the text transition from bullet transitions. You can then click the Options 
button, and set a transition for the bullet.



 Enable the check box to pause each paragraph, or the lines within a paragraph (depending on your selection in 
the Grouping box) as the text appears on the screen. You manually advance each paragraph/line. When you want
the text removed from the slide, you click the manual advance once, and the text flies off the screen without 
pauses.



Click the button to open the Bullet Settings dialog box, which allows you to separate the text transition from 
bullet transitions.



Click an arrow to set the direction of the transition.



!ALink(transitions_proc;;;;;;;;,0,"default_procedure",)Bullet Settings dialog box
Sets the timing, entry and exit directions for the selected bullet.



Choose either Before, After or Same to choose when the bullet appears, in relation to the related text.



Choose the direction from which the bullet appears on the screen.



Choose the direction from which the bullet leaves the screen.



Handouts Page
Sets the handouts properties, including naming the handout, hiding or showing the header, footer and margins. 
The name of the handout appears on its tab at the bottom on the presentation window and in the Object 
Manager.



Type the name you want to give to the handout. The name of the handout appears on its tab at the bottom on 
the presentation window and in the Object Manager.



Speaker Notes Page
Sets the speaker notes properties, including naming the speaker slide, hiding the slide for a set duration, 
displaying the header, footer and margins. The name of the speaker note appears on its tab at the bottom on the
presentation window and in the Object Manager.



Type the name you want to give to the speaker note. The name of the speaker note appears on its tab at the 
bottom on the presentation window and in the Object Manager.



Video Page
Shows the drive, directory and file name of the video file. You can also choose to display the video in the    full 
screen. 



Enable the check box to show the video at the full screen size. If you leave the check box disabled, the video 
plays at the same size as the video frame on the slide.



 

 Background page
Provides information on the current background fill, other slides in the presentation using the background, and 
other information on presentation backgrounds.



_New command [File menu]
Provides access to the Document, From Template and From Wizard commands, which you can use to start a new 
presentation.
New presentations use the same ruler and guideline settings plus the Presentation Options in effect for the 
current session. Use the Preferences command in the Tools menu to change presentation options.

{button ,AL(`how_start_new;how_new_pres_wiz;;;;',0,"Defaultoverview",)} Related Topics



Document command (File,New)
Starts a new, blank presentation. The new presentation uses the default page, ruler, and guideline settings. Click
File, Page Setup to change the page settings.

{button ,AL(`basic_file_proc;;;;;',0,"Defaultoverview",)} Related Topics



From Template command (File,New)
Opens the Templates dialog box, which allows you to start a new presentation from a template of your choice. 
The template provides one slide, with a preset background and layout. You can add slides to the presentation, 
following the template style, by clicking Insert, Slide.

{button ,AL(`basic_file_proc;;;;;',0,"Defaultoverview",)} Related Topics



Templates dialog box
Allows you to start a new presentation from a template of your choice. The template provides one slide, with a 
preset background and layout. You can add slides to the presentation, following the template style, by clicking 
Insert, Slide.



Double-click the thumbnail that you want to use as the template for your presentation.    type of presentation you
want to create. The template provides one slide, with a preset background and layout. You can add slides to the 
presentation, following the template style, by clicking Insert, Slide.



From Wizard command [File menu]
Opens the Corel PRESENTS Presentation Wizard dialog box, which guides you through the creation of a new 
presentation that is customized to your requirements. You respond to a series of simple questions, and the 
Wizard reflects the formatting you choose.

{button ,AL(`basic_file_proc;;;;;',0,"Defaultoverview",)} Related Topics



Corel PRESENTS Presentation Wizard dialog box 
Respond to the questions in each dialog box; the Wizard creates a new presentation that is customized to your 
requirements. Click Next to continue.
Note
The presentation is based on the default presentation template, but the formatting reflects your choices when 
responding to the Wizard.



Corel PRESENTS Presentation Wizard dialog box 
Choose the type of presentation you want to create. Based on the topic you select, a presentation is created with
backgrounds, layouts, sample titles and body text cues. You can modify the presentation to suit you 
requirements. 



Choose the type of presentation you want to create. A presentation is created with backgrounds, layouts, sample
titles and body text cues. You can modify the presentation to suit your requirements.



Open command/button
Opens the Open dialog box, which lets you choose an existing presentation, background or screen show. If you 
already have a presentation open, PRESENTS opens the presentation over the original. Use Tile Horizontally or 
Tile Vertically to display a number of presentations simultaneously.

{button ,AL(`how_open_file;how_open_recent;;;;',0,"Defaultoverview",)} Related Topics



Open dialog box
Opens an existing presentation in a new window. If you already have a presentation open, PRESENTS opens the 
presentation over the original. Use Tile Horizontally or Tile Vertically to display a number of presentations 
simultaneously.



Choose the directory from which you want to open the presentation file. Click the down arrow to see how the 
current folder fits into the hierarchy on your computer. Double-click a file to open it.



Shows the folders or files stored in the directory you specified in the Look in box.
Click the filename in the display window. The name is inserted in the File Name box. Double-click on the filename
in the display window to open the presentation file.



Type the name of the file you want to open.
Click the filename in the display window. The name is inserted in the File Name box. Double-click the filename in 
the display window to open the presentation file.



Click the type of file you want to open.
Presentations have the .CPR extension. Background libraries have the .CPB extension, and portable screen show 
files have the .CRP extension.



Click to view a higher level of folders.



Click to create a sub-folder under the level listed in the Look in box.
To delete a sub-folder you create, choose the folder and press delete.



Click to list the folders or files stored in the directory in the Look in box.



Click to view details on the name, size, type, and modification date of the folders or files listed in the display 
window.



Click to open the file you identified in the File Name box. You can also double-click the filename in the display 
window to open the file.



Save command/button
Saves the current presentation under the name displayed in the title bar. If you have not saved the presentation 
yet, the Save As dialog box appears, prompting you to enter a name. If you are altering an existing presentation,
but want to keep the original version, use the Save As command.
Note
When saving a presentation, the following settings are saved with the file:

page size and orientation
ruler units and origins
snap to guidelines status
presentation options

{button ,AL(`how_saveall;how_save_file;how_save_changes;how_save_new_name;;;',0,"Defaultovervi
ew",)} Related Topics



Save As command (File menu)
Opens the Save As dialog box, which allows you to save:

a new presentation
a new version of an existing presentation
an existing presentation with a new name or in a different location

{button ,AL(`how_saveall;how_save_file;how_save_changes;how_save_new_name;;;',0,"Defaultovervi
ew",)} Related Topics



Save As dialog box
Saves a new presentation, a new version of an existing presentation, or an existing presentation with a new 
name or in a different location.



Choose the directory in which you want to save the presentation file. Click the down arrow to see how the 
current folder fits into the hierarchy on your computer.



Shows the folders or files stored in the directory you specified in the Save in box.



Type the name of the file you want to save. You can also type the full path of the file. For example, you can type 
c:\myfiles\show.cpr to save the show.cpr file to the myfiles directory on the c: drive.



Choose .CPR as the type of file to be saved for a presentation.
To save a background, choose .CPB as the file type.
To save a portable screen show, choose .CRP as the file type.



Click to view a higher level of folders.



Click to create a sub-folder under the level listed in the Save in box.
To delete a sub-folder you create, choose the folder and press delete.



Click to list the folders or files stored in the directory in the Save in box.



Click to view details about the name, size, type, and modification date of the folders or files listed in the display 
window.



Click to save the file you identified in the File Name box.



Runtime File Options dialog box
Allows you to embed fonts and copy animation files to the same directory as you are saving the Runtime Player 
(.CRP) file.



Enable the check box when you are creating a Runtime file for your presentation. This option ensures that even if
the fonts you used in your presentation are not installed on the machine that you’re running the Runtime file, 
you won’t lose your font styles.



Enable the check box to copy animation files that you inserted into the presentation to the same directory as you
are saving the Runtime Player file.



Save All command (File menu)
Saves all open presentations. If you have not saved a presentation yet, the Save As dialog box appears, 
prompting you to enter a name. If you are altering an existing presentation, but want to keep the original 
version, use the Save As command.
Note
When saving a presentation, the following settings are saved with the file:

page size and orientation
ruler units and origins
snap to guidelines status
presentation options

{button ,AL(`how_saveall;how_save_file;how_save_changes;how_save_new_name;;;',0,"Defaultovervi
ew",)} Related Topics



Close command (File menu)
Closes the active presentation window. If you made changes since you last saved the presentation, a message 
appears asking if you want to save them. 
If you choose Yes and the presentation is unnamed, the Save As dialog box appears so that you can name and 
save the file. 
Tip
You can also close a presentation by choosing Close from the presentation window's Control menu.



Import command (File menu)

Brings files into Corel PRESENTS from other programs. You can also use this command to merge other PRESENTS 
files with the current presentation. You can have PRESENTS choose the import filter type for you by choosing All 
Files in the List Files of Type box.



Send command (File menu)
Opens Microsoft Exchange, which allows you to send and receive electronic mail or fax messages. You send 
messages from and store all messages in Microsoft Exchange. You must have the necessary hardware, and 
belong to the Exchange.



Print command (File menu)

Opens the Print dialog box. This dialog box allows you to print your work, change the print options, and change 
the printer and printer properties.



Allows you to print slides, handouts, speaker notes, or the presentation outline.



Print Setup command (File menu)

Opens the Print Setup dialog box. This dialog box allows you to change the printer and printer properties.



Page Setup command (File menu)
Opens the Page Setup dialog box, which allows you to set the page size, orientation, margins, headers and 
footers for all slides in the current presentation. The Page Setup dialog box has two sections: Size/Margin and 
Header/Footer.
When you save a presentation, the Page Setup settings are also saved.
The page orientation you choose here should match the orientation specified with the File, Print Setup command.

{button ,AL(`page_setup_proc;;;;;',0,"Defaultoverview",)} Related Topics



Page Setup dialog box
Opens the Size/Margin and Header/Footer tabs, from which you can set the page size, orientation, margins, 
headers, and footers for all slides in the current presentation. When you save a presentation, the Page Setup 
settings are also saved.
The page orientation you choose here should match the orientation specified with the File,Print Setup command.



Size/Margin page
Sets options for the current view, page size, and margin width of the presentation page. If you change the page 
size, you can set object scaling options to ensure that objects maintain their aspect ratios. The page orientation 
you choose here should match the orientation specified with the File, Print Setup command.



Enable the button to set the default view for all slides in the current presentation to Slide View, with background 
displayed. You must have created or chosen a background from the library for a background to be displayed. 
Otherwise, the background will display as a white page.



Enable the radio button to set the default view for all slides in the current presentation to Speaker Notes view. 
Speaker Notes display a thumbnail of the slide, with a body text section for you to add notes.



Enable the radio button to set the default view for all slides in the current presentation to Handout view. 
Handouts display thumbnails of several slides per page, with body text sections for you to add notes for the 
audience.



Enable the radio button to set the page to be longer vertically than horizontally. The page is oriented so that it 
prints from left to right across its shortest dimension.



Enable the radio button to set the page to be longer horizontally than vertically. The page is oriented so that it 
prints from left to right across its longest dimension.



Choose one of the standard paper sizes or choose Custom.
The following options set page sizes for producing slides, overheads and screen shows.
Slide chooses a page dimension with the same aspect ratio as a 35mm slide.
Screen chooses a page dimension with same aspect ratio as your computer screen.
Overhead adds margins that are required when mounting overheads in frames.



If you chose a custom paper size, set the horizontal dimensions that you require. You can specify a custom page 
size up to 17x17 inches.



If you chose a custom paper size, set the vertical dimensions that you require. You can specify a custom page 
size up to 17x17 inches.



Set the distance from the top of the page that you want the top margin to appear. The margin cannot be less 
than the margin set for your printer.



Set the distance from the bottom of the page that you want the bottom margin to appear. The margin cannot be 
less than the margin set for your printer.



Set the distance from the left side of the page that you want the left margin to appear. The margin cannot be 
less than the margin set for your printer.



Set the distance from the right side of the page that you want the right margin to appear. The margin cannot be 
less than the margin set for your printer.



If you changed the paper size, enable the radio button to modify the aspect ratio of all objects to best fit the 
page.



If you changed the paper size, enable the radio button to change the aspect ratio of all objects to fit to the page 
size.



If you changed the paper size, enable the radio button to leave the aspect ratio of all objects as is.



Header/Footer page
Creates headers and footers in the presentation slides, handouts and speaker notes. The header repeats at the 
top of every page or slide; the footer at the bottom.



Enable the radio button to create a header and footer for your presentation slides. The header and footer are 
diplayed on every slide in the presentation.



Enable the radio button to create a header and footer for your presentation handouts. The header and footer are 
diplayed on every handout page.



Enable the radio button to create a header and footer for your presentation speaker notes. The header and 
footer are diplayed on every speaker notes page.



Choose the information to insert into the header from the list box. You can click the Custom Header button to 
type your own information to display in the header.



Click to create a customized header. You can change the font type, size and characteristics (bold, italics and 
underlining); choose macros to insert information; or type your own text in the Left, Center, and Right display 
windows.



Displays the information that you chose or created. You can type your own text in the Left, Center, and Right 
display windows.



Click to create a customized footer. You can change the font type, size and characteristics (bold, italics and 
underlining); choose macros to insert information; or type your own text in the Left, Center, and Right display 
windows.



Customize Header/Footer dialog box
Creates customized headers and footers in the presentation slides, handouts and speaker notes. The header 
repeats at the top of every page or slide; the footer at the bottom.



Type text you want to appear on the left side of the header or footer. You can choose the font type, size and 
characteristics (bold, italics, and underlining) from the Attributes section. You can also choose a macro to insert 
into the display window, from the Macros section.



Type text you want to appear in the center of the header or footer. You can choose the font type, size and 
characteristics (bold, italics, and underlining) from the Attributes section. You can also choose a macro to insert 
into the display window, from the Macros section.



Type text you want to appear on the right side of the header or footer. You can choose the font type, size and 
characteristics (bold, italics, and underlining) from the Attributes section. You can also choose a macro to insert 
into the display window, from the Macros section.



Changes the font style for the selected text or the default font. Scoll down the list to view all fonts installed on 
your computer.



Changes a point size for the selected text or for the default font. The arrow located on the right of the Point size 
box is used to see the list of point sizes and make a selection. You can type the point size directly.



Applies or removes bolding, italics and underlining to the selected text or the default font.



Inserts the number of the slide in the header or footer.



Inserts the total number of slides in the presentation, e.g.. Slide 1 of 10.



Inserts the date and time, which is automatically updated every time you open the presentation file. Choose the 
date and time format from the dialog box that appears when you click the Date and Time button.



Inserts the user name that is specified in the Tools, Options menu. A name must be entered in the User Info 
dialog box for the information to appear in the header.
To change the user name, click on the User Info tab in the Options menu and change the name in the User Name
box.



Inserts the user organization that is specified in the Tools, Options menu. A name must be entered in the User 
Info dialog box for the information to appear in the header.
To change the user organization, click on the User Info tab in the Options menu and change the name in the User
Organization box.



Date and Time dialog box
Provides date and time formats you can insert into the headers and footers of your slides, handouts and 
speakers notes. If none of the built-in formats suits your needs, you can create your own custom formats.



Lists the preset date and time formats. Click on the format to select it.



Click the language you want the date and time to display in.



Enable this option to have Corel PRESENTS update the date and time each time you open the presentation.



Click to create your own time and date formats.



Click to add the custom format currently displayed in the Format String box to the Available Formats list.



Click to delete a custom format selected in the Available Formats list box. The built-in formats cannot be deleted.



Run Presentation command/button
Runs the current presentation including transition effects, time on screen, and sound and animation files.    The 
show runs according to the presentation options chose in the Tools, Options command. You can click the ESC key 
to exit the running presentation and return to the PRESENTS window.

{button ,AL(`how_play_shw;how_stop_shw;how_present_options;;;',0,"Defaultoverview",)} Related 
Topics



Exit command (File menu)
Ends the current Corel PRESENTS session. If you have any open presentations with unsaved changes, PRESENTS 
prompts you to save those presentations before closing.
The next time you run PRESENTS, the program will use the same settings in effect during the last session. These 
settings are as follows:

default template
Page Setup settings
Grid Frequency and Origin settings
Guidelines and Grid Snap To settings
all settings in the View menu
all settings in the Options dialog box
disk drive and directory for Open, Save, Export, Import, and Print to File dialog boxes



Recent File command (File menu)
Lists the last four presentation files you closed. Type the number next to a file, or click the filename to open that 
presentation.



New Presentation dialog box
Starts a new presentation from the Wizard, template, or a blank presentation. You can also open an existing 
presentation, or the last presentation you opened. You can disable the dialog box from appearing from the 
General tab of the Tools, Options command.



Opens the Corel PRESENTS Presentation Wizard dialog box, which guides you through the creation of a new 
presentation that is customized to your requirements.    You respond to a series of simple questions, and the 
Wizard reflects the formatting you choose.



Opens the Template dialog box, which allows you to start a new presentation from a template of your choice. The
template provides one slide, with a preset background and layout. You can add slides to the presentation, 
following the template style, by clicking Insert, Slide.



Starts a new, blank presentation. The new presentation uses the default page, ruler, and guideline settings. Click
File, Page Setup to change the page settings.



Opens an existing presentation in a new window.



Opens the last presentation that you saved. The presentation filename is listed beside the Open button.



Enable the check box to disable the New Presentation dialog box from appearing when you start PRESENTS.



New Presentation dialog box
Opens a presentation from the Wizard, a template, or a blank presentation.
New presentations use the same ruler and guideline settings plus the Presentation Options in effect for the 
current session. Use the Options command in the Tools menu to change presentation options.



Help Topics command (Help menu)
Opens the Help Contents, which lists available Help topics. If you are viewing a Help topic and you want to return
to Help Contents, click the Contents button.
Double-click on a book to view a list of associated topics.
Double-click on a topic to open the relevant information.



 Tutorial command (Help menu)
Opens the PRESENTS online tutorial, which includes a series of lessons for you to follow and become familiar with
the PRESENTS application. 



What's This command/button
Changes the mouse pointer into a question mark. You can click on any command or area in the screen to receive 
help on the relevant topic. You can also access help on commands by highlighting a command and pressing F1.



Technical Support command (Help menu)

Opens the Technical Support help file, which provides details on product support for Corel applications; including 
available support services, Import and Export filters information, error messages, and troubleshooting tips.



About Corel PRESENTS command (Help menu)
Opens the About Corel Presents dialog box, which displays the version, copyright, and license information for 
Corel PRESENTS.



About Corel PRESENTS dialog box
Displays the version, copyright, and license information for Corel PRESENTS.



Click to escape from the dialog box and return to the presentation.



Click to open the System Info dialog box, which provides you with information about your operating system, 
display, network, printers, Corel executable files, and . DLL files.



 System Info dialog box
Displays information about your operating system, display, network, printers, Corel executable files. and DLL 
files.



Choose a category from the drop-down list box. The categories are: System, Display, Network, Printing, Corel 
EXEs and DLL and System DLLs.



Displays the system information for the chosen category.
System: information about your computer. For example, Windows version, DOS version, processor, etc.
Display: information about your monitor. For example, driver, driver version, etc.
Network: information about the network. For example, drivers, whether a network is installed, etc.
Printing: information about installed printers.
Corel EXEs and DLLs: lists all of the Corel EXEs and DLL.
System DLLs: lists all of the system DLLs.



Click to save all of the chosen category's details to a predefined file.



Proofreading commands
Displays a flyout from which you can choose the Spelling, Quick Proofreading, Full Proofreading, and Advanced 
Options commands.
The International Proofreader's three checking modes Spelling, Quick Proofreading and Full Proofreading

serve users with varying needs. For example, an office worker who considers speed paramount might want to 
check only for spelling and mechanical errors. Meanwhile, a journalist writing an article for publication might want 
to check for stylistic problems. The same journalist, however, having carefully polished and checked the article's 
style, might want to check the spelling quickly once again before submitting the article. Lastly, an academic or 
another journalist might be so confident as to consider it unnecessary to check for items such as confused words, 
clichés, or wordy expressions.

The International Proofreader's functionality is as uniform as linguistically possible across all supported 
languages. It follows the conventions prescribed by widely accepted grammar and style manuals for each 
language, and it handles language variants appropriately.
The checking and correction functionality of the Proofreader is divided into three checking modes:

Spelling mode
Quick Proof mode
Full Proof mode

{button ,AL(`text_overview;proof_proc;',0,"Defaultoverview",`main')} Related Topics



Thesaurus command (Tools menu)
Suggests synonyms for words in your document. Use one of the text tools to highlight the word you want a 
synonym for, and then choose the Thesaurus command.
Tip

You can use the Thesaurus to look up any word, not just the current selection or document.

{button ,AL(`text_overview;;;;',0,"Defaultoverview",)} Related Topics



Type Assist command (Tools menu)
Opens the Type Assist dialog box, which has automatic controls for text capitalization the first letter of 
sentences, two initial consecutive capitals and names of days

and changing straight quotes to typographic quotes. 
Type Assist also enables you to replace text strings automatically if you want to, replacing "teh" with "the" for 
example, and includes a number of presets.
If you enable the Replace Text While Typing option, correction takes place after you finish typing the word, either 
by entering a punctuation mark or a space.

{button ,AL(`wrtp_pr02_cd;type_asst_proc;;;;',0,"Defaultoverview",`main')} Related Topics



slideSlide Sorter





Multimedia Manager (Tools menu)

Opens the Corel MULTIMEDIA MANAGER, which allows you to organize, manage and manipulate your multimedia 
files. You can create albums and sub-albums to group your files any way you want. Graphics files are displayed 
as thumbnail images, so that you can easily identify the contents. You can assign keywords to individual items 
and to whole albums to help you search for a particular file in your collection.



Customize command (Tools menu)
Opens the Customize dialog box, which allows you to rearrange toolbar icons; add, rearrange, and rename 
menus; and create, reassign, load, reset, and save keyboard shortcuts.



Options command (Tools menu)
Opens the Options dialog box, which allows you to set the display options for the Corel PRESENTS user interface 
and to set general presentation options to control the behavior of a screen show.
The Options dialog box is divided into six sections: General, Presentation, Graphics, Text, Animation, and User 
Information. You can access a section by clicking the appropriate tab.



Options dialog box
Opens the General, Presentation, Graphics, Text, and User info tabs, which allow you to set options to undo, set 
default units, show startup dialog, display large thumbnails, set screen show options, determine number of 
default    pixels when drawing, set tab and bullet spacing, and enter user information.



General page
Sets the controls to show the startup dialog when starting PRESENTS, choose the number of levels that can be 
undone using the Edit, Undo command, identify the standard units of measurement, and choose large 
thumbnails.



Type the number of default undo levels that can be used from the Edit, Undo command. More memory is 
required the greater the number of undo levels. 



Choose the default units of measurement that you will use in your presentation.    You can choose inches, 
millimeters, pica , points, centimeters, pixels, cicero, or didots as the default measurement.



Enable the check box to have the Start up screen options dialog box open each time you start Corel PRESENTS. 
From the dialog box, you can choose to start the Presentation Wizard, a template, a blank presentation, open an 
existing file, or open the last presentation used.



Enable the check box to display large thumbnail images in Slide Sorter view. If you have a large presentation, 
this can slow down the refresh speed.



Enable the check box to define that OLE objects that you insert into the presentation maintain their aspect ratio, 
while fitting into the marquee frame you draw. For example, if you draw a marquee frame that is wider than it is 
long, and your object is longer than it is wide, the object will fit the vertical dimensions of the marquee frame, in 
order to maintain its aspect ratio.
If you disable the check box, the object will fit to the marquee frame you draw.



Presentation page
Sets the controls for Corel PRESENTS screen show features. You can choose to automatically advance slides, run 
the show continuously, or display a pointer on-screen during the screen show.



Enable the button to automatically advance from one slide to the next during the screen show.



Enable the check box to continually repeat the screen show until you press the ESC key.



Enable the check box to display the mouse pointer on-screen.



# idh_optionsdb_pres_Generatepresentation



# idh_optionsdb_pres_videopalette



Click to choose the line thickness you want for the pen.



Click to change the pen color. You can choose between sixteen different colors.



Graphics page
Sets the default number of pixels for Freehand drawing mode tracking, corner threshold, straight line threshold, 
and auto join.



Type the number of pixels to control how closely Corel PRESENTS tracks the motion of the mouse when drawing 
in Freehand drawing mode. The lower the number, the rougher the curves tend to appear.



Type the number of pixels to control a smooth corner or a cusp when drawing in Freehand drawing mode. The 
lower the number, the greater the tendency toward cusps.



Type the number of pixels to control a straight or curve segment when drawing in Freehand drawing mode. The 
lower the number, the greater the tendency toward drawing curves.



Type the number of pixels to control the auto join radius when drawing in Freehand drawing mode or Bezier 
drawing mode. The lower the number, the closer the cursor must be to the end nodes of an existing segment in 
order for the next segment to automatically join with it.



# idh_optionsdb_grph_treatobj



Text page
Sets the default tab width and inter bullet spacing options.



Choose the unit of measurement and type the width to set the default tab stops.



Choose the unit of measurement and type the amount of space to leave before and after the bullet. Also known 
as paragraph spacing.



User Info page
Records your name, title, and organization which you can then add to your presentation as part of the header 
and footer. After entering the User Information, use the File, Page Setup command to add the information to the 
slides, handouts and speaker notes .



Type your name.



Type your position title.



Type the name of the company for which you work.



Records your name, title, and organization which you can then add to your presentation as part of the header 
and footer. After entering the User Information, use the File , Page Setup command to add the information to the 
slides, handouts and speaker notes.



Animation page
Use this page to set time properties for animation, transitions and Snap to times, as well as define paths which 
display position and size or position only.



Type the amount of frames per second you want the animation to use. More frames per second result in 
smoother animation.



Type the amount of time you want the transition to last.



Type the amount of time you want the animation to advance when you click the Advance Time command in the 
Animation menu.



Click to create an animation path where you have direct control over changes in an objects size as it travels 
between two non-adjacent nodes. This option is more manual than using the Position only option. For example, if
you want an object to change gradually in size between two non-adjacent nodes, you must change the objects 
size yourself at each node. With this option, each node displays as a two-color rectangle to indicate that both 
position and size are automatically registered.



Click this option to create an animation path where Presents automatically calculates the amount that an object 
changes size as it travels between two non-adjacent nodes. This is a more automatic procedure than using the 
Position /size option. If you want an object to change gradually in size between two non-adjacent nodes, you only
have to decide which nodes are to be the beginning and end nodes, then, change the objects size as required. 
Presents will calculate a smooth, gradual transition in size between the two nodes. With this option, only the 
nods where you change the size of the object display as two color rectangles.



Toolbars page
Allows you complete control over the commands on your toolbars, with the exception of the toolbox and its 
flyouts. With simple mouse actions, you can dock, undock, re-size, and move your toolbars anywhere on the 
screen.
You can also add and remove buttons to the built-in toolbars, or create your own toolbars containing only the 
commands you use most often.



Menus page
Allows you to add commands to existing menus, or add new menus to the menu bar. You can change the order of
the menus and their commands to give you quick, easy access to the functions you use most.



Keyboard page
Allows you to change built-in keyboard assignments, or assign an accelerator key combination to any command. 
You can create several sets of keyboard assignments to use for different types of operations, saving and loading 
sets as they are needed.



bmr ht_00.bmp}Color palette page
Allows you to change colors in your objects. You can move the palette anywhere on the screen and edit the color 
order to make it easy to find your favorite colors.



Slide command/button
Displays Slide View, which includes a slide and any objects used to create the slide contents such as graphics, 
text, animation and sound. From Slide view you use all the other views to help build your presentation.

{button ,AL(`view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Slide Sorter command/button
Switches to Slide sorter view, which displays all slides in the presentation as thumbnails. From Slide Sorter view, 
you can:

rearrange the order of slides in the presentation
add or delete slides
apply layouts or backgrounds to groups of slides
assign transition effects
show or hide the slide or jacket

{button ,AL(`view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Outline command/button
Switches to Outline view, which displays the text typed in the placeholders of all presentation slides. You can:

arrange the text of a slide in hierarchical order
rearrange the order of slides or bullets
choose the type of text, font, style, or layout
select basic effects such as bold, italic and underline
display text in draft or preview mode

{button ,AL(`view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Master Layout command/button
Opens a flyout menu, which allows you to choose the type of master layout to view: title slide master, slide 
master, speaker notes, or handout. You can view the master layout you selected; change the font style, color and
size; change the bullet style and color; and position and size the frames.

{button ,AL(`view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Title Slide Master command (View menu)
Chooses the Title Slide master layout to view. You can view the master layout you selected; change the font 
style, color and size; and position and size the frames.

{button ,AL(`layout_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Slide Master command (View menu)
Chooses the Slide master layout to view. You can view the master layout you selected; change the font style, 
color and size; change the bullet style and color; and position and size the frames.

{button ,AL(`layout_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Handout Master command (View menu)
Chooses the Handout master layout to view. You can view the handout layout, and modify the layout style.

{button ,AL(`layout_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Speaker Note Master command (View menu)
Chooses the Speaker Note master layout to view. You can view the speaker notes layout, and modify the layout 
style.

{button ,AL(`layout_proc;create_note_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background command/button
Switches to Background view, which displays the background elements common to all slides with the same 
background number in the current document, omitting all other objects. Use this command when you want to 
create a new background or make changes to an existing background.

{button ,AL(`background_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Speaker Notes command (View menu)
Switches to Speaker Notes view, which provides a thumbnail representation of the current slide. The extra space 
on the page is for writing speaker notes. The page selection tabs located at the bottom of the presentation 
window can be used to navigate through your speaker notes.
Note

The speaker notes pages are saved with the presentation file and can be printed for use as an aid for the 
speaker.

The speaker notes layout can be changed from the Layout Library.

{button ,AL(`create_note_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Handout command (View menu)
Switches to Handout view, which allows you to create handouts of the presentation for the audience. It provides 
you with a thumbnail of each slide to which you can add accompanying text.
Note

The handout pages are saved with the presentation file.
The handout layout can be changed from the Layout Library.

{button ,AL(`create_note_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Animation command (View menu)
Switches to Animation view, which allows you to animate objects by defining a path along which objects can 
travel. Animation view includes VCR buttons that allow you to set and manage the display of animated objects 
and control the play and playback of animations when editing them.

{button ,AL(`anim_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Object Manager command (View menu)
Opens the Object Manager dialog box, which displays a tree structure of presentation slides and objects; each 
slide or object has a corresponding check box which allows you to show or hide the image in the presentation. 
The information displayed in the Object Manager changes depending on the current view. For example, in Slide 
view, all the objects in the current slide are displayed; in Slide sorter view, all the slides in the presentation are 
displayed, with an option to view the objects on the slide; in Background view, all objects on the background are 
displayed.

{button ,AL(`how_object_mgr;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Object Manager dialog box
Displays a tree structure of presentation slides and objects; each slide or object has a corresponding check box 
which allows you to show or hide the image in the presentation. The information displayed in the Object Manager
changes depending on the current view. For example, in Slide view, all the objects in the current slide are 
displayed; in Slide sorter view, all the slides in the presentation are displayed, with an option to view the objects 
on the slide; in Background view, all objects on the background are displayed.



Enable the check box beside the slide or object to show the in the presentation; disabling the checkbox hides the
slide or object from view. The information displayed in the Object Manager changes depending on the current 
view. The dialog box remains on screen until you close it.



Timelines (View menu)
Opens the Timelines dialog box, which provides a graphical view of display and transition times for slides and 
objects in your presentation. Controls allow you to modify these times interactively.

{button ,AL(`timeline_proc;;;;;',0,"Defaultoverview",)} Related Topics



!ALink(timeline_proc;;;;;;;;,0,"default_procedure",)Timeline dialog box
Provides a graphical view of display times for the slides and objects in your presentation.    You can modify 
timelines for objects and slides.



About the Timelines dialog box
Click on the Timelines graphic to access Help on a particular area.



The slide button indicates that you are at the highest (slide) level of view. When the button turns into a folder, 
you can click the button to change the view to the slide level, hiding all objects.



Click to increase the time measurement units on the Time Scale button.



Click to decrease the time measurement units on the Time Scale button.



Displays the current time that you determine by dragging the time handle.



Displays the current units of time. Select different units of time measurement from the list box.



Disable the check box to hide the slide or object from the current presentation. Effective when you require 
multiple versions of a presentation.



Lists the slides and frames. (Frames appear when you click the icon to the left of the slide). The icon next to the 
frame indicates what type of object it is. For example:

animation sequence Paragraph Text
CorelDRAW graphic chart object
Corel PHOTO-PAINT image map
sound Motion 3D object
graphic object video clip
Artistic Text

Displays the name of the slide or object and the time currently allocated to it.



Drag the vertical line at the end of the timeline to adjust the slide or object’s duration. A red block at the 
beginning of the timeline identifies an opening transition,; green at the end of the timeline identifies a closing 
transition.



Provides a visual reference for judging the duration of slides and frames. For exact times check the Information 
bar at the bottom of the Timelines window; it tells you precisely when and how long a selected slide or object 
appears.



Click on the Horizontal Scroll Bar to scroll right to see more of the Timelines that are covered by the right edge of
the window.
If there are too many object entries in the Timelines window than can be displayed, you can click on the Vertical 
Scroll Bar to travel further up or down the list to see more entries.



Shows the current slide, the start time, and the end time for the selected slide or object.



Background Library command (View menu)
Opens the Libraries dialog box, which allows you to choose a background from a preset background collection or 
from other presentations.
The Libraries dialog box is divided into two sections: Backgrounds and Layouts. You can access either section by 
clicking the appropriate tab.

{button ,AL(`background_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Layout Library command (View menu)
Opens the Libraries dialog box, which allows you to choose an existing layout from a preset layout collection.
The Libraries dialog box is divided into two sections: Backgrounds and Layouts. You can access either section by 
clicking the appropriate tab.

{button ,AL(`layout_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Libraries dialog box
Opens libraries of backgrounds and layouts that can be applied to the active slide, selected slides or to your 
entire presentation.



Background page
Displays various backgrounds available from the libraries or current document. Backgrounds can contain text, 
graphic objects, linked and embedded objects and multimedia elements.



Displays presentation backgrounds available from the library or current document. Each one is represented by a 
thumbnail, which you can double-click to select.



Displays the Open dialog box, which allows you to choose a background from a presentation library.



Select a background to view from either the current document or one of the Background libraries.



{

Layout page
Displays various layouts available from the preset library or current document. Layouts set the location and 
formatting options for frames on slides.    The frames can contain text, graphic objects, animations, or linked and 
embedded objects.



Enable either the current document or present library radio button to select from where you’ll access the 
required layout.



Displays presentation layouts available from the library or current document. Each one is represented by a 
thumbnail, which you can double-click to select.



Select a layout to view from either the current document or one of the layout libraries.



CorelMEMO command (View menu)
Opens a flyout menu, from which you can choose to display or hide the memo pages; change the memo pages 
to pictures or icons; and show or hide the pages when printing.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Display contents of all command (View, CorelMEMO menu)
Shows the information contained in all CorelMEMO pages in the presentation. You must flip to each slide that 
contains a memo to view its contents.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Display as pictures command (View, CorelMEMO menu)

Replaces the CorelMEMO pages with a  icon. This reduces the amount of space the memo takes on your slide.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Display as icons command (View, CorelMEMO menu)
Replaces the CorelMEMO pages with the CorelMEMO application icon. This reduces the amount of space the 
memo takes on your slide.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Hide all CorelMEMOs command (View, CorelMEMO menu)
Removes the CorelMEMO pages from view. If you do not hide the memo pages before your presentation, the 
pages appear on the slide. You can choose Show all CorelMEMOs command to display the memo pages.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Show all CorelMEMOs command (View, CorelMEMO menu)
Displays the CorelMEMO pages. If you do not hide the memo pages before your presentation, the pages appear 
on the slides. You can choose Hide all CorelMEMOs command to remove the memo pages from view.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Make all printable command (View,CorelMEMO menu)
Displays the CorelMEMO pages when you print your slides, handouts, or speaker notes. If you do not hide the 
memo pages before you print, the memos appear on the printouts. You can choose the Make All Unprintable 
command to remove the memo pages from view.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Make all unprintable command (View, CorelMEMO menu)
Hides the CorelMEMO pages when you print your slides, handouts, or speaker notes. If you do not hide the memo
pages before you print, the memos appear on the printouts. You can choose the Make All Printable command to 
display the pages when printing.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



Toolbars command (View menu)
Opens the Toolbars dialog box, which allows you to select the toolbars to display in the PRESENTS application, 
select the tool icon display size, customize existing toolbars, and create your own toolbars.



Toolbars dialog box
Allows you to select the toolbars to display in the PRESENTS application, select the tool icon display size, 
customize existing toolbars, and create your own toolbars.



Displays the available toolbars. Enable the checkbox next to a toolbar to activate it. Click the toolbar’s name tag 
to rename it.



Creates a new toolbar. Click Customize to add buttons to the new toolbar.



Resets a built-in toolbar.



Opens the Customize dialog box, where you can change the configuration of your toolbar buttons.



Displays large-sized toolbar buttons.



Displays medium-sized toolbar buttons.



Displays small-sized toolbar buttons.



Status Bar command (View menu)
Toggles the status bar between visible and hidden. Right-click on the status bar to choose the information you 
want to appear on the status bar, and the display settings you prefer.



Rulers command (View menu)
Toggles the rulers bar between visible and hidden.

{button ,AL(`how_ruler_measure;how_set_ruler_proc;;;;;',0,"Defaultoverview",)} Related Topics



Color Palette command (View menu)
Toggles the Color Palette between visible and hidden.



Cascade command (Window menu)
Arranges open presentation windows so that they overlap. Each window's title bar remains displayed allowing 
you to select any one you want.



Tile Horizontally command (Window menu)
Sets up two or more open presentation windows in equally-sized frames arranged horizontally.



Tile Vertically command (Window menu)
Sets up two or more open presentation windows in equally-sized frames arranged vertically.



Arrange Icons command (Window menu)
Lines up the icons of minimized presentation windows along the bottom of the Corel PRESENTS screen.



Refresh Window command (Window menu)
Redraws objects on the screen, clearing the screen of "dirt" left over from earlier manipulations.



Window 1, 2, 3... command (Window menu)
Opens and activates a presentation window. The windows are listed in the order in which they were opened.



To embed an object
1. Click Insert, New Object.
2. Choose the type of object to insert from the Object Type list box.

The list includes items from applications on your system that support object linking and embedding. You need 
to install these applications using their Setup programs in order for them to appear on the list.

3. Click OK. The chosen application opens within the PRESENTS presentation window.
4. Create or select the object you want to embed in your presentation.
5. From the source application's File menu, choose Update, Exit, or Exit and Return.
6. In some applications, a dialog box appears prompting you to update. Choose Yes or OK.
Note

You can edit an embedded object by double-clicking the object in PRESENTS. This launches the server 
application and allows you to edit the information. When you exit and return to PRESENTS, the changes will be 
reflected in your presentation.

{button ,AL(`ole_proc;;;;;',0,"Defaultoverview",)} Related Topics



To embed an existing file
1. Click Insert, New Object.
2. Enable the Create from File button.
3. Type the path and filename of the file you want to embed. If you don't know the filename or location, click the 

Browse button to display the Browse dialog box.
4. Click OK.
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To embed an object starting from another application
1. Open the server application.
2. Cut or copy the object to the Clipboard.
3. Open the Corel PRESENTS file where you want the object pasted.
4. Click Edit, Paste Special.
5. From the As box, choose the type of information you want to add to your presentation.
6. Click OK.
Note

You can edit an embedded object by double-clicking the object in Corel PRESENTS. This launches the 
server application and allows you to edit the information. When you exit and return to PRESENTS, the changes are 
reflected in your presentation.

Object Linking is another way of including objects and files from other applications. With linking, you can 
share the same information with other files.
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To edit an embedded object
1. Double-click on the object you want to edit.
2. Make the changes you want.
3. From the source application's File menu, choose Update, Exit, or Exit and Return.
4. In some applications, a dialog box appears prompting you to update. Choose Yes or OK.
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To add a linked object
1. Click Insert, New Object.
2. Click Create from File.
3. Enable the Link check box.
4. Type the path, extension, and filename of the file to link. If you don't know the filename or location, click the 

Browse button to display the Browse dialog box.
5. Click OK.
Note

Any changes you make to the information in the source file are reflected in your presentation.
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To link an object from another application
1. Open the server application.
2. Cut or copy the object to the Clipboard.
3. Open the Corel PRESENTS file where you want the object pasted.
4. Click Edit, Paste Special.
5. From the As box, choose the type of information you want to add to your presentation.
6. Click the Paste Link button.
7. Click OK.
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To edit linked information in the source file
1. Open the source file.
2. Make the changes you want to the linked information.
3. Choose Save from the File menu.
Note

Any changes you make to the information in the source file are reflected in your presentation, according to 
the update option you chose.
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To change a link
1. Choose the linked information in your file.
2. Click Edit, Links.
3. Click Change Link.
4. Type a new name for the source file in the Source box.
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To specify automatic or manual link updating
1. Choose the linked information in the destination file you want to update.
2. Click Edit, Links.
3. Choose manual or automatic.
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To break a link
1. Choose the linked information.
2. Click Edit, Links.
3. Click Break Link.
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To manually update a link
1. Choose the linked information in the destination file you want to update.

If you have more than one link in the file that you want to update, hold down the SHIFT key as you choose the 
linked information.

2. Click Edit, Links.
Choose any other links in the Links box you want to update.

3. Click Update Now.
Note

Corel PRESENTS reflects any changes made in the source file, since the last update, in the destination file 
for each, chosen link.
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To update all links
1. Choose the entire Corel PRESENTS destination file by choosing Select All from the Edit menu.
2. Click Edit, Links.
3. Click Update Now.
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To display/hide the grid
1. Click Format, Grid Setup.
2. Click the Grid tab.
3. Enable the Show Grid check box.

If you disable the Show Grid check box, the grid is hidden from view.
4. Click OK.
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To set the Grid parameters
1. Click Format, Grid Setup.
2. Click the Grid tab.
3. In the Horizontal and Vertical Frequency boxes, specify the number of grid lines you want per unit of measure.
4. Click the Show Grid check box to display the grid in the drawing window. Click the Snap to Grid check box to 

have objects snap to the grid.
5. Click OK.
Note

To space the grid lines more than one whole unit apart, enter a fractional value. Entering 0.5, for example, 
spaces them two inches apart if the unit of measure is set to inches. (The Horizontal and Vertical field units are 
accurate up to 2 decimal places.)

If the Drawing Scale is set to 1:1 inches, you can choose another unit of measurement from the Units box. 
When you change units, you must specify the Grid Frequency to use with that unit. Changing the Grid Frequency 
unit also changes the corresponding ruler unit. If the Drawing Scale is set to something other than 1:1 inches, the 
Grid Frequency units are grayed out and set to the units that the Drawing Scale is using.
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To visually align objects to the grid
Select the object and drag it to line up with the desired grid point.

{button ,AL(`align_proc;grid_proc;;;;',0,"Defaultoverview",`proc4')} Related Topics



To snap objects to the grid
1. Click Format, Snap to Grid.

The grid must be visible for objects to snap to the grid.
Snap to Grid is enabled when a checkmark appears beside the command.

2. Select the object and drag it to line up with the desired grid point.
As you move, the mouse pointer is forced to stay on the grid.

Note
You can adjust the spacing between the grid points using the Grid Setup dialog box.
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To set ruler parameters
1. Click Format, Grid Setup.
2. Click the Ruler tab.
3. In the Horizontal and Vertical Unit boxes, specify the unit of measurement you want displayed on the ruler.
4. Set the 0,0 point in the Horizontal and Vertical Original number boxes.

The 0,0 points determine the cursor and object position information you see in the Status Line. The coordinate 
values you specify in some dialog boxes are also based on the position of the 0,0 points.

5. Click OK.
Tip

You can drag the cross hairs 
 onto the drawing window to set the Horizontal and Vertical origins.
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To change the units of measurement on the rulers
1. Click Format, Grid Setup.
2. Click the Ruler tab.
3. In the Horizontal Units box, choose the unit of measurement you want the horizontal ruler to use.
4. In the Vertical Units box, choose the unit of measurement you want the vertical ruler to use.
5. Click OK.
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To set up guidelines
1. Click Format, Guidelines Setup.
2. Choose either Horizontal or Vertical guidelines in the View section.
3. Specify where you want the guideline placed relative to the 0,0 points on the rulers.
4. Enable the Show Guidelines check box.
5. Click Add.
6. Click OK.
Note

You can use the Undo/Redo commands in the Edit menu for guideline movements and setups.
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To move guidelines
Click and drag the guideline to the required location.

Note
To remove a guideline, you can drag it off the window.
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To drag guidelines from the rulers
1. Move the pointer over the top ruler for a horizontal guideline, or the side ruler for a vertical guideline.
2. Click and drag the guideline into the presentation window.
3. Drop the guideline where you want it.
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To reposition a guideline
Click the guideline and drag it to its new position. 
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To position guidelines with numeric precision
1. Click Format, Guidelines Setup.
2. Choose either horizontal or vertical guidelines.
3. Specify the location of the guideline relative to the 0,0 points on the rulers.
4. Click Add.
5. Click OK.
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To measure and check alignment 
1. Click View, Rulers to display the rulers.

Rulers are enabled when a checkmark appears beside the command.
2. Move the pointer to the area where the rulers meet.
3. Click and drag the  crosshairs onto the presentation window.
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To snap objects to guidelines
1. Click Format, Snap to Guidelines.

Snap to Guidelines is enabled when a checkmark appears beside the command.
Guidelines must be visible on the screen for Snap to Guidelines to function.

2. Select the object.
3. Drag the object until one of the sides of its highlighting box aligns with the guideline.

When one of the sides of the object’s highlighting box approaches the guideline, the object snaps to it.
4. Drop the object.
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To visually align objects to guidelines
Select the object and drag it to line up with the guideline.
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To remove a guideline
Click the guideline and drag it off the presentation window.
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To delete guidelines
1. Click the guideline, to delete only one guideline.
2. Click Format, Guideline Setup.
3. Click Delete to remove the selected guideline.
4. Click Clear to remove all guidelines.
5. Click OK.
Note

To remove a guideline, you can also drag it outside of the presentation window.
You can use the Undo/Redo commands in the Edit menu for guideline movements and setups.
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To move an object
1. Select the object.
2. Drag the object to the location you want.

As you drag, the object is replaced by a dotted rectangle.
3. Release the mouse button.
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To scale an object
1. Select the object.
2. Move the mouse pointer over one of the corner handles until it becomes a cross.
3. Drag the handle until the object is scaled to the size you want.
4. Release the mouse button.
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To stretch an object
1. Select the object.
2. Move the mouse pointer over one of the middle handles until it becomes a cross.
3. Drag the handle until the object is stretched to the size you want.
4. Release the mouse button.
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To scale/stretch an object in multiple directions
1. Select the object.
2. Move the mouse pointer over one of the handles until it becomes a cross.
3. Hold down the SHIFT key.
4. Drag the handle until the object is stretched or scaled to the size you want.
5. Release the mouse button.
Tip

Release the mouse button before you release the SHIFT key.
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To stretch/scale in 100%-increments
1. Select the object.
2. Move the mouse pointer over one of the handles until it becomes a cross.
3. Hold down the CTRL key.
4. Drag the handle until the object is stretched or scaled to the size you want.
5. Release the mouse button.
Tip

Release the mouse button before you release the CTRL key.
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To stretch/scale in 100%-increments from the object's center
1. Select the object.
2. Move the mouse pointer over one of the handles until it becomes a cross.
3. Hold down the CTRL and SHIFT keys.
4. Drag the handle until the object is stretched or scaled to the size you want.
5. Release the mouse button.
Tip

Release the mouse button before you release the CTRL and SHIFT keys.
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To leave a copy of the object behind
1. Select the object.
2. Hold down the CTRL key.
3. Drag the object to the location where you want to place the copy.
4. Release the mouse button and the CTRL key.
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To fit an object to the slide
1. Select the object.
2. Click Arrange, Fit Object To Slide. 
Note

This procedure matches the object's aspect ratio to that of the slide.

{button ,AL(`size_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To rotate an object
1. Double-click the object. The object's handles change to double-headed arrows.
2. Move the mouse pointer over one of the corner arrows until it becomes a cross.
3. Drag in a circular motion around the object.
4. Release the mouse button.
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To constrain an object’s angle of rotation
1. Double-click the object. The object's handles change to double-headed arrows.
2. Move the mouse pointer over one of the corner arrows until it becomes a cross.
3. Hold down the CTRL key.
4. Drag in a circular motion around the object.
5. Release the mouse button.
Tip

Release the mouse button before you release the CTRL key.
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To move an object's center of rotation
1. Double-click the object. The object's handles change to double-headed arrows.
2. Drag the center of rotation to the desired spot.
3. Release the mouse button.
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To slant an object
1. Double-click the object. The object's handles change to double-headed arrows.
2. Drag the handles in the direction you want to slant:

Drag handles on vertical sides in a vertical direction.
Drag handles on horizontal sides in a horizontal direction.

3. Release the mouse button.
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To constrain the object's movement when slanting
1. Double-click the object. The object's handles change to double-headed arrows.
2. Hold down the CTRL key.
3. Drag the handles in the direction you want to slant:

Drag handles on vertical sides in a vertical direction.
Drag handles on horizontal sides in a horizontal direction.

4. Release the mouse button.
Tip

Release the mouse button before you release the CTRL key.
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To move an object in front of all others
1. Select the object.
2. Click Arrange, To Front.
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To move an object behind all others
1. Select the object.
2. Click Arrange, To Back.
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To move an object forward one
1. Select the object.
2. Click Arrange, Forward One.
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To move an object backward one
1. Select the object.
2. Click Arrange, Backward One.
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To copy an object to the Clipboard
1. Select an object.
2. Click Edit, Copy.
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To cut an object to the Clipboard
1. Select an object.
2. Click Edit, Cut.
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To paste an object from the Clipboard
1. Select a slide.
2. Click Edit, Paste.
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To duplicate an object
1. Select the object.
2. Click Edit, Duplicate.
Note

The copied object is offset slightly from the original. The default amount is 0.10 inches.
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To group objects
1. Select one of the objects you want to group.
2. Hold down the SHIFT key and select each of the other objects you want to group.
3. Click Arrange, Group.

The objects are now a group. Selecting any object in the group results in the selection of all other objects in 
the group.

Tip
You can edit individual objects in a group by holding down the CTRL key and clicking on the object.
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To ungroup objects
1. Select any object in the group.
2. Click Arrange, Ungroup.

The objects can now be selected individually.
Tip

If you have grouped two or more groups together, click Arrange, Ungroup to ungroup each level at time.
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To select an object in a group
Hold down the CTRL key and click on the object.

If you have nested groups (groups within groups), continue clicking until the object you want is selected. 

{button ,AL(`groupobj_proc;selectobj_proc;;;;',0,"Defaultoverview",`proc4')} Related Topics



To create a nested group
1. Select one of the groups that you want to nest.
2. Hold down the SHIFT key and select all other groups you want to include in the nest.
3. Click Arrange, Group.

The objects are now in a nested group. Selecting any object in the nest results in the selection of all other 
objects in the nest.
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To select an object in a nested group
Hold down CTRL and click on an object in the group you want to select.
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To combine objects
1. Select the objects that you want to combine.

If you select rectangles, ellipses, or text objects, Corel PRESENTS automatically converts them to curve objects
before combining.

2. Click Arrange, Combine.
The objects are now one, single curve object.
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To separate combined objects
1. Select the object.
2. Click Arrange, Break Apart.
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To assign transition effects to an object
1. Select the object to which you want to apply a transition effect.
2. Right mouse-click the Transitions command.
3. Choose the transition, direction, and duration options from the Opening Transition section, to set how the 

transition will enter onto the screen.
4. Choose the transition, direction, and duration options from the Closing Transition section, to set how the 

transition will leave the screen.
5. Click OK.
Note

To apply transition effects to multiple objects, click Apply Now. The dialog box remains on screen.
To preview a transition, enable the Preview check box.
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To assign transition effects to Paragraph text
1. Select the text to which you want to apply a transition effect.
2. Right mouse-click on the text and choose the Text Effects command.
3. Choose to apply the transition to either Line or Paragraph, from the Grouping list box.
4. Choose the transition, direction, and duration options from the Opening Transition section, to set how the 

transition will enter onto the screen.
5. Choose the transition, direction, and duration options from the Closing Transition section, to set how the 

transition will leave the screen.
6. Click OK.
Note

To apply transition effects to multiple text frames, click Apply Now. The dialog box remains on screen.
To preview a transition, enable the Preview check box.
To separate the text transitions from a bullet, enable the Separate from Bullet check box, and click the 

Options button to open the Bullet Settings dialog box.
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To assign transition effects to Artistic text
1. Select the text to which you want to apply a transition effect.
2. Right mouse-click on the text and choose the Transitions command.
3. Click the Transitions tab.
4. Choose the transition, direction, duration, and steps options from the Opening Transition section, to set how 

the transition will enter onto the screen.
5. Choose the transition, direction, duration, and steps options from the Closing Transition section, to set how the

transition will leave the screen.
6. Click OK.
Note

To apply transition effects to multiple text frames, click Apply Now. The dialog box remains on screen.
To preview a transition, enable the Preview check box.
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To assign transition effects to a bullet
1. Select the bullet to which you want to apply a transition effect.
2. Right mouse-click and choose Text Effects.
3. Enable the Separate Bullet From Text check box.
4. Click the Options button.
5. Choose when the bullet will appear, in relation to the text, from the Timing section.
6. Choose the bullet’s point of entry and exit from the Direction section.
7. Click OK.
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To assign transition effects to a slide
1. Click on any blank area on the slide.
2. Right mouse-click and choose the Transitions command.
3. Click the Transitions tab.
4. Choose the transition, direction, duration, and steps options from the Opening Transition section, to set how 

the transition will enter onto the screen.
5. Choose the transition, direction, duration, and steps options from the Closing Transition section, to set how the

transition will leave the screen.
6. Click OK.
Note

To preview a transition, click the Preview button.
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To set a path for a transition
1. Select the text or object to which you want to apply the transition effect.
2. Right mouse-click and choose the Path command.
3. Click the Path Tab.
4. Choose the path that the transition will follow from the list box.
5. Click OK.
Note

To apply paths to multiple objects, click Apply Now. The dialog box remains on screen.
To preview a transition, click the Preview button.
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To set the timelines for a slide
1. Click View, Timelines.
2. Move the pointer over the right boundary of the slide’s timeline. (The timeline is represented by a    white 

rectangle.) The pointer changes to a double-headed arrow.
3. Drag the boundary to the right to increase its time on screen, or left to decrease it. The time on screen, in 

seconds, appears between the slide number and its timeline.
4. Release the mouse button when the End time that you want to set is displayed.
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To adjust the start and end times of an object
1. Click View, Timelines.
2. Double-click the slide number that includes the object. All objects on the slide are listed in the Timelines dialog

box.
3. Move the pointer over one of the object’s timeline boundaries. (The timeline is represented by a    white 

rectangle.) The pointer changes to a double-headed arrow.
4. Drag the boundary in either direction to increase or decrease its time on screen as represented by the white 

rectangle. 
Each objects time on screen, in seconds, appears between the slide number and its timeline.

Note
Object start and finish times must not exceed slide start and finish times.
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To move an object's whole timeline
1. Click View, Timelines.
2. Double-click the slide number that includes the object. All objects on the slide are listed in the timelines dialog 

box.
3. Move the cursor near the middle of the timeline. (The timeline is represented by a white rectangle.) The 

pointer changes to a double-headed arrow.
4. Click and drag the timeline to a new position. 

The total time on screen is unchanged.
5. Release the mouse when you are satisfied with its new position.
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To change a transition's timeline
1. Click View, Timelines.
2. Double-click the slide number that includes the object. 

The transitions for objects and text are identified by shaded areas on the object’s timeline.
3. Click on the transition handle beside the shaded area and drag the transition to the required position on the 

timeline.
Note

The total time of the opening and closing transitions cannot be longer than the life of the object.
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To change the time measurement in timelines
1. Click View, Timelines.
2. Choose the required units of time from the Time Units list box.

Standard time units include minutes:seconds, seconds:frames, seconds:hundreths of seconds, and frames.
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To hide a slide or object in the screen show
Disable the Toggle Slide/Frame check box beside the slide or object that you want to hide.
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To display a hidden slide or object in the screen show
Enable the Toggle Slide/Frame check box beside the hidden slide or object that you want to display.
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To delete an object from the Timelines window
1. Click on the object's icon or name.
2. Press Delete.
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To choose presentation options
1. Click Tools, Options.
2. Click the Presentation tab.
3. Enable the Automatic advance check box to run the presentation automatically.

Disabling the button allows you to manually control slide advancement.
4. Enable the Run continuously check box to play the presentation in a continuous loop.

Disabling the button plays the show once until the end.
5. Enable the Display pointer on screen check box to display the mouse pointer on the screen during the 

presentation.
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To automatically advance slides
1. Click Tools, Options.
2. Click the Presentation tab.
3. Enable the Automatic advance check box.
Note

Disabling the button allows you to manually control slide advancement.
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To run a presentation continuously
1. Click Tools, Options.
2. Click the Presentation tab.
3. Enable the Run continuously check box.
Note

Disabling the button plays the show once until the end.
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To display the mouse pointer during a presentation
1. Click Tools, Options.
2. Click the Presentation tab.
3. Enable the Display pointer on screen check box.
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To play a presentation
1. Open the presentation.
2. Click File, Run Presentation.
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To stop a presentation in progress
Press the ESC key.
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To create a portable presentation
1. Finalize the presentation.
2. Click File, Save As.
3. Choose the drive and folder where you want to save the file in the Save in box.
4. Type a filename in the File Name list box.
5. Choose the Corel Runtime Player file type (.CRP) from the Files of type list box.
6. Click Save.
Note

A portable screen show can be played but not edited. Make sure that you save the presentation as a .CPR 
presentation file, as well as the .CRP Runtime Player file, if you want to edit it in future.

Use the Runtime Player to play the portable presentation.
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To play a portable presentation
1. Save the file as a .CRP file type in PRESENTS.
2. Install the Runtime Player on the machine that you want to play the presentation on.
3. Play the presentation on the Runtime Player.

Refer to the Runtime Player’s online help for instructions.
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To set the on screen annotation pen
1. Click Tools, Options.
2. Click the Presentation tab.
3. Choose the line thickness you want for the pen.
4. Click the Color button to choose a pen color.
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To use the on screen annotation pen
1. Click File, Run Presentation to begin the screen show, or start the screen show from the Runtime player.
2. When you reach a point in the presentation that you want to emphasize, hold down the left mouse button and 

highlight the important points on screen.
3. Click the right mouse button, hit the right arrow key, or press F2 to continue the presentation.
Tip

You can clear the annotations from your slide by pressing the DELETE key. This refreshes the screen, while 
leaving it in Annotation mode.
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To select an object

1. Click .
2. Click anywhere on the object you want to select.

{button ,AL(`select_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To marquee select objects

1. Click .
2. Hold down the mouse button and drag the marquee box until it completely encloses the objects.
3. Release the mouse button.
Note

Selecting more than one object lets you apply the same commands, transformations, or attributes to them.
When you select multiple objects, a single highlighting box enclosing them all appears.

When you hold down ALT while you drag, any object that intersects with the marquee box is selected. If 
you do not release the mouse button before releasing ALT, only those objects enclosed by the marquee box will be 
selected.
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To select the next object
1. Click .
2. Press the TAB key to select the next object.

{button ,AL(`select_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To select multiple objects
1. Click .
2. Hold down SHIFT and click on the objects.
Note

Selecting more than one object lets you apply the same commands, transformations, or attributes to them.
When you select multiple objects, a single highlighting box enclosing them all appears.

{button ,AL(`select_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To select all objects
Click Edit, Select All.

Tip
You can also double-click on Pick tool to select all objects.

{button ,AL(`select_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To select multiple groups
Hold down SHIFT and click an object in each group.

Note
You can also drag a marquee box around all objects in the groups to select. When you select a group, a 

highlighting box enclosing all of the objects in the group appears.
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To deselect all objects
Click any open space on the slide or press ESC.

{button ,AL(`select_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To deselect only one of several objects selected
Hold down the SHIFT key and click anywhere on the object.
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To select the previous object
1. Click .
2. Press the SHIFT and TAB keys to select the previous object.
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To delete an object
1. Select the object.
2. Click Edit, Delete.

{button ,AL(`select_obj_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the page orientation
1. Click File, Page Setup.
2. Click the Size/Margin tab.
3. Enable the radio button in the Current View section, for the page type to which you want the settings applied. 
4. Enable either the Portrait or Landscape radio button in the Page Size section.
5. Click OK.

{button ,AL(`page_setup_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set page margins
1. Click File, Page Setup.
2. Click the Size/Margin tab.
3. Enable the radio button in the Current View section, for the page type to which you want the settings applied. 
4. Set the margins for Top, Bottom, Left, and Right in the Page Margins section.
5. Click OK.

{button ,AL(`page_setup_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the page size
1. Click File, Page Setup.
2. Click the Size/Margin tab.
3. Enable the radio button in the Current View section, for the page type to which you want the settings applied. 
4. Choose a paper type from the Paper Type list box in the Paper Size section.
5. If you choose a custom paper type, set the Horizontal and Vertical dimensions.
6. Click OK.

{button ,AL(`page_setup_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set a custom page size
1. Click File, Page Setup.
2. Click the Size/Margin tab.
3. Enable the radio button in the Current View section, for the page type to which you want the settings applied. 
4. Choose Custom from the Paper Type list box in the Paper Size section.
5. Set the Horizontal dimensions.
6. Set the Vertical dimensions.
7. Click OK.

{button ,AL(`page_setup_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create a header or footer for slides
1. Click File, Page Setup.
2. Click the Header/Footer tab.
3. Enable the Slides button in the View section.
4. Choose a header from the list box in the Header section.
5. Choose a footer from the list box in the Footer section.
6. Click OK.
Note

The header and footer appear on all slides.
You can customize the header and footer by clicking on the Custom Header or Custom Footer button.
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To create a header or footer for Speaker Notes
1. Click File, Page Setup.
2. Click the Header/Footer tab.
3. Enable the Speaker Note radio button in the View section.
4. Choose a header from the list box in the Header section.

A preview of the header appears in the display window.
5. Choose a footer from the list box in the Footer section.

A preview of the footer appears in the display window.
6. Click OK.
Note

The header and footer appear on all Speaker Note pages.
You can customize the header and footer by clicking on the Custom Header or Custom Footer button.

{button ,AL(`page_setup_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create a header or footer for Handouts
1. Click File, Page Setup.
2. Click the Header/Footer tab.
3. Enable the Handout radio button in the View section.
4. Choose a header from the list box in the Header section.

A preview of the header appears in the display window.
5. Choose a footer from the list box in the Footer section.

A preview of the footer appears in the display window.
6. Click OK.
Note

The header and footer appear on all Handout pages.
You can customize the header and footer by clicking on the Custom Header or Custom Footer button.
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To create a custom header or footer
1. Click File, Page Setup.
2. Click the Header/Footer tab.
3. Enable either the Slide, Handouts, or Speaker Note button in the View section.
4. Click the Custom Header button in the Header section.
5. Make any of the following changes:

Click in the Left, Center, or Right box to choose the justification.
Choose the font type from the list box in the Attributes section.
Choose the font size from the number box in the Attributes section.
Enable the bold, italic, or underline buttons in the Attributes section.
Click the Slides button in the Macros section to enter the slideglos_slide@glossary.hlp name. You must 

have named the slide for this option to function.
Click the SlideNum button in the Macros section to enter the slide number.
Click the Date and Time button in the Macros section to open the Date and Time dialog box. From the 

dialog box, you can choose the format and language in which you want the date and time to appear.
6. Click the Custom Footer button in the Footer section Make any changes listed in step 5 to the footer.
7. Click OK.
Note

The header and footer appear on all slides/Speaker Note/Handout pages.
Previews of the header and footer appear in the display windows.
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To enter user information
1. Click Tools, Options, User Info.
2. Type your name in the Name box.
3. Type your position title in the Title box.
4. Type the name of your organization in the Organization box.
5. Click OK.
Tip

You can choose to have this information appear in the header or footer of your presentation, by using the 
macro buttons in the File, Page Setup, Header/Footer, Custom dialog box.
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To choose custom workplace options
1. Click Tools, Options, General.
2. Type the number of undo levels to allow in the Edit, Undo command, in the Undo Levels number box.
3. Disable the Show Startup Dialog check box to remove the New Presentation dialog box from appearing each 

time that you open PRESENTS.
4. Enable the Show Margins check box to suppress the display of slide margins.
5. Enable the Large Thumbnails check box to display large size slide thumbnails in the Slide Sorter.
6. Enable the Insert OLE Objects Using Best Fit check box to define that OLE objects that you insert into the 

presentation maintain their aspect ratio , while fitting into the marquee frame you draw.
If you disable the check box, the object will fit to the marquee frame you draw.

7. Click OK.
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To add a slide
1. Click Insert, Slide.
2. Type the number of slides you want to add in the Number of Slides box.
3. Click either the Before Current or After Current radio button and click Next.
4. Select the layout you want to apply to the slide and click Next.
5. Select the background you want to apply to the slide and click Next.
6. Click Finish.
Note

After Current is the default setting.
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To delete a slide
1. Select the desired slide to delete.
2. Click Insert, Delete Slide.
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To rearrange the order of slides
1. Click View, Slide Sorter.
2. Drag and drop the slide to its new position.

Note
A vertical line displays when you drag a slide. If you drag a slide to the left, the vertical line displays on the

left of the slide that will be displaced when you release the mouse button. If you drag a slide to the right, the 
vertical line displays on the right of the slide that will be displaced when you release the mouse button.

{button ,AL(`slide_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create Speaker Notes
1. Click View, Speaker Notes.
2. Double-click on the text frame.
3. Type text relevant to the current slide, that will act as cue information for the presenter.

{button ,AL(`how_head_foot_speaker;create_notes_proc;how_view_speak_notes;;;;;;',0,"Defaultoverv
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# how_enter_quickspeaker$ To type speaker notes using the Quick Speaker Notes dialog 
boxK speaker notes, creating;creating, speaker notes;notes, creating speaker 
notes;presentation aids, speaker notes;quick speaker notes, ;A 
how_enter_quickspeaker;creat_notes_proc> proc4



To customize the Speaker Notes layout
1. Click View, Master Layout, Speaker Notes, to modify the text frame, or move the slide thumbnails.
2. Make any required layout changes, including:

change text attributes
change bullet styles
move or size the frames
insert a text box

Note
The layout changes are reflected when you switch to Speaker Notes view.

{button ,AL(`how_head_foot_speaker;create_notes_proc;how_view_speak_notes;;;;;;',0,"Defaultoverv
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To print Speaker Notes
1. Click View, Speaker Notes.
2. Click File, Print.
3. Click Notes in the Print list box.
4. Select the print range and number of copies to print.
5. Click OK.
Note

The page orientation automatically changes to portrait to accommodate the slide and notes.
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To create Handouts
1. Click View, Handout.

The page appears with slide thumbnails.
2. Double-click on the text section beside the first slide.
3. Type text relevant to the slide.
4. Repeat steps 2 and 3 for each thumbnail on the page.

{button ,AL(`how_head_foot_handout;create_notes_proc;how_view_handout;;;;;',0,"Defaultoverview"
,)} Related Topics



To print Handouts
1. Click View, Handout.
2. Click File, Print.
3. Click Handouts in the Print list box.
4. Select the print range and number of copies to print.
5. Click OK.

{button ,AL(`how_view_handout;how_head_foot_handout;create_notes_proc;;;;;;',0,"Defaultoverview
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To customize the Handouts layout
1. Click View, Master Layout, Handout, to modify the text frame, or move the slide thumbnails.
2. Make any required layout changes, including:

change text attributes
change bullet styles
move or size the frames

Note
The layout changes are reflected when you switch to Handout view.

{button ,AL(`how_view_handout;how_head_foot_handout;create_notes_proc;;;;;;',0,"Defaultoverview
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To change to Slide view
Click View, Slide.
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To change to Slide Sorter view
Click View, Slide Sorter.
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To change to Outline view
Click View, Outline.
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To change to Speaker Notes view
Click View, Speaker Notes.
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To change to Handout view
Click View, Handout.
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To change to Animation view
Click View, Animation.
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To change to Background view
Click View, Background.
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To change to Master Layout view
Click View, Master Layout.
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To view the Layout Library
1. Click View, Layout Library.
2. Click the Layout tab.
3. Enable the Preset Library radio button.
4. View the layout thumbnails shown in the display window.
Note

You can also choose a thumbnail from the library to apply as your layout.
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To view the Background Library
1. Click View, Background Library.
2. Click the Background tab.
3. Choose a background library from the list box.
4. View the background thumbnails shown in the display window.
Note

You can also choose a thumbnail from the library to apply as your background.
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To work with the Object Manager
1. Click View, Object Manager.

The information displayed in the Object Manager changes depending on the current view. For example, in Slide
view, all the objects in the current slide are displayed; in Slide Sorter view, all the slides in the presentation are
displayed, with an option to view the objects on the slide; in Background view, all objects on the background 
are displayed.

2. Enable the checkbox beside the slide or object, if you want to display it in the presentation.
Disable the checkbox beside the slide or object, if you want to hide it from the presentation.

Note
If you delete frames in the Master Layout view, you can retrieve them in the Object Manager.
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To view a CorelMEMO
Click View, CorelMEMO.

{button ,AL(`sticky_proc;view_proc;;;;;',0,"Defaultoverview",)} Related Topics



To select a slide in Slide view
At the bottom of the presentation window, click the numbered tab that corresponds to the slide you want 

to choose.
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To select a slide in Slide Sorter view
Click the slide in the presentation window.

Tip
Double-click the slide to change to Slide View.
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To select a slide in Outline view
Double-click the 

 icon next to the desired slide number.
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To select a slide in Speaker Notes view
At the bottom of the presentation window, click the numbered tab that corresponds to the slide you want 

to choose.

{button ,AL(`select_view_proc;;;;;',0,"Defaultoverview",)} Related Topics



To select a slide in Animation view
At the bottom of the presentation window, click the numbered tab that corresponds to the slide you want 

to choose.
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To view multiple slides
Click View, Slide Sorter.
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To return to a single slide view
Click View, Slide.
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To view a slide at the size it will print
1. Click the Zoom tool. 

2. Click .
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To zoom in on a slide
1. Click the Zoom tool.

2. Click .
3. Repeat steps 1 and 2 to zoom in further.

Tip
Each time you click the mouse the slide view magnifies by a factor of two.
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To zoom in on a specific area
1. Click the Zoom tool.

2. Click .
3. Position the cursor at the top left corner of the area you want to zoom.
4. Drag down and to the right until the desired area is enclosed in the marquee box.
5. Release the mouse button.
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To zoom out
1. Click the Zoom tool.

2. Click .
Tip

Each time you click the mouse the slide view zooms out by a factor of two.
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To zoom to all objects on a slide
1. Click the Zoom tool. 

2. Click .
Note

Objects outside of the slide border are also displayed.
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To zoom the entire slide
1. Click the Zoom tool.

2. Click .
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To zoom to a selected object
1. Click the Zoom tool.

2. Click .
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To play an animation from its start point
1. Select the slide with the animation you want to play from its start point.
2. In Animation view, click Animation, First Frame.
3. Click Animation, Play.

{button ,AL(`anim_proc;;;;;',0,"Defaultoverview",)} Related Topics



To modify the time of an animation with numeric precision
1. In Animation view, select the slide you want to modify.
2. Click the up and down arrow buttons in the Time text box to modify the current time of the slide.
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To turn sound on or off
1. In Animation view, click Tools, Options.
2. Click the Animation tab.
3. Check Sound to allow sound, uncheck to suppress sound.
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To play an animation in reverse
1. In animation view, select the animated slide you want to play in reverse.
2. Move the Animation trackbar until the object is at the point in its path where you want to start playing it 

backwards.
3. Click Animation, Play Reverse.
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To stop an animation
Click Animation, Stop.
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To move an animation one frame back
1. In animation view, select the animated slide you want to move.
2. Verify that the animated slide is not at the first frame.
3. Click Animation, Previous Frame.
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To move an animation one frame forward
1.  Verify that the animated slide is not at the last frame.
2. In animation view, select the animated slide you want to move.
3. Click Animation, Next Frame.
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To move an animation to the last frame
1. In Animation view, select the animated slide you want to move.
2. Click Animation, Last Frame.
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To fast forward an animation using the Animation Trackbar
1. Select the slide you want to fast forward.
2. Move the handle in the Animation Trackbar until the animation is advanced to where you want it.
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To animate an actor by applying a path to an object
1. In animation view, select the object you want to use as an actor.
2. Move the Animation trackbar until the Time is where you want it.
3. Move the object to the next location on screen where you want it to display.
4. Repeat steps 2 and 3 above until the path is complete.
Note

Each actor should have an individual name to identify it. This is because as you create or import actors into
your animation, they are added to the list of objects in the animation. This list is found in the Timelines dialog box.
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To animate an actor by adding cels to it
1. Select the slide where you want to create the actor.
2. Click Animation, Create/Edit Actors.
3. Click the object you want to add to the actor.
4. Click the Add button.
Note

The objects you add to an actor all display at the size of the largest object added. See Related topics for 
creating cels used in animating an actor’s change in size.
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To create cels for animating an actors change in size
1. Draw a rectangle large enough to accommodate the largest object you want to use as a cell of the actor.
2. Remove the fill form the rectangle.
3. Grab one of the objects you want to use as an actor cel and drag it to the center of the rectangle.
4. Remove the outline form the rectangle.
5. Select both the object and the rectangle.
6. Click Arrange, Group.
7. Repeat these procedures for each of the objects you want to use as a cel in the actor.
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To insert cels in an actor
1. Select the actor you want to edit.
2. Click Animation Create/Edit Actors.
3. Drag Objects from the Objects in Slide list to the Cels in Actor list.
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To reorder the cels in an actor
1. In animation view, select the actor you want to modify.
2. Click Animation, Create/Edit Actors.
3. In the Cels in actor dialog box, drag and drop objects to their new place in the list.
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To select items in the Create/Edit Actors dialog box
Do any of the following in either the Objects in slide or Cels in actor list boxes:

To select a single item, click the item.
To select all items between a first and last one, click the first item, then Shift click the last item.
To select a group of items in different parts of the list, press Ctrl and click each of the items you want to 

include in the selection.
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To remove cels from an actor
1. Select the actor you want to modify.
2. Click Animation, Create/Edit Actors.
3. Select the cel you want to remove form the actor.
4. Click the Remove button.
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To create a custom path
1. In Animation view, click the object you want to move through a custom path.
2. Click Animation, Custom Path.
3. When the cursor displays as a pencil, move it to the start point of the path you want to create.
4. Drag the pointer along the path you want use.
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To edit path nodes
1. In Animation view, select the object that has the path you want to modify.
2. Click the node editing tool on the toolbox.
3. Click a node and drag until the node is modified as required.
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To repeat the same cel of an actor
1. In Animation view, click the actor you want to modify.
2. Click Animation, Cel Sequence.
3. Click Constant in the Effects list box.
4. In the Cel # text box, type the cel number you want to use.
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To modify the cel sequence of an actor
1. In Animation view, click the actor you want to modify.
2. Click Animation, Cel Sequence
3. In the Effects list box, click the effect you want to use.
4. In the Speed group of options, click the speed you want to use.
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To add, modify or delete a transition effect of an object
1. Click the object you want to use.
2. Click Animation, Transitions.
3. In the Opening Transition area, click the opening transition in the Transition list box you want to use.
4. Click the direction button to define the direction you want the opening transition to follow.
5. In the Duration text box, type the time you want to use for the Opening transition.
6. In the Steps text box type the number of steps you want to use for the Opening transition.
7. In the Closing transition area, click the closing transition in the Transition list box you want to use.
8. Repeat steps 5, 6, 7 for the Closing transition.
9. Check Preview screen when you want to see a preview of the transition you defined..
Note

You can also access the transitions options by clicking the selected object with the right mouse button.
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To add, modify or delete preset paths of objects
1. Click the object you want to modify.
2. Click Animation, Path.
3. Check Preview to see an example of the options you want to use.
4. In the Path list box, click the preset path you want to use.
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To add, modify or delete paths of objects
1. In Animation view, click the object you want to modify.
2. Click the node edit tool in the Toolbox.
3. Drag nodes as required.
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To modify physical attributes of objects
1. Click the object you want to modify.
2. Click the object with the right mouse button.
3. Click Object Attributes.
4. Check the options you want to use.
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To modify animation speed
1. In Animation view, click Tools, Options.
2. Click the Animation tab.
3. In the Animation speed text box, type the frames per second you want to use.
Note

Frames per second refers to the number of times a slide is displayed every second. A higher number 
produces a smoother animation.
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To modify the default time that a transition will last for new slide objects
1. In Animation view, click Tools, Options.
2. Click the Animation tab.
3. In the Transition duration text box, type the default time you want to apply to transitions in new slides.
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To modify the Snap to time increment
1. In Animation view, click Tools, Options.
2. Click the Animation tab.
3. In the Snap to time increment text box, type the increment you want to use.
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To show an object changing size gradually between two non-adjacent nodes
1. In Animation view, click Tools, Options.
2. Click the Animation tab.
3. Click Position.
4. Create the Path for the object.
5. Move the object to the node where you want to change its size.
6. Resize the object as required.
Note

With this option, PRESENTS automatically calculates the amount the object changes size as it travels 
between the two non-adjacent nodes. This is a more automatic procedure than using the Position /size option. If you
want an object to change gradually in size between two non-adjacent nodes, you only have to decide which nodes 
are to be the beginning and end nodes, then, change the objects size as required. PRESENTS will calculate a 
smooth, gradual transition in size between the two nodes. With this option, only the nods where you change the 
size of the object display as two color rectangles.

The first node in the path is always a beginning node. This is because at this node, the object already has 
size. 
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To modify the amount that an object changes between two non-adjacent nodes manually
1. In Animation view, click Tools, Options.
2. Click the Animation tab.
3. Click Position/size.
4. Create the path for the object.
5. Move the object to the node where you want to change its size.
6. Change the size of the object.
Note

With this option you have direct control over changes in an objects size as it travels between two non-
adjacent nodes. This option is more manual than using the Position only option. For example, if you want an object 
to change gradually in size between two non-adjacent nodes, you must change the objects size yourself at each 
node. Also, with this option, each node displays as a two-color rectangle to indicate that both position and size are 
automatically registered.

The first node in the path is always a beginning node. This is because at this node, the object already has 
size. 
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To insert a background from the Library
1. Click View, Slide.
2. Click View, Background Library.
3. Click the Background tab.
4. Choose a background library from the list box.
5. Click the background you want from the thumbnails shown in the display window.
6. Click Apply Now.
7. Click OK.
Note

Any objects that were placed on the original background are deleted.
The background you create becomes the default background for new slides that you insert.

Tip
When you insert a background, it is placed as a thumbnail in the current document set in the Background 

Library.
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To edit background fills
1. Click View, Background.
2. Click Edit, Background: Blank, Uniform Fill, Fountain fill, Two-Color Bitmap, Full-Color Bitmap, Texture fill, or 

Vector Pattern.
3. Make the required changes.
4. Click OK.
Note

Editing the fill changes the background on all slides that follow the one that you edit.
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To add objects to the background
1. Click View, Background.
2. Add the objects or text you want to include in the background.

You can add objects using:
rectangle or geometric shape tools on the toolbar
import, cut or copy and paste from another application
object embedding or linking
Insert, New Object command
Insert, Chart command
Insert, Map command
Insert, Video command
Insert, Sound command

3. Change the background fill, if required.
Note

To edit the background of a slide without deleting the background objects, switch to slide view and then 
make the required background changes.
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To insert a uniform fill background
1. Click View, Slide.
2. Click Insert, Background, Uniform Fill.

Click Yes in the Edit Background dialog, to add objects to the new background.
3. Enable the Color Models, Palettes, or Mixers radio button.

If you choose Color Models, choose a type from the Models list box.
4. Modify the Level, Color Options or Palette Options, if required.
5. Click OK.
Note

The background you create becomes the default background for new slides that you insert.
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To change a background to uniform fill
1. Click View, Background.
2. Click Edit, Background, Uniform Fill.
3. Enable either the Color Models, Palettes, or Mixers radio button.

If you choose Color Models, choose a type from the Models list box.
4. Modify the Level, Color Options or Palette Options, if required.
5. Click OK.
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To insert a fountain fill background
1. Click Insert, Background, Fountain Fill.

Click Yes in the Edit Background dialog, to add objects to the new background.
2. Choose the Type, Center offset, Options and Color blends you require.
3. Click OK.
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To change a background to fountain fill
1. Click View, Background.
2. Click Edit, Background, Fountain Fill.
3. Choose the Type, Center offset, Options and Color blends you require.
4. Click OK.
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To insert a two-color bitmap pattern background
1. Click Insert, Background, Two-Color Bitmap Pattern.

Click Yes in the Edit Background dialog, to add objects to the new background.
2. Click the Create button to design your own pattern.
3. Click the Preview button to choose a preset pattern.
4. Click Import to open the Import dialog box, and select a pattern.
5. Enable the Small, Medium, or Large radio button to choose the size the pattern appears.
6. Click the Tiling option to set options to tile the pattern across the background.
7. Click OK.
Note

The image fits to the slide size.
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To change a background to a two-color bitmap pattern
1. Click View, Background.
2. Click Edit, Background, Two-Color Bitmap Pattern.
3. Click the Create button to design your own pattern.
4. Click the Preview button to choose a preset pattern.
5. Click Import to open the Import dialog box, and select a pattern.
6. Enable the Small, Medium, or Large radio button to choose the size the pattern appears.
7. Click the Tiling option to set options to tile the pattern across the background.
8. Click OK.
Note

The image fits to the slide size.
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To insert a full-color bitmap pattern background
1. Click Insert, Background, Full-Color Bitmap Pattern.

Click Yes in the Edit Background dialog, to add objects to the new background.
2. Click the Preview button to choose a preset pattern.
3. Click Import to open the Import dialog box, and select a pattern.
4. Enable the Small, Medium, or Large radio button to choose the size the pattern appears.
5. Click the Tiling option to set options to tile the pattern across the background.
6. Click OK.
Note

The image fits to the slide size.
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To change a background to a full-color bitmap pattern
1. Click View, Background.
2. Click Edit, Background, Full-Color Bitmap Pattern.
3. Click the Preview button to choose a preset pattern.
4. Click Import to open the Import dialog box, and select a pattern.
5. Enable the Small, Medium, or Large radio button to choose the size the pattern appears.
6. Click the Tiling option to set options to tile the pattern across the background.
7. Click OK.
Note

The image fits to the slide size.
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To insert a vector pattern background
1. Click Insert, Background, Vector Pattern.

Click Yes in the Edit Background dialog, to add objects to the new background.
2. Click Load to bring an existing vector pattern into the slide.
3. Click the Preview button to choose a preset pattern.
4. Click Import to open the Import dialog box, and select any graphic to use as a vector pattern.
5. Enable the Small, Medium, or Large radio button to choose the size the pattern appears.
6. Click the Tiling option to set options to tile the pattern across the background.
7. Click OK.
Note

The image fits to the slide size.
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To change a background to a vector pattern
1. Click View, Background.
2. Click Edit, Background, Vector Pattern.
3. Click Load to bring an existing vector pattern into the slide.
4. Click the Preview button to choose a preset pattern.
5. Click Import to open the Import dialog box, and select any graphic to use as a vector pattern.
6. Enable the Small, Medium, or Large radio button to choose the size the pattern appears.
7. Click the Tiling option to set options to tile the pattern across the background.
8. Click OK.
Note

The image fits to the slide size.
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To insert a texture fill background
1. Click Insert, Background, Texture fill.

Click Yes in the Edit Background dialog, to add objects to the new background.
2. Choose a fill from the Texture Library and Texture List.
3. Modify the texture, if required.
4. Click OK.

{button ,AL(`how_view_back;background_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change a background to a texture fill
1. Click View, Background.
2. Click Edit, Background, Texture Fill.
3. Choose a different fill from the Texture Library and Texture List, if required.
4. Modify the texture, if required.
5. Click OK.
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To add text to an existing background
1. Click View, Background.
2. Click the Text flyout icon.
3. Choose either Paragraph or Artistic Text.
4. Type the text.

{button ,AL(`how_view_back;background_proc;;;;;',0,"Defaultoverview",)} Related Topics



To save a customized background
1. Create the background you want to save.
2. Click File, Save As.
3. Choose the Corel60/Presents/Backgrounds folder from the Save In list box.
4. Choose .CPB from the Save As Type box.
5. Type a filename in the File Name box.
6. Click Save.
Note

When you save the file to the Backgrounds folder, the filename appears with the list of PRESENTS 
backgrounds whenever you open the Libraries dialog box.
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To save a customized background Library
1. Click Insert, Background, or create a new background.
2. Insert or create one background for each slide, up to the number of backgrounds you want save in the Library.
3. Click File, Save As.
4. Choose the Corel60/Presents/Backgrounds folder from the Save In list box.
5. Choose .CPB from the Save As Type box.
6. Type a filename in the File Name box.
7. Click Save.
Note

When you save the file to the Backgrounds folder, the filename appears with the list of PRESENTS 
backgrounds whenever you open the Libraries dialog box.

{button ,AL(`how_view_back;background_proc;;;;;',0,"Defaultoverview",)} Related Topics



To insert a background from an existing presentation
1. Click View, Background Library.
2. Click the Background tab.
3. Click the Load From button.
4. Choose the drive, directory, folder and filename of the presentation from which you want to insert the 

background.
5. Click OK.

The Import Collection dialog box appears.
6. Choose the desired background to insert, from the thumbnails displayed.
7. Click Apply.
Tip

If you saved the background to the Corel60/Presents/Backgrounds library directory, the background is 
available from the list box.
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To clear the background on a slide
Click Insert, Background, Blank.
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To change the background on a selection of slides
1. Click View, Slide Sorter.
2. Choose the slide whose background you want to change.
3. Click Insert, Background: Blank, Uniform Fill, Fountain Fill, Two Color Bitmap, Full Color Bitmap, Texture Fill, or 

Vector Pattern.
4. Choose the options from the dialog box.
5. Click OK.
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To apply a background to all slides
1. Click View, Slide Sorter.
2. Click Edit, Select All.
3. Click Insert, Background: Blank, Uniform Fill, Fountain Fill, Two Color Bitmap, Full Color Bitmap, Texture Fill, or 

Vector Pattern.
4. Choose the options from the dialog box.
5. Click OK.
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To insert new slides with a different background
1. Click Insert, Slide.
2. Choose the number of slides to insert, choose Before Current or After Current and click Next.
3. Choose a layout from the layout library and click Next.
4. Choose a background from the list box or choose Load From to load a library from another presentation.

If the Current Document radio button is enabled, the thumbnails in the display window only show backgrounds 
used in the current document.

5. Click Finish.
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To apply a layout from the Library
1. Click View, Layout Library.
2. Click the Layout tab.
3. Enable the Preset radio button.
4. Click the layout you want from the thumbnails in the display window.
5. Click Apply Now.
6. Click OK.
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To edit a master layout
1. Click View, Master Layout, and:

Title Slide Master, to modify the title layout.
Slide Master, to modify the title and body text frames of layouts that have a body and title frame.
Handout, to modify the body text frame in for audience handouts.
Speaker Notes, to modify the body text frame for speaker notes.

2. Make any required layout changes, including:
change text attributes
change bullet styles
move or size the frames

Note
If you delete a frame in the master layout, you can retrieve it by opening the Object Manager in the View 

menu, and enabling the check box beside the frame.
The layout changes are reflected when you switch to Slide View.
Changing the master layout makes global changes to your layouts; an effective way to ensure consistency 

within slides.
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To change a slide’s layout
1. Select the slide you want to change.
2. Click View, Layout Library.
3. Click the Layout tab.
4. Enable the Preset radio button.
5. Click the layout you want from the thumbnails in the display window.
6. Click Apply Now.
7. Click OK.
Note

The body text in the original layout is inserted into the first Body Text frame of the second layout.
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To edit a slide’s layout
1. Click View, Slide.
2. Make any required layout changes, including:

change text attributes.
change bullet styles
move or size the frames

Note
Any change that you make to a layout destroys the link to the master. To make a global change to layouts, 

make the changes in the appropriate master layout.
If you delete a frame in the master layout, you can retrieve it by opening the Object Manager in the View 

menu, and enabling the check box beside the frame.
You can relink attributes to the master layout using Edit, Properties, Attributes.
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To view the Title Slide master layout
Click View, Master Layout, Title Slide Master.
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To view the Slide master layout
Click View, Master Layout, Slide Master.
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To view the Handout master layout
Click View, Master Layout, Handout Master.
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To view the Speaker Notes master layout
Click View, Master Layout, Speaker Notes Master.
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To change the layout on a selection of slides
1. Click View, Slide Sorter.
2. Choose the slides whose layouts you want to change.
3. Click View, Layout Library.
4. Choose the Preset library radio button in the Select a Layout From section.

If the layout you want to apply is already in the current document, select the Current document radio button.
5. Click Apply Now.
6. Click OK.
Tip

You can double-click the thumbnail to apply the layout to the slides, instead of clicking Apply Now.
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To apply a layout to all slides
1. Click View, Slide Sorter.
2. Click Edit, Select All.
3. Click View, Layout Library.
4. Choose the Preset library radio button in the Select a Layout From section.

If the layout you want to apply is already in the current document, select the Current document radio button.
5. Click Apply Now.
6. Click OK.
Tip

You can double-click the thumbnail to apply the layout to the slides, instead of clicking Apply Now.
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To link layouts to the master
1. Select the layout frames on the    slide that you want to link to the master layout.
2. Click Edit, Properties, Attributes.
3. Enable the Fill, Outline, Position, Size, or Font, Style & Size check boxes, for the attributes you want to link to 

the master layout.
4. Click OK.
Note

Any change that you make to a layout destroys the link to the master. To make a global change to layouts, 
make the changes in the appropriate master layout.

If you delete a frame in the master layout, you can retrieve it by opening the Object Manager in the View 
menu, and enabling the check box beside the frame.
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To start a new blank presentation
Click File, New, Document.
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To start a new presentation from a template
1. Click File, New, From Template.
2. Click on a tab that represents the type of template you want to use, e.g., the Funky tab includes fun, colorful 

backgrounds, with corresponding layout formats.
3. Click the thumbnail of the template that you want to use for your presentation.
4. Click OK.
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To start a new presentation from the Wizard
1. Click File, New, From Wizard.
2. Follow the instructions on the page.
3. Click Next to move to the next page of the Wizard.
4. Repeat steps 2 and 3 until the end of the Wizard, or click Finish to skip the remaining pages .
Note

Default settings are applied to all skipped pages.
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To open a presentation
1. Click File, Open.
2. Choose the drive and folder in the Look in list box. 
3. Choose the Corel PRESENTS file type (.CPR) from the Files of type list box.
4. Type the name of an existing file in the File Name box.
5. Click Open.
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To open a recently closed presentation
1. Click File.
2. At the bottom of the File menu, click the filename.
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To save a presentation for the first time
1 Click File, Save.
2. Choose the drive and folder where you want to save the file in the Save in box.
3. Type a filename in the File Name list box.
4. Click Save.
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To save changes to an existing presentation
Click File, Save.
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To save an existing file with a new name or different location
1. Click File, Save As.
2. Choose the drive and folder where you want to save the file in the Save in box.
3. Type a filename in the File Name list box.
4. Click Save.
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To close a presentation
1. Click File, Close.

If you have not saved your changes, a dialog appears asking if you want to save changes to the presentation.
2. Click Yes to save your changes.

If it is a new presentation, the Save As dialog appears, for you to choose a path and name to save the file to.
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To add a new sound
1. Click File, Import.
2. In the Files of type list box click Windows Waveform (WAV).
3. In the Look in list box, click the folder you want to use.
4. In the files list box, click the file you want to use.
5. Click Import.
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To edit a sound wave
1. In Animation view, click View, Timelines .
2. From the list double click the slide containing the sound.
3. With the right mouse button, click the sound you want to edit.
4 Click Properties.
5. Use the scroll bars and the Play, Pause, Stop, and Record commands in the File menu.
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To select an entire waveform
Do one of the following:

Drag the mouse from the start of the waveform to the end.
 Click Edit, Select All.
 Double-click anywhere on the waveform.
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To cut a section of a sound wave to the Clipboard
1. Drag the cursor to select the area of the waveform you want to cut.
2. Click Edit, Cut. 
Note

The remaining portion of the wave that follows the cut section is then moved backward in time to where 
the cut began. In this way, no holes are left from cutting a portion of a wave.
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To copy a section of a sound wave to the Clipboard
1. Drag the cursor to select the area of the waveform you want to copy.
2. Click Edit, Copy
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To paste a section of a sound wave from the Clipboard
1. Click the waveform where you want to paste the sound wave from the clipboard .
2. Click Edit, Paste.
Note

The portion of the sound wave that was to the right of the insertion line is pushed ahead in time. It now 
begins after the section you've just Pasted.
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To remove a section of a sound wave
1. Drag the cursor to select the area of the waveform you want to remove.
2. Click Edit, Delete. 
Note

This command works exactly as the Cut command, except that the deleted section is not placed on the 
clipboard.
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To play a sound in the Wave editor
Click File, Play.

{button ,AL(`wave_editor_proc;;;;;',0,"Defaultoverview",)} Related Topics



To pause a sound
Click File, Pause.
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To play part of a sound wave
1. Drag the cursor to select the part of the waveform you want to play.
2. Click File, Play.
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To stop playing a sound in the Wave Editor
Click File, Stop.
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To save an edited sound wave
1. Click File, Exit.
2. Click Save, in the Save Wave dialog box.
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To exit without saving changes to the sound wave
1. Click File, Exit.
2. Click Cancel.
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To reverse the effects of the last command
Click Edit, Undo.
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To zoom in or out of a waveform
Click View, Zoom in, or Zoom out.
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To use mono or stereo sound
1. Click Effects, Change Characteristics
2. Click Mono or Stereo as required.
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To get a better quality sound
1. Select the area of the sound you want to modify.
2. Click Effects, Amplify.
3. Type the percentage you want to use.
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To make a part of a sound silent
1. Drag the cursor to select the part of the waveform you want to make silent.
2. Click Effects, Silent.
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To fade a sound from soft to loud
1. Select the part of the waveform you want to fade in from soft to loud.
2. Click Effects, Fade In.
3. Type the percentage you want to use.
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To fade a sound out from loud to soft
1. Select the part of the waveform you want to fade out.
2. Click Effects, Fade out.
3. Type the percentage of fade out you want to use.
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To reverse a sound
1. Select the part of the waveform you want to reverse.
2. Click Change Characteristics, Reverse.
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To record a new sound
1. Connect the input device as described by the vendor of the device.
2. In Animation view, click Insert, Sound.
3. In the Wave Editor, click File, Record.
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To turn sound on and off
1. Click Tools, Options
2. Click the Animation tab.
3. Check Sound to turn it on, uncheck to turn it off.
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To import a background sound for your presentation background
1. Select the file you want to import.
2. In the Import on area click Background.
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To add an echo effect to a sound wave
1. Select all or part of the waveform.
2. Click Effects, Echo.
3. Type the amount of delay you want to use.

Note
The value you type in Delay of, is the amount of time in milliseconds that the selected waveform is delayed 
before it plays. On the waveform, this is the distance that the selection is moved to the right on the waveform.
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To modify the volume of a wave in the Wave Editor
Drag the handle of the Volume control to the right to increase volume; drag to the left to decrease volume.

Note
The Volume control modifies volume only for current playback. The modifications you make with the 

Volume control cannot be saved with he sound. Use Amplify if you want to modify the file.
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Function keys
Press To
F1 Get help on the currently selected command or open dialog box
SHIFT+F1 Get help on screen item or active command
F2 Select the Zoom In option from the Zoom tool menu
SHIFT+F2 Zoom in on selected object(s)
F3 Select the Zoom Out option from the Zoom tool menu
F4 Change the current view to fit all objects in the drawing window
F5 Run presentation
F6 Select the Rectangle Tool
F7 Select the Ellipse Tool
F8 Select the Artistic Text Tool
SHIFT+F8 Select the Paragraph text tool
F9 Select the Star tool
F11 Open the Fountain Fill dialog box
SHIFT+F11 Open Uniform Fill dialog box
F12 Open Outline Pen dialog box
SHIFT+F12 Open Outline Color dialog box
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Menu keys
File menu
Edit menu
Insert menu
Format menu
Arrange menu
Tools menu
Help menu
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File menu

Press To
CTRL+N Create a new document
CTRL+O Open a file
CTRL+S Save a file
CTRL+P Print



Edit menu

Press To
CTRL+Z Undo the last action(s)
ATL+INSERT Redo
CTRL+X Cut
CTRL+C Copy
CTRL+V Paste



Insert menu

Press To
CTRL+G Insert slides



Format menu

Press To
CTRL+T Change text character attributes
CTRL+Y Snap to Grid



Arrange menu

Press To
SHIFT+PGUP Move object to front
SHIFT+PGDN Move object to back
CTRL+PGUP Move object forward one
CTRL+PGDN Move object backward one
F4 Fit object to slide



Tools menu

Press To
CTRL+J Open the Options dialog box



Help menu

Press To
SHIFT+F1 Access What’s This help



Toolbox keys
Pick Tool
Shape Tool
Zoom Tool
Pencil Tool
Rectangle Tool
Ellipse Tool
Text Tool
Outline Tool
Fill Tool
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Pick Tool

Press To
CTRL+Spacebar Select the Pick tool
original object
Hold down To
CTRL Constrain move vertically or horizontally
CTRL+SHIFT Stretch in 100% increments in two directions

Scale in 100% increments in four directions



Shape Tool

Press To
CTRL+F10 Open the Node Edit dialog box
HOME Select the start node of a curve
SHIFT+HOME Toggle selection of start node on and off
CTRL+HOME Select the first subpath in the selected curve
SHIFT+CTRL+HOME Toggle selection of first subpath on and off
END Select the end node of a curve
SHIFT+END Toggle selection of end node on and off
CTRL+END Select the last subpath in the selected curve
SHIFT+CTRL+END Toggle selection of last subpath on and off
DELETE Delete the selected node
+ (plus key) Add a node to the selected point on the path
- (minus key) Delete selected nodes
TAB Shift current node selections forward along the curve
SHIFT+TAB Shift current node selections backward along the curve
Hold down To
SHIFT Select multiple nodes

Change complement of nodes selected when you marquee select nodes
CTRL Constrain the movement of a node or control point to multiples of 90 degrees

Constrain the movement of characters to nearest baseline
SHIFT+CTRL Select all nodes on the path or subpath



Zoom Tool

Press To
F2 Zoom in
F3 Zoom out
SHIFT+F2 Zoom to all objects
CTRL+F3 Zoom to page



Pencil Tool

Press To
ALT+F5 Select the Freehand tool
Hold down To
SHIFT Erase as you backtrack over a path being drawn
CTRL Constrain the movement of control points to increments of user-specified degrees when 

drawing in Bezier mode
Constrain Freehand, Bezier and Angular dimension lines to horizontal, vertical or a user-
specified angle



Rectangle Tool

Press To
F6 Select the Rectangle tool
Hold down To
CTRL Draw squares
CTRL+SHIFT Draw squares from the center out
SHIFT Draw rectangles from the center out



Ellipse Tool

Press To
F7 Select the Ellipse tool
Hold down To
CTRL Draw circles
CTRL+SHIFT Draw circles from the center out
SHIFT Draw ellipses from the center out



Text Tool

Press To
F8 Select the Artistic Text tool
SHIFT+F8 Select the Paragraph Text tool
Arrow keys Move insertion point in direction of arrow
HOME Move insertion point to start of current line
CTRL+HOME Move insertion point to start of text
END Move insertion point to end of current line
CTRL+END Move insertion point to end of text
SHIFT+HOME Select all text left of insertion point to the start of the line
SHIFT+END Select all text right of insertion point to the end of the line
Backspace Delete selected text or individual characters before the insertion point
DELETE Delete selected text or individual characters after the insertion point
ENTER Begin a new line
CTRL+X Cut selected text to the Clipboard
CTRL+C Copy selected text to the Clipboard
CTRL+V Paste text from the Clipboard
CTRL+Left arrow Move insertion point to beginning of word to the left of insertion point
CTRL+Right arrow Move insertion point to beginning of word to the right of insertion point
CTRL+Up arrow Move insertion point to previous paragraph
CTRL+Down arrow Move insertion point to next paragraph
CTRL+HOME Move insertion point to start of text frame
CTRL+END Move insertion point to end of text frame
SHIFT+ Left arrow Select character to the left of insertion point
SHIFT+ Right arrow Select character to the right of insertion point
CTRL+SHIFT+Left arrow Select the word to the left of insertion point
CTRL+SHIFT+Right arrow Select the word to the right of insertion point
SHIFT+Up arrow Select one line up from insertion point
SHIFT+Down arrow Select one line down from insertion point
CTRL+SHIFT+Up arrow Select text left of the insertion point to previous paragraph
CTRL+SHIFT+Down arrow Select text right of the insertion point to the end of frame
CTRL+SHIFT+HOME Select text left of insertion point to the start of frame
CTRL+SHIFT+END Select text to the right of insertion point to the end of frame
CTRL+SHIFT+PGUP Select text left of the insertion point to the start of the text block
CTRL+SHIFT+PGDOWN Select text right of the insertion point to the end of the text block
CTRL+Backspace Delete the word left of the insertion point
CTRL+DELETE Delete the word right of the insertion point



Outline Tool

Press To
F12 Select the Outline dialog box
SHIFT+F12 Select the Outline Color dialog box



Fill Tool

Press To
SHIFT+F11 Select the Fill Color dialog box
F11 Select the Fountain Fill dialog box



Dialog box keys
Press To
TAB Move to next control
SHIFT+TAB Move to control
Arrow Keys Move and selects within active group of option buttons
Spacebar Turn on or off active check box or chooses active command button
Letter Keys Move to next item beginning with that letter in an active list box
ALT+Underlined letter Select item with that underlined letter
ENTER Choose active command button
ESC Cancel command and close dialog box

{button ,AL(`refer_proc;;;;;',0,"Defaultoverview",)} Related Topics



Views keys
Outliner view
Press To
TAB Demote text
SHIFT+TAB Promote text
CTRL+ENTER on slide title Create bullet on slide
CTRL+ENTER on bullet Create a new slide
Double-click on slide Change to Slide view

Slide Sorter view
Press To
Double-click on slide Change to Slide view
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Right mouse button
You can right mouse click on the following items to access a flyout menu with commands that relate specifically 
to that item:

All views
Collection library
Color palette
Corel PRESENTS title bar
Import dialog
Object
Open dialog
Rulers
Save As dialog
Scroll bars
Slide
Slide tab
Status line
Text
Toolbars

Tip
If you are not using a mouse, press SHIFT+F10 on the keyboard to access the flyout commands. If you are 

using a Microsoft keyboard, you can also press the Menus key.



Commands
You can access any menu command in PRESENTS by pressing ALT+the underlined letter in the menu+the 
underlined letter of the command.
Examples
ALT+F+I opens the Import dialog box from the File menu.
ALT+O+B opens the Select Bullet dialog box from the Format menu.



Custom shortcuts
You can create you own shortcuts or change PRESENTS defined shortcuts in the Tools, Customize, Keyboard 
option. If the shortcut results listed in this section of the help file do not match the shortcut actions you are 
performing, check the Keyboard option to ensure that another shortcut has not been assigned to the particular 
action.





When rearranging slides
If you are rearranging slides in Slide Sorter view, you must select the slide you want to move and drag it 
between two other slides; a vertical line appears when you drag the slide. If you drag the slide to the left, the 
vertical line displays on the left of the slide that will be displaced when you release the mouse button. If you drag
a slide to the right, the vertical line displays on the right of the slide that will be displaced when you release the 
mouse button.

{button ,AL(`trouble_proc;;;;;',0,"Defaultoverview",)} Related Topics



When importing text from Word to PRESENTS Outline
Tabs are used in PRESENTS as the distinguishing markers between slides, bullets, and bullet levels. If you create 
the text for your presentation outline in Microsoft Word and import it into PRESENTS, do not format the text in 
Word. Perform all the required formatting of levels in the PRESENTS Outline, using the Promote and Demote 
buttons.
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When working with master layouts
If you make any change to a layout, it disables its links to the master layout. Any changes you make to the 
master layout will not be applied to the unlinked attributes with the changed layout.
To restore the link to the master layout, switch to Master Layout view. Right mouse click and choose the Frame 
Attributes command. Enable any of the check boxes that you want to link the option to the master layout.

{button ,AL(`trouble_proc;;;;;',0,"Defaultoverview",)} Related Topics



When the Layout icon is unavailable
The Layout icon on the standard toolbar is not active until you apply a layout to your slide.



When the Insert Background commands are unavailable
If you are in Background view and choose the Insert Background command, only the From Library option is 
available. Switch to Slide view to access the other Insert Background options.



When canceling from the Map Wizard
If you choose to insert a map from PRESENTS, and then cancel while in the Map Wizard, a map is still inserted 
onto the slide. To remove the map, click on any blank area of the slide, then select the map and press the 
DELETE key.



When exiting from the Map server
If you click Exit, while in the Map server, PRESENTS will close down. Make sure that you save your changes, then 
reopen the PRESENTS application.
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When video and sound are out of synch
If your video image and the associated soundtrack aren’t matching within a video file, try using the Insert, Video 
command to incorporate the video file, as opposed to the File, Import command.

{button ,AL(`trouble_proc;;;;;',0,"Defaultoverview",)} Related Topics



When editing time slows down
If you include many OLE objects such as bitmaps or video files, you may find that it takes longer to do basic 
tasks in your presentation. To speed up the editing time while working on your presentation, click View, 
Timelines. Disable the check box beside all OLE objects in the presentation; this hides the objects. Don’t forget to
enable the check boxes before you run your presentation!
You can also wait until you’ve finished all other aspects of creating your presentation before inserting large OLE 
objects.
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When transitions lag in preview mode
When previewing closing transitions in the Object Properties dialog box, there is a time delay that is equal to the 
time you’ve set your transition to run. For example, if you have set your timing so that there are five seconds of 
slide time before the closing transition appears, you have to wait five seconds for the closing transition to appear
in the preview box.

{button ,AL(`trouble_proc;;;;;',0,"Defaultoverview",)} Related Topics



Restore command (Control menu)
Returns the active window to the size and location it had before you chose the Minimize or Maximize command 
from the Control menu.

You can also restore a window by clicking its Restore button, .



Move command (Control menu)
Allows you to move the active window with the arrow keys.
This command is unavailable if the window is maximized.
You can also use this command to move buttons of minimized presentation windows and dialog boxes that have 
a Control menu.



Size command (Control menu)
Allows you to resize the active window with the arrow keys.
This command is unavailable if the window is maximized.



Minimize command (Control menu)
Shrinks the active window to a button.    If the minimized window is an application, the button is located in the 
Windows task bar. If you are minimizing a presentation window, its associated button appears at the bottom of 
the Corel PRESENTS screen, just above the status line.
Using the Minimize command in the Control menu is equivalent to clicking the Minimize button with the mouse.



Maximize command (Control menu)
Expands the active window to fill the entire screen.
Using the Maximize command in the Control menu is equivalent to clicking on the Maximize button with the 
mouse.



Close command (Control menu)
Closes the active window or dialog box. If you have made changes to the current file, a dialog box appears 
asking you whether you want to save the file.



Next command (Control menu)
Switches between open presentation windows.



Used to access the menus and their respective commands. The menu bar include Minimize, Restore, and Close 
buttons when you have a maximized presentation window.



The slide area is the rectangle with drop shadow located in the presentation window. You can place objects 
beyond the borders of the slide area, but only objects on the slide will print or display in a screen show.
Choose File, Page Setup to set the dimensions and orientation of the Slide area.



The area in which presentations are created. Each presentation that you open appears in a separate window. 
Each window has its own Control menu with commands for moving, sizing, closing, and minimizing windows. 
Closing or minimizing windows you are not currently working on keeps your screen from becoming too cluttered.
You can open more than one presentation at a time, and move or copy entire slides or selected objects from one 
presentation to another.



Displays measurements of the presentation windows, which is helpful for sizing and positioning objects in your 
slide s. Choosing Rulers from the View menu turns the display of the rulers on and off.
Clicking a ruler and dragging brings a guideline onto the screen. 

Holding the mouse button down on  and dragging toward the center of the screen brings out a set of 
crosshairs.



Expands the window to fill the entire screen. After you expand a window, the button changes to the Restore 

button . Use this button to return the window to its former size.



Shrinks the application window to a rectangular button in the Windows task bar or, in the case of a presentation 
windows, to a button at the bottom of the PRESENTS screen, immediately above the status line.
As a button, the application or presentation stays in memory, but its window does not take up space on your 
screen.



Returns the active window to the size and location it had before you chose the Minimize or Maximize command 
from the Control menu.



Closes the active window or dialog box. If you have made changes to the current file, a dialog box appears 
asking you whether you want to save the file.
Closing Corel PRESENTS is the same as choosing Exit from the File menu.



Displays portions of a drawing outside the current viewing area of the .

Click to
An arrow move the current view 10% in selected direction
An elevator move the view by one full window
A    thumb and drag move the view an arbitrary amount in any direction



Includes drop-down lists and buttons for editing text objects in your presentation file. It includes buttons and lists
for font selection, text styles, alignment, bullets, spell checker, and color. The Text Ribbon Bar works only on text 
created in Corel PRESENTS using the Text tool as opposed to text brought in from other applications through OLE.



Includes buttons that provide quick access to menu commands such as:
new, open, save, and print
cut, copy, paste, and import
display views and libraries
insert map, chart, or Motion 3D
access online help



Includes tools allowing you to draw, select, stretch, and scale objects, add text, and apply attributes to the 
objects.



Provides information about a the current tool or command, the current view, time and date. 



Shows the name of the program plus the name and location of files in fully-expanded presentation windows. In 
presentation windows less the full size, the title bar shows the file's name and location or the word 
"Presentation1", "Presentation2", etc., for new presentations you have not yet saved. 
The Title Bar may also contain the Close, Restore, Maximize, Minimize, and Control menu buttons for controlling 
the window.



Opens commands that allow you to move, resize, minimize, maximize, and close applications.



Appears around windows that are less than full size. Dragging the border lets you customize the size of    the 
window border.
Drag the top, bottom, or side border to size the window in one direction only.
Drag the corner of the border to size the window vertically and horizontally.



Only objects within this rectangular area will print. You can adjust the size of the printable page in the Page 
Setup dialog box, opened by choosing File, Page Setup; the printable page corresponds to the paper size you've 
specified in the Page Setup dialog box, not the printer's "image area," which includes margins that are 
determined by your printer.



Displays a Color Palette along the bottom of the Corel PRESENTS window for choosing outline and fill colors.
To select a fill color, click it with the left mouse button.
To select an outline color, click it with the right mouse button.
Clicking on the arrows at the ends of the palette with the left mouse button scrolls the colors one at a time.
Clicking the 

 arrow with the left mouse button enlarges the Color Palette.
Clicking the 

 button at the left end of the palette removes the object's fill if you click with the left mouse button, or outline if 
you click with the right mouse button.



Displays the last four colors selected. Click the arrow key to view all colors; you can choose fill colors to apply.
To select a fill, click on the color with the left mouse button.



Displays which slide you are working on. Click on a tab to switch to that slide in the presentation.





Starts a new presentation, giving you the choice of using a Wizard, applying a template, or using a blank page.
The new presentation uses the same page, ruler and guideline settings plus the Presentation Options in effect for
the current session. Use the Page Setup command in the File menu to change the page settings. To change the 
Presentation Options use the Preferences command in the File menu.



Opens an existing presentation file in a new window. The .CPR file extension is automatically assigned to your 
PRESENTS files.



Saves the current presentation under the name displayed in the title bar. If the presentation is new and has not 
been saved, the Save As dialog box opens so that you may give it a name. If you are altering an existing 
presentation, but want to keep the original version, use the Save As command in the File menu.
When you save a presentation, the following settings are saved with the file: page size and orientation, ruler 
units and origins, snap to guidelines, and grid status and presentation options



Prints the presentation according to the options you select in the Print dialog box. You select the printer to be 
used, the range of pages, and the number of copies to print.



Removes the selected object from the current slide and places it on the Clipboard. In Slide sorter view, it is used 
to cut an entire slide . Once on the Clipboard, you can paste the object onto another slide, another PRESENTS 
file, or into another Windows application.
To permanently remove the selected object, use the Delete command in the Edit menu.



Places a copy of the selected object(s) onto the Clipboard. In slide sorter view, it is used to copy entire slides. 
Once on the Clipboard, you can paste the object to another slide, another PRESENTS file, or into another 
Windows application.



Places a copy of the object stored on the Clipboard onto the current slide. The object(s) remains on the Clipboard
until you copy or cut another object or end the current Windows session.



Imports graphics created in other applications and saved using various file extensions, allowing you to use clipart
images, text, and graphics created in other software applications.



Runs the presentation in the active window as a screen show. Once it has started, all PRESENTS’ tools, ribbon 
bars, menus, and other interface items are hidden from view, and the entire screen is used for the screen show. 
You can stop a screen show by pressing the ESC key.    The behavior of the screen show depends on the 
presentation options set using the Preferences command in the File menu. 



Shows the active slide in full screen preview hiding all Corel PRESENTS interface items temporarily. If the slide 
includes an animation sequence, the movement is shown in this preview.    Transition effects applied to the slide 
or objects on the slide are also displayed.



Displays a single slide in the presentation so that you can add new or edit existing foreground elements. You can 
tell from the Slide Selection tabs at the bottom of the screen which slide you are working on, and the number of 
slides in the presentation.



Displays all slides in the presentation as thumbnails. Select this view to arrange the order of slides in a 
presentation or to verify its overall effect and contents before printing it.



Displays outline view in which you can type the text for your presentation ideas and format them. Comprises a 
page with a left margin. Each slide is identified in the left margin by a number and a slide icon. The outline view 
includes a special toolbar for change the heading level of text strings on slides and for switching from draft to 
preview outline mode. Draft shows text without any formatting, whereas preview displays the font, bold, italic, 
and underline attributes.
Various indentation levels indicate the relative position of text on a slide. The slide title appears first and is not 
indented. When you press ENTER at he end of a line of text Presents automatically creates a new line at the 
same heading level and advances the cursor to it. Use the toolbar arrows to indent text to the next higher or 
lower heading level. If you type text at the first level and press ENTER, you create a new slide title, as well as 
new slide in the Presentation.
This view allows you to add the text to your presentation very quickly because there are no graphic objects to 
redraw every time you make a change.



 Displays the selected master layout. When working in this view, any changes to the layout frames are applied to
all slides that share the same layout.



Displays only the background objects present on the current slide. Select this view when you want to make 
changes to the background. When working in this view, any object you add becomes part of the background and 
will be present in all slides that share the same background.



Opens the Libraries dialog, from which you select ready-made backgrounds or layouts to apply to the current 
slide or to the entire presentation.



Opens the Insert Slide Wizard, which allows you to define the number of slide you want to add, specify whether 
you want them added before or after the current slide, and choose a background and layout.



Opens the Insert Map dialog, which allows you to select a map to insert into the slide. You can edit the map and 
legend to customize it for your requirements.



Opens the Insert Chart dialog box, where you can choose from the available chart types and open the charting 
module where you can create and edit your charts.



Opens the Insert Motion 3D dialog, which allows you to select a three dimensional, moving image to insert into 
the slide. You must have the Motion 3D application installed on your system for this option to work.



 Opens the Spell Checker dialog box, which allows you to check the spelling of text on the current slide.



Opens a flyout menu listing Corel applications installed on your system; you can open an application by choosing
the appropriate command. To add other programs to the Application Launcher list, add the program name and 
path to the Applications section of the CORELAPP.INI file.



Changes the pointer to a question mark , which you can place anywhere on the screen to view relevant 
information.





Changes the font for the selected text or the default font.



Changes a point size for the selected text or for the default font. The arrow located on the right of the Point size 
box is used to see the list of point sizes and make a selection. You can    type the point size directly.



Applies or removes bolding for selected text or the default font.



Applies or removes italics for selected text or the default font.



Applies or removes underlining for selected text or the default font.



Aligns Paragraph and Artistic text to the left side of the Bounding box.



Centers Paragraph and Artistic text in the Bounding box.



Aligns Paragraph and Artistic text to the right side of the Bounding box.



Increases spacing between characters to align Paragraph and Artistic text to the left and right sides of the 
Bounding box.



Inserts a bullet in front of the selected text and applies the current bullet style to it.    The Bullet Style command 
in the Format menu is used to set the bullet style.



Checks the spelling of words in the selected text string or paragraph.
You can limit spell checking to portions of text by selecting the word(s) with the Text tool before performing the 
spell check.
The CD-ROM version of PRESENTS provides different dictionaries, allowing you to check the spelling of words in 
other languages. You specify which dictionary to use by editing your CORELAPP.INI file.



Used exclusively to set the color of text and objects created using PRESENTS’ drawing and text tools. The More 
button that appears at the bottom of the palette gives access to the Select Color dialog for choosing a Color 
mode, editing an existing color, and even creating your own Color Palette.





Plays the animation from the current point in the animation file.



Plays the animation backward, from the current point in the animation file.



Stops playing the animation file.



Moves forward one frame from the current point in the animation file.



Backs up one frame from the current point in the animation file.



Returns to the first frame of the animation file.



Moves forward to the last frame of the animation file.



Displays the time that has played in the animation file.



Graphically displays the time that has played in the animation file. You can drag the track bar back and forth to 
move frames around in the animation file.





Selects objects or groups of objects. After you select an object, you can use commands in the menus or the 
toolbox to change the object’s appearance.
You can also use the Pick Tool to interactively move, stretch, scale, rotate, and skew objects.



Shapes lines/curves, text, bitmaps, rectangles/squares, ellipses/circles. The function of the Shape Tool varies 
depending on the type of object selected.
Object Type Function
Line/Curve Changing the shape by moving nodes and control points and using the Node Edit Roll-Up
Text Editing character attributes and interactive kerning
Rectangle/Square Rounding corners
Ellipse/Circle Creating arcs and pie wedges
Animation Path Customizing the animation path at the node level 



Node Edit roll-up
The Node Edit roll-up is available when editing a curve object with the Shape tool. Draw a curve object with the 
Freehand or Bezier tool, select the Shape tool, and double-click on a node to open the roll-up.
Click a button on the graphic below to learn more about the node edit functions.



Click to change the roll-up to modal. When you click outside the roll-up after making a selection the roll-up 
disappears.



Click to make the roll-up appear rolled up on the screen. Click  to make the roll-up appear full-size on the 
screen.



Closes the roll-up.



Adds a node. Click on the spot where you want to add a node, and click the Add button. You can marquee select 
multiple nodes to insert a node between each of them.



Deletes the selected node(s). Click on the node that you want to delete, and click the Delete button.



Connects end nodes on segments that are part of the same path. Use to close an open path or make two 
different paths into a single continuous curve. Use the Combine command to make separate curves into one 
path.



Splits the curve into two or more subpaths at the selected node.



Eliminates extraneous nodes without significantly altering the shape of the curve.



Converts a curve segment to a line segment.



Converts a line segment to a curve segment.



Changes the selected node into a cusp node Use when you want to add a sharp bend to a curve.



Changes the selected node into a symmetrical node Use when you want the same curvature on both sides of the
node.



Changes the selected node into a smooth node. Use when you want a different curvature on each side of the 
node.



Changes the way the selected nodes move when dragged with the mouse. If the check box is disabled, all nodes 
move by the same amount. When checked, nodes move in proportion to their distance from the base node, i.e., 
the node you are dragging. The result is that the curve appears to behave like an elastic expanding and 
contracting in response to the movement of the mouse.



Opens the Zoom flyout toolbar, which includes buttons to zoom in, out, to actual size, selected object, all objects,
and to full page.



Magnifies a portion of the screen.



Zooms out by a factor of two each time you click, or returns to the view you were at before the last zoom-in.



Displays the Slide at the size at which it will print.



Zooms in on all selected objects.



Brings all objects on the screen into view.



Shows the entire page.



Draws lines and curves. Holding the mouse button down on the Pencil tool opens a menu that lets you choose 
the drawing mode Freehand or Bezier

you want to use to draw.



Selects the Freehand drawing tool, which is a click and drag style of drawing similar to moving a pencil on paper. 
Draws lines, curves, and dimension lines. You can also use the Pencil tool to trace bitmaps. Holding the mouse 
button down on the Pencil tool opens a menu that lets you choose the drawing mode and the type of dimension 
line you want to draw.



Selects the Bezier drawing tool, which is a connect-the-dots style of drawing where you specify the start and end
points of the line/curve you want to draw and how CorelDRAW connects them. Draws lines, curves and dimension
lines. You can also use the Pencil tool to trace bitmaps. Holding the mouse button down on the Pencil tool opens 
a menu that lets you choose the drawing mode and the type of dimension line you want to draw.



Draws rectangles, ellipses and stars. Holding down the mouse button on the Shapes tool opens a menu that lets 
you choose the the type of shape you want to draw.



Draws rectangles and squares. Objects drawn with the Rectangle tool are assigned the current default Fill, 
Outline Pen, and Outline Color attributes.



Draws ellipses and circles. Objects drawn with the Ellipse tool are assigned the current default Fill, Outline Pen, 
and Outline Color attributes.



Draws polygons. Objects drawn with the Polygon tool are assigned the current default Fill, Outline Pen, and 
Outline Color attributes.
To create a pointed star, click on the Shape tool after drawing the polygon, then drag any of its points.



Enables you to add text directly on the screen as strings of Artistic Text.or blocks fo Paragraph text.



Enables you to add text directly on the screen as strings of Artistic Text.



Enables you to enter text directly on the screen as blocks of Paragraph Text.



Opens the Outline Pen flyout menu, from which you can specify preset or custom attributes including outline 
thickness, line pattern, and calligraphic pen effects. Choose an icon from the flyout with no object selected to 
change the default outline pen attributes for new objects you create.



Opens the Outline Color dialog box. Click it with no object selected to change the default outline color for new 
objects you create.



Opens the Outline Pen dialog box, from which you can choose color, width, corners, line caps, arrows and 
calligraphic options. Click it with no object selected to to change the default pen attributes for new objects you 
create.



Applies a white outline to the selected graphic object. Click it with no object selected to to make white the 
default outline color for new objects you create.



Applies a black outline to the selected graphic object. Click it with no object selected to to make black the 
default outline color for new objects you create.



Removes outlines from the selected graphic object(s). Click it with no object selected to have new objects you 
create drawn without an outline.
You can also remove outlines by right-clicking the  at the left end of the Color Palette.



Applies a 0.2 point line width to the selected graphic object. Click it with no object selected to to make this the 
default outline width for new objects you create.



Applies a 2 point line width to the selected graphic object. Click it with no object selected to to make this the 
default outline width for new objects you create.



Applies an 8 point line width to the selected graphic object. Click it with no object selected to to make this the 
default outline width for new objects you create.



Applies a 15 point line width to the selected graphic object. Click it with no object selected to to make this the 
default outline width for new objects you create.



Applies a 24 point line width to the selected graphic object. Click it with no object selected to to make this the 
default outline width for new objects you create.



Opens the Fill flyout menu, from which you can choose preset fills or set custom attributes including solid color, 
bitmaps, textures, and patterns. Click an icon in the flyout with no object selected to change the default fill 
attributes for new objects you create.



Opens the Uniform Fill dialog box for specifying uniform fills. Click it with no object selected to make the uniform 
color the default fill for new objects you create.



Opens the Fountain Fill dialog box, from which you can create linear, radial, conical, or square fountain fills. Click 
the Fountain Fill icon with no object selected to to make the the fountain fill the default outline width for new 
objects you create.



Selects white for the fill color. Click it with no object selected to to make white the default fill for new objects you 
create.



Selects black for the fill color. Click it with no object selected to to make black the default fill for new objects you 
create.



Selects 50% black for the fill color. Click it with no object selected to to make 50% black the default fill for new 
objects you create.



Removes the fill from the object, allowing objects behind it to show through. Click it with no object selected to 
have new objects you create drawn without a fill.
You can also remove fills by clicking with the left mouse button on the  button at the left end of the Color 
Palette.



Opens the Two-Color Pattern dialog box, from which you choose two-color pattern fills. Click the icon with no 
object selected to make the pattern the new default fill for new objects you create.



Opens the Vector Pattern dialog box, from which you import vector images. Click the icon with no object selected
to make the pattern the new default fill for new objects you create.



Opens the Texture fills dialog box, from which you choose Texture Fills. Click the icon with no object selected to 
make the texture the new default fill for new objects you create.



Opens the Full Color Bitmap Pattern dialog box, from which you import bitmap images to use as fills. Click the 
icon with no object selected to make the pattern the new default fill for new objects you create.





Draws the chosen geometric shape on screen. Objects drawn with the Geometric Shapes tool are assigned the 
current default Fill, Outline Pen, and Outline Color attributes.





Moves the text up one level in the hierarchy.



Moves the text down one level in the hierarchy.



Moves the slide or bullet down one level in the hierarchy from its current position.



Moves the bullet up one level in the hierarchy from its current position.



Shows the text format as it appears on the slide in draft mode.







Displays thumbnails representing the transitions appearing on a slide.



Hides the slide from the current presentation. Effective when you require multiple versions of a presentation, or 
to remove information for certain audiences.



Enables and disables the jacket that appears around each slide in Slide sorter view.



Color Preferences dialog box
Appears when you try to open any of the outline or fill options, without first selecting an object. The Color 
Preferences dialog allows you to choose either graphic objects, Artistic text or Paragraph text to apply the colors.
Once you select the object to apply the preferences to, the outline or fill option that you clicked opens.



Enable the button to select graphic objects that you draw with the toolbox option to apply the default color 
preferences.



Enable the button to select Artistic text to apply the default color preferences.



Enable the button to select Paragraph text to apply the default color preferences.



Insert Slide command/button
Opens the Insert Slides Wizard, which allows you to define the number of slides you want to add and if you want 
them added before or after the current slide.
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Insert Slides dialog box
Allows you to define the number of slides you want to add and if you want them added before or after the 
current slide.



Type the number of slides you want to add to the presentation.



Enable the button to add slides before the current slide.



Enable the button to add slides after the current slide.



Insert Slides - Select a Layout dialog box
Allows you to choose a layout from the current document or a preset library.



Enable either the current document or preset library radio button to select from where you’ll access the required 
layout.



Displays presentation layouts available from the library or current document. Each one is represented by a 
thumbnail, which you can double-click to select.



Insert Slides - Select a Background dialog box
Allows you to choose a background from the current document or a preset library.



Displays presentation backgrounds available from the library or current document. Each one is represented by a 
thumbnail, which you can double-click to select.



Displays the Open dialog box, which allows you to choose a background from a presentation library.



Select a background to view from either the current document or one of the Background libraries.



Delete Slide command (Insert menu)
Removes the currently displayed or selected slide from the presentation. If you change your mind after deleting 
the slide, click Edit, Undo.

{button ,AL(`how_delete_obj;slide_proc;;;;',0,"Defaultoverview",)} Related Topics



 Insert Background command (Insert menu)
Opens a flyout menu, which allows you to choose a background from the None, Uniform Fill, Fountain fill, Image, 
Texture fill, or From Library commands.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Blank command (Insert menu)
Choose the command to apply a blank, white background to the selected slides.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Uniform Fill command (Insert menu)
Opens the Uniform Fill dialog box, which allows you to select color models, palettes or mixers, modify color and 
palette options, or create a custom palette.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Fountain Fill command (Insert menu)
Opens the Fountain Fill dialog box, which allows you to select the fountain type, angle. steps and color blend or 
to apply a preset fill.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Two-Color Bitmap Pattern command (Insert menu)
Opens the Import dialog box, which allows you to select a two-color bitmap pattern to import as a background.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Full-Color Bitmap Pattern command (Insert menu)
Opens the Import dialog box, which allows you to select a full-color bitmap pattern to import as a background.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Vector Pattern command (Insert menu)
Opens the Import dialog box, which allows you to select a full-color bitmap pattern to import as a background.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



Background, Texture Fill command (Insert menu)
Opens the Texture fill dialog box, which allows you to select a texture from the library, and modify it to apply as a
background.

{button ,AL(`background_proc;;;;;',0,"Defaultoverview",)} Related Topics



# IDH_INSERT_LIBRARY$ Background, From Library command (Insert menu)> proc4 



Insert CorelMEMOs command (Insert menu)
Opens the CorelMEMO dialog box, which allows you to insert notes and bitmapped images into any program that 
supports Object Linking and Embedding (OLE). Use a CorelMEMO when you want to leave yourself a reminder, 
note a change in a document, or place a comment into a program. Add one of the bitmapped images provided 
with CorelMEMO, or include your own bitmapped image to customize your CorelMEMO.



Insert Sound command (Insert menu)
Opens the Import dialog box, which allows you to record a sound file and place it on the slide. If you want to 
insert an existing sound, use the File, Import command to place the sound file in the presentation. You can then 
invoke the Wave Editor to make edits.

{button ,AL(`sound_proc;;;;;',0,"Defaultoverview",)} Related Topics



Insert Video command (Insert menu)
Opens the Open dialog box, which allows you to choose an .AVI video file to insert onto the slide.

{button ,AL(`video_proc;;;;;',0,"Defaultoverview",)} Related Topics



New Object command (Insert menu)

Inserts a linked or embedded object, such as a chart, graphic, or spreadsheet data created in another 
application. Also lets you insert the contents of another file as an embedded or linked object.

{button ,AL(`ole_proc;;;;;',0,"Defaultoverview",)} Related Topics



Insert chart command/button
Opens the Chart Type dialog box, which allows you to select the type of chart to create.

{button ,AL(`chart_over;how_choose_charts;how_crea_chrt_sample;how_crea_chrt_own;;',0,"Defaulto
verview",)} Related Topics



 

Chart Type dialog box
Displays a list of the chart types and a visual representation of the variations available for each type.



Select the chart type you want to use. Scroll the list if you want to see more chart types.



 Double click the chart type you want to use. The display changes with the chart type selected in the list box at 
left.



Lists the chart type and subtype selected.



Insert Map command/button
Opens the Map Wizard, allowing you to create a map.





Character command (Format menu)
Opens the Character Attributes dialog box, which you can use to edit font and alignment. 
The Character Attributes, Font dialog box controls your font or typeface, placement (e.g., Normal, Superscript), 
effect (e.g., small caps), size, text style, underline, and range kerning.
The Character Attributes, Alignment dialog box controls text character, word, and line spacing, and alignment or 
justification. To change the attributes of individual characters, drag across them with either text tool or select 
character nodes with the Shape tool. Selecting characters individually enables you to rotate and shift them 
horizontally and vertically. You can also use the Character Attributes, Alignment dialog box to rotate selected 
characters or shift the characters horizontally and vertically.
Choosing the Character Attributes command with no text objects selected enables you to change the default 
Artistic Text and/or Paragraph Text attributes.
Note

Spacing changes apply to all text in the current string or paragraph, not just selected text.

{button ,AL(`text_overview;add_text_proc;wts30_pro2_cd;default_proc;char_dlg;para_dlg;;',0,"Defaul
toverview",)} Related Topics



Change Case command (Format menu)
Opens the Change Case dialog box, which provides the following options for changing the case of selected text:

Sentence case (capitalizes the first word of the selection)
lowercase (makes all letters lower case)
UPPERCASE (converts all letters to upper case)
Title Case (capitalizes each word)
tOGGLE cASE (changes the case of all selected letters)

{button ,AL(`format_text_proc;edit_text_proc;;;;',0,"Defaultoverview",)} Related Topics



Bullet Style command (Format menu)
Opens the Bullet Style dialog box, which allows you to select a font grouping of bullets, size and to enable the 
bullet.

{button ,AL(`bullet_proc;;;;;',0,"Defaultoverview",)} Related Topics



Select Bullet dialog box
Sets the type, style and size for the bullets in your presentation.



Select a font style from the list of available symbol fonts.



Type the point size you want the bullet to appear.



Displays available bullet shapes in the current font. Click on the bullet shape that you want to select.



Disable the check box to remove the bullet you selected.



Fit Text to Path command (Format menu)
Opens Fit Text to Path, which enables you to shape a selected Artistic Text object to the outline of a selected non-
text object. The text and path become a dynamically-linked group, enabling you to edit the text or change the 
shape of the path and automatically refit the text.

If you want to fit the text to a character, convert the character to a curve object using the Arrange menu's 
Convert to Curves command.

If you want to keep the path, but prevent it from printing, click the path while holding down the CTRL key 
and remove the path's fill and outline. To delete the path, use the same technique to select it then press DELETE.

{button ,AL(`text_overview;format_text_proc;',0,"Defaultoverview",)} Related Topics



Separate Text from Path command (Format menu)
Detaches text fit to a path using the Fit Text to Path command.

{button ,AL(`text_overview;format_text_proc;',0,"Defaultoverview",)} Related Topics



Straighten Text command (Format menu)
Returns selected text to the baseline and resets Vertical and Horizontal Shift and Angle to zero.
Straighten Text does not affect text spacing options (Inter-character Spacing, Inter-Word Spacing, and Inter-Line 
Spacing) specified with the Edit Text or Paragraph commands.
Note

Straighten Text is used for removing Horizontal Shift, Vertical Shift, and Angle. If you want to return a text 
object rotated with the rotation handles to the baseline, click Arrange, Clear Transformations.

{button ,AL(`wts106_pro2_cd;;;;;',0,"Defaultoverview",)} Related Topics



Grid Setup command (Format menu)
Opens the Ruler and Grid tabs, which allow you to set the ruler measurements and grid parameters.

{button ,AL(`grid_proc;;;;;',0,"Defaultoverview",)} Related Topics



Ruler page
Sets the horizontal and vertical units of measurement, the horizontal origin and the vertical origin.



Select the units of measurement from the list box; the measurement is displayed on the horizontal ruler.



Select the units of measurement from the list box; the measurement is displayed on the vertical ruler.



Type the number, in inches, that you want the 0,0 points set on the horizontal ruler.



Type the number, in inches, that you want the 0,0 points set on the vertical ruler.



Grid page
Controls the location of the grid zero point, the spacing of the grid lines, the grid display, and the drawing scale.

When you save your drawing, the Grid settings are saved with it.
If you change the grid spacing, objects in your drawing retain their position even if they do not line up with

the new grid line positions.
When you change Grid Frequency units, the values in the dialog box are not converted. Each time you 

change units, you must specify the frequency you want to use with that unit.



Type the number for the amount of space per unit that is left between grid points going horizontally.



Type the number for the amount of space per unit that is left between grid points going vertically.



Enable the check box to display the grid in the presentation window.



Enable the check box to force objects into alignment with a grid point when the object is drawn or moved close 
to it.



Guidelines Setup command (Format menu)
Opens the Horizontal and Vertical tabs, which allow you to add Guidelines at specific locations in the drawing 
window. Also lets you move and delete existing guidelines.

You can add, move and delete guidelines by dragging them with the mouse.
With Snap To Guidelines enabled, an object drawn or moved near a guideline snaps to it.
You can add as many guidelines as you need.

{button ,AL(`guides_proc;;;;;',0,"Defaultoverview",)} Related Topics



Horizontal page
Add horizontal guidelines at specific locations in the drawing window. Also lets you move and delete existing 
ones.



Enable the button to specify that    horizontal guidelines    are to be added, moved or deleted.



Specifies the location of the guidelines relative to the zero points on the rulers. 



Click to add a guidelines at the position specified in the Guideline position field list box.



Click to move the guidelines to the new location specified in the Guideline position field. If you have added more 
than one guideline, click the one you want to move in the position field. Enter the new location, then choose the 
Move button.



Click to remove the guidelines at the location displayed in the Guideline position field. Delete selected guidelines
by continuing to press Delete. If the guidelines to be deleted are not sequential, click the specific guideline 
position and then click delete.



Click to remove all the guidelines displayed in the Guideline position field.



Enable the check box to display guidelines in the presentation window.



Enable the check box to force objects into alignment with a guidelines when the object is drawn or moved close 
to it.



Vertical page
Add vertical guidelines at specific locations in the drawing window. Also lets you move and delete existing ones.



Enable the button to specify that    vertical guidelines are to be added, moved or deleted.



Specifies the location of the guidelines relative to the zero points on the rulers. 



Click to add a guidelines at the position specified in the Guideline position field list box.



Click to move the guidelines to the new location specified in the Guideline position field. If you have added more 
than one guideline, click the one you want to move in the position field. Enter the new location, then choose the 
Move button.



Click to remove the guidelines at the location displayed in the Guideline position field. Delete selected guidelines
by continuing to press Delete. If the guidelines to be deleted are not sequential, click the specific guideline 
position and then click delete.



Click to remove all the guidelines displayed in the Guideline position field.



Enable the check box to display guidelines in the presentation window.



Enable the check box to force objects into alignment with a guidelines when the object is drawn or moved close 
to it.



Snap to Grid command (Format menu)
Toggles Snap To Grid on and off. Working with the grid on makes it easy to accurately align and position objects. 
It also allows you to draw precisely-sized objects. The grid is non-printing.
When Snap To Grid is on, the cursor is forced to stay on the grid    points, except when you are:

Selecting an object with the Pick or Shape Tools
Drawing in Freehand or Bezier mode
Rotating/skewing an object with the Pick Tool
Modifying ellipses with the Shape Tool
Zooming in with the Zoom Tool

Notes
When moving objects with Snap To Grid on, the handles on the object's highlighting box are forced to the  

grid    points.
Text snaps to the grid along its baseline when moved vertically. When moved horizontally, the text snaps 

according to the Justification option assigned with the Character command. For example, with Right Justification 
selected, text snaps to the grid along the right edge of its highlighting box.

When moving rotated text, the handles on its highlighting box snap to the grid.
The Constrain feature always overrides the grid.
The Grid Setup command allows you to display the grid and to set the spacing of the grid points.
Snap To Guidelines has priority over Snap To Grid.
Turning Snap To Grid on will not affect the position of objects already on the screen.

{button ,AL(`grid_proc;;;;;',0,"Defaultoverview",)} Related Topics



Snap to Guidelines command (Format menu)
Toggles Snap To Guidelines on and off. Guidelines are non-printing lines that you can place anywhere in the 
drawing window. With Snap To Guidelines on, an object drawn or moved near a guideline snaps to it, which is 
useful for aligning objects with precision.
Note

The position of objects already on the screen does not change when you turn Snap To Guidelines on.
You can position guidelines by dragging them from the rulers, or by using the Guidelines Setup command.

{button ,AL(`guides_proc;;;;;',0,"Defaultoverview",)} Related Topics



To insert a video file
1. Click Insert, Video.
2. Select the drive and folder in the Look in list box.
3. Select the video file extension from the Files of type list box.
4. Type the name of an existing file in the File name box, or click on the file name in the display window.
5. Click Open.

A frame labeled AVI appears on the slide. To view the video clip, click the Run button.
Note

You can only insert .AVI files. To incorporate other video file formats into your presentation, use the File, 
Import command.

{button ,AL(`video_proc;;;;;',0,"Defaultoverview",)} Related Topics



To import a video file
1. Click File, Import.
2. Select the drive and folder in the Look in list box.
3. Select the video file extension from the Files of type list box.

You can import . AVI, .MPEG, .MOV, .FLI, and .FLC video files.
4. Type the name of an existing file in the File name box, or click on the file name in the display window.
5. Click Import.
Tip

Importing the video file treats the video as a multicel actor. You can work with the video frames in the 
same ways as you would work with an animation actor.

If you are including an ..AVI file in your presentation, you can also use the Insert, Video command.

{button ,AL(`video_proc;;;;;',0,"Defaultoverview",)} Related Topics



To delete a video file
1. Select the video frame on the slide.
2. Click Edit, Delete.

{button ,AL(`video_proc;;;;;',0,"Defaultoverview",)} Related Topics



To move a video clip
1. Select the video frame on the slide.
2. Drag and drop the frame to the new location on the slide.
Note

You cannot resize video clips in PRESENTS.

{button ,AL(`video_proc;;;;;',0,"Defaultoverview",)} Related Topics







3. Click Insert, Motion 3D, in PRESENTS.











Following has been changed Aug. 8, 1995 for use as what's this help. The dialog does not have a help button. --
Gordon x1126



When checked, enables you to change the default Artistic Text.



When checked, enables you to change the default Paragraph Text.



 Character command
Opens the Character Attributes dialog box, which you can use to edit font and alignment. 
The Character Attributes, Font dialog box controls your font or typeface, placement (e.g., Normal, Superscript), 
effect (e.g., small caps), size, text style, underline, and range kerning.
The Character Attributes, Alignment dialog box controls text character, word, and line spacing, and alignment or 
justification. To change the attributes of individual characters, drag across them with either text tool or select 
character nodes with the Shape tool. Selecting characters individually enables you to rotate and shift them 
horizontally and vertically. You can also use the Character Attributes, Alignment dialog box to rotate selected 
characters or shift the characters horizontally and vertically.
Choosing the Character Attributes command with no text objects selected enables you to change the default 
Artistic Text and/or Paragraph Text attributes.
Notes

Spacing changes apply to all text in the current string or paragraph, not just selected text.
Bar code fonts installed with CorelDRAW's Bar Code Wizard do not display in the Character dialog box 

because they are special fonts used for bar code generation only. Fonts in imported bar codes do not display in the 
document window and Character dialog box.

{button ,AL(`text_overview;add_text_proc;wts30_pro2_cd;default_proc;char_dlg;para_dlg;;',0,"Defaul
toverview",)} Related Topics



Character Attributes, Font options
Use the Character Attributes, Font dialog box to control your font or typeface, placement (e.g., Normal, 
Superscript), effect (e.g., small caps), size, text style, underline, and range kerning. 
To change the attributes of individual characters, drag across them with either text tool or select character nodes
with the Shape tool. 
To change the text attributes of multiple text objects at the same time, select them with the Pick tool before you 
open the dialog box.
Choosing the Character Attributes command with no text objects selected enables you to change the default 
Artistic Text and/or Paragraph Text styles.
Note

Bar code fonts installed with CorelDRAW's Bar Code Wizard do not display in the Character dialog box 
because they are special fonts used for bar code generation only. Fonts in imported bar codes do not display in the 
document window and Character dialog box.

{button ,AL(`text_overview;para_dlg;char_dlg;;;',0,"Defaultoverview",)} Related Topics



Displays the names of the available fonts you can choose from. If necessary, use the scroll bar to the right to 
scroll through the list.



Converts selected text to subscript or superscript.



Converts selected text to SmallCaps or AllCaps.



Sets the size of the current font (available sizes are 0.72 to 4,000 points).



If you prefer a different unit of measure from the default, pick one from the list box. 



Lists the type styles available for the chosen font. 



Underlines selected text. The options are: Single Thin, Single Thin Word, Single Thick, Single Thick Word, Double 
Thin or Double Thin Word.
If you want to underline each word in the selected text but not space between words, choose Single Thin Word, 
Single Thick Word, Double Thin or Double Thin Word.



Opens the Edit Underline dialog box, where you can change default line thicknesses or baseline shift.



Applies overlines to selected text. The options are: Single Thin, Single Thin Word, Single Thick, Single Thick Word,
Double Thin or Double Thin Word.
If you want to overline each word in the selected text but not space between words, choose Single Thin Word, 
Single Thick Word, Double Thin or Double Thin Word.



Opens the Edit Overline dialog box, where you can change default line thicknesses or baseline shift.



Applies strikeout to (draws a line through) selected text. The options are: Single Thin, Single Thin Word, Single 
Thick, Single Thick Word, Double Thin, and Double Thin Word.
If you want to strike out each word in the selected text but not space between words, choose Single Thin Word, 
Single Thick Word, or Double Thin Word.



Opens the Edit Strikeout Line dialog box, where you can change default line thicknesses or baseline shift.



Adjusts the amount of space, or range kerning, between selected characters.



Displays sample characters in the selected font and text style. The type of font you have selected, for example 
TrueType or PostScript Type 1, is indicated below the Preview area.



Applies Single Thin, Single Thin Word, Single Thick, Single Thick Word, Double Thin, or Double Thin Word 
underlining, overlining, or strikeout formatting.
If you want to apply formatting each word in the selected text but not space between words, choose Single Thin 
Word, Single Thick Word, Double Thin or Double Thin Word.



Provides choice of unit of measure.



Edit Underline, Overline, and Strikeout dialog boxes
Use the Edit Underline, Overline, and Strikeout dialog boxes if you want to change default line thicknesses or 
baseline shift. You can also use the Edit Underline, Overline, and Strikeout dialog boxes to change unit of 
measure if required.

{button ,AL(`text_overview;char_dlg;;;',0,"Defaultoverview",)} Related Topics



You can use the list boxes below to the default text line thicknesses.



You can use the list boxes below to set default baseline shift for the current type of line attribute you are editing.



Sets thickness for Single Thin lines.



Sets thickness for Single Thick lines.



Sets thickness for Double Thin lines.



Sets thickness for Double Thin lines.



Sets the amount of Baseline Shift applied for line effect.



 Character Attributes, Alignment options
Use the Character Attributes, Alignment dialog box to control character, word, and line spacing, justification, 
shift, and angle.
Selecting characters individually enables you to rotate and shift them horizontally and vertically. You can also use
the Character Attributes, Alignment dialog box to rotate selected characters or shift the characters horizontally 
and vertically.
Notes

The Horizontal Shift, Vertical Shift and Angle controls appear only when you have selected text by dragging
with the Insertion Point or selected character nodes with the Shape tool.

Spacing changes apply to all text in the current string or paragraph, not just selected text.

{button ,AL(`text_overview;char_dlg;para_dlg;;',0,"Defaultoverview",)} Related Topics



Sets spacing between Artistic Text and Paragraph Text characters as a percentage of the SPACE character in the 
selected font.



Sets spacing between words as a percentage of the SPACE character in the selected font.



Sets spacing between lines of text in points or percentages of character height or point size.



Provides choice of unit of measure.



Moves selected text along the baseline. Increments are measured in percent of point size.



Moves selected text above the baseline. Increments are measured in percent of point size.



Rotates selected text from the baseline. Increments are measured in degrees.



Use the character alignment controls to set text alignment, or justification options  Left, Center, Right, Full Justify,
Force Justifiy or None. Choose None if you want to use the Shape tool to change the position of individual 
characters, adjust kerning or rotate a character without automatically repositioning remaining text.



Sets Paragraph Text spacing between characters as a percentage of the SPACE character in the selected font.



Sets spacing between words as a percentage of the SPACE character in the selected font.



Sets spacing between lines of text in points or percentages of character height or point size.



Sets spacing before paragraphs in percentages of character height; uses the same measurement type set for Line 
spacing.



Sets spacing after paragraphs in percentages of character height; uses the same measurement type set for Line 
spacing.



Provides choices for the unit of measure for spacing before and after paragraphs. Choose % of Char. height, points, 
or % of Pt. size.



Turns off Alignment, so that if you can use the Shape tool to change the position of individual characters, adjust 
kerning or rotate a character without automatically repositioning remaining text.



Aligns text to both the left and right margins of the Paragraph Text frame.



Stretches the last line of a paragraph to the right frame margin.



Aligns text to the left margin, resulting in a "ragged" or uneven right margin.



Aligns text to the center of the Paragraph Text frame.



Aligns text to the right margin, resulting in a ragged left margin.



If you choose Full Justify or Force Justify you can edit the settings for Maximum Word Spacing (0-999 %).



If you choose Full Justify or Force Justify you can edit the settings for Minimum Word Spacing (0-999 %).



If you choose Full Justify or Force Justify you can edit the default settings for how far apart you can set characters, 
the Maximum Character Spacing (0-999 %).



Enables the International Hyphenator. You can choose between various language databases for hyphenation in the 
International Proofreader's Advanced Options dialog box.



Enables hyphenation of capitalized words if required.



Sets how far the end of a line must be from the right margin before hyphenation of the first word of the next line 
occurs. 
A smaller hot zone results in more hyphens and better word spacing along the margin. 



Choose alternate units of measure from the list as required.



Sets the minimum length of words to be included for automatic hyphenation.



Sets the minimum number of characters (including spaces) that must appear in the Hot Zone before a hyphen.



Sets the minimum number of characters (including spaces) that must appear in the Hot Zone after a hyphen.



Displays the current tab settings and unit of measure selected. Drag tabs along the ruler if you want to move them. 
If you prefer another unit of measure, choose one from the Units list box.



Change the number if you want to change the distance between evenly spaced tabs along the ruler.



Inserts tab stops at evenly spaced intervals. 



Choose another unit of measure from the list box if required.



Click a tab to select it or type in a tab stop above.



Click to place a new tab on the ruler at the tab stop location selected in the tabs list. The new tab assumes current 
alignment options.



Clears a tab stop selected from the list or ruler.



Clears all tab stops.



Sets leadered tab stops.



Sets the character used for leadered tab stops.



Sets the spacing for leadered tab stops. You can also enter a value from 0 (tight) to 10 (loose) to set leader spacing 
numerically.



Enables you to choose leader characters for leadered tab stops by their symbol numbers.



Drag the slider left or right to make leader tab spacing tighter or looser. 
You can also enter a value from 0 (tight) to 10 (loose) to set leader spacing numerically.



Sets leadered tab stops close together.



Spreads leadered tab stops apart.



Text flows from the tab stop to the right



Centers text at the tab stop.



Text flows from the tab stop to the left.



Aligns decimal points in the text to the tab stop. Text without decimal points extends to the left of the tab stop.



Use the Indents group box to set Paragraph Text indents.



Displays the current indent settings and unit of measure selected. You can drag the markers along the ruler to 
change indents as required or use the Indents area below to make precise changes. If you prefer another unit of 
measure, choose one from the Units list box.



Sets the distance the first line of a paragraph is set from the left side of the text frame. 
Drag the top marker along the ruler if you want to change your first-line indent visually.



Sets the distance of lines coming after the first line from the left side of the text frame. 
Drag the bottom marker along the ruler if you want to change your indent visually.



Sets the distance of lines coming from the right side of the text frame. Drag the right-side bottom marker along the 
ruler if you want to change your right margin indents visually.



Choose another unit of measure from the list box if required.



Disables bullet effects.



Enables bullet effects. You can choose from all of the symbol sets included with your software.



Sets the size of the current bullet, from 0 to 360 points. 



List units of measure for bullet indents.



Sets how far the bullet is set from the left margin of the text frame. 



Sets the distance of the bullet from the baseline. 



Lists all of the available bullet categories (symbol sets). Choose a bullet type from the preview area.



Displays all of the bullet symbols available in the selected symbol set.



You can use this box to type the Index number for the symbol listed in the Symbol and Clipart Catalog.



Enter a number to divide the selected text frame into columns The maximum number of columns for one frame is 
eight. If you want to add more columns you can drag out more text frames. 
The preview area at right displays how your changes will look as you make them.



Displays the number of the column currently shown in the Width and Gutter boxes at right. 
You can scroll through the Column number list to show other columns when you want to edit column and gutter 
widths. Column width editing is disabled if the Equal column width option is selected.



Displays a preview of your changes as you make them.



Sets the size of the column. Width also controls the overall frame width if you choose Automatically adjust frame 
width. Column width is adjustable from 0.25 to 1,000.00 inches.
The preview area at right displays how your changes will look as you make them.



Sets the spacing between columns. The maximum spacing is 200.00 inches.
The preview area at right displays how your changes will look as you make them.



Specifies the unit of measurement. If you prefer another unit of measure, choose one from the Units list box.



Sets the same column and gutter widths for all columns. Disable this option to set individual column and gutter 
widths.



Ensures frame width remains unchanged and adjusts column and gutter widths automatically, preventing settings 
that exceed the frame or page size.
The preview area at right displays how your changes will look as you make them.



Adjusts frame, column, and gutter widths automatically.
The preview area at right displays how your changes will look as you make them.



Enables on-screen text editing. When disabled, the Edit Text dialog box opens whenever you select a text object 
with a text tool or click in the drawing window or pasteboard area with a text tool. 



Enables display of a font for drop-down list boxes. Disable this command if you want to turn the sample off.



Sets the minimum number of characters permitted in lines of Paragraph Text shaped to fit into odd-shaped 
envelopes. When set to the default value of three, lines must have at least three characters to appear.



Simplifies the appearance of text below a certain size to increase screen redraw speed. This option does not affect 
the appearance of printed text. You can make greeked text readable again by choosing a higher Greeking level or 
using Zoom.



Specifies whether calligraphic pen outlines are transferred to the Clipboard or exported using any of the vector 
graphics export filters. If your file contains many calligraphic outlines, excluding them during cut and paste 
operations reduces the size of the exported file and time required to transfer the file through the Clipboard. 
Some export filters retain calligraphic outlines regardless of the setting chosen.



Specifies whether text cut or copied to the Clipboard should be pasted as text or curves. When enabled, text is 
pasted as text; when disabled, text is pasted as curve objects. When text is pasted as text, font, point size and 
other text attributes are copied along with the text string.



Enables PANOSE font matching. Font matching occurs when (a) you open a Corel file from another user or computer
system, or (b) import text or graphics files that supports text and your current system does not have the same 
fonts.



Applies the same text formatting to all connected Paragraph Text frames.



Applies the same text formatting only to selected Paragraph Text frames.



Applies the same text formatting only to selected and succeeding linked Paragraph Text frames.



Toggles display of non-printing characters you want to appear in your document while in text editing mode. 
To display, the Text menu's Show non-printing characters command must be enabled.



Fit Text To Path command
Opens Fit Text to Path, which enables you to shape a selected Artistic Text object to the outline of a selected non-
text object. The text and path become a dynamically-linked group, enabling you to edit the text or change the 
shape of the path and automatically refit the text.

If you want to fit the text to a character, convert the character to a curve object using the Arrange menu's 
Convert to Curves command.

If you want to keep the path, but prevent it from printing, click the path while holding down the CTRL key 
and remove the path's fill and outline. To delete the path, use the same technique to select it then press DELETE.

{button ,AL(`text_overview;format_text_proc;',0,"Defaultoverview",)} Related Topics



Fit Text To Path
Enables you to shape a selected Artistic Text object to the outline of a selected non-text object. The text and 
path become a dynamically-linked group, enabling you to edit the text or change the shape of the path and 
automatically refit the text.

If you want to fit the text to a character, convert the character to a curve object using the Arrange menu's 
Convert to Curves command.

If you want to keep the path, but prevent it from printing, click the path while holding down the CTRL key 
and remove the path's fill and outline. To delete the path, use the same technique to select it then press DELETE.

{button ,AL(`text_overview;;;;',0,"Defaultoverview",)} Related Topics



Determines the orientation of the letters on the path.
Rotate 
Letters

rotates individual characters to follow the contours of the 
path.

 Vertical 
Skew

vertically skews each character, creating the impression that 
the text is standing upright on the path. The amount of 
skewing varies with the slope of the path.

Horizontal 
Skew

similar to Vertical Skew, but with an added effect that makes 
letters appear to turn into the screen as they wrap around 
the path. The amount of skewing varies with the slope of the 
path.

Center Base centers the base of each letter on the path.

Determines the vertical placement of text with respect to the path.
Baseline aligns the text baseline with the path.
Top aligns the text ascender line with the path.
Bottom aligns the descender line of the text with the path.
Center Centers the text on the path.

    Variable allows you to move the text off the path by dragging with the
mouse. 

Flips the text to the opposite side of the path and reverses the path's start and end nodes.



Displays a dialog box you can use to specify text placement on the path.



Fit Text to Path Offsets dialog box
Provides precision Horizontal Offset and Distance From Path controls for text shaped to paths.
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Specifies how far along the path you want to position the text.



Specifies how far above or below the path you want to position the text.



Describes what text objects in the document have been counted. If objects are selected, they are listed. 
If no objects are selected, all text in the document is counted, including tab and space characters.



Lists all text object types counted and displays totals for each.



Proofreading command
Displays a flyout from which you can choose the Spelling, Quick Proofreading, Full Proofreading, and Advanced 
Options commands.
The International Proofreader's three checking modes Spelling, Quick Proofreading and Full Proofreading

serve users with varying needs. For example, an office worker who considers speed paramount might want to 
check only for spelling and mechanical errors. Meanwhile, a journalist writing an article for publication might want 
to check for stylistic problems. The same journalist, however, having carefully polished and checked the article's 
style, might want to check the spelling quickly once again before submitting the article. Lastly, an academic or 
another journalist might be so confident as to consider it unnecessary to check for items such as confused words, 
clichés, or wordy expressions.

The International Proofreader's functionality is as uniform as linguistically possible across all supported 
languages. It follows the conventions prescribed by widely accepted grammar and style manuals for each 
language, and it handles language variants appropriately.
The checking and correction functionality of the Proofreader is divided into three checking modes:

Spelling mode
Quick Proof mode
Full Proof mode

{button ,AL(`text_overview;proof_proc;',0,"Defaultoverview",`main')} Related Topics



Spell Checking dialog box
The Spell Checking dialog box detects and corrects numerous types of spelling errors, including those related to 
complex language-specific phenomena such as clitics in the Romance languages and compound words in the 
Germanic languages. Spelling mode corrects errors involving the following categories of writing elements:

A/An use (English)
Capitalization
Spelling (abbreviation errors, apostrophe errors, cognitive misspellings, and typographic errors)
Capitalization
Clitics (Romance languages)
Compounding (English and the other Germanic languages)
Doubled words
Hyphenation (including soft-hyphen errors and hyphenation-dependent spelling errors)

Tip
By default, the Spell Checker refers to the Personal Dictionary USERPD during spelling checks.

{button ,AL(`text_overview;proof_over;',0,"Defaultoverview",`main')} Related Topics



Quick Proofreading dialog box
The Quick Proofreading dialog box provides all the functionality of Spelling mode, in addition to correcting errors 
involving the following categories of writing elements:

Confused words
Double negatives
Format
Homonyms
Inappropriate prepositions
Misspelled expressions
Misspelled foreign expressions
Noun-phrase agreement (Romance languages)
Punctuation
Spacing between words and sentences 
Ungrammatical expressions
Uppercase/lowercase spellings of words, depending on their function or context (German)

{button ,AL(`text_overview;proof_over;',0,"Defaultoverview",`main')} Related Topics



Enables you to choose between checking the current text object or the full document if necessary.



Highlights unrecognized words. Click the word and make your changes as you would in the document window.



Describes errors when found. The type of rule shown depends on the proofreading level you choose.



Opens a dialog box you can use to add words to your personal dictionary.



When an error is found, the International Proofreader lists all alternative spelling words found in its database.



Moves the Proofreader to the next sentence.



Leaves the current word unchanged and continues checking. 



Ignores all subsequent words or phrases during the current proofreading session.



Replaces the currently flagged error with the word or phrase in the Change To box. 



Replaces all instances of the currently flagged error and continues the proofreading session.



Stops the checking session and closes the International Proofreader.



Full Proofreading dialog box
The Full Proofreading dialog box provides all the functionality of Spelling mode and Quick Proofreading mode in 
addition to identifying many categories of stylistically questionable expressions and offering assistance in 
eliminating them. The words and expressions flagged in Full Proofreading mode are not grammatically incorrect, 
but they are ones that careful writers avoid in most contexts or use only for intentional effect. The error 
messages displayed in Full Proofreading mode are designed to provide you with the stylistic guidelines you need 
to make a subjective decision about including or omitting such words and expressions. The categories include 
the following:

Archaic expressions
Clichés
Contractions
Gender-specific expressions
Informal expressions
Jargon expressions
Overused phrases
Pretentious words
Redundant expressions
Sexist expressions
Stock phrases
Unnecessary prepositions
Vague quantifiers
Wordy expressions

{button ,AL(`text_overview;proof_over;',0,"Defaultoverview",`main')} Related Topics



Advanced Options dialog box
This dialog box enables you to set the languages you want the Proofreader to check in your document. You can 
also set up which language rules and errors are displayed in, whether alternative spellings are displayed when 
an error is found, use of personal dictionaries, and maximum sentence elements.

{button ,AL(`text_overview;proof_over;languages;;',0,"Defaultoverview",)} Related Topics



Lists all installed International Proofreader checking languages.



Lists all available International Proofreader Rule languages.



Lists all available International Proofreader Error languages.



Causes the International Proofreader to search the current language database for alternative spellings when an 
error is encountered.



Enables the creation of personal dictionaries.



Enables you to turn off your personal dictionary or the International Proofreader's dictionary.



Opens the New Personal Dictionary dialog box, where you can save Advanced Option settings in a file for reuse.



You can set the maximum number of sentence elements for each language that you initialize. Sentence 
elements are words or punctuation that International Proofreader treats as units. The default setting for each 
language should be acceptable for most text; you should not change the default unless you need to reduce the 
memory overhead required by the buffer-processing function.



Opens the Rule Manager, where you can customize the International Proofreader's rules.



Rule Manager dialog box
As International Proofreader processes text, it distinguishes between sentence text and non-sentence text and 
uses appropriate rules to check each type of text. With the Rule Manager, you can customize your proofreading 
environments by turning off specific rules or categories of rules (called rule types).
The Rule Manager gives you the ability to turn individual rules or entire rule types off and to use different 
combinations of rules or rule types when writing for different readers. It keeps track of which rules and rule types
you have turned off, and of whether you want to do this for the current writing session and/or for future writing 
sessions. If you turn off rules or rule types for future sessions, the Rule Manager maintains a list of these in a 
user profile and reloads it when the next writing session starts. If you turn off a rule or rule type for the current 
session only, the Rule Manager discards the information at the end of that session.
The Rule Manager displays a description of each Rule Type when selected in the Rule Manager dialog box.
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Opens a dialog box where you can enter a name for a new user profile, a file containing personal rule settings.



Lists all personal user profiles created.



Enables you to choose between Spelling, Quick Proofreading, and Full Proofreading modes for your user profile 
changes.



Enables you to choose between Formal, Standard, and Informal modes for your user profile changes.



Click to restore the default settings for the Check Mode selected.



Describes the error type highlighted in the Rules Types box.



New User Profile dialog box
Enables you to create a new custom file containing your own rule changes for the Proofreader. If you turn off 
rules or rule types for future sessions, the Rule Manager maintains a list of these in a user profile and reloads it 
when the next writing session starts. By default these settings are kept in the user profile "USERPF." Type in a 
new name if you want to create one. Type in a new name if you want to create a new file.
Note

If you turn off a rule or rule type for the current session only, the Rule Manager discards the information at 
the end of that session.
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New Personal Dictionary dialog box
Enables you to create a new custom file containing your own additional spellings for the Spell Checker. By 
default these settings are kept in the personal dictionary "USERPD." Type in a new name if you want to create a 
new personal dictionary.

{button ,AL(`text_overview;proof_over;;;',0,"Defaultoverview",)} Related Topics



Thesaurus command
Opens the Thesaurus, which suggests synonyms for words in your document. Use one of the text tools to 
highlight the word you want a synonym for and then choose the Thesaurus command.
Tip

You can use the Thesaurus to look up any word, not just the current selection or document.

{button ,AL(`text_overview;spell_proc;proof_proc;wts23_pro2_cd;;;',0,"Defaultoverview",)} Related 
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Thesaurus
Suggests synonyms for words in your document. Use one of the text tools to highlight the word you want a 
synonym for, and then choose the Thesaurus command.
Tip

You can use the Thesaurus to look up any word, not just the current selection or document.

{button ,AL(`text_overview;;;;',0,"Defaultoverview",)} Related Topics



Displays the currently selected word. You can type in any word you want if you did not select one. Click the down
arrow to display previously looked up words.



Displays a list of found definitions of the word shown in the Looked up box.



Displays all of the text in the definition of the word in the Looked up box.



Displays the first synonym for the word you looked up.



Lists all synonyms for the word you looked up. Double-click any word in the list to look up its definition.



Click to look up a word.



Click to replace the word you looked up with the word in the Replace with box.



Click to see the previous word.



Type Assist command
Opens the Type Assist dialog box, which has automatic controls for text capitalization the first letter of 
sentences, two initial consecutive capitals and names of days

and changing straight quotes to typographic quotes. 
Type Assist also enables you to replace text strings automatically if you want to, replacing "teh" with "the" for 
example, and includes a number of presets.
If you enable the Replace Text While Typing option, correction takes place after you finish typing the word, either 
by entering a punctuation mark or a space.
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Type Assist
Opens Type Assist, which has automatic controls for text capitalization the first letter of sentences, two initial 
consecutive capitals and names of days

and changing straight quotes to typographic quotes. 
Type Assist also enables you to replace text strings automatically if you want to, replacing "teh" with "the" for 
example, and includes a number of presets.
If you enable the Replace Text While Typing option, the Replacement Text operation occurs after you finish typing
the word, either by entering a punctuation mark or a space.
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Capitalizes the first letter following a sentence end. A sentence end is defined by a period (.), an exclamation 
mark (!), or a question mark (?). In Spanish, the marks ¿ and ¡ are also supported.



Changes the standard quotation marks (") included in most font sets to curly, typographical quotes typically 
used in newspapers and books.



Changes the second capital to lowercase if by mistake you hold down the SHIFT key too long and start a word 
with two capitals. No change is made if the capitals are followed by a space or period or the word contains other 
capital letters.



Automatically capitalizes the names of days.



Enables the Replacement Text option, shown below. Text replacement occurs when you press the Spacebar or 
press ENTER.



Type the code you want Type Assist to use to replace longer text strings automatically .



Type the full word, phrase or text string you want to replace the abbreviation.



Click to add Replacement text to the list.



Deletes replacement options, including the defaults provided in Type Assist if you choose.



Lists the preset strings included with your software and any new ones you've created.



Find command
Opens the Find dialog box, which searches for specific text in a document. In text mode, searching begins at the 
insertion point and continues to the end of the selected text. When the Pick tool is active, the search checks the 
entire document one text object at a time. When the search has reached the end of the text, a prompt appears 
asking if you want to continue searching from the beginning. 
If you want to limit your search to text with specific capitalization, enable Match case and enter the capitalized 
text string you want to find.
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Find dialog box
Searches for specific text in a document. In text mode, searching begins at the insertion point and continues to 
the end of the selected text. When the Pick tool is active, the search checks the entire document one text object 
at a time. When the search has reached the end of the text, a prompt appears asking if you want to continue 
searching from the beginning. 
If you want to limit your search to text with specific capitalization, enable Match case and enter the capitalized 
text string you want to find.
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Finds and selects each occurrence of the specified text. You can type as many as 100 characters. The text scrolls 
horizontally as you type.



Select this option if you want to find only text that matches the combination of upper and lowercase letters you 
type in the Find What box. 



Closes the dialog box.



Replace command
Opens the Replace dialog box, which searches for and replaces specific text in a document. In text mode, 
searching begins at the insertion point and continues to the end of the selected text. When the Pick tool active, 
the search checks the entire document one text object at a time. When the search has reached the end of the 
text, a prompt appears asking if you want to continue searching from the beginning.



Replace dialog box
Searches for and replaces specific text in a document. In text mode, searching begins at the insertion point and 
continues to the end of the selected text. When the Pick tool active, the search checks the entire document one 
text object at a time. When the search has reached the end of the text, a prompt appears asking if you want to 
continue searching from the beginning.
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Type the text you want to find. You can type as many as 100 characters. The text scrolls horizontally as you type.



Type the replacement text. You can type as many as 100 characters. The text scrolls horizontally as you type.
If you want to delete the text in the Find What box from the document, leave the Replace With box empty.



Finds and selects each occurrence of the specified text.



Choose this button if you want to confirm the replacement of each occurrence of the text you are searching for. 
For long documents, it is recommended that you use Replace for a few occurrences of the text you want to 
replace. When you are sure that no similar text strings you do not want to include will be replaced, you can click 
Replace All.



Choose this button if you want to replace all instances of the text you are searching for.
You can press ESC to cancel replacing. To reverse changes made before you pressed ESC, choose the Undo 
command from the Edit menu.
For long documents, it is recommended that you use Replace for a few occurrences of the text you want to 
replace. When you are sure that no similar text strings you do not want to include will be replaced, you can click 
Replace All.



Select this option to find only text that matches the combination of upper and lowercase letters you type in the 
Find What box.



Change Case command
Opens the Change Case dialog box, which provides the following options for changing the case of selected text:

Sentence case (capitalizes the first word of the selection)
lowercase (makes all letters lower case)
UPPERCASE (converts all letters to upper case)
Title Case (capitalizes each word)
tOGGLE cASE (changes the case of all selected letters)
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Change Case dialog box
Changes the case of selected text. The available options are as follows:

Sentence case (first word initial capped)
lowercase (all letters lower case)
UPPERCASE (all letters upper case)
Title Case (each word initial capped)
tOGGLE cASE (changes the case of all selected letters)
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Capitalizes the first word of each sentence.



Changes all capitals in the selection to lower case.



Changes all capitals in the selection to UPPER case.



Capitalizes the first letter of all words in the selection.



Toggles the case of all letters in the selection.



Opens the Character Attributes dialog box, where you can apply special font and alignment effects to Artistic Text or
Paragraph Text.



Opens the Paragraph dialog box, which controls Paragraph Text spacing, tabs, indents, and bullet effects.



Provides an editing window you can use to enter text without waiting for screen redraws.



 Scrolls the text window up and down.



Applies boldface text style. If no text is selected, boldfacing begins at the insertion point.



Applies italic text style to selected text. If no text is selected, italics begin at the insertion point.



Applies underline text style to selected text. If no text is selected, underlining begins at the insertion point.



Aligns lines of text down an imaginary center line down the middle of the current page or frame.



Stretches the last line of a paragraph to the right margin.



Automatically adjusts inter-word spacing to align text to both right and left margins



Aligns text to the left text frame margin, removing any shift effects you may have applied.



Like left justification, No justification causes text to align along a straight left margin, with "ragged right" 
margins. With this option, however, shifted or kerned characters are unaffected.



Causes text to align along a straight right margin, with uneven left margins.



Applies bullets to the selected text.





Text Object Properties
You can use Text Object Properties, available from the right-mouse button, to change your fonts, text styles and 
size, and justification. You can also use the to open the Character Attributes, Paragraph or Columns dialog boxes 
for further edits. The buttons for the Paragraph and Columns dialog boxes are available only for Paragraph Text.
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Locks current changes.



Makes your changes without closing the dialog box.



Opens the Columns dialog box.



Provides options for which frames your changes apply to.





Enables you to enter Artistic Text directly on the screen.



Enables you to enter Paragraph Text directly on the screen.



Topics taken from Draw 5, F2--p_text.rtf



Artistic and Paragraph Text overview
Adding Artistic and Paragraph Text
Corel's powerful text-handling capabilities let you add and manipulate text with ease, entering Artistic Text or 
Paragraph Text directly on the screen. In CorelDRAW, you can also add text in the Edit Text dialog box.
Editing and formatting text
As long as you don't convert it to curves, text remains editable even after you transform or apply special effects 
to it. Some of the formatting you can apply to text includes changing the font, point size, and spacing. 
Using Paragraph Text, you can:

flow text into columns (CorelDRAW only);
choose a font and set its point size and attributes
set tabs and indents (CorelDRAW only)
create bulleted lists
adjust character, word, line, and paragraph spacing
hyphenate text automatically (CorelDRAW only)

You can change text formatting using commands in CorelDRAW’s Text menu and Corel PRESENTS Format menu, 
or the text toolbar.
Symbols (CorelDRAW only)
You can also add symbol from the Symbol Library, which is a collection of graphic symbols relating to business, 
transportation, sports and many other subjects.
Outline and fill
As with other objects, text and symbols are given a default outline and fill. You can change the defaults using the
Outline and Fill tools.
Proofreading text
The new International Proofreader helps you improve your writing by finding spelling errors, correctly 
hyphenating words, and listing synonyms.
Using special text features
Some of the special text features let you: 

fit text to the outline of another object
reshape and wrap Paragraph Text frames around other objects    (CorelDRAW only)
create your own Adobe Type 1 and TrueType-compatible fonts and symbols and use them in other Windows

programs
extract text from a CorelDRAW document, edit it in a word processor, then merge it back into the 

document
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Adding text



To add Artistic Text
1. Click the Text tool and hold down the left mouse button.

2. Click the Artistic Text.tool  from the flyout.
3. Click the document window.
4. Type the text.

Note
Once the text is on the page, you can use the text toolbar or Character Attributes command to change the 

font, point size, and other character attributes. 
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To add Paragraph Text
1. Click the Text tool and hold down the left mouse button.

2. Click the Paragraph Text tool  from the flyout.
3 Click the document window.
4. Type the Paragraph Text into the resulting text frame.

Notes
For projects that rely heavily on text, use Paragraph Text, which offers more formatting options than Artistic

Text.
Once the text is on the page, you can use the text toolbar or the Character Attributes command to change 

the font, point size and other character attributes. To change paragraph formatting, use the Paragraph and Columns
commands in the Text menu or toolbar.
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To flow Paragraph Text to another frame on the same page
1. Click the Text tool and hold down the left mouse button.
2. Click the Paragraph Text tool  from the flyout.

3. Drag to create another text frame.
4. Click the frame filled with text. with the Pick tool.
5. Click the text flow tab  on the top or bottom middle of the frame
6. Click the empty frame to flow the text into it.

Notes
The frames are linked, so that if you shrink one frame (or change the size of the text), the amount of text 

in the next frame adjusts automatically. Similarly, if you enlarge a frame, text can flow in from the next linked 
frame.

You can use the Text menu's, Options, Formatting dialog box to apply formatting in the current frame to all 
linked frames, selected frames only, or selected and subsequent frames.

Changing the point size or font in the linked frame causes text to reflow, which can change the location of 
text in linked frames that follow.

For frames that have been previously linked, the previous link is broken and a new one is established with 
the new text.
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To import text
1. Click File, Import.
2. Choose the file format from the Files of Type box. 
3. From the Look in box, choose the drive and directory where your file is located. 
4. Type the name of the file in the File Name box. 
Note

A new text frame appears, sized according to the page size specified in the file. If the frame can't hold all 
the text, additional frames and pages are created.
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To paste Artistic Text
1. Cut or copy the text to the Clipboard. 
2. Open the document you want to paste the text into.
3. Click where you want the text to appear.
4. Click Edit, Paste.
Note

If you paste the text before clicking the Artistic Text tool, the text will appear in the center of the page.
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To paste Paragraph Text
1. Cut or copy the text to the Clipboard. 
2. Open the document you want to paste the text into. 
3. Click the Paragraph Text tool and drag to draw a frame. 
4. Click Edit, Paste. 
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To enter special characters using mnemonic hotkeys
1. Press and hold down the CTRL key. 
2. Press the mnemonic symbol (e.g., ‘`~:,^@) associated with the letter you want accented.
Note

You can use the Character Reference Chart supplied with your software for a list of all mnemonic hotkeys.
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Adding and Creating Symbols



Selecting Text



To select text with a Text tool
1. Click the Text tool and hold down the left mouse button.
2. Click the text tool you want to use from the flyout.
3. Click and hold the mouse button to the left of the first character you want to select.
4. Drag the mouse pointer over the characters you want to edit to select.
Notes

To select one character at a time, hold down the SHIFT key and press an Arrow key. 
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new topic:



To select a Text tool
If the Text tool you want to use is not active, hold the mouse button down on the tool button and choose 

either Artistic Text or Paragraph Text from the flyout.
Tip

Press F8 to activate the Artistic Text tool, or Shift+F8 for the Paragraph Text tool. For a complete list of the 
default hotkeys, click Default Hotkeys.
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To select text with the Pick tool
Click inside a Paragraph Text frame or on any Artistic Text character with the Pick tool.

Notes
To select Artistic Text while working in CorelDRAW's wireframe view, click anywhere on the outline of the 

text.
To select Paragraph Text while working in CorelDRAW's wireframe view, click anywhere on the outline of the

frame.
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To select characters with the Shape tool

1. Click the text with the Shape tool . For Paragraph Text, click anywhere inside the frame. Character nodes 
appear next to each character along with a pair of handle for adjusting spacing.

2. To select a single character, click the node to the left of the character.
Note

To select multiple characters, hold down the SHIFT key and click the nodes of each character you want 
selected. Or, drag until the marquee box encloses the characters' nodes.
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To deselect a character with the Shape tool
Hold down the SHIFT key and click the node to the left of the character.
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Editing Text



To type or edit text on screen
1. Click the Text tool and hold down the left mouse button.
2. Click the Text tool you want to use from the flyout.
3. Select the text you want to edit.
4. Position the insertion point and make changes.
Notes

In CorelDRAW, use the Edit Text dialog box or wireframe view for word processing where system resources 
are heavily taxed.

You can edit text on screen provided none of the following CorelDRAW effects have been applied to it: 
Perspectives, Envelope, Extrude, Contour or PowerLine.

You can edit Artistic Text shaped to paths and Paragraph Text shaped with envelopes on-screen.
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Dublin: new topics to next note



To choose a new font
1. Select the text you want to change.
2. Choose a font from text toolbar.
Note

If you have created new Text Styles, select the text you want to change and click a new text style from the 
Styles list.

{button ,AL(`edit_text_proc;default_proc;wts29_pro2_cd;;;',0,"Defaultoverview",`main')} Related 
Topics



To change font size
1. Click the Text tool and hold down the left mouse button.
2. Click the Text tool you want to use from the flyout.
3. Select the text you want to change.
4. Click the Font Size list on the text toolbar.
Tip

In text editing mode, select the text in the current object, click the Font list, and select a new font size or 
type in a new one.

{button ,AL(`edit_text_proc;wts29_pro2_cd;;;;',0,"Defaultoverview",`main')} Related Topics



To choose a new font style
1. Click the Text tool and hold down the left mouse button.
2. Click the Text tool you want to use from the flyout.
3. Select the text you want to change.
4. Click a Text Style button Bold, Italic, or Underline on the text toolbar.
Note
{bmc bullet.bmp If a font does not support a text style, the button for that text style is grayed out.

{button ,AL(`edit_text_proc;wts29_pro2_cd;;;;',0,"Defaultoverview",`main')} Related Topics



To edit line and strikeout thickness
1. Click the Text tool and hold down the left mouse button.
2. Click the Text tool you want to use from the flyout.
3. Select the text you want to edit.
4. Click Text (Format in PRESENTS), Character.
5. Click the Edit button next to the attribute type you want to change.
6. Type a new underline or strikeout thickness as required.
Tip

To remove text underlining, overlining or strikeout, select None from the list box.

{button ,AL(`edit_text_proc;wts29_pro2_cd;;;;',0,"Defaultoverview",`main')} Related Topics



To edit Baseline Shift
1. Click the Text tool and hold down the left mouse button.
2. Click the Text tool you want to use from the flyout.
3. Select the text you want to change.
4. Click Text (Format in PRESENTS), Character.
5. Click the Alignment tab.
6. Type new values in the Vertical or Horizontal Baseline Shift number boxes.
Tip

To remove Vertical or Horizontal Baseline Shift, select the text and click Text, Straighten Text.

{button ,AL(`edit_text_proc;wts29_pro2_cd;;;;',0,"Defaultoverview",`main')} Related Topics



To edit text character angle
1. Click the Text tool and hold down the left mouse button.
2. Click the Text tool you want to use from the flyout.
3. Select the text you want to change.
4. Click Text, Character.
5. Click the Alignment tab.
6. Type a new value in the Angle number box.
Tip

To remove text Angle, reset the angle to 0, or on the Text menu, click Straighten Text.

{button ,AL(`edit_text_proc;;;;;',0,"Defaultoverview",`main')} Related Topics



To straighten shifted or angled text
1. Select the vertically or horizontally shifted or angled text.
2. Click Text (Format in PRESENTS), Straighten Text.

{button ,AL(`edit_text_proc;;;;;',0,"Defaultoverview",`main')} Related Topics



Dublin: back to old topics



To find text
1. Click Text (Edit in PRESENTS), Find.
2. In the Find What box, type the text you want to search for.
3. Click the Match Case checkbox to find words that have a particular captilization.
4. Click Find Next to begin searching. The first occurance of the search text is highlighted.
5. Click Find Next to search for the next occurrence of the text.
Note

You can enter as many as 100 characters into the Find list box; the text will scroll horizontally as you type.
Click Close to edit the found text on-screen.

{button ,AL(`spell_proc;;;;;',0,"Defaultoverview",)} Related Topics



To find and replace text
1. Click Text (Edit in PRESENTS), Replace.
2. In the Find What box type the text you want to search for.
3. Type the replacement text in the Replace With box.
4. Click the Match Case checkbox to find words that have a particular captilization.
5. Click Replace to confirm the replacement of each occurrence.
Notes

If the string of text that you want to replace is unique (that is, it does not occur in any other text strings in 
the document) you can click the Replace All button to make the apply the change to the entire document.

You can type as many as 100 characters into the Find and Replace boxes; the text will scroll horizontally as 
you type.

{button ,AL(`spell_proc;;;;;',0,"Defaultoverview",)} Related Topics



To copy and paste text
1. Select the text you want to copy.
2. Click Edit, Copy.
3. Place the cursor where you want the text copied to.
4. Click Edit, Paste.

{button ,AL(`edit_text_proc;wts29_pro2_cd;;;;',0,"Defaultoverview",)} Related Topics



To cut and paste text
1. Select the text you want to cut. 
2. Click Edit, Cut.
3. Place the cursor where you want the text moved to.
4. Click Edit, Paste.

{button ,AL(`edit_text_proc;wts29_pro2_cd;;;;',0,"Defaultoverview",)} Related Topics



To change text case with the Change Case command
1. Select the text you want to change.
2. Click Text (Format in PRESENTS), Change Case.
3. Click a text case option.

{button ,AL(`edit_text_proc;type_assist_proc;;;;',0,"Defaultoverview",)} Related Topics



Formatting Text



new topic:



To apply or remove underline, overline, or strikeout formatting
1. Point to the text tool and hold down the left mouse button.
2. Click the text tool you want to use from the flyout.
3. Select the text you want to format.
4. Click Text (Format in PRESENTS), Character.
5. Click the Underline, Overline, or Strikeout list box.
6. Click a line style option.
Note

 To remove underline, overline, or strikeout formatting, Click none from the option list

{button ,AL(`format_text_proc;;;;;',0,"Defaultoverview",`main')} Related Topics



To apply character attributes to selected text
1. Drag the insertion point over some characters. 
2. Click Text (Format in PRESENTS), Character. 
3. Choose the attributes you want. 
Note

Click Text, Paragraph to set up spacing, tabs, indents, and bullets for Paragraph Text.

{button ,AL(`wts29_pro2_cd;char_attrib_proc;;',0,"Defaultoverview",)} Related Topics



To clear all tabs
1. Click anywhere in the Paragraph Text.
2. Click Text, Paragraph.
3. Click the Tabs tab.
4. Click Delete All.

{button ,AL(`format_text_proc;;;;;',0,"Defaultoverview",)} Related Topics



To indent a paragraph using the mouse
1. Point to the text tool and hold down the left mouse button.
2. Click the Paragraph Text tool  from the flyout.

3. Click anywhere in the paragraph. 
4. Drag the indent markers along the Tabs ruler to set your new indents.

Notes
You can indent all lines, only the first line, or all but the first line in a paragraph.
You cannot indent Artistic Text.

{button ,AL(`format_text_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change text alignment
1. Point to the text tool and hold down the left mouse button.
2. Click the text tool you want to use from the flyout.
3. Select the text you want change alignment, or justification for.
4. Click Text (Format in PRESENTS), Character.
5. Click the Alignment tab.
6. Click an Alignment option.
Note

Alignment changes apply to all text in the selected Artistic Text or Paragraph Text objects.

{button ,AL(`format_text_proc;;;;;',0,"Defaultoverview",)} Related Topics



To copy text attributes
1. Select a text object or frame using the Pick tool.
2. Click Edit, Copy Properties From.
3. Enable the Text Attributes checkbox.
4. Click OK.
5. Click the text object or frame whose attributes you want to copy.
Tip

If you use a particular set of attributes often, you can make it easier to apply them to other text by saving 
them as a style.

{button ,AL(`char_attrib_proc;us01_pro2_cd;styles_proc;;;',0,"Defaultoverview",)} Related Topics



Using Bullets with Paragraph Text



Adjusting spacing



Changing spacing numerically



To adjust spacing with the Character Attributes dialog box
1. Click a text object or paragraph.
2. Click Text (Format in PRESENTS), Character.
3. Click Alignment.
4. Under Spacing, make changes to Character, Word, or Line Spacing as required. 

{button ,AL(`text_space_proc;;;;;',0,"Defaultoverview",)} Related Topics



To kern text with the Character Attributes dialog box
1. Select two or more characters with either text tool.
2. Click Text (Format in PRESENTS), Character.
3. In the Range kerning box, Enter a Percent of Space Width value.
Notes

You can also kern selected text using hotkeys.
Negative values shift the characters closer together, while positive values shift them farther apart.
You can also select the text using the Shape tool and apply the same changes indicated above.

{button ,AL(`text_space_proc;;;;;',0,"Defaultoverview",)} Related Topics



Changing Spacing On Screen



To adjust character spacing on screen
1. Select the text with the Shape tool    .
2. Click and drag the node at the left of the character.
Notes

To adjust character spacing for all the selected text, click and drag the Kerning arrow 
 to the right to increase or drag to the left to decrease spacing.

If you have two or more lines of Artistic Text, you can click and drag the Interline spacing arrow 
 up or down to adjust spacing as required.

{button ,AL(`text_space_proc;;;;;',0,"Defaultoverview",)} Related Topics



To kern text precisely with the Shape tool
1. Select the text with the Shape tool    .
2. Select two or more consecutive characters you want to shift.
3. Click Text (Fomat in PRESENTS), Character.
4. Click the Alignment tab.
5. In the Characters number box, type the percent of space width you want to shift the selected characters.
Notes

Adjusting spacing for two or more consecutive characters is called range kerning. Inter-character spacing, 
set in the Paragraph, Spacing dialog box, applies to the entire paragraph.

You can also adjust the kerning of selected text manually using hotkeys.

{button ,AL(`text_space_proc;;;;;',0,"Defaultoverview",)} Related Topics



To adjust word spacing on-screen
1. Select the text with the Shape tool    .
2. Hold down the CTRL key.
3. Click the kerning arrow  and drag.

{button ,AL(`text_space_proc;;;;;',0,"Defaultoverview",)} Related Topics



To adjust line spacing on-screen
1. Click the Shape tool .

2. Click the Interline spacing arrow  and drag.

{button ,AL(`text_space_proc;;;;;',0,"Defaultoverview",)} Related Topics



To adjust paragraph spacing on-screen
1. Click the Shape tool .
2. Click the paragraph or text object you want to edit.
3. Hold down the CTRL key.
4. Click the Interline spacing arrow  and drag.

{button ,AL(`text_space_proc;;;;;',0,"Defaultoverview",)} Related Topics



Using text styles



Dublin: Following topic taken from p_custom.rtf



Special text features



To fit text to a path
1. Draw a graphic object (ellipse, box, line, etc.) that has the shape you want to fit your Artistic Text to.
2. Select the graphic object.
3. Holding down the SHIFT key, select the Artistic Text you want to shape to the path. 
4. Click Text (Format in PRESENTS), Fit Text to Path.
5. Choose the text orientation in the first list box.
6. Choose the vertical placement in the second list box.
7. For objects with open paths, choose the horizontal placement in the third list box.

8. For objects with closed paths, the following graphic appears . Click the side you want to fit the object.
9. Click Apply
Tips

You can edit Artistic Text strings directly on paths.
Enable the Place on other side checkbox to move the text to the opposite side of the path.
Click Edit if you want to change the Horizontal Offset and Distance From the Path by typing in numbers.

{button ,AL(`fit_path_proc;;;;;',0,"Defaultoverview",)} Related Topics



To make changes to text shaped to a path
1. Select the text/path group you want to edit.
2. Click Text, Fit Text to Path.
3. Select the text orientation in the first box.
4. Select the vertical placement in the second box.
5. Select horizontal placement when fitting text to an open path.

6. For objects with closed paths, the following graphic appears . Click the side of the graphic you want to fit 
the text object to.

7. Click Apply.
9. Enable the Place on other side checkbox to move the text to the opposite side of the path.
8. Click Edit if you want to change the Horizontal Offset and Distance From the Path by typing in numberes
Tip

You can edit Artistic Text strings directly on paths.

{button ,AL(`fit_path_proc;;;;;',0,"Defaultoverview",)} Related Topics



To edit the shape of a text path with the mouse
1. Click the Shape tool .
2. Click the path (or object) you want to edit.
3. Move selected character nodes and control points. 

{button ,AL(`fit_path_proc;so07_pro2_cd;;;;',0,"Defaultoverview",)} Related Topics



To move Artistic Text along a path
1. Click the Shape tool .
2. Click the Artistic Text you want to move. The Shape tool's spacing arrows appear and character nodes (empty 

to indicate they are not selected) appear.
3. Marqee select the text you want to move.
4. Drag in the desired direction.

{button ,AL(`fit_path_proc;text_space_proc;wts12a_pro2_cd;;;',0,"Defaultoverview",)} Related Topics



To adjust the distance of text from a path
1. Click the Pick tool.
2. Hold the CTRL key down and click the text on the path.
3. Drag away from the path in the desired direction. A slide control appears.
4. Release the mouse button when the slide control is the distance you want the text to appear from the path.
Tip

If you prefer to change the Horizontal Offset and Distance From Path by typing in numbers, click Edit on the
Fit Text to Path Roll-Up.

{button ,AL(`fit_path_proc;;;;;',0,"Defaultoverview",)} Related Topics



To detach text from a path
1. Select the text/path group.
2. Click Arrange, Separate.

{button ,AL(`fit_path_proc;;;;;',0,"Defaultoverview",)} Related Topics



Proofreading Text



Checking Statistics



Checking spelling



To run a spelling check
1. Select the text frame with the Pick tool.
2. Click Text (Tools in PRESENTS), Proofreading.
3. Click Spelling from the flyout.
4. Click an option in the Check range list box to determine the scope of the spelling check.
5. For each unknown word, you can choose from the following options:

Edit the word in the Sentence box. The unrecognized word is highlighted. Click the word and make your 
changes as you would in the document window.
Click Change if the Change To box shows the word you want. 
Click Change All if you want to change all instances of the word as shown.
Click Ignore to leave the current word unchanged. 
Click Ignore All if you want to leave all such words unchanged.
Click Add Word when you want to include unrecognized words in the current personal dictionary.

Tip
By default, the Spell Checker refers to the Personal Dictionary USERPD during spelling checks.
Click the Options button to customize you spelling check.

{button ,AL(`spell_proc;proof_proc;formality_levels;;;',0,"Defaultoverview",)} Related Topics



To correct a misspelled word during a spelling check
Type the correct spelling in the Sentence display box and click Change.

Tip 
You can also select one of the alternative spellings from the Change To list box and click Change, or to 

correct all occurrences of the word, click Change All. 

{button ,AL(`spell_proc;proof_proc;;;;',0,"Defaultoverview",)} Related Topics



To create a personal dictionary
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Spelling from the flyout.
3. Click Options, Create New Dictionary when the Spell Checker selects an unknown word or name that you'd like 

to add to the spelling database.
4. Type a name in the Dictionary Name box.
Note

After you create a personal dictionary, you can have the Spell Checker refer to it along with the standard 
dictionary during a spelling check.

By default the International Proofreader adds all new words to a personal dictionary called USERPD.

{button ,AL(`spell_proc;proof_proc;;;;',0,"Defaultoverview",)} Related Topics



To add a word to a personal dictionary
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Spelling from the flyout.
3. When the Spell Checker displays a word you want to add to a personal dictionary click the Add Word button.

{button ,AL(`spell_proc;proof_proc;;;;',0,"Defaultoverview",)} Related Topics



To open a personal dictionary
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Spelling from the flyout.
3. Click Options  Personal Dictionary.

4. Choose the dictionary you want to use.

{button ,AL(`spell_proc;proof_proc;;;;',0,"Defaultoverview",)} Related Topics



Checking Grammar



To check grammar
1. Select the text frame with the Pick tool.
2. Click Text (Tools in PRESENTS), Proofreading.
3. Click Quick Proofreading or Full Proofreading from the flyout.
4. Click Options, Explain Error if you want an explanation of the grammatical errors.
5. Change the Check range from Current Text Object to Full Text if necessary.
6. For each unknown word, you can choose from the following options:

Edit the word in the Sentence box. The unrecognized word is highlighted. Click the word and make your 
changes as you would in the document window.

Click Change if the Change To box shows the word you want. 
Click Change All if you want to change all instances of the word or phrase as shown.
Click Ignore to leave the current word unchanged. 
Click Ignore All if you want to leave all such words unchanged.
Click Add Word when you want to include unrecognized words in the current personal dictionary.

Tip
Click the Options button to customize your grammar check.

{button ,AL(`proof_proc;quick_proof;fullproof_mode;;',0,"Defaultoverview",)} Related Topics



To set the Proofreader's formality level
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Spelling from the flyout.
3. Click Options        Rule Manager.

4. Choose an option in the Formality Level list box.

{button ,AL(`spell_proc;proof_proc;formality_levels;;;',0,"Defaultoverview",)} Related Topics



Setting Proofreading Options



To set advanced proofreading options
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Advanced Options from the flyout.
3. Choose a new language from the Language box list box.
4. Disable the Always provide alternative spelling checkbox if you do not want the International Proofreader to 

retrieve and display all possible spellings for words not listed in its spelling database.
5. Enable the Use personal dictionaries checkbox if you want the International Proofreader to use personal 

dictionaries for the check.
Note

Change the Maximum sentence elements only if you want to reduce memory demands made by the 
International Proofreader.

{button ,AL(`spell_proc;proof_proc;proof_reader_over;;;',0,"Defaultoverview",`main')} Related 
Topics



To set up the Rule Manager
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Spelling from the flyout.
3. Click Options        Rule Manager.

4. Choose an option in the User Profile or click New if you want to create and attach a new one to your file.
5. To make changes to the rules for another proofreading mode, choose the mode in the Check Mode list box
6. To set the checking level, choose an option in the Formality Level.
7. Select or deselect Rule Types by clicking the asterisks as required. Options you change in the Current 
column apply to the current session only. Options changed under Long-Term are changed for all future sessions.

Tip
You can restore the original Rule Types settings at any time by clicking Defaults in the Rule Manager.

{button ,AL(`spell_proc;proof_proc;proof_over;formality_levels;;',0,"Defaultoverview",`main')} 
Related Topics



To restore Rule Manager defaults
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Advanced Options from the flyout.
3. Click Rule Manager.
4. Click Defaults to restore the original rule settings.

{button ,AL(`spell_proc;proof_proc;proof_reader_over;formality_levels;default_proc;',0,"Defaultover
view",`main')} Related Topics



To choose language options
1. Click Text (Format in PRESENTS), Proofreading.
2. Click Advanced Options from the flyout.
3. Choose a language you want the International Proofreader to display rules in.
4. Choose a language you want the International Proofreader to display errors in.
Note

Portuguese and Spanish rules and error descriptions are not available. 

{button ,AL(`proof_proc;spell_proc;languages;;;',0,"Defaultoverview",)} Related Topics



To choose another proofreading language
1. Click Text (Format in PRESENTS), Proofreading
2. Click Advanced Options from the flyout.
2. Click Languages.
3. Choose a new proofreading language.
Note

U.S. English is the default language dictionary installed when you choose Full Install during your program 
setup. If you want to add another language, run Setup, click Custom installation, and choose the language database
you want under Utilities.

{button ,AL(`languages;proof_over;proof_proc;;;',0,"Defaultoverview",)} Related Topics



To choose spelling correction options
1. Click Text (Format in PRESENTS), Proofreading.
2. Click Advanced Options from the flyout.
3. Click the language for which you want to choose spelling correction options.
4. Under Spelling correction, enable the Always Provide Alternative Spellings check box if you want the 

International Proofreader to display suggested replacements for words that are misspelled.
5. Under Spelling Correction, enable the Use Personal Dictionaries check box if you want to use a personal 

dictionary.

{button ,AL(`proof_proc;spell_proc;languages;;;',0,"Defaultoverview",)} Related Topics



To install another proofreading language database
1. Close all programs.
2. Click Start, Run.
3. Type Setup and click OK.
4. Choose Custom installation and select the language databases you want to install under Utilities.
5. Reopen your Corel program.
6. Click Text (Tools in PRESENTS), Proofreading, Advanced Options.
7. Click Languages.
8. Choose a new proofreading language.
Notes

U.S. English is the default language dictionary installed when you choose Full Install during your program 
setup.

Portuguese and Spanish rules and error descriptions are not available. 

{button ,AL(`languages;proof_over;proof_proc;;;',0,"Defaultoverview",)} Related Topics



To choose a proofreading error language
1. Click Text, Proofreading.
2. Click Advanced Options from the flyout.
3. Under Error Language, click the name of the language in which you want error messages displayed.
Note

Portuguese and Spanish rules and error descriptions are not available. 

{button ,AL(`proof_proc;spell_proc;languages;;;',0,"Defaultoverview",)} Related Topics



To choose a proofreading rule language
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Advanced Options from the flyout.
3. Under Rule Language, click the name of the language in which you want descriptions of rule types displayed.
Note

Portuguese and Spanish rules and error descriptions are not available. 

{button ,AL(`proof_proc;spell_proc;languages;;;',0,"Defaultoverview",)} Related Topics



To turn rule types off or on
1. Click Text (Tools in PRESENTS), Proofreading.
2. Click Advanced Options from the flyout.
3. Click Rule Manager. 
4. Under Check mode, click Full Proofreading.
5. In the Rule Types box, click the name of the rule types that you want to turn off or on.
6. If the rule types are not visible in the Rule Types box, make sure you chose Full Proofreading under Check 

mode to list all rule types, and if necessary, use the vertical scroll bar to make the desired rule type visible.
7. Under Current Status (for the current writing session), click the check mark to enable or disable the rule type 

for the current session.
8. Under Long-Term (for future writing sessions), click the check mark to enable or disable the rule type for future

sessions.
Note

The Rule Manager accordingly modifies the long-term status of the rule and reloads it for the next 
International Proofreader session. 

{button ,AL(`proof_proc;spell_proc;languages;;;',0,"Defaultoverview",)} Related Topics



Using Type Assist



To change straight quotes to typographic quotes automatically
1. Click Text (Tools in PRESENTS), Type Assist.
2. Enable Change straight quotes to typographic quotes checkbox.

{button ,AL(`type_asst_proc;;;;;',0,"Defaultoverview",)} Related Topics



To correct consecutive capitals
1. Click Text (Tools in PRESENTS), Type Assist.
2. Enable the Correct two initial, consecutive capitals checkbox.
Tip

No change is made if the capitals are followed by a space or period, or the word contains other capital 
letters.

{button ,AL(`type_asst_proc;;;;;',0,"Defaultoverview",)} Related Topics



To capitalize the first letter of sentences
1. Click Text (Tools in PRESENTS), Type Assist.
2. Enable the Capitalize first letter of sentences checkbox.
Notes

A sentence end is defined by a period (.), an exclamation mark (!), or a question mark (?). In Spanish, the 
marks ¿ and ¡ are also supported.

You can also use the Change Case command to change selected text to Sentence case.

{button ,AL(`type_asst_proc;;;;;',0,"Defaultoverview",)} Related Topics



To capitalize the names of days
1. Click Text (Tools in PRESENTS), Type Assist.
2. Enable the Capitalize names of days checkbox.
Tip

You can also use the Change Case command to change the case of selected text.

{button ,AL(`type_asst_proc;;;;;',0,"Defaultoverview",)} Related Topics



To replace abbreviations while typing
1. Click Text (Tools in PRESENTS), Type Assist.
2. Enable the Replace text while typing checkbox.
3. In the Replace box, type the code you'll use for your replacement string, for example, "H!".
4. In the With box, type the replacement string of text.

In this case "H!" might become "Human Resources". 

{button ,AL(`type_assist_proc;;;;;',0,"Defaultoverview",`main')} Related Topics



Using the Thesaurus



To use the Thesaurus
1. With the text tool active, click the word you want to look up synonyms for.
2. Click Text (Tools in PRESENTS), Thesaurus. 
3. Click the synonym you want to replace the selected word.
4.  Click Replace.
Note

You can also click other definitions to see their synonyms.

{button ,AL(`spell_proc;proof_proc;;;;',0,"Defaultoverview",)} Related Topics



Setting Text Options and Defaults



Dublin: Following topics (to the next note to you) are taken from p_custom.rtf



To display the text toolbar
1. Click View, Toolbars.
2. Click Text.

{button ,AL(`format_text_proc;default_proc;;;;',0,"Defaultoverview",)} Related Topics



Dublin: Following topic taken from p_defaul.rtf



To change the default tab stops in a paragraph
1. Select the Paragraph Text you want to set default tab stop for.
2. Click anywhere in the paragraph or select the frame with the Pick tool. 

To change tab stops for consecutive paragraphs, drag to highlight the paragraphs or select the frame with the 
Pick tool.

3. Click Text, Paragraph.
4. Click Tabs.
5. In the box next to Apply Tabs Every, type the distance you want between tab stops.

To use a different unit of measurement, choose one from the units box. The Tab Stop value is converted to its 
equivalent in the unit you choose.

6. Click Apply Tabs Every to implement your changes.

{button ,AL(`format_text_proc;default_proc;;;;',0,"Defaultoverview",)} Related Topics



Working with Fonts



To change the bullet style
1. Select a bulleted paragraph with the Pick tool or the Paragraph Text tool.
2. Click Text, Bullet Style.
3. Do one or more of the following:

choose a Symbol category from the list.
click a bullet in the display box.
type a new point size.

4. Enable the Enable Bullet check box.
5. Click OK.

{button ,AL(`bullet_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the bullet style in the master layout
1. Click Master Layout, Slide Master.
2. Select the buttlon on the level that you want to change.
3. Click Format, Bullet Style.
4. Do one or more of the following:

choose a Symbol category from the list
click a bullet in the display box
type a new point size

5. Enable the Enable Bullet check box.
6. Click OK.

{button ,AL(`bullet_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the bullet color
1. Select a bullet with the Pick tool.
2. Select the required color from the Color Palette.

{button ,AL(`bullet_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the bullet color in the master layout
1. Click Master Layout, Slide Master.
2. Select the bullet on the    level that you want to change.
3. Select the color you want from the Color Palette.

{button ,AL(`bullet_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the default tab width
1. Click Tools, Options, Text.
2. Type the tab width to apply to all text tabs, in the Tab Width scroll box.
3. Choose the units of measurement to apply to the tab widths, in the Tab Width list box.
4. Click OK.

{button ,AL(`bullet_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the inter bullet spacing
1. Click Tools, Options, Text.
2. Type the spacing to apply to all bullets, in the Inter Bullet Spacing scroll box.
3. Choose the units of measurement to apply to the bullets in the Inter Bullet Spacing list box.
4. Click OK.

{button ,AL(`bullet_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a rectangle
1. Click the Rectangle tool.
2. Position the crossbar where you want one corner of the rectangle to appear.
3. Click and drag.
Tip

Press SHIFT while dragging to draw the rectangle from the corner opposite to the mouse pointer.
Press CTRL while dragging to constrain the shape to a square.
Press CTRL and SHIFT while dragging to draw the rectangle from the center.

{button ,AL(`draw_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a square
1. Click the Rectangle tool.
2. Position the crossbar where you want one corner of the square to appear.
3. Hold down CTRL, click and drag.
Tip

Press SHIFT while dragging to draw the square from the corner opposite to the mouse pointer.
Press CTRL and SHIFT while dragging to draw the square from the center.

{button ,AL(`draw_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw an ellipse
1. Click the Ellipse tool.
2. Position the crossbar where you want one corner of the ellipse's highlighting box to appear.
3. Click and drag.
Tip

Press SHIFT while dragging to draw the ellipse from the side opposite to the mouse pointer.
Press CTRL while dragging to constrain the shape to a circle.
Press CTRL and SHIFT while dragging to draw the ellipse from the center.

{button ,AL(`draw_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a circle
1. Click the Ellipse tool.
2. Position the crossbar where you want the center of    the ellipse to appear.
3. Hold down CTRL, click and drag.
Tip

Press SHIFT while dragging to draw the circle from the center.

{button ,AL(`draw_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a star
1. Click the Star from the toolbar.
2. Mark the size you want the shape to appear on the slide.
3. Click the Node Edit tool.
4. Click and drag the shape to create the star image you want.

{button ,AL(`draw_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a geometric shape
1. Click the Geometric Shape tool from the toolbar.
2. Mark the size you want the shape to appear on the slide.



To draw curves with the Freehand tool
1. Open the Curve flyout.
2. Click the Freehand tool.
3. Click and drag along the desired path.
Note

To erase part of the path you have drawn, hold down SHIFT while continuing to drag backwards. When you
release SHIFT, you will resume drawing your line.

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a curve connected to another with the Freehand tool
1. Open the Curve flyout.
2. Click the Freehand tool.
3. Click and drag from the endpoint of another curve.
Note

To connect the line segments, you must click within five pixels of the endpoint. You can adjust this five-
pixel threshold by changing the pixel value in the AutoJoin box on the Curve, Bezier tool properties sheet.

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw curves with the Bezier tool.
1. Open the Curve flyout.
2. Choose the Bezier tool.
3. Click where you want the curve segment to start and drag.

As you drag, two control points move in opposite directions from the node. The distance between the control 
points and the node determines the height or depth of the curve. The angle of the control points determines 
the slope of the curve.

4. Click where you want the curve segment to end and drag.
As you drag, two more control points appear. These allow you to change the curve further.

5. Click where you want the next curve segment to end and drag.
As you drag, two more control points appear.

6. Repeat step 5 to draw more connected curves.
7. Press SPACEBAR twice or choose another tool to stop drawing connected curves.
Note

Curves created with the bezier tool have symmetrical nodes.
Tip

Hold down CTRL as you position the control points to move in 15 degree increments. You can specify a 
different angle on the General page in the Options dialog box.

To draw a curve with no change of direction (i.e., a curve with one bump) drag in the direction the curve is 
moving through the end node. Dragging in the opposite direction creates a curve with a smooth change in direction 
(i.e., a curve with two bumps).

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw unconnected curves with the Bezier tool
1. Open the Curve flyout.
2. Choose the Bezier tool.
3. Click where you want the curve segment to start and drag.

As you drag, two control points move in opposite directions from the node. The distance between the control 
points and the node determines the height or depth of the curve. The angle of the control points determines 
the slope of the curve.

4. Click where you want the curve segment to end and drag.
As you drag, two more control points appear. These allow you to change the curve further.

5. Press SPACEBAR twice.
6. Repeat steps 3 through 5 to create the next curve.
Note

Curves created with the bezier tool have symmetrical nodes.
Tip

Hold down CTRL as you position the control points to move in 15 degree increments. You can specify a 
different angle on the General page in the Options dialog box.

To draw a curve with no change of direction (i.e., a curve with one bump) drag in the direction the curve is 
moving through the end node. Dragging in the opposite direction creates a curve with a smooth change in direction 
(i.e., a curve with two bumps).

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a straight line with the Freehand tool
1. Open the Curve flyout.
2. Click the Freehand tool.
3. Click where you want the line to begin.
4. Click where you want the line to end.
Note

To draw another line connected to the first, click the endpoint of the last line and continue drawing. You 
can streamline this action by double-clicking to finish each line segment and start the next. Remember to click, not 
double-click, when you finish the final segment.

To connect the line segments, you must click within five pixels of the endpoint. You can adjust this five-
pixel threshold by changing the pixel value in the AutoJoin box on the Curve, Bezier tool properties sheet.

Tip
Hold down CTRL as you draw the line to constrain it to 15 degree increments. You can specify a different 

angle on the General page in the Options dialog box.

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw connected straight lines with the Bezier tool
1. Open the Curve flyout.
2. Choose the Bezier tool.
3. Click where you want the line to start.
4. Click where you want the line to end.
5. Click where you want the next line to end.
6. Repeat step 5 to draw more lines.
7. Press SPACEBAR twice or choose another tool to stop drawing connected lines.

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw unconnected lines with the Bezier tool
1. Open the Curve flyout.
2. Choose the Bezier tool.
3. Click where you want the line to start.
4. Click where you want the line to end.
5. Press SPACEBAR twice
6. Repeat steps 3 through 5 to draw another line.

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



To draw a closed shape with the Bezier tool
1. Draw the shape segment by segment.
2. When placing the final node, click the start node of the first segment.

{button ,AL(`draw_lines_proc;;;;;',0,"Defaultoverview",)} Related Topics



 The Curve flyout can be opened by clicking on any of the tool buttons it contains. One of these is visible in the 
Toolbox.



 The Freehand tool allows you to create a curve by dragging the mouse along the path of the curve.



 The Bezier tool allows you to create a curve by placing and manipulating bezier nodes.



 The Polygon tool allows you to create complex shapes by clicking and dragging.



 The Shape flyout can be opened by clicking on any of the tool buttons it contains. One of these is visible in the 
Toolbox.







Filling objects
Any object with a closed path can be filled in with a solid color or one of several Special Fill types. If you leave an
object without a fill or remove an object's existing fill, objects behind it will show through as if it were 
transparent.

Fountain Fills
A fountain fill is a progression of colors following a circular, square, straight, or radial path. You can have a direct 
blend from one color to another, or a cascade of different colors. You can use pre-generated fountain fills to 
create neon tubes, metal cylinders, and a variety of similar effects.

Texture fills
A texture fill is a fractally-generated picture that you can use to give your object the appearance of natural 
materials. You can choose from a series of pre-generated textures, or randomly generate variations.

Pattern Fills
Pattern fills are pre-generated, symmetrical images that easily lend themselves to tiling. You can fill an object 
completely with one image, but you would more often use a series of repeated images to form a tiled fill. You can
import bitmaps or vector graphics to use as pattern fills, and you can create simple two-color bitmap patterns.

Uniform Fills
You can quickly fill an object with a solid color using the on-screen palette. If you want more control over the 
color, you should use the Color dialog box.

{button ,AL(`fill_over;clr_palettes_for_clr;clr_cr_overview;clr_cr_overview;;',0,"Defaultoverview",)} 
Related Topics





To make an object transparent using the Fill tool
1. Select the object with the fill you want to remove.
2. Click Fill tool.
3. Click No Fill.

{button ,AL(`filltool_proc;;;;;',0,"Defaultoverview",)} Related Topics



To make an object transparent using the on-screen color palette
1. If the palette is not displayed:

Click View, Color Palette.
Choose one of the palettes from the sub-menu (see Related Topics).

2. Select the object with the fill you want to remove.
3. Click No Color.

{button ,AL(`palette_proc;clr_palettes_for_clr;;;;',0,"Defaultoverview",)} Related Topics



To fill an object with a uniform color using the Fill tool
1. Select the object.
2. Click Fill tool.
3. Click Black Fill or White Fill.

{button ,AL(`filltool_proc;;;;;',0,"Defaultoverview",)} Related Topics



To fill an object with a uniform color using the on-screen color palette
1. If the palette is not displayed:

Click View, Color Palette.
Choose one of the palettes from the sub-menu (see Related Topics).

2. Select the object.
3. Click the palette's scroll arrows until the color you want is visible.
4. Click the color you want with the left mouse button.

{button ,AL(`palette_proc;clr_palettes_for_clr;;;;',0,"Defaultoverview",)} Related Topics



To fill an object with a uniform color using the Fill Color dialog box
1. Select the object.
2. Click Fill tool, Fill Color.
3. Choose the color you want (see Related Topics).

{button ,AL(`clr_cd_overview;filltool_proc;;;;',0,"Defaultoverview",)} Related Topics



To change the default fill for graphic objects
1. Click a white space in the window to ensure that no object is selected.
2. Click Fill tool.
3. Click the tool that corresponds to the type of fill you want for the default. Click No Fill to give all new graphic 

objects a transparent fill.
4. Enable the Graphic option.
5. Set the appropriate fill attributes.

The set attributes are now applied to any new non-text objects you create. You may of course change the fill of
any individual object.

{button ,AL(`filltool_proc;default_proc;;;;',0,"Defaultoverview",)} Related Topics



To change the default background fill for paragraph text
1. Click a white space in the window to ensure that no object is selected.
2. Click Fill tool.
3. Click the tool that corresponds to the type of fill you want for the default. Click No Fill to give all new Paragraph

text objects a transparent background.
4. Enable the Paragraph Text option.
5. Set the appropriate fill attributes.

The set attributes are now applied to any new paragraph text objects you create. You may of course change 
the fill of any individual object.

{button ,AL(`filltool_proc;default_proc;;;;',0,"Defaultoverview",)} Related Topics



To change the default background fill for artistic text objects
1. Click a white space in the window to ensure that no object is selected.
2. Click Fill tool.
3. Click the tool that corresponds to the type of fill you want for the default. Click No Fill to give all new Artistic 

text objects a transparent background.
4. Enable the Artistic Text option.
5. Set the appropriate fill attributes.

The set attributes are now applied to any new artistic text objects you create. You may of course change the 
fill of any individual object.

{button ,AL(`filltool_proc;default_proc;;;;',0,"Defaultoverview",)} Related Topics





Fountain fills
A fountain fill is a progression of colors following a circular, square, straight, or radial path. You can have a direct 
blend from one color to another, a rainbow of several colors, or a set of color peaks and highlights. You can use 
pre-generated fountain fills to create neon tubes, metal cylinders, and a variety of similar effects.
You can change the number of color steps in a fill to give it a smoother or rougher appearance. However, since a 
large number of steps is slow to draw, you might want to limit how the fill appears on screen and how it prints.

The Preview Fountain Steps option in the Display pane of the Options dialog box sets the number of steps 
that are drawn on screen.

The Fountain Steps option in the Options pane of the Print Options dialog box sets the number of steps that
are printed.

The Steps option in the Fountain Fill dialog box overrides these two settings when unlocked (see Related 
Topics).

{button ,AL(`fill_over;g_h_pt_fountain;cc09_pro2_cd;;;',0,"Defaultoverview",)} Related Topics



To create a fountain fill using the dialog box
1. Select the object you want to fill.
2. Click Fill tool, Fountain Fill.
3. In the Type list, click the type of fountain you want:

Linear Fountain creates a fill that changes color in one direction.
Radial Fountain creates a fill that changes color in concentric circles from the center of the object outwards.
Conical Fountain creates a fill that radiates from the center of the object.
Square Fountain creates a fill that changes color in concentric squares from the center of the object outwards.

4. Click the From color button and choose a color for the start of the fountain. 
5. Click the To color button and choose a color for the end of the fountain. 
Tip

You can change the number of color steps in a fountain fill with the Steps option. Enable Unlock and enter 
a new value. When the Steps option is locked, the fill will print with the number of steps specified in the Print 
Options dialog box and display with the number of steps specified in the Options dialog box (see Related Topics)

{button ,AL(`fountain_proc;g_h_pt_fountain;cc09_pro2_cd;;;',0,"Defaultoverview",)} Related Topics



To change the orientation of a fountain fill using the dialog box
1. Select the object you want to fill.
2. Click Fill tool, Fountain Fill.
3. Adjust the Horizontal Offset setting until the center of the fill is where you want it. A value of -50% will place 

the center on the left edge of your object; a value of 50% will place it on the right edge.
4. Adjust the Vertical Offset setting until the center of the fill is where you want it. A value of -50% will place the 

center on the bottom edge of your object; a value of 50% will place it on the top edge.
5. Adjust the Angle setting until the fill is oriented the way you want it. Positive values will rotate the fill counter-

clockwise, negative values will rotate it clockwise.
Note

The Horizontal and Vertical Offset options are not available for linear fountain fills.
The Angle option is not available for radial fountain fills.

{button ,AL(`fountain_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create a fountain fill containing only two colors
1. Select the object you want to fill.
2. Click Fill tool, Fountain Fill.
3. Click Two Color.
4. Click Direct Color Path.
5. Click the From color button and choose a color for the start of the fountain. 
6. Click the To color button and choose a color for the end of the fountain. 
7. Adjust the Mid-Point slider until the color proportions are correct.
Tip

You can increase the percentage of start and end color by adjusting the Edge Pad value.

{button ,AL(`fountain_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create a fountain fill containing multiple colors
1. Select the object you want to fill.
2. Click Fill tool, Fountain Fill.
3. Click Two Color.
4. Click the From color button and choose a color for the start of the fountain. 
5. Click the To color button and choose a color for the end of the fountain. 
6. Click Clockwise Color Path to determine the intermediate colors from a clockwise path around the color wheel.

or
Click Counter-Clockwise Color Path to determine the intermediate colors from a counter-clockwise path around 
the color wheel.

7. Adjust the Mid-Point slider until the color proportions are correct.
Note

You can increase the percentage of start and end color by adjusting the Edge Pad value.

{button ,AL(`fountain_proc;;;;;',0,"Defaultoverview",)} Related Topics



To specify the intermediate colors of a fountain fill
1. Select the object you want to fill.
2. Click Fill tool, Fountain Fill.
3. Click Custom.
4. Double-click in the preview ribbon to add a color marker.

You can move existing markers by dragging them along the preview ribbon, and delete them by double-
clicking.

5. Click a color in the palette to assign it to the marker.
You can change the color of an existing marker by selecting it and clicking a new color in the palette.

6. Repeat steps 4 and 5 until you achieve the desired effect.

{button ,AL(`fountain_proc;;;;;',0,"Defaultoverview",)} Related Topics





Pattern fills
Pattern fills are pre-generated, symmetrical images that easily lend themselves to tiling. You can fill an object 
completely with one image, but you would more often use a series of repeated images to form a tiled fill. You can
import bitmaps or vector graphics to use as pattern fills, and you can create simple two-color bitmap patterns.
For information on a specific type of pattern fill, click the appropriate button:

{button ,JI(`',`two_color_bitmap_patterns')} Two-color bitmap patterns
{button ,JI(`',`full_color_bitmap_patterns')} Full-color bitmap patterns
{button ,JI(`',`vector_patterns')} Vector patterns





Two-color bitmap patterns
A two-color bitmap is a very simple picture composed of only "on" and "off" pixels. There are no colors in the 
bitmap except for the two you define. The pre-generated patterns are designed so that they will interlock to fill 
an object with seamless tiles.
You can import an external bitmap to use as a two-color pattern, providing it is composed of just two colors. If 
you want to import a multi-colored pattern, use the Full-Color Bitmap Pattern dialog box (see Related Topics).
Transformations applied to objects with two-color bitmap pattern fills do not affect the pattern. For example, if 
you rotate the object, the orientation of the pattern remains constant. However, you can have the designs 
maintain their aspect when you scale or stretch the object.

{button ,AL(`fill_over;;;;;',0,"Defaultoverview",)} Related Topics





Two-Color Bitmap Pattern Editor
This dialog box lets you create your own two-color bitmap patterns. A two-color bitmap is a very simple picture 
composed of only "on" and "off" pixels. There are no colors in the bitmap except for the two you define in the 
Two-Color Bitmap Pattern dialog box.
Remember that two-color bitmap patterns are meant to be tiled. If the pattern you create is not symmetrical, it 
might not look very good as a tiled fill.

{button ,AL(`fill_over;;;;;',0,"Defaultoverview",)} Related Topics



To fill an object with a two-color bitmap pattern using the dialog box
1. Select the object you want to fill.
2. Click Fill tool, Two-Color Bitmap pattern.
3. Click the preview box.
4. Click the pattern you want.
5. Click the Back color button and choose a color for the background.
6. Click the Front color button and choose a color for the foreground.

{button ,AL(`2color_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create a new two-color bitmap pattern fill
1. Select the object you want to fill.
2. Click Fill tool, Two-Color Bitmap Pattern.
3. Click Create.
4. Click the Bitmap Pattern size you want. The size you choose determines the resolution of the pattern.
5. Click the Pen Size you want. The size you choose determines how many squares in the drawing area are filled 

when you click with the mouse.
6. Click with the left mouse button to fill squares in the drawing area.

Click with the right mouse button to erase squares in the drawing area.
Note

Once you have completed your pattern, you can change its colors and tile properties just as you would any
other two-color bitmap pattern. The pattern you create is added to the end of the pattern list.

{button ,AL(`2color_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the size of two-color bitmap pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Two-Color Bitmap Pattern.
3. Enable one of the Small (0.25x0.25 inches), Medium (0.50x0.50 inches) or Large (1.00x1.00 inches) options

or
Click Tiling.

4. Type a value in the Width box. The maximum tile width is 3 inches.
5. Type a value in the Height box. The maximum tile height is 3 inches.
Note

To use a different unit of measurement, choose it from the Units list. The height and width values are 
automatically converted when you change units.

{button ,AL(`2color_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset the first tile of a two-color bitmap pattern using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Two-Color Bitmap Pattern.
3. Click Tiling.
4. Type the amount of horizontal offset in the X box under First Tile Offset.
5. Type the amount of vertical offset in the Y box under First Tile Offset.

{button ,AL(`2color_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset rows of two-color bitmap pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Two-Color Bitmap Pattern.
3. Click Tiling.
4. Click Row.
5. Type the amount of offset in the % of Tile Side box.

{button ,AL(`2color_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset columns of two-color bitmap pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Two-Color Bitmap Pattern.
3. Click Tiling.
4. Click Column.
5. Type the amount of offset in the % of Tile Side box.

{button ,AL(`2color_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To create a two-color bitmap pattern fill from an imported image
1. Select the object you want to fill.
2. Click Fill tool, Two-Color Bitmap Pattern.
3. Click Import.
4. Choose the file to import (see Related Topics). For best results, import graphics with only two colors.
Note

Imported patterns appear at the end of the pattern list.

{button ,AL(`2color_proc;;;;;',0,"Defaultoverview",)} Related Topics



To delete a two-color bitmap pattern
1. Select the object you want to fill.
2. Click Fill tool, Two-Color Bitmap Pattern.
3. Click the Preview box.
4. Click the pattern you want to delete.
5. Click Delete.

{button ,AL(`2color_proc;;;;;',0,"Defaultoverview",)} Related Topics





Full-color bitmap patterns
A full-color bitmap is a regular color picture such as you might get with an electronic photograph. They can vary 
widely in complexity, and it is best to use simpler bitmaps for fill patterns, as complex ones will be very memory-
intensive and slow to draw. The pre-generated patterns are designed so that they will interlock to fill an object 
with seamless tiles.
You can import external bitmaps to use as full-color bitmap patterns. If you want to import a simple two-color or 
black and white bitmap, you might want to use the Two-Color Bitmap Pattern dialog box (see Related Topics).
Transformations applied to objects with full-color bitmap pattern fills do not affect the pattern. For example, if 
you rotate the object, the orientation of the pattern remains constant. However, you can have the designs 
maintain their aspect when you scale or stretch the object.

{button ,AL(`fill_over;;;;;',0,"Defaultoverview",)} Related Topics



To fill an object with a full-color bitmap pattern using the dialog box
1. Select the object you want to fill.
2. Click Fill tool, Full-Color Bitmap Pattern.
3. Click the preview box.
4. Click the pattern you want.

{button ,AL(`fullcolor_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the size of full-color bitmap pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Full-Color Bitmap Pattern.
3. Enable one of the Small (0.25x0.25 inches), Medium (0.50x0.50 inches) or Large (1.00x1.00 inches) options

or
Click Tiling.

4. Type a value in the Width box. The maximum tile width is 3 inches.
5. Type a value in the Height box. The maximum tile height is 3 inches.
Note

To use a different unit of measurement, choose it from the Units list. The height and width values are 
automatically converted when you change units.

{button ,AL(`fullcolor_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset the first tile of a full-color bitmap pattern using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Full-Color Bitmap Pattern.
3. Click Tiling
4. Type the amount of horizontal offset in the X box under First Tile Offset.
5. Type the amount of vertical offset in the Y box under First Tile Offset.

{button ,AL(`fullcolor_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset rows of full-color bitmap pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Full-Color Bitmap Pattern.
3. Click Tiling.
4. Click Row.
5. Type the amount of offset in the % of Tile Side box.

{button ,AL(`fullcolor_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset columns of full-color bitmap pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Full-Color Bitmap Pattern.
3. Click Tiling.
4. Click Column.
5. Type the amount of offset in the % of Tile Side box.

{button ,AL(`fullcolor_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To create full-color bitmap pattern fills from imported images
1. Select the object you want to fill.
2. Click Fill tool, Full-Color Bitmap Pattern.
3. Click Import.
4. Choose the file to import (see Related Topics).
Note

Imported patterns appear at the end of the pattern list.

{button ,AL(`fullcolor_proc;;;;;',0,"Defaultoverview",)} Related Topics



To delete a full-color bitmap pattern
1. Select the object you want to fill.
2. Click Fill tool, Full-Color Bitmap Pattern.
3. Click the Preview box.
4. Click the pattern you want to delete.
5. Click Delete.

{button ,AL(`fullcolor_proc;;;;;',0,"Defaultoverview",)} Related Topics





Vector patterns
A vector pattern is a picture composed of lines and fills, instead of just dots of color like a bitmap. These pictures
are smoother and more complex than bitmap images, and are generally easier to manipulate. 
You can import any CorelDRAW file to use as a vector pattern.
Transformations applied to objects with vector pattern fills do not affect the pattern. For example, if you rotate 
the object, the orientation of the pattern remains constant. However, you can have the designs maintain their 
aspect when you scale or stretch the object.

{button ,AL(`fill_over;;;;;',0,"Defaultoverview",)} Related Topics



To fill an object with a vector pattern using the dialog box
1. Select the object you want to fill.
2. Click Fill tool, Vector Pattern.
3. Click the preview box.
4. Click the pattern you want.

{button ,AL(`vector_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the size of vector pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Vector Pattern.
3. Enable one of the Small (0.25x0.25 inches), Medium (0.50x0.50 inches) or Large (1.00x1.00 inches) options

or
3. Click Tiling.
4. Type a value in the Width box. The maximum tile width is 3 inches.
5. Type a value in the Height box. The maximum tile height is 3 inches.
Note

To use a different unit of measurement, choose it from the Units list. The height and width values are 
automatically converted when you change units.

{button ,AL(`vector_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset the first tile of a vector pattern using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Vector Pattern.
3. Click Tiling
4. Type the amount of horizontal offset in the X box under First Tile Offset.
5. Type the amount of vertical offset in the Y box under First Tile Offset.

{button ,AL(`vector_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset rows of vector pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Vector Pattern.
3. Click Tiling
4. Click Row.
5. Type the amount of offset in the % of Tile Side box.

{button ,AL(`vector_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To offset columns of vector pattern tiles using the dialog box
1. Select the object you want to change.
2. Click Fill tool, Vector Pattern.
3. Click Tiling
4. Click Column.
5. Type the amount of offset in the % of Tile Side box.

{button ,AL(`vector_proc;tiles_proc;;;;',0,"Defaultoverview",)} Related Topics



To create vector pattern fills from imported images
1. Select the object you want to fill.
2. Click Fill tool, Vector Pattern.
3. Click Import.
4. Choose the file to import (see Related Topics).
Note

Imported patterns appear at the end of the pattern list.

{button ,AL(`vector_proc;;;;;',0,"Defaultoverview",)} Related Topics



To delete a vector pattern
1. Select the object you want to fill.
2. Click Fill tool, Vector Pattern.
3. Click the Preview box.
4. Click the pattern you want to delete.
5. Click Delete.

{button ,AL(`vector_proc;;;;;',0,"Defaultoverview",)} Related Topics





Texture fills
A texture fill is a fractally-generated picture that you can use to give your objects a natural appearance. There 
are more than three hundred pre-generated textures, and each texture has a set of parameters that you can 
change to create millions of variations.
Texture fills add significantly to the size of your file and the time it takes to print. As such, you should avoid filling
numerous or large objects with them.
When you rotate an object with a texture fill, the fill does not rotate. Re-sizing an object with a texture fill can 
distort the texture. To restore its appearance, apply the texture to the object a second time.
Note

You can use colors from any color model or palette for texture fills. However, if you apply a Spot color to a 
texture fill, it is converted to a Process color (CMYK) when you create color separations. Since the conversion may 
not reproduce exactly the same color, and since you would necessarily have four color plates in a CMYK separation, 
it's best to apply Process colors to texture fills.
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To fill an object with a texture using the dialog box
1. Select the object you want to fill.
2. Click Fill tool, Texture.
3. In the Textures Library list box, click the library containing the texture you want.
4. In the Textures List box, click the texture you want.
5. Adjust the parameters to customize the texture as required. Click the Preview button to see the results of your 

modifications.
Tip

Click the Preview button to randomly change the unlocked parameters. You can unlock a parameter by 
enabling the Unlock button next to it.
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To save a customized texture
1. Make sure the texture you want to save is displayed in the Preview box.
2. Click Add.
3. Type a name in the Texture Name box. The name can be up to 32 characters long, including spaces. You can 

overwrite an existing texture by typing its name.
4. Click the library in which you want to save the texture.

or
Type the name of a new library in the Library Name box.

Note
You cannot save or overwrite textures in the Styles library. You can, however, modify a Styles texture and 

then save it in another library. 



To delete a texture
1. In the Textures Library list box, click the library containing the texture you want.
2. In the Texture List box, click the texture you want to delete.
3. Click Delete.
Note

You cannot save or overwrite textures in the Styles library. You can, however, modify a Styles texture and 
then save it in another library.
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Outlining objects
Every object has a set of outline attributes that you can manipulate in a variety of ways. You can think of each 
object as being drawn with a pen that changes size, shape, and color. You can use round or square nibs, slanted 
or symmetrical, thick or hairline-thin to draw dashed, dotted, solid , or calligraphic lines.
In addition to the shape and color of the nib, you can also change the ending shape of an outline. Lines, or 
objects with open paths, can have ends that are rounded, square, cropped, or tipped with arrowheads and other 
line-ending shapes. Objects with closed paths (squares, polygons, etc.) naturally have no end-points, but you can
still choose from pointed, rounded, or truncated corners.
You can change the outline of an object using the Outline tool or the Outline Pen dialog box. 

The Outline tool gives you quick access to the most commonly-used outline styles, and buttons to access 
more detailed controls.

The Outline Pen dialog box lets you change any aspect of your outline or line-ending shape.
If you just want to change the color of an outline, you can also use the on-screen palette (see Related Topics).
The outline attributes of the current object are always displayed on the far right end of the Status Line.
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To set an object's corner shape
1. Select the object.
2. Click Outline tool, Outline Pen.
3. Click a corner style.
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To set an object's line cap shape
1. Select the object.
2. Click Outline tool, Outline Pen.
3. Click Square Line Caps to cut the line off exactly at the end points.

Click Rounded Line Caps to round off the ends of the line.
Click Extended Square Line Caps to square off the line and extend it beyond the endpoints for a distance equal
to half the line thickness.
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To set outline width using the Outline tool
1. Select the object you want to outline.
2. Click the Outline tool.
3. Click the line width you want.

The available widths are: Hairline, Thin, Medium, Medium-Thick, and Thick.
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To set outline width using the Outline Pen dialog box
1. Select the object you want to outline.
2. Click Outline tool, Outline Pen.
3. In the Width box, type the line width you want.
Note

To use a different unit of measurement, choose it from the Units list. The width value is automatically 
converted when you change units.
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To set outline color using the Outline tool
1. Select the object you want to outline.
2. Click the Outline tool.
3. Click Black Outline Color or White Outline Color.
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To set outline color using the on-screen color palette
1. If the palette is not displayed:

Click View, Color Palette.
Click one of the palettes in the sub-menu (see Related Topics).

2. Select the object you want to outline.
3. Click the palette's scroll arrows until the color you want is visible.
4. Click the color you want with the right mouse button.
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To set outline color using the Outline Color dialog box
1. Select the object you want to outline.
2. Click Outline tool, Outline Color.
3. Select the color you want (see Related Topics).
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To remove an object's outline using the Outline tool
1. Select the object with the outline you want to remove.
2. Click the Outline tool.
3. Click No Outline.
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To remove an object's outline using the on-screen color palette
1. If the palette is not displayed:

Click View, Color Palette.
Click one of the palettes in the sub-menu (see Related Topics).

2. Select the object with the outline you want to remove.
3. Click No Color with the right mouse button.
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To create a dashed outline using the dialog box
1. Select the object you want to outline.
2. Click Outline tool, Outline Pen.
3. Click the Line Style Selector.
4. Click the style you want.
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To create a dotted line or a line with rounded line segments
1. Select the object you want to outline.
2. Click Outline tool, Outline Pen.
3. Click the Line Style Selector.
4. Click the style you want. For a dotted line, click a style with short, widely spaced segments.
5. Click Rounded Line Caps.
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To set the default outline for graphic objects
1. Click a white space in the window to ensure that no object is selected.
2. Click the Outline tool.
3. Click the tool that corresponds to the type of outline you want for the default. Click No Outline to give all new 

graphic objects a transparent outline.
4. Enable the Graphic option.
5. If you're using the Outline Pen dialog box, set the appropriate attributes (see Related Topics).

The outline is now applied to any new non-text objects you create. You may of course change the outline of 
any individual object.
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To set the default outline for paragraph text
1. Click a white space in the window to ensure that no object is selected.
2. Click the Outline tool.
3. Click the tool that corresponds to the type of outline you want for the default. Click No Outline to give all new 

Paragraph text objects a transparent outline.
4. Enable the Paragraph Text option.
5. If you're using the Outline Pen dialog box, set the appropriate attributes (see Related Topics).

The outline is now applied to any new paragraph text objects you create. You may of course change the outline
of any individual object.
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To set the default outline for artistic text objects
1. Click a white space in the window to ensure that no object is selected.
2. Click the Outline tool.
3. Click the tool that corresponds to the type of outline you want for the default. Click No Outline to give all new 

Artistic text objects a transparent outline.
4. Enable the Artistic Text option.
5. If you're using the Outline Pen dialog box, set the appropriate attributes (see Related Topics).

The outline is now applied to any new artistic text objects you create. You may of course change the outline of 
any individual object.
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To create a calligraphic outline
1. Select the object with the outline you want to change.
2. Click Outline tool, Outline Pen.
3. Click one of the Corner Styles. The first and third options make the nib square; the second makes it round.
4. Type a value in the Stretch box. 

Lowering the value makes a square nib rectangular and a round nib oval. A low value will create a more 
pronounced calligraphic effect.

5. Type a value in the Angle box. The angle controls the orientation of the pen to the drawing surface.
Tip

You can adjust Stretch and Angle interactively by dragging in the Nib Shape box. Experiment to find the 
combination you want.

Note
To change line widths after creating the calligraphic outline, use the Width setting in the Outline Pen dialog 

box. Choosing a line width from the Outline menu will reset the Angle to zero degrees and Stretch to 100 percent, 
thus removing the calligraphic effect.
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Arrowhead Editor
The Arrowhead Editor lets you make changes to the existing line-ending shapes. You can stretch, scale, or move 
the arrowhead around in relation to the ending point of the line, but you cannot change its basic shape. 
If you are looking for a specific effect, choose the line-ending shape closest to what you are looking for, and then
edit it using the Arrowhead Editor.
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To apply line-ending shapes using the dialog box
1. Select a line or curve.
2. Click Outline tool, Outline Pen.
3. Click the left Arrowhead Selector, then click the shape you want for the start of the line.
4. Click the right Arrowhead Selector, then click the shape you want for the end of the line.
Note

To swap arrowheads from one end of the line to another, click Options, Swap.
To remove an arrowhead, click Options, None.
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To apply line-ending shapes using the Pen Roll-Up 
1. Select a line or curve.
2. Click Outline tool, Pen Roll-Up.
3. Click the left Arrowhead Selector, then click the shape you want for the start of the line.
4. Click the right Arrowhead Selector, then click the shape you want for the end of the line.
5. Click Apply.
Notes

To remove an arrowhead, click the first option in the shape list.
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To stretch an arrowhead or line-ending shape
1. Select a line or curve.
2. Click Outline tool, Outline Pen.
3. Under the arrowhead you want to edit, Click Options, Edit.
4. Drag on the solid handles along the sides of the arrow's box to stretch, or on the corner handles to scale. 
Tip

To get a closer view of the arrowhead, enable the 4X zoom option.
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To move an arrowhead or line-ending shape
1. Select a line or curve.
2. Click Outline tool, Outline Pen.
3. Under the arrowhead you want to edit, Click Options, Edit.
4. Drag the hollow nodes along the arrow's outline.
Tip

To get a closer view of the arrowhead, enable the 4X zoom option.
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To center an arrowhead or line-ending shape
1. Select a line or curve.
2. Click Outline tool, Outline Pen.
3. Under the arrowhead you want to edit, Click Options, Edit.
4. Click Center in X to center the arrowhead horizontally.

Click Center in Y to center it vertically.
Tip

To get a closer view of the arrowhead, enable the 4X zoom option.
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To flip an arrowhead
1. Select a line or curve.
2. Click Outline tool, Outline Pen.
3. Under the arrowhead you want to edit, Click Options, Edit.
4. Click Reflect in X to flip the arrowhead horizontally.

Click Reflect in Y to flip it vertically.
Tip

To get a closer view of the arrowhead, enable the 4X zoom option.
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Views



Slide view displays a single slide with any objects that are included on it. You can draw shapes, write text, add 
sound, video and OLE objects, and insert maps and charts. You can also print the presentation slides. Use the 
View menu to switch to other views.



Slide Sorter view displays all presentation slides as thumbnails in a scrollable window. You can change the order 
of slides, insert/delete slides, apply backgrounds and layouts to selections of slides, show/hide slides in the 
presentation, or proof a presentation before printing it or starting the screen show. Use the View menu to switch 
to other views.



Master Layout view displays the current master layout; the four different master layouts are: Title Slide Master, 
Slide Master, Handout, and Speaker Notes. When you choose a master layout to apply, all slides that follow have 
the same layout.
You can change the following attributes within the master layouts:

change text attributes
change bullet styles
move or size the frames

Use the View menu to switch to Master Layout view.



Speaker Notes view displays presentation slides in thumbnail form on a notes page, along with room for you to 
type key notes that you want to remember. You can print out the Speaker Notes and use them as a presentation 
aid when speaking to the audience. Use the View menu to switch to Speaker Notes view.



Handout view displays presentation slides as two slide thumbnails per notes page, along with room for you to 
add relevant text. Handouts make it easy for the audience to make notes during your presentation, and to 
remember key points later. You can print out the Handouts. Use the View menu to switch to Handout view.



Animation view displays the current slide you are working on, in animation mode. A VCR toolbar appears at the 
bottom of the screen. When you are in animation mode, you can select objects to animate, create multicel 
actors, sequence cels, assign paths, snap to key frames, advance the time, and play the animation. Use the View
menu to switch to Animation view.



Background view displays the background of the current slide you are working on. You can apply a new 
background from fills or the library, modify an existing background, draw objects, add text and insert graphics 
into the background. When you choose a background to apply, all slides that follow have the same background. 
Use the View menu to switch to Background view.



Outline view displays the text of all presentation slides. You can arrange the text of a slide in hierarchical order; 
rearrange the order of slides or bullets; choose the type of text, font or style; select basic effects such as bold, 
italic and underline; and display text in draft or preview mode. Use the View menu to switch to Outline view.



Handout Layout view displays the slide and text layout frames for handouts. You can change the following 
attributes within the master layout:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to Master Handout Layout view.



Speaker Notes Layout view displays the slide and text layout frames for Speaker Notes. You can change the 
following attributes within the master layout:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to Master Handout Layout view.



Frames



The Group frame contains objects that are grouped using the Arrange menu. An object group, while made up of 
several objects, is treated as one entity.



The MCI frame contains an .AVI video file. The video plays at the same size as the video frame on the slide. You 
can enable the check box in the Video Properties dialog box to show the video at the full screen size. Click with 
the right mouse button on the MCI frame and choose the Properties command to display the Video Properties 
dialog box.



The Notes Constrain Group frame contains the slide image on the Handout or Speaker Notes page.



The Sound Object frame contains a sound file. You can edit the sound file by double-clicking anywhere within the 
frame, launching the Wave Editor. You can sequence cels, select mono or stereo output, and create special sound
effects while in editing mode.



The thumbnail frame contains a miniature image of a slide or group of slides.



The Text Object frame contains text created in PRESENTS. You can add and manipulate text with ease, entering 
Artistic Text or Paragraph Text directly onto the screen. Text features include editing and formatting; selecting a 
font and setting its point size and attributes; adjusting character, word, line, and paragraph spacing; adding 
symbols; and proofreading.



The Template frame is empty until you double-click to insert the type of object you chose from the layout. For 
example, if you chose a chart layout, a chart appears when you double-click inside the empty frame.



The Title Object frame contains the slide title or subtitle master layout. You can do the following in the Title Slide 
Master layout:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to other Master Layout views.



The Body Text Object frame contains the body text master layout. This frame is available in Slide Master, 
Handout, or Speaker Notes master layouts. You can do the following in the body text frames:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to Master Layout views.



The Header Text Object frame contains the header that appears on your slides. You can create a header by 
accessing File, Page Setup, Header/Footer. Headers can be created for slides, handouts and speaker notes. You 
can modify the size or location of the header frame on the Slide Master, Handout, or Speaker Notes master 
layouts, accessible from the View, Master Layouts command.



The Footer Text Object frame contains the footer that appears on your slides. You can create a footer by 
accessing File, Page Setup, Header/Footer. Footers can be created for slides, handouts and speaker notes. You 
can modify the size or location of the footer frame in the Slide Master, Handout, or Speaker Notes master 
layouts, accessible from the View, Master Layouts command.



The OLE Object frame contains objects that are linked or embedded from other applications. You can insert and 
OLE object onto your slide from the Insert, New Object command.



The Chart OLE Object frame contains a chart that is inserted into your presentation. You can double-click the 
chart to open the Chart server, which contains two principal tools: the chart-building screen, called Chart View, 
and an underlying spreadsheet program called the Datasheet. You can create custom charts and display them in 
PRESENTS.



The Map OLE Object frame contains a map that is inserted into your presentation. You can double-click the map 
to open the Map server. You can create custom maps and display them in PRESENTS.



The bitmap object frame contains a graphic object that you inserted, imported, linked, or embedded into the file.



The Rectangle frame contains a rectangle drawn using the Rectangle tool 
. 
You can change the shape, size, angle, rotation, outline, or fill; edit nodes, or zoom in or out on the rectangle.



The Ellipse frame contains an ellipse drawn using the Ellipse tool 
.
You can change the shape, size, angle, rotation, outline, or fill; edit nodes, or zoom in or out on the ellipse.



The Polygon frame contains a Polygon drawn using the Polygon tool. You can change the shape, size, angle, 
rotation, outline, or fill; edit nodes, or zoom in or out on the Polygon. To create a variety of star shapes, click on the 
Edit Nodes tool and drag the Polygon into the desired shape.



The Curve frame contains curve objects drawn using the Freehand tool.



The Artistic Text frame contains Artistic text created using the  tool. Use Artistic Text when you want to 
apply special effects such as shaping text to a path and creating extrusions or contours. You can add Artistic Text
objects containing up to 32,000 characters.



Print dialog box
The Print dialog box allows you to set basic print settings, to set more complex print settings, and to print. Use 
the dialog box to indicate:

which device driver to use
whether to print to the device or to a file instead
which pages or objects to print
how many copies you require
whether to collate the pages
which printer color profile to use
which printing style to use

You can also choose the following:
To change or to review your printer settings
To set more complex parameters, including color separation specifications, and preview your print job
To print using the settings you have chosen
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Print Options dialog box
The Print Options dialog box allows you to set more complex parameters, including color separation 
specifications and to preview your print job.
Printing style
Use Printing style to select, create, edit, and delete printing styles. Printing style allows you to save the Print 
Options settings for later use.
Preview box

Use the Preview box to position and size your artwork. The Preview box also allows you to review color-separated
jobs separation by separation.

Reference tools

Use reference tools to add reference marks to your print job (e.g., crop marks and page number), as well as to 
specify whether you wish to print a negative or positive image and whether you wish to print with the film emulsion 
up or down.

Layout page
Use Layout page options to position and size your artwork.
The Layout style options allow you to print your work in different forms. For example, you can create a greeting 
card or a booklet with your work by properly applying layout styles.
Options page
Use the Options page to set various advanced options.
The Fountain steps option allows you to specify how many steps your linear fountain fills will contain when 
printed.
The Screen frequency option allows you to specify what halftone screen frequency you will use.
Note

If you are using color separations and advanced settings, set the screen frequency in advanced settings
The PostScript Preferences button allows you to change your PostScript settings if you are using a PostScript 
device driver.
The Proofing options allow you to specify specific types of objects to print (e.g., text only). They also allows you 
to print colors as black or grayscale, to print text as black, and to fit printer's marks (such as crop marks and 
calibration bars) and layout to the page.
The Print job information sheet option prints a report with information about your print job. Use the Info Settings 
to customize the information sheet.
The Special settings option allows you to change settings that were previously edited in CORELPRN.INI.
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Print Job Information dialog box
The Print Job Information dialog box allows you to specify what type of information you want included in the print
job report. You can direct the report to a printer or text file or both.
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PostScript Preferences dialog box
The PostScript Preferences dialog box allows you to set advanced PostScript options. You can optimize object 
outlines and fills for printing, and control the way your PostScript driver handles fonts and bitmaps.
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Save Print Style dialog box
The Save Print Style dialog box allows you choose a name for the current print style (i.e., the current settings in 
Print Options). You can also change any settings you wish in Settings to save in style.
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Print Setup dialog box
The Print Setup dialog box allows you to select a device driver. Click Properties to change or review your printer 
settings.
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Edit Layout Style dialog box
The Edit Layout Style dialog box allows you to create custom layout styles. By increasing the Across and Down 
values, you allow space for several working pages on a single sheet of paper. The options in this dialog box allow
you to place the working pages in any order.
Note

When you create a custom style you are creating a template for the entire print job. If your document has 
a lot of pages, Corel will place subsequent pages in an order based on the page order of the template. For example, 
if page seven is place on the right page of a booklet, page fourteen will appear on the next right page.
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Edit Positioning dialog box
The Edit Positioning dialog box allows you to place several existing printable pages on a single printable page, or 
to place several copies of an existing printable page on a single page. You can also set page margins in this 
dialog box.
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Advanced Separations Settings dialog box
The Advanced Separations Settings dialog box allows you to customize the color separations. You can specify 
screen technology, adjust individual color separations, create color trapping for individual color separations, and 
select a halftone type.
Consult your service bureau to ensure that all options are set properly.
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Opens a Windows dialog box which allows you to set printing options not controlled by Corel.



Opens the Print Options dialog box which allows you to set advanced printing parameters such as sizing and 
positioning, halftone screening, color separations, etc.



Indicates which device driver is selected. Click the arrow to access a list of other available printer and 
imagesetter drivers.
If the driver you need is not listed, install it by using the usual Windows procedure.



Ensures that colors will print as expected.
The printer color profile shown here matches the printer that was chosen in the System Profile (Color Manager).
If you want your print job to be filtered through a different profile, you must go back to the Color Manager, select
the appropriate printer, and generate a new System Profile.



Stores a configuration of print settings that can be used again.



Stores a configuration of print settings that can be used again.



Saves the current print settings as a new style.



Deletes the selected style.



Creates a .PRN file from your print job (instead of actually printing).



Prepares the .PRN file for printing from a Macintosh computer.



Identifies the number of copies that will be printed.
Note

When printing to file, request one copy only, with no collation.



Prints one full set of the selected pages before printing the second full set (e.g., a first set of pages 1 to 10 will 
print, before the second set of pages 1 to 10 will print, and so on).
If you do not enable Collate, the requested number of copies of each selected page will print before the next 
page will print (e.g., five copies of page 1 will print before five copies of page 2 will print, and so on).



Prints one full set of the selected pages before printing the second full set (e.g., a first set of pages 1 to 10 will 
print, before the second set of pages 1 to 10 will print, and so on).
If you do not enable Collate, the requested number of copies of each selected page will print before the next 
page will print (e.g., five copies of page 1 will print before five copies of page 2 will print, and so on).



Print all pages in your document.



Prints only the objects that are currently selected.



Prints only the page currently displayed.



Specifies the pages, or the range of pages, to print.
A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 to 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print pages 1, 2, 3, 5, 7, 

10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example, 1~6 will print pages 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.
The option works in conjunction with the Print Odd/Even Pages option.



Specifies the pages, or the range of pages, to print.
A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 to 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print pages 1, 2, 3, 5, 7, 

10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example, 1~6 will print pages 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.
The option works in conjunction with the Print Odd/Even Pages option.



Allows you to specify whether odd, even, or both odd and even pages will be printed.



Displays your file as it will print and allows you to size and reposition your image. Right click on the preview 
window to choose one of four options: Preview Image, Preview in Color, Full Image Drag, and Print This Sheet 
Now.
Note

For your image to appear, you must enable Preview image. Otherwise your image will be represented by a 
bounding box.



Displays your file as it will print and allows you to size and reposition your image. Right click on the preview 
window to choose one of four options: Preview Image, Preview in Color, Full Image Drag, and Print This Sheet 
Now.
Note

For your image to appear, you must enable Preview image. Otherwise your image will be represented by a 
bounding box.



Allows you to move back in a multi-page document.



Allows you to move forward in a multi-page document.



Changes to a full screen preview. Click it again to return to a normal preview.



Displays your file in the Preview box as it will print.
Preview Image is a handy feature. Enable it, unless the image is complex and takes a long time to display. If you 
disable the preview, a bounding box will still indicate the position and size of your image.



Allows you to choose whether the Preview box will display a composite view of your print job or only a specific 
color separation.
Note

This feature is only available when Print Separations is enabled.



Prints the filename, current date, and time (and tile number, if applicable) at the bottom of the sheet.
If applicable, color separation information (color, screen frequency and angle, plate number) is printed at the top
of the sheet.
Note

To see the file information, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work. If not, you can request that the file information be 
printed within the page.



Places page numbers on the printed sheets.
Note

To see the page numbers, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Causes the file information to print within the page.
Tip

If the working page size is identical to the paper or film size, enable File Info Within Page. Make sure the 
artwork is positioned so that the file information does not overlap it.



Prints crop marks. These marks are used as alignment aids when trimming the printed output down to its final 
size.
Note

To see the crop marks, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Prints crop marks only along the outer edge of the sheet.
Tip

This option is often preferable when you are printing multiple layouts per sheet.



Prints registration marks on each sheet. These marks serve as guides for aligning color separations.
Note

To see the registration marks, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work.



Prints a bar of the six basic colors (red, green, blue; cyan, magenta, yellow) beside your artwork. These color 
patches are used to verify the quality of the printed output.
Note

To see the calibration bar, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Prints a Densitometer Scale, a bar of varying shades of gray, on each separation sheet. This is an advanced 
feature that allows you to check the accuracy, quality, and consistency of the output with an instrument called a 
densitometer.
Note

To see the densitometer scale, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work



Prints a negative image when enabled.



Specifies that the film emulsion faces down when enabled.
Emulsion is the coating of light-sensitive material on a piece of film.



These options allow you to resize and reposition your artwork.
Note

These options do not affect the artwork itself, only the way it is printed.



Applies positioning and sizing to all pages.



Identifies the unit of measurement that is used when you specify the layout of your artwork.



Specifies the placement of your artwork on the page. The Top value indicates the distance from the top edge of 
the printable page.



Specifies the placement of your artwork on the page. The Top value indicates the distance from the top edge of 
the printable page.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Resizes your printed artwork (not the original document) according to the width specified.



Resizes your printed artwork (not the original document) according to the width specified.



Scales the width of your printed artwork (not the original document) by the specified percentage.



Scales the width of your printed artwork (not the original document) by the specified percentage.



Scales the height of your printed artwork (not the original document) by the specified percentage.



Scales the height of your printed artwork (not the original document) by the specified percentage.



Resizes your printed artwork (not the original document) according to the height specified.



Resizes your printed artwork (not the original document) according to the height specified.



Automatically centers your artwork on the page.



Automatically scales your artwork so that it fits the printable page.
Note

Unless Maintain aspect ratio is enabled, Fit to Page will distort your image.



Constrains resizing and scaling so that the height and width ratio of the artwork is maintained.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Allows you to print large artwork on multiple sheets, or tiles, that can later be assembled to form the whole 
picture.



Indicates the level of flatness that will be applied to curves when you print.
Tip

Increasing the flatness reduces printing time and therefore is useful when you need to produce quick 
proofs. Be careful however as a flatness level set too high will produce distorted curves.



Causes Corel to automatically increase the flatness in increments of 2, as needed. Attempts to print an object 
will stop when the flatness value exceeds the value set in the Set Flatness To box by 10. At this point, the printer 
skips the problematic object and goes on to the next object.



Specifies the maximum allowable number of control points per curve. Reducing this number helps alleviate 
printing problems caused by objects that are too complex.



Allows one or more warnings to be issued if objects that are too complex and could cause printing problems are 
detected.



This value reflects the number of steps that will be used to render any fountain fills in your artwork. A low value 
(less than 20) will print faster but the transition between shades may be coarse, which causes what is known as 
banding. A higher value (over 40) will result in a smoother blend but longer printing times. 
Note

Fountain steps that are set in the Options dialog box only affect the way fountain fills display on your 
monitor. To control how the fountain fills actually print, you must set the value for fountain steps here or in the 
Fountain Fill dialog box.



Warns you of potential banding (the appearance of discreet strips in a fill) which is caused by to few steps in a 
fountain fill, when it is enabled.
Note

This warning only applies to linear fountain fills.



Prints a job information sheet with your print job. This report contains information about the application that 
produced the job, the driver that was used, the print settings, the font information, and the file links.



Opens the Job Information Sheet dialog box, which allows you to specify which categories of information you 
want included in the report.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Identifies the basic halftone screen frequency that your job will print at.
Screen frequency is expressed as a number of lines per inch (lpi). This value refers to the number of lines of dots 
(or other shapes) that make up a halftone screen. A halftone screen is a pattern of shapes of various sizes that is
used to simulate a continuous tone image.
Note

Check with your service bureau for the optimum setting for your print job.



Enables the use of PostScript level 2 features.
Note
This option is only available to level 2 PostScript devices. If you are not certain whether you will be printing on a 
level 2 postscript device, DO NOT enable this option.



Enables an analysis of your file and the various print settings you have specified, and, if necessary, automatically
increases the number of steps used to render fountain fills to avoid banding. 
Note

This option may increase print time, but it will ensure the best possible rendering of fountain fills.



Enables an analysis of your file and the various print settings you have specified. If the number of steps in a 
fountain fill is greater than the number that your output device can render, the number of steps used to render 
the fountain fill is decreased automatically. 



Downloads Type 1 fonts to the output device. Generally, this option is enabled because it is particularly beneficial
when you want to print large tracts of text that use only a few fonts. Printing is faster as each font is first 
downloaded, and then only referenced by text that uses it.
If you disable this option, fonts are output as graphics (either curves or bitmaps). This may be useful if the file 
contains a large number of fonts that would take longer to download, or not download at all, because of sheer 
size.



Converts True Type fonts to Type 1 fonts. If you enabled the Download Type 1 Fonts option, by default the 
Convert True Type to Type 1 is also enabled. This ensures that True Type fonts are converted to Type 1 fonts so 
that they can be downloaded. 
Only disable this option if your output device has difficulty interpreting the Type 1 fonts.



Tells the service bureau's OPI server to substitute the corresponding high-resolution images for the low-resolution
ones in your file. This substitution is done before your print file is rasterized and imaged to film.



Defines bitmaps in RGB values instead of the usual CMYK values that are found in PostScript files.
Tip

Use this option when you are outputting to RGB devices (e.g., slidemakers).
Also use this option when you are printing to CMY devices. It is easier for these devices to translate from 

RGB to CMY than from CMYK to CMY.



Separates color artwork into its component colors, causing each component color to print out on a single sheet.
If you used a process color model (which uses four colors to simulate any color), you'll get up to four sheets per 
page.
If you used spot colors, one sheet per color is printed.



Allows you to print the separations in color (i.e., on a color printer). Separations are usually printed in black, with 
a screen to represent shading. This option allows you to print the separations in color instead.



Converts any spot colors present in your artwork to process colors.
Note

This does not affect the artwork itself, only the way it is printed.



Prints all plates, including those that contain no image.
Note

Printing empty plates wastes film and adds to the cost of your job. Generally, you'll want to leave this 
option disabled.



Specifies which color separation(s) to print.
The list of colors shows all separations used in your artwork. You can choose to print all separations, one 
separation only, or any combination of separations.



Allows you to adjust the advanced settings of your color separations, which includes setting halftone screens and
creating color trapping.
Note

Do not adjust these settings without first talking to your service bureau or printing shop.



Opens the Advanced Separations Setting dialog box that allows you to set advanced screening parameters such 
as screening technology, screen frequency and angle per color plate, overprinting per plate, halftone dot type, 
etc.



Identifies the imagesetter and screening technology that will be used to image your job.
Proprietary screening technologies supported by Corel include AGFA Balanced screening, Linotronic RT and, HQS 
screening.



Identifies the imagesetter and screening technology that will be used to image your job.
Proprietary screening technologies supported by Corel include AGFA Balanced screening, Linotronic RT and, HQS 
screening.



Identifies the resolution (in dots per inch, or "dpi") the job will be printed at.



Identifies the resolution (in dots per inch, or "dpi") the job will be printed at.



Identifies the basic screen frequency (in lines per inch, or "lpi") the job will be printed at.
Note

The higher the screen frequency setting, the more intense the colors and the sharper the image. The lower
the screen frequency, the lighter the colors and the less sharp the image. 

A high frequency gives you fewer levels of gray; a low frequency gives you more levels of gray.
The upper limit of your screen frequency is define by the type of printing press to be used and the type of 

paper stock.



Identifies the basic screen frequency (in lines per inch, or "lpi") the job will be printed at.
Note

The higher the screen frequency setting, the more intense the colors and the sharper the image. The lower
the screen frequency, the lighter the colors and the less sharp the image. 

A high frequency gives you fewer levels of gray; a low frequency gives you more levels of gray.
The upper limit of your screen frequency is define by the type of printing press to be used and the type of 

paper stock.



Identifies the screen frequency the selected color separation will be printed at. The default values are based on 
the imagesetter, screening technology, and basic screen frequency chosen; it is best not to change these values.
Note

Check with your service bureau before modifying these values.



Shows the screen angle for the selected color separation. Screen angles are used to offset the different films in 
process color separations to avoid moiré patterns. The default values are based on the imagesetter, screening 
technology, and basic screen frequency chosen; it is best not to change these values.
Note

Check with your service bureau before modifying these values.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to specify a halftone screen for your drawing if you are printing to a PostScript device. A halftone 
screen is a pattern of shapes that is used to simulate shades of colors (i.e. darker to lighter) while using the 
same ink. Dot, line, diamond, elliptical, and Euclidean are only a few of the available halftone types.



Allows you to specify a halftone screen for your drawing if you are printing to a PostScript device. A halftone 
screen is a pattern of shapes that is used to simulate shades of colors (i.e. darker to lighter) while using the 
same ink. Dot, line, diamond, elliptical, and Euclidean are only a few of the available halftone types.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color, 
the smaller the percentage of the maximum trap value.

The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Causes any object that contains 95% black or more to overprint underlying objects.
Note

This is a useful option for artwork containing a lot of black text, but it should be used with caution on 
artwork with a high graphics content.



Provides preset page layouts and allows you to store custom styles.



Provides preset page layouts and allows you to store custom styles.



Opens the Edit Layout dialog box.



Specifies the number of working pages to place on a single printable page.



Specifies the number of working pages to place on a single printable page.



Places the current layout in each frame of the printable page.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles based on a 
percentage of the page width.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles based on a 
percentage of the page width.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Resizes your printed artwork (not the original document) according to the width specified.



Resizes your printed artwork (not the original document) according to the height specified.



Stores the page positioning settings specified in the Positioning dialog box.



Opens the Positioning dialog box. This dialog box allows you to specify positioning settings that can be save in 
Positioning styles.



Stores the page positioning settings specified in the Positioning dialog box.



Prints only vector graphics unless combined with Print bitmaps or Print text.



Prints only bitmaps unless combined with Print vectors or Print text.



Prints only text unless combined with Print vectors or Print bitmaps.



Prints all text in black.



Prints using the full color capabilities of the selected printing device.



Prints all colors in black.



Prints all colors in grayscale.



Opens the Postscript Preferences dialog box.



Scales everything that will be printed so that it fits within the printable page of the current printer. Use this 
setting to proof a large layout on your desktop printer.
This option is only intended for proofing, and should be disabled for the final output. If you wish to scale your 
artwork to fill the printable page, you should use the fit to page option. Position and size measurements reflect 
the size of the final output, not the size of the proof.



Provides information about the current printing device.



Provides information about the current printing device.



Provides information about the current printing device's location.



Provides information about the current printing device.



Displays a list of documents that you can print.



Allows you to choose what to print.



Stores a configuration of print settings that can be used again.



Stores a configuration of print settings that can be used again.



Displays a list of the current device's mode settings.



Displays information about the current printing device.



Displays a list of the current device's capabilities.



Displays information about the current printing device.



Specifies which color separation(s) to print.
The list of colors shows all separations used in your artwork. You can choose to print all separations, one 
separation only, or any combination of separations.



Shows all separations used in your artwork. Click each one to change frequency, angle, and to enable 
overprinting.



Shows all separations used in your artwork. Click each one to change frequency, angle, and to enable 
overprinting.



Displays the present print style, or a name you have typed for a new style.



Provides a list of the present print options and allows you to change them.



Allows you to save this dialog box's settings.



Makes the right margin equal to the left margin, and the bottom margin equal to the top margin.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Automatically sets the gutters.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Displays a model of the printable page based on the positioning settings.



Automatically sets the margins.



Specifies the number of rows of positioning frames to be placed on the printable page.



Specifies the number of columns of positioning frames to be placed on the printable page.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Stores the page positioning settings specified in this dialog box.



Saves the present positioning settings.



Deletes the selected positioning style.



Specifies the number of rows of positioning frames to be placed on the printable page.



Specifies the number of columns of positioning frames to be placed on the printable page.



Stores the page positioning settings specified in this dialog box.



Specifies the number of working pages to position across the printable page.



Specifies the number of working pages to position across the printable page.



Specifies the number of working pages to position down the printable page.



Specifies the number of working pages to position down the printable page.



Places the current working page in each frame of the printable page.



Keeps the frame size equal to the working page size.



Displays a model of how the pages will be arranged on the printed sheet.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Shows the other side of a double sided layout.



Allows you to print on both sides of the page.
Note

When you enable this option, and you print to a non-double sided printer, Corel automatically runs a wizard
that ensures all of the pages are ordered and oriented correctly.



Provides preset page layouts and allows you to store custom styles.



Saves the present layout settings.



Deletes the selected layout style.



Selects a page to be placed on the layout sheet.



Selects a page to be placed on the layout sheet.



Allows you to specify whether the top of the selected page points up or down.



Allows you to specify whether the top of the selected page points up or down.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Shows the contents of the Print Job Information Sheet.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Sends the Print Job Information Sheet to a .TXT file.



Allows you to specify the .TXT file the Print Job Information Sheet is sent to.



Sends the Print Job Information Sheet to a printer.



Allows you to specify the printer the Print Job Information Sheet is sent to.



Places the current working page in each frame of the printable page.



BOO



Allows you to choose proofing options.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Provides information about the current printing device.



Provides information about the current printing device.



Provides information about the current printing device's location.



Provides information about the current printing device.



Provides information about the current printing device, and allows you to change devices.



Allows you to specify the number of copies and whether to collate them.



Allows you to specify color trapping settings.



Allows you to change screening options for the selected color separation.



Provides a list of the present print options and allows you to change them.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to set the page margins. You can also change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Sets PostScript font handling.



Sets PostScript bitmap handling.



Allows you to enable PostScript warnings.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to choose the output format and destination of the Print Job Information Sheet.



To print all pages
1. Click File, Print.
2. Choose All.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only the current page
1. Click File, Print.
2. Choose Current Page.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only certain pages
1. Click File, Print.
2. Choose Pages.
3. Choose Even Pages, Odd Pages, or Even and Odd from the pages list box.
4. Type the pages you want printed in the pages box.
Note

A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 through 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print the following pages: 

1, 2, 3, 5, 7, 10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example,1~6 will print the following pages: 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only selected objects
1. Select the objects to print.
2. Click File, Print.
3. Choose Selection.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only vectors, bitmaps or text
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Enable Vectors, Bitmaps, Text, or a combination of these.
5. (Optional) Enable Print All Text In Black if you want to print text in black instead of in color.

{button ,AL(`g_h_pt_print;;;;;',0,"Defaultoverview",)} Related Topics



To print only certain layers
1. Click Layout, Layers Roll-Up.
2. Enable or disable the Printable option for each layer, as required.
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To immediately print the sheet being previewed
1. Point to the Preview box.
2. Click the right mouse button, click Print This Sheet Now.
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To print a memo
1. Select the memo you want to print.
2. Click Edit, Note object, Open.
3. Click File, Print from inside the Memo window.
4. Choose a printing device.
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To select a device
1. Click File, Print.
2. Choose a printer or imagesetter from the Name list box. If the device driver you need is not listed, install it 

following the usual Windows procedure.
Tip

If you're proofing or printing a job in-house, choose the driver for your local device.
If you're sending a file to a service bureau, choose the device driver that's specified by the service bureau.
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To set the device properties
1. Click File, Print.
2. Click Properties.
3. If printing to a PostScript device, set only the Page Size, Orientation, Tray, and Resolution here. Leave all other 

options at their default and set them from Print options instead.
or
If printing to a non-PostScript device, set all relevant options here.

Note
As these are Windows-controlled options, see your Windows documentation for more information.

Tip
To verify the extent of the unprintable area for the selected device, click Unprintable Area.
To print on both sides of the page (duplex printing), click More Options.
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To print to file
1. Click File, Print.
2. Enable Print to File.
3. Enable For Mac if your print file is being sent to a service bureau with Macintosh equipment.

PostScript files created using the Print to File option contain two Control-D (^D) characters that prevent them 
from printing on any PostScript device controlled by Macintosh computers. Enabling the For Mac option 
removes the ^D characters from the files.

4. Click OK.
5. Type a filename and choose a destination. The appropriate extension (.PRN) will be appended to your filename.
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To select a print style
1. Click File, Print.
2. Choose a print style from the Style list box.

{button ,AL(`g_h_pt_settingjob;;;;;',0,"Defaultoverview",)} Related Topics



To edit an existing print style or create a new one
1. Click File, Print.
2. Click Options.
3. (Optional) Choose an existing print style to edit from the Style list box.
4. Change the print options.

5. Click .
6. Choose a name for the style.

Tip
When you click Cancel instead of OK in the Print dialog box, all of the changes you have made in print 

options are discarded. If you do not want to lose these changes and you need to click Cancel (i.e. you need to 
change your work before you print), save your settings as a print style.
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To delete a print style
1. Click File, Print.
2. Click Options.
3. Select a print style to delete from the Style list box.

4. Click .
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To print color artwork in black or grayscale
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click All Colors As Black or All Colors As Grayscale.
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To print multiple copies
1. Click File, Print.
2. Type the number of copies you need in the Number of copies number box.
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To collate multiple copies
1. Click File, Print.
2. Enable Collate.
Note

Choosing Collate allows you to print one full set of the selected pages before printing the second full set 
(e.g., a set of pages 1 to 10 will print before a second set of pages 1 to 10 will print, and so on). Otherwise the 
requested number of copies of each selected page will print going on to the next page (e.g., five copies of page 1 
will print, before five copies of page 2 will print, and so on).
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To preview your print job
1. Click File, Print.
2. Click Options.
3. Enable Preview Image.
Tip

You can choose whether you prefer the preview to be on or off by default. Click the Options tab, and from 
Special Settings choose Preview Image Default. Set to On By Default or Off By Default.

You can also toggle the preview on or off by clicking the Preview box with the right mouse button and then 
clicking Preview Image on the pop-up menu.

Preview Image is a handy feature. We recommend that you enable it unless the image is complex and 
takes a long time to display. If you disable the preview, a bounding box will indicate the position and size of your 
image.
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To preview your color separations
1. Click File, Print.
2. Click Options.
3. Enable Preview Image.
4. Choose composite (all color separations together) or a single color separation (e.g., cyan) from the list box.
Note

You can only view individual Color separations if you have enabled color separations in Print Options.
Tip

You can choose whether you prefer the preview to be on or off by default. Click the Options tab, and from 
Special Settings choose Preview Image Default. Set to On By Default or Off By Default.

You can also toggle the preview on or off by clicking on the Preview box with the right mouse button and 
then clicking Preview Image on the pop-up menu.

Preview Image is a handy feature. We recommend that you enable it unless the image is complex and 
takes a long time to display. If you disable the preview, a bounding box will indicate the position and size of your 
image.
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To specify a color or grayscale print preview
1. Point to the Preview box.
2. Click the right mouse button. Enable Preview In Color to specify a color preview. Disable this option to specify a

grayscale preview.
Tip

Displaying individual color separations in grayscale instead of color can be helpful when you are 
attempting to study color distribution. Yellow in particular can be difficult to discern against a white background. 
Even magenta and cyan, if sparse, can be easier to discern when displayed in grayscale.
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To enlarge the preview box
Click the enlarge icon at the top-left corner of the Preview box.
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To move from page to page in print preview
Click one of the page-flipper buttons. The button pointing left flips back through the pages and the button 

pointing right flips forward.
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To specify full image or marquee drag in print preview
1. Point to the Preview box.
2. Click the right mouse button. Enable Full Image Drag to keep the image visible while it is being repositioned. 

Disable this option to change the image to a marquee box while it is being repositioned.
Tip

The default is Full Image Drag. To make the default drag marquee, click the Options tab, and in Special 
Settings, and choose Print Preview Drag Mode. Change the setting to Drag Marquee.
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To size your artwork when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. (optional) Enable (or disable) Maintain Aspect.
5. Assign the height and width values in the unit of measurement you want

or
Drag the handles in the Preview box.

Note
You can only size your artwork this way when you are using the Full Page layout style with no rows or 

columns, or when you are using the Manual layout style.
If you enabled Maintain Aspect, you can only resize the image proportionally.
This option does not affect the artwork itself, only the way it is printed.
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To fit your artwork to the page when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. (optional) Enable (or disable) Maintain aspect ratio.
5. Click Fit to Page.
Note

Your artwork is automatically scaled (up or down) so that it fits the printable page. Your image will be 
distorted if you do not enable Maintain Aspect.

This option does not affect the artwork itself, only the way it is printed.
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To maintain the aspect ratio of your artwork when sizing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Enable Maintain aspect ratio.
Note

This is the default setting.
This option does not affect your artwork. When you are finished printing you will still be able to change the 

aspect ratio of your work.
Tip

The height and width ratio of an image is known as its "aspect". If you are resizing or scaling your artwork 
using the print preview, it is a good idea to enable Maintain Aspect to prevent image distortion.
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To manually position your artwork when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Change the Top value (distance from the top of the printable area) and the Left value (distance from the left 

side of the printable area).
or
Drag the graphic in the Preview box.

Note
This option does not affect the artwork itself, only the way it is printed.
If you select the Manual Layout style, you can place several working pages on a single printable page. 

Each of these pages can be sized and positioned individually. You can also use the Clone Page option to place 
several copies of the same working page on a single sheet of paper.
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To automatically center your artwork when printing
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Enable Center image.
Note

This option does not affect the artwork itself, only the way it is printed.
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To set a bleed limit
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Enable Bleed Limit.
6. Enter a bleed limit value. This value represents the distance the artwork will be allowed to bleed beyond the 

crop marks (i.e. the edge of final paper size).
Note

This setting has no effect unless the working page size is smaller than the printable page and your artwork
extends beyond the edge of the working page (see Page layout (and printing) in related topics).

Consult your service bureau or printing shop to determine the appropriate bleed limit for your job. 
Excessive bleeds waste film and may cause other problems.

{button ,AL(`g_h_pt_settingart;;;;;',0,"Defaultoverview",)} Related Topics



To print large artwork as tiles
1. Click File, Print.
2. Click Options. 
3. Click the Layout tab.
4. Enable Print tiled pages.
5. Indicate by how much you want the tiles to overlap. Enter a value (e.g., a quarter of an inch) or a percentage 

of the page size.
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To apply position and size settings to all pages when printing
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Enable Apply Settings to All Pages.
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To choose a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Choose a layout style from the Layout Styles list box.
Note

If you chose a layout style    before you open the print dialog box (i.e. using Page Setup) then the 
appropriate layout style will automatically be selected in the print dialog box. If you change it (with the exception of
Full Page)your work will not print correctly.

Tip
If you have created your work in a Full Page layout then you may choose to print this work using a different

layout style. For example, if you have designed a four-page document set up as Full Page, but would like to print it 
as a top-fold or side-fold card, you can choose the appropriate card style here. Or you may have designed a 
business card as full-page document and elect to print it using the labels layout.
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To edit a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Choose a layout style to edit from the Layout style list box.
5. Click the Layout style, Edit button.
6. Indicate the number of working pages from the Corel document to include on each printable page in the 

Across and Down number boxes.
7. Indicate the size of the gutters (space between pages) in the Horizontal and Vertical number boxes. You can 

change the unit of measurement in the Units number box on the right.
8. Click each box on the model of the of the printable page and choose a page number and an angle.
9. If you will be printing on both sides of the paper, enable Double sided layout. Click Flip Page to see each side.
Note

When you select Double sided layout and you print on a non-duplex printer, a wizard automatically 
provides instructions on how to insert the pages.
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To save a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Layout style, Edit button.
5. Edit a layout style (see related topics).

6. Click .
7. Choose a name for the layout style.
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To delete a layout style in the Print Options dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Layout style, Edit button.
5. Choose a layout style from the Layout style list box.

6. Click .
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To print several pages on a single sheet of paper
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button
5. Indicate how many rows and columns of the chosen layout you want printed per sheet.
6. Indicate the size of the gutters (space between rows and columns) in the Horizontal and Vertical number 

boxes. You can change the unit of measurement in the Units number box on the right.
or
Enable Auto Spacing.

7. (Optional) Enable Clone frame.
8. (Optional) Enable Maintain document page size.
Note

When you use Rows and Columns without enabling Clone Frame or Maintain document page size, each 
page of your work will be reduced in size and placed into a single frame (the intersection of one row and column). 
Each frame is placed starting with the first page at the top left and then each succeeding page is placed from left to
right and down.

If you enable Clone Frame, only one page of your work is placed in all of the frames for that sheet. In this 
way you can print multiple copies of one piece of artwork on a single sheet.

If you enable Maintain document page size each frame will be the same size as the page size specified in 
the document. For example, if you create a document on an 8.5 inch by 11 inch page, the frames will be 
constrained to that size. Thus, if you choose 11 inch by 17 inch paper, and specify 2 rows by 2 columns, some of the
frames will not fit on the page.

When you use Rows and Columns with a layout style that places several working pages on a single 
printable page (e.g., Tent-Card) each printable page is treated as a frame.
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To change the margins of the printed sheet of paper
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button
5. Indicate the size of the margins in the Left, Right, Top, and Bottom number boxes. You can change the unit of 

measurement in the Units number box on the right.
or
Enable Auto Margins.

6. If you want the left and right margins to be equal, and you want the top and bottom margins to be equal, 
enable Equal Margins.
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To save settings in the Edit Positioning dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button.
5. Change the settings (see related topics).
6. Click .

7. Choose a name for the settings.
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To delete settings in the Edit Positioning dialog box
1. Click File, Print.
2. Click Options.
3. Click the Layout tab.
4. Click the Positioning, Edit button.
5. Choose a saved settings name from the Positioning list box.
6. Click .
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To print file information
1. Click File, Print.
2. Click Options.
3. Enable File Info Button.
4. (Optional) Enable File info within page.
Note

To see the file information, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work, or you must indicate that the file information should be
printed within the page. If you do print the file information within the working page, make sure the artwork is 
positioned so that the file information does not overlap it.
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To print crop marks
1. Click File, Print.
2. Click Options.
3. Enable Crop Marks.
4. (Optional) Enable Exterior crop marks only.
Note

To see the crop marks, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.

If you are printing multiple pages per sheet (e.g., 2 rows by 2 columns), and you will not be cutting these 
pages into individual sheets, you may want to enable Exterior crop marks only. If you disable this option there will 
be crop marks around each row and column.

{button ,AL(`g_h_pt_reftools;;;;;',0,"Defaultoverview",)} Related Topics



To print registration marks
1. Click File, Print.
2. Click Options.
3. Enable Registration Marks.
Note

To see the registration marks, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work.

Tip
Corel offers a variety of registration mark styles. Look up what's available under Registration Mark Type in 

Special Settings on the options page in Print options. Choose a different style if you prefer. This option is available 
to PostScript devices only.
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To print page numbers
1. Click File, Print.
2. Click Options.
3. Enable Page numbers.
Note

To see the page numbers, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.
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To print a calibration bar
1. Click File, Print.
2. Click Options.
3. Enable Calibration Bar.
Note

To see the calibration bar, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.
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To print a densitometer scale
1. Click File, Print.
2. Click Options.
3. Enable Densitometer Scale.
Note

To see the densitometer scale, you must defined a working page size that is smaller than the dimensions of
the actual sheet of paper or film that is used to image the work.
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To print negative film
1. Click File, Print.
2. Click Options.
3. Enable Negative Film.
Tip

Do not choose negative film if you are outputting to a desktop printer.Check with your service bureau. Be 
especially careful if you require negative film: if you enable Negative Film and the service bureau's equipment is 
also set to negative, you will end up with positive film.
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To specify emulsion down 
1. Click File, Print.
2. Click Options.
3. Enable Emulsion Down
Note

Emulsion is the coating of light-sensitive material on a piece of film. Normally, images printed to a laser 
printer are printed with the emulsion up (button not enabled). Other types of reproduction may call for either 
emulsion up or down. Check with your service bureau.

Printing with the emulsion down produces a backwards image.
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To set the screen frequency
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Choose a screen frequency, expressed in lines per inch (lpi). Check with your service bureau for the optimum 

setting for your job.
Note

When the screen frequency is set to Default, your artwork is printed using the default screen frequency of 
the output device.

If you are using the Advanced settings, found on the Separations page in the Print Options dialog box, set 
the screen frequencies for each color separation here. These settings override the settings on the Options page.

This option is available to PostScript devices only.
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To set Level 2 usage
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Use PostScript Level 2 Features.
Note
This option is only available to Level 2 PostScript devices. If you are not certain whether you will be printing on a 
Level 2 PostScript device, DO NOT enable this option.
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To test for complex objects
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Complex Objects Warnings.
Note

This option is available to PostScript devices only.
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To reduce curve complexity by increasing flatness
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Increase the flatness value manually

or
enable Auto Increase Flatness.

Note
If you enable Auto Increase Flatness, the printer increases the flatness of curves in each object which is too

complex by increments of 2. If the object is still too complex when the flatness value exceeds the value in the Set 
Flatness To box by 10, the printer will skip the problematic object and go on to the next object. With this option 
enabled, the PostScript program is far less likely to cause errors on complex printing jobs.

If the printer skips an object because Auto increase flatness is enabled then the object will NOT appear in 
the final output. You will not be informed that this has happened while you print. The problem will only become 
evident when the print job is imaged to paper or film. Therefore it is important to inspect proofs before your job is 
printed.

This option is available to PostScript devices only.
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To reduce curve complexity by limiting control points
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enter a value for Maximum points per curve.
Note

Reducing this number helps alleviate printing problems caused by objects that are too complex. A lower 
number of points per curve will not reduce quality but it will increase printing time.

This option is available to PostScript devices only.
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To verify fountain fills for banding
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Banded fountain fill warnings.
Note

This warning only applies to linear fountain fills.
This option is available to PostScript devices only.
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To automatically increase fountain steps
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Auto increase fountain steps.
Note

This option will increase the number of steps that are used to render fountain fills to avoid banding (the 
appearance of discreet strips in a fountain fill). This may increase printing time, but it will ensure the best possible 
rendering of fountain fills.

This option is available to PostScript devices only.
Tip

You can enable both Auto increase fountain steps and Optimize Fountain Fills. Fountain steps will be 
increased in fountain fills that require more steps and fountain steps will be reduced in fountain fills that have too 
many.

{button ,AL(`g_h_pt_postscript;;;;;',0,"Defaultoverview",)} Related Topics



To optimize fountain fills to reduce complexity
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Optimize fountain fills.
Note

This option is available to PostScript devices only.
Tip

You can enable both Auto increase Fountain steps and Optimize Fountain Fills. Fountain steps will be 
increased in fountain fills that require more steps and fountain steps will be reduced in fountain fills that have too 
many.
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To download type 1 fonts
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Click Download Type 1 Fonts.
Note

If you enable the Download Type 1 Fonts , by default Convert True Type to Type 1 is also enabled. This 
ensures that True Type fonts are converted to Type 1 fonts so that they can be downloaded. Only disable this option 
if your output device has difficulty interpreting the Type 1 fonts.

This option is available to PostScript devices only.
Tip

Generally, you will want to leave this option enabled and let the driver download the Type 1 fonts to the 
output device. If you disable this option, fonts are output as graphics (either curves or bitmaps). This may be useful 
if the file contains a large number of fonts that would take an unacceptably long time to download, or not download 
at all, because of sheer size.
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To limit the number of bitmap fonts created
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Bitmap Font Limit.
5. Enter a number between 0 and 250.
Note

This option applies to text that will be printed on a PostScript printer.
If the font used meets certain criteria, a bitmap version of the font is created in the printer's memory. 

Bitmap character descriptions are used because they look better at small point sizes and they print faster than the 
normal character outline descriptions. The fonts created in this way consume a large amount of PostScript memory. 
As a result, you may need to limit the number of such fonts created to avoid a PostScript error when you are 
printing.

The following criteria must be met for a bitmap version of the font to be created in printer memory:
The printed character size is no larger than 75 pixels. This corresponds to a point size of 18 at 300 dpi, 9 

points at 600 dpi, and so on.
The text is not scaled or skewed.
The text does not have an outline or a fill other than a uniform fill.
The text does not have any envelopes (non-linear transformations) applied to it.
The drawing is not being printed using the Sizing options or Fit To Page option in the Print Options dialog 

box.
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To set a bitmap font size threshold
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From Special Settings choose Bitmap Font Size Threshold.
5. Enter a number between 0 and 1000. This value represents the bitmap height in pixels.
Note

The value set here determines if a Bitmap representation of the font can be created by the printer if the 
specific font is not loaded on the printer. The value represents the bitmap height in pixels. The higher the value, the
bigger the bitmaps. If a bitmap cannot be created, the text can be sent to the printer as curves.

This option applies to text that will be printed on a Postscript printer.
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To control bitmap conversion to grayscale
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Color Bitmap Output.
5. Choose Send Color Bitmaps As Grayscale or Send Color Bitmaps As Color.
Note

The default setting calls for color bitmaps to be reduced to grayscale if they are going to a grayscale 
device. Transmission time is much faster this way and the file size is smaller. If you switch this setting to Send As 
Color the device will do the conversion which results in slower transmission and a larger file size.

This option is available to PostScript devices only.
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To output color bitmaps in RGB
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Output Color Bitmaps in RGB.
Note

This option is available to PostScript devices only. 
Tip

PostScript output normally uses the CMYK color model. If outputting color bitmaps to an RGB or CMY 
device, enable the Output Color Bitmaps in RGB option. RGB devices will then receive ready-to-use RGB values 
(instead of CMYK). CMY devices will have an easier time translating RGB to CMY (3-color model to 3-color model) 
than CMYK to CMY (4-color model to 3-color model).
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To maintain OPI links
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Maintain OPI links.
Note

To use OPI links, you must enable the "Link to high resolution file for output using OPI" option when 
importing your TIFF (or CT) files. These TIFF (or CT) images become known as OPI images. When your service 
bureau receives your print file, the OPI server substitutes the high-resolution images for the low-resolution images. 
If there are no OPI images in your file, the Maintain OPI Links option will not be available at print time.

Maintain OPI links is enabled automatically if you import your bitmaps correctly.
This option is available to PostScript devices only.

Tip
To proof a file that contains OPI images on a device that doesn't have the high-resolution files (e.g., your 

desktop printer), disable the Maintain OPI Links option.
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To specify fountain steps
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Specify the number of steps to be used when rendering fountain fills.
Note

Fountain steps set from the Options dialog box only affect the way fountain fills display on your monitor. To 
control how they actually print, you must set the fountain steps on the Print Options page.

A low value will print faster but the transition between shades may be rather coarse, causing what is 
known as "banding". A higher value will result in a smoother blend but the printing times will be longer.

Tip
You can assign a custom fountain fill to one particular object. Select the object and 'open' the lock in the 

Fountain Fill dialog box (if the lock is closed then the number box is grayed out). Objects that are locked will print 
according to the number of steps assigned in the Print facilities. For example, you might want to set a high number 
of fountain steps for the one or two big objects in your drawing and leave the smaller items locked into the printer 
settings to be printed at a smaller step setting.
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To print a job information sheet
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Enable Print job information sheet.
5. (Optional) To customize this report, click Info Settings and indicate which categories of information are to be 

included. Also specify whether the job information is to be saved to a file or printed or both.
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To define special settings
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. Choose an option from the Special Settings group box.
5. Choose a new setting for it.
Note

In previous versions of Corel products, these options were only changed by editing the CORELPRN.INI file. 
This new feature in the Print Options dialog box allows you to customize these options directly from the Corel 
program.

This is a list of all of the special settings:
Bitmap Font Limit (PostScript only)
Bitmap Font Size Threshold (PostScript only)
Composite Crop Marks (PostScript only)
Conform to DSC (PostScript only) 
Grayscale Driver Bitmap Output (PostScript only) 

Overprint Black Threshold (PostScript only)
Postscript 2 Stroke Adjust (PostScript only)
Registration Mark Type (PostScript only)
Bitmap Printing
Drive Banding
Fill Clipping
Page Orientation Warning
Preview Image Default
Print Preview Drag Mode
Text Output Method
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To print bitmaps in small chunks
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Bitmap Printing.
5. Choose Output In 64K Chunks.
Note

This switch determines whether bitmaps are sent to non-PostScript printers all at once or in smaller blocks 
(below 64K). Usually, the driver tells the application which method it can or cannot handle. If you find that bitmaps 
do not print as expected, try forcing bitmaps to be output in a number of smaller blocks.

{button ,AL(`h_pt_controls;;;;;',0,"Defaultoverview",)} Related Topics



To assign control over printer bands
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Driver Banding.
5. Choose Let Driver Handle Banding (the printer driver creates the bands) or Send Bands to Driver (the Corel 

application splits the print job into bands before sending it to the printer driver).
Note

This option applies to non-PostScript printers only.
Tip

Some printers can't hold a full page in memory; therefore they must print the page in multiple passes, or 
"bands". The default setting lets the driver split the page into bands before sending them to the printer. If this 
proves too slow, or you encounter problems, request that Corel send the page to the driver already split into bands.
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To assign control over fill clipping
1. Click File, Print.
2. Click Options.
3. Click the Options tab.
4. From the Special Settings group box, choose Fill Clipping.
5. Choose Use Driver Clipping For Fills or Use Software Clipping For Fills.
Note

This option applies to non-PostScript printers only.
Tip

Any fill other than Uniform fill (including Lenses and PowerClips) requires clipping if the object is not 
rectangular. The default setting is clipping controlled by the driver, because that usually means faster processing. If 
you encounter a problem printing non-Uniform fills, switch to clipping controlled by the software.
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To print to a black and white desktop printer
1. Click File, Print.
2. Choose a printer and make sure its properties are set correctly.
3. Make sure the Printer color profile and the Print to file options are NOT selected.
4. Indicate which pages or objects to print.
5. Indicate how many copies you need and whether to collate them.
6. (Optional) Click Options.

If required, enable file information, page numbering and crop marks.
Enable Preview Image and adjust the size and position of your artwork.
Click OK.

Note
The above procedure applies to printing a black and white composite to a black and white desktop printer. 

If you are printing color separations to a black & white desktop printer, also set the appropriate options under the 
Separations tab.
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To print to a color desktop printer
1. Click File, Print.
2. Choose the printer and make sure its properties are set correctly.
3. Verify that the Print to file option is NOT selected.
4. Make sure the printer color profile that matches your printer is identified and enabled. If the profile identified is

not the correct one, go to Tools, Color Manager and select the appropriate profile. Enable the correct profile in 
the Print dialog box.

5. Indicate which pages or objects to print.
6. Indicate how many copies you need and whether to collate them.
7. (Optional) Click Options.

If required, enable file information, page numbering and crop marks.
Enable Preview Image and adjust the size and position of your artwork.
Click OK.

Note
The above procedure applies to printing a color composite to a color desktop printer. If you are printing 

color separations to a color desktop printer also set the appropriate options under the Separations tab.
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To print to a color press
1. Prepare your project.

It is crucial that you start off on the right foot. Make sure you understand the importance of color management
and color correction. Also, consult your service bureau and printing shop AT THE VERY BEGINNING of your 
project. They will provide you with invaluable information. Skipping this preparatory step can result in costly 
errors or omissions.
Once you have all the necessary information from your service bureau and printing shop, and your artwork is 
ready, you will need to create a "print file"(.PRN). This is the file you will send to your service bureau.
For a better understanding of what will happen to your file once you send it out, review the information about 
going to press (see related topics).
To begin creating the .PRN file, click File, Print.

2. Set up the basics of the print job.
Enable Print to File. (You will enter a name for the file later, at step 7.)
Choose the imagesetter driver specified by your service bureau.
Make sure the printer color profile that matches the above imagesetter is selected. If it isn't, go to File, Color 
Manager and select the appropriate profile.
Specify a print range.
Set the number of copies to 1.

3. Set up the printable page.
Click Options and enable Preview Image.
Adjust the size and position of your artwork, if required.
Set the bleed limit, if required.
Choose a layout style, if required.

4. Set up the reference tools (below the Preview box).
Set the printers' marks as specified by your service bureau: file information, crop marks, registration marks, 
calibration bar, and densitometer scale. 
Choose negative or positive film and emulsion up or down, according to your service bureau's specifications.

5. Set the advanced options (Options tab).
If required, adjust the number of fountain steps.
Set the screen frequency. You can fine-tune this setting at step 6, if required.
Click PostScript Preferences and set all options that apply.
(optional) Enable Print job information

6. Set the color separation parameters (Separations tab) if applicable.
Enabled Print Separations. Make sure the In Color option is NOT enabled.
If required, enable Convert Spot Colors to CMYK.
Choose all the color separations; indicate whether you want empty plates printed.
Customize your halftone screen, in consultation with your service bureau, if required.
Choose the appropriate trapping strategy, in consultation with your service bureau, if required.

7. Click OK. 
At the prompt, enter a name for your print file.

8. Send out, proof, and approve your job for printing.
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To print Object Data
1. In the Object Data Manager dialog box, click File, Print.
2. (Optional) To print only the highlighted range of cells, choose Selection for Page Range.



To print slides, notes, handouts, or an outline
1. Click File, Print.
2. Choose Slides, Notes, Handouts, or Outline from the Print box (lower left corner of the Print dialog box).



The printer icon is in the second column from the left. When it is not grayed out (as in the fourth row), the layer 
will print.



The Enlarge Print Preview button allows you to switch from a regular to a full-screen print preview and back 
again.



These two arrow buttons allow you flip through the pages of your document. They are located at the lower-right 
corner of the Preview box.



The File Information button allows you to print the filename, current date, and time (and tile number, if 
applicable) at the bottom of the sheet.
If applicable, color separation information (color, screen frequency and angle, plate number) is printed at the top
of the sheet.



The Crop Mark button allows you to print crop marks. These marks are used as alignment aids when trimming 
the printed output down to its final size.



The Registration mark button allows you to print registration marks on each sheet. These marks serve as guides 
for aligning color separations.



The Page Number button allows you to place page numbers on the printed sheets.



The Calibration bar button allows you to print a bar of the six basic colors (red, green, blue; cyan, magenta, 
yellow) beside your artwork. These color patches are used to verify the quality of the printed output.



The Densitometer Scale button allows you to print a Densitometer Scale, a bar of varying shades of gray, on 
each separation sheet. This is an advanced feature that allows you to check the accuracy, quality, and 
consistency of the output with an instrument called a densitometer.



The Negative button allows you to print a negative image.



The Emulsion Down button allows you to specify that the film emulsion faces down.





These controls let you specify the number of rows and columns of labels you want to appear on each sheet.



The available corner styles.



The available line cap styles.



These controls let you change the nib shape and angle to create calligraphic effects.



These controls specify the size of each label on the sheet.



These controls change the margins of a sheet of labels.    



These controls change the distance between labels in a sheet.



The number of pages on each sheet of paper. Some layout styles have more than one page per sheet.



The width of the text on each page.



The width of the text on each page.



The type of fold or cut used in the specified layout style.



The height of the text on each page.



The height of the text on each page.



The label type.



Displays controls for choosing and editing fountain fills.



Displays controls for choosing and editing two-color bitmap pattern fills.



Displays controls for choosing full-color bitmap pattern fills.



Displays controls for choosing texture fills.



Displays controls for choosing vector pattern fills.



Displays controls for choosing PostScript texture fills.



Displays controls for choosing uniform color fills.



Displays a pair of boxes inside the selected object for scaling and offsetting tiles.
Drag the left box to offset the first tile.
Drag the node along the bottom edge of the boxes to scale the tiles. Hold down the CTRL key as you drag 

to maintain the pattern's aspect.
Drag the right box down to offset alternating columns of tiles.
Drag the right box down and to the left to offset alternating rows of tiles.



Prompts you to choose an existing object, and displays that object's fill attributes in the Fill Roll-up. You can then 
easily apply the same fill to other objects.



Opens a dialog box where you can further refine your fill properties. 



Applies your fill to the selected objects. If no objects are selected, you can define the default fill for new objects.



Opens a flyout from which you can choose a new foreground color.



Opens a flyout from which you can choose a new background color.



Changes the foreground color to one you select from a palette.



Changes the background color to one you select from a palette.



Displays a linear fountain in the Preview box. 
To change the angle of the linear fountain, click in the preview box. Hold down the CTRL key to constrain the 
angle to multiples of 15 degrees.



Displays a radial fountain in the Preview box. 
To move the center of a radial fountain, click in the preview box. Hold down the CTRL key to constrain your 
movements to 10-percent increments.



Displays a conical fountain in the Preview box. 
To move the center of a conical fountain, left-click in the preview box. Hold down the CTRL key to constrain

your movements to 10-percent increments. 
To change the angle of a conical fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Displays a square fountain in the Preview box. 
To move the center of a square fountain, left-click in the preview box. Hold down the CTRL key to constrain 

your movements to 10-percent increments. 
To change the angle of a square fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Shows the current texture library. Click in this field to get a drop-down list of available texture libraries.



Shows the name of the current texture. Click in this field to get a drop-down list of the textures in this library.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Lists the available textures by name. Click on a name, or use the scroll bars to see the entire list.
Each name represents a special type of pattern fill which will only print on a PostScript printer. In the Drawing 
Window, PostScript textures are represented by the letters PS instead of the actual pattern.



Changes the current color. Click the color you want, or use the scroll bars to see more of the palette.



Displays the current color.



Opens a box with a selection of arrowheads you can apply to the start of an open path. 
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Opens a box with a selection of arrowheads you can apply to the end of an open path. 
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a selection of dashed and dotted line styles.
Use the scroll bars to see other styles in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a palette of outline colors. Use the scroll bars to see other colors in the list. Click the one you want.



Opens the Outline Pen dialog box where you can access all of the available Outline Pen controls.



Applies your choices to the selected objects. If no objects are selected, you can define the default outline for new
objects.



Displays the current thickness of the outline. To change the width, enter a new value, or click the arrow buttons.



Specifies whether the outline is placed behind or in front of the object's fill. When placed behind, only half the 
outline's thickness will be visible. This option is particularly useful for outlined text.



Specifies whether the outline thickness and nib orientation remain the same or change in proportion to the 
object.
If enabled, the outline thickness increases when the object is enlarged (by scaling or stretching) and decreases 
when the object is made smaller. If the object is rotated, the nib shape also changes accordingly.



Toggles the current outline on and off. If the button is depressed, the object will have no outline.



Displays controls for choosing and editing fountain fills.



Displays controls for choosing and editing two-color bitmap pattern fills.



Displays controls for choosing full-color bitmap pattern fills.



Displays controls for choosing texture fills.



Displays controls for choosing vector pattern fills.



Displays a pair of boxes inside the selected object for scaling and offsetting tiles.
Drag the left box to offset the first tile.
Drag the node along the bottom edge of the boxes to scale the tiles. Hold down the CTRL key as you drag 

to maintain the pattern's aspect.
Drag the right box down to offset alternating columns of tiles.
Drag the right box down and to the left to offset alternating rows of tiles.



Prompts you to choose an existing object, and displays that object's fill attributes in the Fill Roll-up. You can then 
easily apply the same fill to other objects.



Opens a dialog box where you can further refine your fill properties. 



Applies your fill to the selected objects. If no objects are selected, you can define the default fill for new objects.



Previews the current fill.



Opens a flyout from which you can choose a new starting color.



Opens a flyout from which you can choose a new ending color.



Opens a flyout from which you can choose a new foreground color.



Opens a flyout from which you can choose a new background color.



Displays a linear fountain in the Preview box. 
To change the angle of the linear fountain, click in the preview box. Hold down the CTRL key to constrain the 
angle to multiples of 15 degrees.



Displays a radial fountain in the Preview box. 
To move the center of a radial fountain, click in the preview box. Hold down the CTRL key to constrain your 
movements to 10-percent increments.



Displays a conical fountain in the Preview box. 
To move the center of a conical fountain, left-click in the preview box. Hold down the CTRL key to constrain

your movements to 10-percent increments. 
To change the angle of a conical fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Displays a square fountain in the Preview box. 
To move the center of a square fountain, left-click in the preview box. Hold down the CTRL key to constrain 

your movements to 10-percent increments. 
To change the angle of a square fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Previews the current pattern. Click the preview box to display a list of available patterns.



Opens the Load dialog box, where you can load a new vector pattern file.



These controls let you choose the foreground and background colors of your pattern.



Opens a flyout from which you can choose a new background color.



Opens a flyout from which you can choose a new background color.



Opens a flyout from which you can choose a new foreground color.



Opens a flyout from which you can choose a new foreground color.



Opens the PostScript Options Dialog Box, where you can adjust the halftone screen settings for spot colors. This 
button is only active when there is a spot color selected for both the background and foreground.



Opens the Two-Color Pattern Editor, where you can create your own two-color patterns.



Opens the Import dialog box, where you can import a graphic to use as your pattern.



Permanently removes the current pattern from the pattern list.



Reveals controls for editing the pattern's tiling properties.



Sets the size of your pattern tiles. You can choose one of the pre-set sizes, or enter custom dimensions.



Sets the tile size to 0.25 x 0.25 inches, or to 25% if Scale pattern with object is enabled.



Sets the tile size to 0.50 x 0.50 inches, or to 50% if Scale pattern with object is enabled.



Sets the tile size to 1.00 x 1.00 inches, or to 100% if Scale pattern with object is enabled.



The width of each tile. You can specify new tile widths from 0.1 to 15 inches.



The width of each tile.



Displays the units you are using to measure the tile width. Click in this field to display a list of available units. 
The Width value is automatically converted when you change units.



The height    of each tile. You can specify new tile heights from 0.1 to 15 inches.



The height    of each tile.



Displays the units you are using to measure the tile height. Click in this field to display a list of available units. 
The Height value is automatically converted when you change units.



Sets the offset of the first tile (and therefor, the rest of the pattern) relative to the top right-hand corner of the 
object. If you want the pattern to start flush with the corner, set these two values to zero.



Sets the horizontal position of the first pattern tile relative to the left side of the object.



Sets the horizontal position of the first pattern tile relative to the left side of the object.



Sets the horizontal position of the first pattern tile relative to the left side of the object.



Sets the vertical position of the first pattern tile relative to the top of the object.



Sets the vertical position of the first pattern tile relative to the top of the object.



Sets the vertical position of the first pattern tile relative to the top of the object.



Shifts rows or columns of tiles so that the pattern is staggered, rather than continuous.



Shifts alternating rows of tiles by the amount specified.



Shifts alternating columns of tiles by the amount specified.



Shifts alternating rows or columns by the amount specified.



Shifts alternating rows or columns by the amount specified.



Shifts alternating rows or columns by the amount specified.



Alters the pattern tiles so that they seem to be continuous.



Toggles between absolute and proportional tile sizes. When the option is enabled, the tiles will grow and shrink 
with the object.



The width of each tile. You can specify widths from 5 to 500% of the object width.



The width of each tile. You can specify widths from 5 to 500% of the object width.



The height of each tile. You can specify heights from 5 to 500% of the object height.



The height of each tile. You can specify heights from 5 to 500% of the object height.



Displays a magnified, editable image of your pattern as you draw it. Left-click to add a colored area to the grid, 
right-click to erase.



Changes the resolution of the Edit Grid to 16 x 16 squares. You lose all pattern edits when you change 
resolutions.



Changes the resolution of the Edit Grid to 32 x 32 squares. You lose all pattern edits when you change 
resolutions.



Changes the resolution of the Edit Grid to 64 x 64 squares. You lose all pattern edits when you change 
resolutions.



Changes the pen size to 1 grid square.



Changes the pen size to a 2 x 2 square.



Changes the pen size to a 4 x 4 square.



Changes the pen size to an 8 x 8 square.



Shows the current texture library. Click in this field to get a drop-down list of available texture libraries.



Shows the name of the current texture. Click in this field to get a drop-down list of the textures in this library.



Displays the current fountain fill type. Click in this field to choose one of the four fountain fill types.
A Linear fountain fill changes color in one direction. A Radial fountain fill changes color in concentric circles from 
the center of the object outwards. A Conical fountain fill radiates from the center of the object like rays of light. A
Square fountain fill changes color in concentric squares from the center of the object outwards.



Repositions the center of a radial, conical, or square fountain fill so that it no longer coincides with the center of 
the object. Negative values shift to the left, positive values shift to the right.



Repositions the center of a radial, conical, or square fountain fill so that it no longer coincides with the center of 
the object. Negative values shift the center down, positive values shift it up.



Changes the angle of linear, conical, and square fountain fills. Positive values rotate the fill counter-clockwise, 
negative values rotate it clockwise.



Changes the number of bands used to display and print the fountain fill. For a smoother gradation, increase the 
number of steps. 



Toggles the lock on the Steps box.



Increases the amount of From and To color in your fountain fill. The ends of a fountain fill will often be obscured 
by the edges of circular and irregular objects. Padding the edges will allow more of the end colors to show.
The Edge Pad option is not available for conical fills.



Previews the selected fountain fill.
You can change the fill's orientation by dragging the pointer in the preview box. Left-click to move the center of 
radial, conical and square fills. Right-click to change the angle of linear, conical, and square fills. Holding down 
the CTRL key while dragging constrains your adjustments to regular increments.



These controls let you modify the intermediate colors of your fill.



Determines the intermediate fill colors from a straight line beginning at the From color and continuing across the 
color wheel to the To color.
This option produces a color series composed of blends of your From and To colors.



Opens a flyout from which you can choose a starting color for your fill.



Opens a flyout from which you can choose an ending color for your fill.



Displays controls to set the starting and ending colors of your fill, and the color wheel path that the 
intermediated colors follow. You can create a direct blend containing only two colors, or a multi-colored rainbow 
blend.



Determines the intermediate colors from a counter-clockwise path around the color wheel.



Determines the intermediate colors from a clockwise path around the color wheel.



Shows the color path that determines your intermediate fill colors.



Adjusts the midpoint of the color blend.



Displays controls that let you manually determine the intermediate colors of your fountain fill. You can add up to 
99 color markers to control your blend.



Shows the position of the current color marker. You can change a marker's position by editing its position value.



Opens a flyout from which you can change the current color.



Changes the current color. Click the color you want, or use the scroll bars to see more of the palette.



Previews your custom fountain fill. You can add, remove, or edit color markers by clicking in the marker bar just 
above the preview ribbon.



Previews your custom fountain fill. You can add, remove, or edit color markers by clicking in the marker bar just 
above the preview ribbon.



Shows the positions of your color markers. Each triangle marks a peak of color in your fountain fill. Once you 
have selected a color marker by clicking it, you can change its color with the on-screen palette.
You reposition a peak by dragging it along the marker bar, and you delete it by double-clicking. You can add a 
new peak by double-clicking a blank spot on the bar.



Displays a list of pregenerated fountain fills. You can save a modified fill by typing a name in this field and 
clicking on the add button.



Saves the current fountain fill. If you have created the fill from scratch, you must first type a name in the Presets 
field.



Deletes the selected fill from the Presets list.



Opens the PostScript Options Dialog Box, where you can adjust the halftone screen settings for spot colors.



Shows the current texture library. Click in this field to get a drop-down list of available texture libraries.



Opens the Save Texture As dialog box, where you can add a new texture to one of your libraries, or overwrite an 
existing texture with the current one.
You cannot overwrite textures in the Style Library, but you can modify them and then save the modified textures 
in other libraries.



Deletes the selected texture. You can delete textures from any Library except the Styles library.



Shows a list of the textures in the current texture library. Click on the texture you want, or use the scrollbars to 
see the entire list.



Displays a preview of the texture with the current parameters. Click the Preview button to update the preview 
after making changes to the texture parameters.



Updates the texture preview to reflect any changes to the texture parameters.
If you have not made any changes, the Preview button varies the selected texture by randomly changing all 
unlocked parameters. Click a parameter's Lock icon to lock or unlock it.



Opens the Texture Options dialog box where you can set the resolution and maximum tile width of your texture 
fill.



Lists parameters for the current texture. Changing one or more of these parameters alters the appearance of the
texture. 
To see the effect of your changes to the texture parameters, click the Preview button. If you have not made any 
changes since the last time you updated the preview, clicking the Preview button randomizes all unlocked 
parameters. Click a parameter's Lock icon to lock or unlock it.



Lists parameters for the current texture. Changing one or more of these parameters alters the appearance of the
texture. 
To see the effect of your changes to the texture parameters, click the Preview button. If you have not made any 
changes since the last time you updated the preview, clicking the Preview button randomizes all unlocked 
parameters. Click a parameter's Lock icon to lock or unlock it.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



The name of your texture. It can be up to 32 characters long, including spaces.
You cannot save new textures or overwrite existing textures in the Style Library.



The name of the library where you want to store your texture. It can be up to 32 characters long, including 
spaces. 
You cannot save new textures or overwrite existing textures in the Style Library.



Sets the resolution at which your pattern will print.



Sets the maximum width of your pattern at full resolution. Larger tile widths take more memory to draw.



The amount of memory your bitmap will use at its maximum tile width. Reduce the Maximum Tile Width value to 
conserve memory.



Returns the texture options to their default settings.



Opens a flyout from which you can choose a new color.



These controls let you add arrowheads and other line-ending shapes to the ends of lines (open paths). 



Opens a flyout containing a list of arrowheads and symbols you can apply to the beginning of a line. Use the 
scroll bars to see other arrowheads in the list. Click the one you want. To close the flyout without making a 
selection, press the ESC key.
To find out which terminus of a line is the beginning, select the line with the Shape Tool and press the HOME key.



Opens a flyout containing a list of arrowheads and symbols you can apply to the end of a line. Use the scroll bars
to see other arrowheads in the list. Click the one you want. To close the box without making a selection, press 
the ESC key.
To find out which terminus of a line is the end, select the line with the Shape Tool and press the END key.



Opens a menu of options that you can apply to the start of the line. 
The None option removes the current arrowhead from your line.
The Swap option moves the arrowhead to the other end of the line.
The Edit option opens the Arrowhead Editor, where you can change the size, Placement , and general 

shape of the arrowhead.
The Delete option deletes the current arrowhead.



Opens a menu of options that you can apply to the end of the line. 
The None option removes the current arrowhead from your line.
The Swap option moves the arrowhead to the other end of the line.
The Edit option opens the Arrowhead Editor, where you can change the size, Placement , and general 

shape of the arrowhead.
The Delete option deletes the current arrowhead.



Displays the current thickness of the outline. To change the width, enter a new value, or click the arrow buttons.



Displays the current thickness of the outline. To change the width, enter a new value, or click the arrow buttons.



Displays the units you are using to measure the line width. Click in this field to display a list of units. The width 
value is automatically converted when you change units.



Opens a flyout containing a list of dashed styles that you can apply to your line. Use the scroll bars to see other 
line styles in the list. Click the one you want. To close the flyout without making a selection, press the ESC key
You can create dotted lines by applying round Line Caps to a line style with short, widely-spaced dashes.



Draws mitered (pointed) corners for polygons, and selects a square nib shape.



Draws rounded corners for polygons, and selects a round nib shape.



Draws blunted corners for polygons, and selects a square nib shape.



Truncates the line at each endpoint.



Draws round caps extending beyond the ends of the line.



Draws square caps extending beyond the ends of the line.



Previews the shape and orientation of the nib, showing the effects of varying Angle and Stretch. You can also 
change the shape of the nib by dragging in the preview box. 



Previews the shape and orientation of the nib, showing the effects of varying Angle and Stretch. You can also 
change the shape of the nib by dragging in the preview box. 



Changes the width of the nib. A square nib has a stretch value of 100%; smaller values will make the nib 
narrower, creating a calligraphy effect.



Changes the width of the nib. A square nib has a stretch value of 100%; smaller values will make the nib 
narrower, creating a calligraphy effect.



Changes the width of the nib. A square nib has a stretch value of 100%; smaller values will make the nib 
narrower, creating a calligraphy effect.



Varies the angle of the nib, creating a calligraphy effect.



Varies the angle of the nib, creating a calligraphy effect.



Varies the angle of the nib, creating a calligraphy effect.



Resets the Angle value to 0.0 degrees and the Stretch value to 100%.



Specifies whether the outline is placed behind or in front of the object's fill. When placed behind, only half the 
outline's thickness will be visible. This option is particularly useful for outlined text.



Specifies whether the outline thickness and nib orientation remain the same or change in proportion to the 
object. 
If enabled, the outline thickness increases when the object is enlarged (by scaling or stretching) and decreases 
when the object is made smaller. If the object is rotated, the nib shape also changes accordingly.



Displays a magnified, editable image of your arrowhead. You can stretch the arrowhead with the solid markers, 
and move it with the hollow markers.



Displays a magnified, editable image of your arrowhead. You can stretch the arrowhead with the solid markers, 
and move it with the hollow markers.



Flips the arrowhead horizontally.



Flips the arrowhead vertically.



Centers the arrowhead horizontally with respect to the X marker.



Centers the arrowhead vertically with respect to the X marker.



Magnifies the arrowhead by a factor of four. Helpful when positioning the arrowhead.



Selects a line thickness. Each click on the scroll arrows changes the thickness by .01 inches. Scroll down 
repeatedly for the Hairline or No Outline options.



Selects a line thickness from .001 to 0.5 inches. Each click on the scroll arrows changes the thickness by .01 
inches. Scroll down repeatedly for the Hairline or No Outline options.



Opens a box with a selection of arrowheads you can apply to the ends of open paths. The left and right selectors 
let you choose different arrowheads for both ends of the path.
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Opens a box with a selection of arrowheads you can apply to the ends of open paths. The left and right selectors 
let you choose different arrowheads for both ends of the path.
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a selection of dashed and dotted line styles.
Use the scroll bars to see other styles in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a palette of outline colors. Use the scroll bars to see other colors in the list. Click the one you want.



Prompts you to choose an existing object, and displays that object's outline attributes in the roll-up. You can then
easily apply the same outline to other objects.



Opens the Outline Pen dialog box where you can access all of the available Outline Pen controls.



Applies your choices to the selected objects. If no objects are selected, you can define the default outline for new
objects.



Swaps the height and width values so that the vertical dimension of the page is greater than the horizontal 
dimension. This switch is not available with paper styles that have fixed orientations, such as labels and 
envelopes.



Swaps the height and width values so that the horizontal dimension of the page is greater than the vertical 
dimension. This switch is not available with paper styles that have fixed orientations, such as labels and 
envelopes.



The current paper style. Click in this field to get a list of available paper styles. When you select a style, the 
height and width values will adjust to reflect the paper you are using.
Use the Custom style to manually determine the size of your page. Use the Labels style to create your own 
labels.



The width of the page. When you modify this value, the paper style is automatically set to Custom.



The height of the page. When you modify this value, the paper style is automatically set to Custom.



Displays the units you are using to measure the page size. Click in this field to display a list of available units. 
The Height and Width values are automatically converted when you change units.



Queries the current printer for the page size and orientation, and displays those dimensions in the Width and 
Height fields.



Previews the page dimensions and orientation, and shows examples of the page layout you have selected.



Previews the page dimensions and orientation, and shows examples of the page layout you have selected.



Toggles the working page border in the Drawing Window. When you disable this option, the shadowed page 
outline is no longer displayed in the Drawing Window.
Note that any part of your drawing that falls outside the border will not be printed, so it's a good idea to make 
sure this option is enabled before printing.



Displays two facing pages at the same time in the Drawing Window. 
When this option is enabled, and your document has multiple pages, individual objects can lie across two facing 
pages. Such objects will not print in the page gutter.
This option is not available for top-fold and tent cards.



Indicates whether you want to begin a document with facing pages on the left or right page. This option is only 
available when using the Book layout style or the Facing Pages option.



Puts a printable background frame the same size as the page on the screen. The frame will have the default fill 
and outline, and you can change it the same way as you would any other object.



Opens a flyout that lets you color the Preview screen to approximate the paper you plan to print on. 
The color you choose is for viewing and information only; it does not print. If you want a color background that 
does print, choose Add Page Frame.



Displays the current page layout style. Click in this field to get a list of available styles. When you choose a style 
from the list, an example of it appears in the preview box above.
Once you've chosen a page layout style, you still need to insert the required number of pages for the particular 
style. For example, Side-Fold Card prints four pages per sheet, however, when you start a new drawing and 
choose this style, you still need to insert the three remaining pages.
Note that the layout styles in the Print Options Dialog Box will not work properly unless the Full Page Layout is 
selected here. Any other combination will have unpredictable results.



Opens the Customize Label dialog box, where you can modify an existing label style, or create your own labels 
from scratch.



Shows the available label styles, grouped by manufacturer.



Saves the current custom label setting under a name you specify.



Automatically adjusts the margins to evenly space the labels on the page.



Automatically equalizes the space between labels. If possible, auto spacing will keep the labels within the 
defined margins.



Adjusts the bottom page margin.



Adjusts the number of label columns.



Removes the current label style from the Label Style list.



Automatically sets the right margin to mirror the left, and the bottom margin to mirror the top.



Adjusts the height of each label.



Adjusts the horizontal space between labels.



Sets the Gutter units. When you choose a new unit, the values are automatically recalculated.



Adjusts the left page margin.



Sets the Margin units. When you choose a new unit, the values are automatically recalculated.



Previews the current label settings.



Adjusts the right page margin.



Toggles the label corners from square to rounded.



Adjusts the number of label rows.



Shows the name of the current label style.



Adjusts the top page margin.



Adjusts the vertical space between labels.



Adjusts the width of each label.



Sets the Label Size units. When you choose a new unit, the values are automatically recalculated.



The name of the new custom label style.



Three unique PHOTO-PAINT controls in the Full-Color Bmp Pattern DB



Enable to use the original (default) tile size of the currently selected bitmap pattern.



Enable to scale the tile pattern to fit entirely within the tile Preview window.



Enable to maintain identical tile width and height values. When enabled, any value entered in one number box 
will cause the other box to change automatically.





Lists the available textures by name. Click a texture, or use the scroll bars to see the entire list.
Note

In the Drawing Window, PostScript textures are represented by the letters PS instead of the actual pattern.



The current texture. Enable Preview fill to preview the texture, and click Refresh to regenerate the texture after 
changing the parameters.
Note

Some textures are extremely complicated and require several minutes or more to generate. In the Drawing
Window, PostScript textures are represented by the letters PS instead of the actual pattern.



Toggles the PostScript texture preview.
Note

Some textures are extremely complicated and require several minutes or more to generate.



Regenerates the texture preview with the current parameters.
Note

Some textures are extremely complicated and require several minutes or more to generate.



Lists parameters for the current texture. Changing one or more of these parameters alters the appearance of the
texture. To see the effect of your changes to the texture parameters, enable Preview fill and click the Refresh 
button.





Saves the current custom label setting under a name you specify.



Removes the current label style from the Label Style list.



Displays controls for choosing texture fills.



Opens the Save Texture As dialog box, where you can add a new texture to one of your libraries, or overwrite an 
existing texture with the current one.



Deletes the selected texture. 



Locks and unlocks the parameter.



Determines the intermediate colors from a counter-clockwise path around the color wheel.



Determines the intermediate colors from a clockwise path around the color wheel.



Displays a linear fountain in the roll-up's Preview box. 



Displays a radial fountain in the roll-up's Preview box. 



Displays a conical fountain in the roll-up's Preview box. 



Displays a square fountain in the roll-up's Preview box. 



Opens a flyout from which you can choose colors. Click More to open the Color dialog box.



Previews your custom fountain fill. You can add, remove, or edit color markers by clicking in the marker bar just 
above the preview ribbon.



Adjusts the midpoint of the color blend.



Shows the color path that determines your intermediate fill colors.



Determines the intermediate fill colors from a straight line beginning at the From color and continuing across the 
color wheel to the To color.



Removes the current fill or outline color. 



Lets you adjust the tiling in the current object.



Opens the Fill Tool flyout.



Opens the Special Fill Roll-Up.



Displays controls for editing fountain fills.



Displays controls for choosing full-color bitmap pattern fills.



Displays controls for choosing vector pattern fills.



Displays controls for choosing two-color bitmap pattern fills.



Opens the PostScript Texture dialog box.



Deletes the fill of the current object, leaving it transparent.



Fills the current object with solid black.



Fills the current object with solid white.



Opens the Color Roll-Up.



Opens the Fill Color dialog box.



Opens the Outline Tool flyout.



Applies a hairline (0.25-point) outline to the current object.



Applies a thin (2-point) outline to the current object.



Applies a medium (8-point) outline to the current object.



Applies a medium-thick (16-point) outline to the current object.



Applies a thick (24-point) outline to the current object.



Opens the Pen Roll-Up.



Opens the Outline Pen dialog box.



Opens the Outline Color dialog box.



Applies a solid black outline to the current object.



Applies a solid white outline to the current object.



Removes the outline from the current object.



Opens a flyout where you can choose from a variety of line styles. Press the ESC key to exit without making a 
selection.



Rounds off the ends of each line segment so that it appears to be dotted.



Determines the corner shape, and, therefore, the nib shape of the outline.



Opens a flyout where you can choose from a variety of line -ending shapes. Press the ESC key to exit without 
making a selection.



The nodes marked in red stretch the arrowhead in one direction.



The nodes marked in red scale the arrowhead evenly.



The nodes marked in red move the arrowhead without changing its size or shape.



To import a file into PRESENTS
1. Click File, Import.
2. Choose the drive and folder in the Look in list box. 
3. Choose the type of file to import from the Files of type list box.
4. Type the name of an existing file in the File Name box.
5. Choose Full Image from the list box.
6. Click the Options button.
7. Enable the New Slides, Current Slide or Background radio button, to select where the imported image will 

appear.
8. Click Import.

{button ,AL(`import_files_proc;;;;;',0,"Defaultoverview",)} Related Topics



To import a cropped bitmap
1. Click File, Import.
2. Choose the file to import.
3. Choose Crop from the list box.
4. Click Import.

The Crop Image dialog box appears.
5. Resize the bounding box by dragging the handles with the mouse, or enter exact values for the top left corner 

and the dimensions of the bounding box.
The image size indicator is updated as you resize the image.

6. Click OK.

{button ,AL(`import_files_proc;;;;;',0,"Defaultoverview",)} Related Topics



To import a resampled bitmap
1. Click File, Import.
2. Choose the file to import.
3. Choose Resample from the list box.
4. Click Import.

The Resample Image dialog box appears.
5. Use one of the following methods to resample the image:

Assign specific values for Width or Height.
Indicate percentages for Width or Height.
Change the Horizontal or Vertical resolution.

The aspect ratio is always maintained. The image size indicator is updated as you resize the image.
6. Click OK.

{button ,AL(`import_files_proc;;;;;',0,"Defaultoverview",)} Related Topics



To round the corners of a rectangle or square
1. Select the rectangle or square with the Shape tool.
2. Click and drag one of the corner nodes along the outline of the rectangle or square.

As you drag, the four corner nodes each divide into two nodes with a round corner forming in between. As you 
continue to drag, the corners become increasingly round.

3. Release the mouse button when the rectangle/square is shaped the way you want.
Note

The amount of rounding (the corner radius) is displayed on the Status Line.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To convert an ellipse or circle into an arc or pie wedge
1. Select the ellipse or circle with the Shape tool.
2. Drag the node at the top or bottom of the ellipse or circle around the outside to create an arc, or around the 

inside to create a pie wedge.
As you drag, the node divides into two nodes with the arc or pie wedge forming in between.

3. Continue dragging until the arc or pie wedge is the shape and size you want.
Note

 The Status Line shows the position of the two nodes and the distance (the total angle) between them in 
degrees.

If you are creating the arc or pie wedge from an ellipse, the word "distorted" appears after the total angle. 
This means, for example, that a 45-degree angle will be an eighth of the way around the ellipse rather than actually
being at 45 degrees.

Holding down the CTRL key as you drag the arc or pie wedge constrains the movement to 15-degree 
increments.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To mirror edit objects created with the Polygon tool
1. Select the object created with the Polygon tool using the Shape tool.
2. Mirror edit the object using the features of the Shape tool and Node Edit Roll-Up.
Note

You cannot mirror edit an object if it has been converted to curves.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To convert an object to a curve object
1. Select the object.
2. Click Arrange, Convert To Curves.
Note

The object looks the same, but it is now a curve object that you can reshape by manipulating its nodes and
control points with the Shape tool.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To select the first or end node in a curve object
1. Select the curve object with the Shape tool.
2. Press HOME to select the first node and END to select the end node.
Note

On a closed curve, the first and last nodes are the same.
In an object with subpaths, HOME selects the first node of the first object and END selects the last node of 

the last object.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To select a single node or segment on a curve object
Click the node or segment with the Shape tool.

Note
 Selected nodes becomes highlighted in one of two ways: hollow if the associated segment is a line; solid if

it's a curve.
If the node is on a curve, control points extending from the selected node and those on either side of it 

appear.
The Status Line shows the type of node (smooth, cusped or symmetrical) and segment (line or curve).
If you click the segment, a dot appears.
Once you select a node or segment, you can change its characteristics by applying commands from the 

Node Edit Roll-Up. You can also move a selected node and its associated control points.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To select multiple nodes
 Hold down SHIFT and click the nodes you want to select.

Note
You can also drag a marquee box around the nodes to select them.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To deselect one or more nodes
Hold down SHIFT and click the nodes you want to deselect.

Note
You can also hold down SHIFT and drag a marquee box around the nodes you want to deselect. This 

method also selects any nodes inside the marquee box that are not selected.
To deselect all of the nodes, click any white space away from the outline of the curve.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To shape a curve object by moving its segments
1. Select the curve object with the Shape tool.
2. Click and drag the segment.
Note

You cannot move line segments in this fashion.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To shape a curve object by moving its nodes
1. Select the curve object with the Shape tool.
2. Click and drag a node.
Note

As you drag, the segments on either side of the node move. If the node is on a curved segment, the 
control points also move so that the angles at which the curve enters and leaves the node remain unchanged.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To shape a curve object by moving several nodes at once
1. Select the curve object with the Shape tool.
2. Hold down SHIFT and click the nodes you want to select.
3. Enable Elastic Mode (optional).
4. Click and drag any of the selected nodes.
Note

Elastic Mode changes the way several nodes move when dragged with the mouse. If left unchecked, all 
nodes move by the same amount. When checked, nodes move in proportion to their distance from the base node 
(i.e., the node you are dragging). The end result is that the curve appears to behave like an elastic, expanding and 
contracting in response to the movement of the mouse.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To shape a curve object by moving its control points
1. Select the curve object with the Shape tool.
2. Click the node you want to manipulate.
3. Click and drag the control points.
Note

Control points only extend from the selected node and those on either side of it if the node is on a curved 
segment.

 The control points move differently depending on whether the node they are associated with is smooth, 
cusped or symmetrical. This, in turn, affects the shape of the curve.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To constrain the movement of a node or control point
Pressing CTRL while dragging forces the node or control point to move horizontally or vertically from its 

starting point.

{button ,AL(`shape_proc_basic;;;;;',0,"Defaultoverview",)} Related Topics



To add a single node to a curve object
1. Select the curve object with the Shape tool.
2. Click the spot along the curve where you want the node added.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Click the Add Node button.
Note

If you clicked a node, the new node appears midway along the adjacent segment.
Adding more nodes to a curve  is useful when you are shaping a curve object, especially if the existing 

segments, and control points are not giving you the results you want.

{button ,AL(`shape_proc;;;;;',0,"Defaultoverview",)} Related Topics



To add several nodes at once to a curve object
1. Select the curve object with the Shape tool.
2. Select the nodes between which you want further nodes added.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Click the Add Node button.

{button ,AL(`shape_proc;;;;;',0,"Defaultoverview",)} Related Topics



To delete a node or segment from a curve object
1. Select the curve object with the Shape tool.
2. Click the node you want to delete.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Click the Remove Node button.
Note

The position of the deleted node determines the change in the curve's shape.
Tips

Deleting closely bunched nodes and segments helps to simplify complex curve objects. You can also delete
them to smooth unwanted bumps along a curve. 

You can delete several nodes at once by selecting multiple nodes.
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To simplify a curve object using Auto-reduce
1. Select the curve object with the Shape tool.
2. Select all the nodes in the portion of the object that you want to simplify.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Click the Auto-reduce button.

Note
The Auto-reduce setting on the Node Edit tools property sheet controls the extent to which the curve's 

shape changes when nodes are removed.
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To break a path
1. Select the curve object with the Shape tool.
2. Click the spot where you want to break the path.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Click the Break Path button.
Note

When you break a path, any subpaths and nodes that are created remain a part of the original curved 
object.

Two superimposed nodes appear at each break.
To break the path at several nodes at once, select all of the nodes.
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To change curve or a segment to a line
1. Click the curve object with the Shape tool.
2. Click the segment you want to change.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Click the To Line button or the To Curve button.
Note

If you chose To Line, the curve segment redraws as a straight line.
If you chose To Curve, the line segment appears unchanged. However, if you select a node at either end of 

the segment, control points appear, indicating that it is now a curve.
You can also change a segment to a curve or line by selecting a node on the end of the segment.
To change several segments at once, select them or their associated nodes.

{button ,AL(`shape_proc;;;;;',0,"Defaultoverview",)} Related Topics



To determine whether you need to add or delete nodes
A curve requires more nodes if you cannot shape it the way you want by moving the existing nodes. You need to 
delete nodes to remove unwanted dips or bumps associated with them.
There are three rules of thumb for determining whether you need to add or delete nodes on a curve.

For curves moving
in one direction, 
you need a node 
every 120 
degrees.
 For curves 
changing direction
smoothly, you 
need a node for at
least every two 
points at which 
the curve changes
direction.

 For curves 
changing direction
at a cusp (pointed
corner) you need 
a node at every 
cusp.
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To join two nodes
1. Select the curve object with the Shape tool.
2. Select the nodes you want to join.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Click the Join button.
Note

You cannot join nodes of two separate objects. You must first combine the objects with the Combine 
command in the Arrange menu.

If you join nodes that are not in the same place, the new node is placed in the middle.
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To make a node smooth, cusped or symmetrical
1. Select the curve object with the Shape tool.
2. Click the node you want to change.
3. Double-click a node or segment to open the Node Edit Roll-Up.
4. Choose Smooth, Cusp or Symmetrical.
Note

Unless the curve passed through the node on a fairly sharp angle, changing the node's type will not 
noticeably affect its shape. It will, however, affect the way in which you can reshape the curve by adjusting the 
node's control points.

Tip
You can change several nodes at once, select them by dragging a marquee box around them or by holding 

down SHIFT and clicking them.

{button ,AL(`shape_proc;;;;;',0,"Defaultoverview",)} Related Topics



To move a control point hidden under a node
1. Deselect all nodes on the curve object.
2. Hold down SHIFT and click and drag the control point out from under the node.
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The Add Node button allows you to add nodes to a path.



The Remove Node button allows you to remove nodes from path.



The Auto-reduce button allows you to automatically reduce the number of nodes on a path.



The Align button allows you to align selected nodes.



The Break button allows you break a path. Two unconnected nodes will appear at the break.



The To Line button allows you to convert curve segments to line segments.



The To Curve button allows you to convert line segments to curve segments.



The Join button allows you to connect two unconnected nodes. Each node must be at the end of a path.



The Stretch button allows you to stretch and size selected nodes.



The Rotate button allows you to rotate and skew selected nodes.



The Extend button allows you to draw a line between two unconnected nodes. Each node must be at the end of a 
path.



The Shape tool allows you to manipulate nodes and paths.



The PowerLine Auto-reduce button allows you to reduce the number of PowerLine nodes in a PowerLine.



The Add PowerLine Node button allows you to add a pair of PowerLine nodes to a PowerLine.



The Remove PowerLine Node button allows you to remove a PowerLine node from a PowerLine.



The PowerLine To Curve button allows you to change a straight PowerLine segment to a curved PowerLine segment.



 The PowerLine To Line button allows you to change a curved PowerLine segment to a straight PowerLine segment.



 The PowerLine Convex button allows you to make a PowerLine segment Convex.



 The PowerLine Concave button allows you to make a PowerLine segment Concave.



 The knife tool allows you to break paths.



 The Eraser tool allows you to erase portions of objects.



 The Node Edit flyout can be opened by clicking on any of the three tool buttons it contains. One of these is visible 
in the Toolbox.



The Smooth Node button allows to make a node smaooth. A smooth node is a bezier node that constrains the angle 
between the two control points to 180 degrees, but allows you to vary the length of the control points 
independantly. Use when you want a smooth transition between line segments.



The Cusp Node button allows you to make a node cusped. A cusped node is a bezier node that allows you to edit 
the line segments on either side of the node independantly. Use when you want to add a sharp bend to a curve.



The Symmetrical Node button allows you to make a node symmetrical. A symmetrical node is a bezier node that 
constrains the angle between the two control points to 180 degrees, and keeps both control points equal lengths. 
Use when you want the same curvature on both sides of the node.



The Separate button allows you to separate a subpath from an object to create a separate path.



COLOR MODEL RADIO BUTTON



Click the color model radio button to use a model for color editing. Color models are listed in the Model list box. 
Your choice of model is based on whether you are working with a drawing or an image. If you’re working with an 
image, you choice is further limited by the image mode. When you choose a model, number boxes for the 
model’s digital components are displayed to the left of the Model drop-down list.



PALETTES RADIO BUTTON



Click the palettes radio button to use a color matching palette. Palettes are listed in the Type list box. You may 
want to use the palettes if you are working with spot or process color systems by DIC, DuPont®, FOCOLTONE®, 
PANTONE®, TOYO, or TRUMATCH®. By using these palettes along with a color reference book, you can be 
reasonably certain of how the colors will look when printed. The Uniform palette is also provided, with colors 
based on the RGB color model.



MIXERS RADIO BUTTON



Click the mixers radio button to use either the Color Blend or the Mixing area to create a custom color. The 
mixing modes are listed in the Mode list box.



LIST BOX



Lists the color models, color matching palettes, and mixing modes depending on the radio button that you 
enable. The label changes to "Model" for color models, "Type" for palettes, and "Mode" for mixers. Click this box 
to display the models, types, and modes that are available.



REFERENCE COLOR



The Reference Color swatch shows the color of the selected object when you open the dialog box, or the last 
color placed in the reference area from the color models, color matching palettes, mixers, or the custom palette. 
The contents of this swatch remains unchanged, regardless of the color editing you undertake, until you update 
it by clicking the Update Reference Color Button.



NEW COLOR



The New Color swatch shows the color of the selected object when you open the dialog box, or the last color 
selected from the color models, color matching palettes, mixers, or the custom palette. If this color is not 
available in the color gamut of the delivery system (which is usually your printer), the Printable Color swatch 
appears below it to show the color you’ll print in place of the New Color. You can update the New Color with the 
Printable Color by clicking Update New Color button.



PRINTABLE COLOR



The Printable Color swatch shows the color that will print if the color in the New Color swatch is not possible in 
the printer’s color space. The gamut mapping used to do this is determined using the Color Manager. Change the
printable color to the new color by clicking the Update New Color button. When the edited color does fall within 
the printer’s color space, this color does not display.



UPDATE REFERENCE COLOR BUTTON



Click the update reference color button to use the New Color as the Reference Color. This is useful when you are 
matching colors and wish to update your reference point. To swap the Reference and New Colors, use the Color 
Options, Swap Color menu selection.



UPDATE NEW COLOR BUTTON



Click the update new color button to use the Printable Color as the New Color, which you can then edit. This 
button appears only if the New Color is not available in the printer’s color space and a Printable Color swatch is 
displayed.



COMPONENT FIELDS



The color component fields show the numeric values of the selected color. These fields are accessible when you 
have edited the New Color through a color model or a mixer. They are inaccessible (grayed out) if the color is 
selected from a color matching palette. Components change for each color model and palette selected. For 
colors in the custom palette, the components correspond to the color model or color matching palette through 
which the color was edited.



NAME FIELD



The color name field shows the name of the selected color, if a name is available. Color names are shown only 
for the color matching palettes, the custom palette, and the color buttons for the Color Blend (which correspond 
to swatches in the custom palette). Use this field to name a new color or to rename the selected color in the 
custom palette. Colors in the color matching palettes cannot be renamed.



CUSTOM PALETTE



Shows the colors in the current user palette. Use the scroll bar on the right to display other areas of the palette. 
You can create new custom palettes and save them to create a library of palettes.



COLOR OPTIONS BUTTON



Click this button to open the Color Options menu. Use this menu to add the selected color to the custom palette, 
to swap the Reference Color with the Selected Color, and to use the features of the color model, palettes, and 
mixers.



PALETTE OPTIONS BUTTON



Click this button to open the Palette Options menu. Use this menu to rename or delete the selected color on the 
custom palette, to open and save the custom palette, and to start a new custom palette.



CMY



Cyan, Magenta, Yellow. Use this color model if the drawing or image will be produced on a CMY device, such as a 
3-ink printer. C, M, and Y values range between 0 and 255. The three-dimensional visual selector defines the C, 
M, and Y values; the vertical visual selector scales all current C, M, and Y values geometrically.



CMYK



Cyan, Magenta, Yellow, Black ("K" is used to indicate black). Use this color model to use CMYK values on a 
percentage scale (0 to 100). Color values correspond to CMYK swatches. The three-dimensional visual selector 
defines the level of cyan, magenta, and yellow; the vertical visual selector defines the level of black. This model 
is based on the printer primary colors.



CMYK 255



Cyan, Magenta, Yellow, Black ("K" is used to indicate black). Use this color model to use CMYK values on a 
computer-based scale (0 to 255). The three-dimensional visual selector defines the level of cyan, magenta, and 
yellow; the vertical visual selector defines the level of black. This model is based on the printer primary colors.



RGB



Red, Green, Blue. Use this color model if the drawing or image will be produced on a radiant device, such as a 
computer monitor or a television screen, or on a transparent media such as slides. R, G, and B values range 
between 0 and 255. The three-dimensional visual selector defines the R, G, and B values; the vertical Visual 
adjusts color brightness by scaling all current R, G, and B values geometrically. This model is based on the light 
primary colors.



HSB



Hue, Saturation, Brightness. An alternative to RGB. Hue determines color, saturation determines color depth, and
brightness determines the percentage of white used to make the color lighter or darker. This model is the closest
approximation to how we perceive color. There are three visual selectors. The circular selector is for hue (0 to 
360), and the vertical selector is for brightness (0 to 100). The triangular selector is used to simultaneously 
adjust saturation (0 to 100) and brightness. Also known as HSV (hue, saturation, value). The HLS color model is a
variant.



HLS



Hue, Lightness, Saturation. A variation on HSB and an alternative to RGB. Hue determines color (yellow, orange, 
red, etc.), lightness determines perceived intensity (lighter or darker color), and saturation determines color 
depth (from dull to intense). The circular visual selector defines the H value (0 to 360) and the S value (0 to 100);
the vertical visual selector defines the L value (0 to 100).



LAB



The color model developed by Commission Internationale de l’Eclairage (CIE) based on three parameters: 
lightness (L*), green to red chromaticity (a*), and blue to yellow chromaticity (b*). The square two-dimensional 
visual selector defines the a* and b* coordinates from -60 to 60; the vertical visual selector defines the L* value 
from 0 to 100. This model is device-independent, and encompasses the color gamuts of both the CMYK and the 
RGB color models.



YIQ



YIQ is the color model used in television broadcast systems (North American video standard - NTSC). Colors are 
split into a luminance value (Y) and two chromaticity values (I and Q). On a color monitor, all three components 
are visible; on a monochrome monitor, only the Y component is visible. The square two-dimensional visual 
selector defines the I and Q values, and the vertical visual selector defines the Y value. All values are scaled from
0 to 255. In Corel PHOTO-PAINT, the Y component of the splitting process produces a grayscale image that is 
often superior to results obtained with a grayscale conversion using the Convert To command from the Image 
menu.



GRAYSCALE COLOR MODEL



Use grayscale to choose from 256 shades of gray. Each colors is defined as a single value between 0 and 255, 
where 0 is darkest (black) and 255 is lightest (white). A single visual selector is used. A grayscale value can also 
be thought of in terms of the other color models: in RGB, a grayscale value corresponds to equal amounts of all 
RGB colors; in CMYK, a grayscale value corresponds to zero C, M, and Y values with a positive K value; in HSB, a 
grayscale value corresponds to zero H and S values with a positive B value.



UNIFORM PALETTE



The uniform palette offers 255 standard RGB colors for quick selection. Colors are expressed as RGB values to 
the right of the Type box. Use the scroll bar on the right to display other areas of the palette. Colors can be 
displayed by name through the Color Options menu (the color names correspond to the R, G, and B values).



DIC PALETTES



Offers colors that are available through the DIC Color Guide, DIC Color Guide Part II, and DIC Traditional Colors of 
Japan. Colors in these palettes are created by mixing DIC brand inks. Reproduction through Corel applications is 
achieved through the CMYK color space. Colors can be displayed by name or swatch through the Color Options 
menu. Swatches are identified by palette and color ID code: 

DIC id# for DIC Color Guide
DIC Part II id# for DIC Color Guide Part II
DIC Traditional id# for DIC Traditional Colors of Japan



DUPONT PALETTE



Offers colors that are available through the DuPont® Spectramaster® solid color library. This library was 
developed to provide a paint color selection and matching tool for industrial coatings and colorants. Colors are 
based on L*a*b* and are converted to RGB for display and CMYK for printing. Colors can be displayed by name or
swatch through the Color Options menu.



FOCOLTONE PALETTE



Offers colors that are available through the FOCOLTONE® color system. Colors are based on CMYK, and therefore
do not add additional color separation plates. Use the scroll bar on the right to display other areas of the palette.
Colors can be displayed by name or swatch through the Color Options menu.



PANTONE SPOT COLORS PALETTE



Offers colors that are available through the PANTONE® Spot Colors (also known as PANTONE® Matching 
System). You define tint through the Tint Number Box, ranging from 0 (lightest) to 100 (darkest) to control 
saturation. You can also define PostScript options. Since spot colors correspond to solid inks and are not CMYK-
based, each unique color applied to an object results in an additional color separation plate. In Corel DRAW, you 
can use spot colors freely. In PHOTO-PAINT, you can use spot colors only in CMYK images to affect duotones. 
Colors can be displayed by name or swatch through the Color Options menu. See also PANTONE® Process Color 
system.



PANTONE PROCESS COLOR PALETTE



Offers colors that are available through the PANTONE® Process Color system, which is based on the CMYK color 
model. The first 2,000 colors are two-color combinations; the remainder are three- and four-color combinations. 
Colors are based on CMYK, and therefore do not add additional color separation plates. Use the scroll bar on the 
right to display other areas of the palette. Colors can be displayed by name or swatch through the Color Options 
menu. See also PANTONE® Spot Colors.



TOYO PALETTE



Offers colors that are available through the TOYO 88 Color Finder system. The range of colors offered here 
includes those created using TOYO process inks and those that are reproduced using TOYO standard inks. These 
colors are defined using the L*a*b* color space and are converted to RGB for display and CMYK for printing. 
Colors can be displayed by name or swatch through the Color Options menu.



TRUMATCH PALETTE



Offers colors that are available through the TRUMATCH® color system. This system is based on the CMYK color 
model and therefore colors do not add additional color separation plates. Colors are organized by hue (red to 
violet), saturation (deep to pastel), and brightness (adding or removing black). Use the scroll bar on the right to 
display other areas of the palette. Colors can be displayed by name or swatch through the Color Options menu.



COLOR SEARCH FIELD



Click the Search field to find a color in the palette using the color name. You can search on a full or partial name. 
Color names consist of two parts: the first is the palette name, and the second is the color name or code. A 
search can be done using only the color name or code.



TINT FIELD



Used the Tint field to control the saturation of the selected PANTONE® Spot Color. This color parameter is 
available only for the PANTONE® Spot Color palette.



COLOR BLEND



Use the color blend to create a four-way blend of color and choose from the range of color variations. Grids are 
square, ranging in size from 3x3 to 12x12 (smaller grids produce more distinct colors while larger grids produce 
more subtle color variations). Colors are selected from the custom palette and can be mapped to the CMYK, RGB,
and HSB color models.



COLOR BUTTON



The color button displays the color chosen for this corner of the grid. Click the color button in each corner to 
display the custom palette from which you can choose a new color.



AUTOBLEND BUTTON



Click this button to enable or disable automatic blending. When enabled, colors are automatically blended in the 
grid when a new color is selected in the color boxes. When disabled, colors are not automatically blended in the 
grid.



MIXING AREA



Use the mixing area to mix any number of colors from the color models, palettes, or color blend. The color in the 
New Color swatch is the active color in the mixing area.



PAINT BRUSH



Use the paint brush to apply color to the mixing area (the cursor changes to a paintbrush). Adjust the blend 
value through the Blend number box (this is a means of controlling color saturation). Brush size can be adjusted 
to small, medium, or large through the Color Options button.



EYEDROPPER



Used to pick up color from the mixing area (the cursor changes to an eye dropper).



BLEND FIELD



Click the Blend number box to increase or decrease the amount of color blending when you apply color to the 
mixing area. A large value increases the blending effect (the color is more transparent); a low value decreases 
the blending effect (the color is more opaque).



OPEN DIALOG



Lists the folders and files in the selected location. To see what’s inside a folder, double-click it. You can also use 
the Look In box to see the hierarchy of folders.



Lists the available folders and files.    To see how the current folder fits in the hierarchy on your computer, click 
the down arrow. To see what’s inside a folder, click it. The box below shows the folders and files in the selected 
location. You can also double-click a folder or file in that box to open it.



Provides a space for you to type the name of the file. You can use * as a wildcard. For example, you can type *.* 
to see a list of all files.



Lists the type of files to display. This is useful for narrowing the list of files displayed to only those files you’re 
interested in.



Opens the file with the name, file type, and location you have specified.



Closes this dialog box without saving any changes you have made.



Displays a thumbnail image of the currently selected graphics file. If a non-graphics file is selected, the Preview 
window is de-activated and appears crossed through with an X. 

Note
You must enable the Preview check box to display graphics files in the Preview window. If this check box is disabled, 
the Preview window appears crossed through with an X.



Displays the progress of the selected file as it loads into the Preview window.



Use the scroll bar to visually scroll through a file containing more than one graphic item. Executable (EXE) files, 
for example, often contain icons and cursors which may be viewed in the Preview window.
Only graphics files will appear in the Preview window. Non-graphics files are not displayed.



Click the Preview check box (if it is not already enabled) to see a thumbnail of your image. When Preview is 
disabled an X appears in the Preview window. Also, vector files that do not have a BMP header associated with 
them cannot be previewed and appear as an X.



Click the down arrow to display a drop-down box listing several different methods of opening files. You can load 
files as:

Full Image
Loads the entire file. If the file you are opening is too large for your system resources, "not enough memory" is 
displayed. The file is loaded as a partial area.

Crop
Loads a cropped area. The Crop Image dialog box opens. Crop an area.

Resample
Loads a resampled version of the file. The Resample dialog box opens. Resample an area.

Partial Load
Loads a partial area. The Partial Area dialog box opens. Select an area.



Click to view file information such as image size, file format, keywords, notes, and suppress filter.



Click to open the About Import Filter dialog box that displays information about the currently selected file/filter 
type (i.e., Corel PHOTO-PAINT Image, CPT).



Select filter.



Displays the image dimensions (in pixels) and image color mode.



Displays the file format of the currently selected image (e.g., Corel PHOTO-PAINT Image (CPT) Uncompressed).



Displays a list of all notes that are attached to the currently selected file.



Provides a space for you to type file keywords. These keywords are used to find files stored on your system. You 
can type single words, phrases, or combinations of both. Use commas to separate each keyword.



To use OPI links, you must enable the "Link to high resolution file for output using OPI" option when importing 
your TIFF (or CT) files. These TIFF (or CT) images become known as OPI images. When your service bureau 
receives your print file, the OPI server substitutes the high-resolution images for the low-resolution images. If 
there are no OPI images in your file, the Maintain OPI Links option will not be available at print time.



Enable the radio button to import the file onto a new slide.



Enable the radio button to import the file onto the current slide.



Enable the radio button to import the file onto the current background.



When enabled, suppresses the dialog box that lets you specify options for opening, importing, exporting, or 
saving a file to or from the specified file format. The program automatically assigns default settings.



Enable this check box when importing vector formats only. If turned on, CorelDRAW eliminates redundant points 
in the imported graphic. Set the tolerance value in the number box. This value controls how much the curve can 
vary from the original. A small value forces high accuracy, but will result in more points.



SAVE DIALOG



Lists the folders and files in the selected location. To see what’s inside a folder, double-click it. You can also use 
the Look In box to see the hierarchy of folders.



Lists the available folders and files. To see how the current folder fits in the hierarchy on your computer, click the
down arrow. To see what’s inside a folder, click it. The box below shows the folders and files in the selected 
location. You can also double-click a folder or file in that box to open it.



Provides a space for you to type the name of the file.



Lists the type of files to display. This is useful for narrowing the list of files displayed to only those files you’re 
interested in.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made.



Click to displays an overview of this dialog box. For help on an item, click the ? button at the top of the dialog 
box, and then click the item.



Click to open the About Import Filter dialog box that displays information about the currently selected file/filter 
type (i.e., Corel PHOTO-PAINT Image, CPT).



Displays a list of all keywords that are attached to the currently selected file.



Displays a list of all notes that are attached to the currently selected file.



Displays a drop-down box listing the available compression types. The compression types vary with the file/filter 
type selected in the Save as type: drop-down box. Click to select a compression type before saving.



When enabled, suppresses the dialog box that lets you specify options for opening, importing, exporting, or 
saving a file to or from the specified file format. The program automatically assigns default settings.



Enable to create a backup copy of the file when saved. 



Enable to save only selected objects. 
Note

Ensure that you have selected the desired objects before choosing Save, otherwise this option will be grayed out.



CROP DIALOG



Overview info



Crop Image dialog box
The Crop Image dialog box allows you to crop an image before loading. The cropping is permanent and creates a 
new, smaller image.

For more information on the options included in this dialog box, use the What’s This? online Help tool.



What’s This?



Displays the path, file name, and file extension of the image to be cropped. 



Displays the image with a bounding box. Move the nodes on the bounding box to crop the image. Use the Hand 
cursor to move the bounding box to a specific area of the image.



Enter a number or use the scroll arrows to select the height of the cropped area.



Enter a number or use the scroll arrows to select the width of the cropped area.



Enter a number or use the scroll arrows to position the top of the cropped area.



Enter a number or use the scroll arrows to position the left side of the cropped area.



Click to select the entire image or to resize the bounding box to cover the entire area and reselect the cropped 
area.



Displays a drop-down box listing a number of image measurement units. The values displayed in the Width and 
Height number boxes will reflect the measurement unit selected here.



Displays the size of the new, cropped image in bytes.



RESAMPLE



Overview



Resample dialog box
The Resample dialog box creates a new image, resampled to a smaller size.

For more information on the options included in this dialog box, use the What’s This? online Help tool.



What’s This?



Displays the path, file name, and file extension of the image to be resampled.



Enter a number or use the scroll arrows to select the width of the resampled image.



Enter a number or use the scroll arrows to select the height of the resampled image.



Displays a drop-down box displaying a number of measurement units by which you can resample an image. The 
values displayed in the Width and Height boxes reflect the chosen unit of measurement. 



Displays the width of the original file according to the measurement unit selected in the Units drop-down box.



Displays the height of the original file according to the measurement unit selected in the Units drop-down box.



Controls the horizontal resolution of the image currently being resampled. Resolution refers to the fineness of 
image detail and the amount of information required to record, store, display and print an image. Resolution is 
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail.



Displays the horizontal resolution of the original image prior to resampling.



Displays the vertical resolution of the original image prior to resampling.



Controls the vertical resolution of the image currently being resampled. Resolution refers to the fineness of 
image detail and the amount of information required to record, store, display and print an image. Resolution is 
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail.



Enable to maintain equal horizontal and vertical resolution values. Any value entered in one box will cause the 
other box to change automatically.



Enable to maintain the image aspect ratio (the image width and height proportions rated in percentage values). 
Any value entered in one box will cause the other box to change automatically.



Displays the original image size in bytes prior to resampling.



Displays the new image size in bytes based on the current resampling settings.



BITMAP



Bitmap Import/Export dialog box
Use this dialog box to specify how you want to import or export bitmap files.

For more information on the options included in this dialog box, use the What’s This? online Help tool.



Displays a drop-down list box where you choose a color mode. Choose the number of shades of gray or the 
number of colors you want.
The greater the number of colors, the larger the file.

Black and white = 1 bit
16 shades of gray = 4 bits
256 shades of gray = 8 bits
16 colors = 4 bits
256 colors = 8 bits
16 million colors = 24 bits
CMYK image = 32 bits

Not all levels of color or grayscale are supported by all the bitmap formats. If you have chosen a bitmap format 
that does not support a gray or color format, the option will not appear in the list box. For example, SCITEX CT is 
only exportable in CMYK, 32-bit format.



Dithers the colors and gray shades in the file. Dithering may produce better results when you use fewer colors 
than the original image. If the image contains fountain fills or color blends, dithering can cause obvious banding. 
Here are some guidelines to help you decide whether to dither the bitmap:

When you are importing 16 or 256 colors or grays, use dithering.
When you intend to scale the bitmap in another application, dithering is not recommended.



Specifies the resolution (in dots per inch) for bitmaps. Choose one of the preset resolutions from the list box or 
choose Custom and type or choose the resolution in the DPI box.

Note
As the resolution increases, so does the size of the file and the time required to print the image.



Specifies the dimensions of the bitmap. Choose one of the preset sizes from the list box or choose Custom and 
type the dimensions in the Width and Height boxes. If a size is not selected, the original size of the image is 
used.



Compresses the imported file so that it takes less disk space. Compressed files take more time to save and load. 
Compression is optional for some bitmap formats; for others, compression is always performed.



Shows the estimated size of the imported file before it is compressed. Compressed files will be smaller than the 
value displayed.



Returns to the settings that were in effect when you opened the dialog box.



Enable to maintain equal horizontal and vertical resolution values. Any value entered in one box will cause the 
other box to change automatically.



Controls the width of the file in pixels. To change the file width, type (or use the scroll arrows to select) a new 
value.



Controls the height of the file in pixels. To change the file height, type (or use the scroll arrows to select) a new 
value.



Type (or use the scroll arrows to select) a new vertical resolution (dpi) value. Resolution refers to the fineness of 
image detail and the amount of information required to record, store, display and print an image. Resolution is 
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail. Enter a value in the number box 
or use the scroll arrows to select a dpi value.

Note
High resolutions require large amounts of disk space.



Type (or use the scroll arrows to select) a new horizontal resolution (dpi) value. Resolution refers to the fineness 
of image detail and the amount of information required to record, store, display and print an image. Resolution is
measured in dots per inch (dpi), referring to the number of pixels used to construct an image. Choose a 
resolution in keeping with the resolution of both your monitor and (if you plan to print an image) printer. When 
you work with an image that you want to print, choose a resolution close to the maximum dpi output value of 
your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan to print 
an image, you can freely choose a higher resolution to maximum image detail. Enter a value in the number box 
or use the scroll arrows to select a dpi value.

Note
High resolutions require large amounts of disk space.



Creates a smoother graphics file by removing the jagged edges from the original.





Displays text just as you entered it. Numbers display without leading or trailing zeroes, and with no thousands 
separators.
You can use the & placeholder symbol to add a common string to another string. For example, the format string 
"Hello," & ",you may have already won $5,000,000.00" would format the string "John Doe" as: Hello, John Doe, 
you may have already won $5,000,000.00.
Note the use of the quotation marks around the strings before and after the &. You must include these when 
creating your own General format.



Creates date/time formats.
The default date and time formats are based upon the current International settings which you can modify using 
the Windows Control Panel.



Creates numeric formats to display non-linear values, including currency.



Creates Linear formats to display measurements in the Imperial or Metric system, or in picas and points. Each 
format can have one or two entries with the first used for the major (or larger unit) and the second the minor (or 
smaller unit). If the first unit contains digits after the decimal, or a fraction, then you cannot enter a minor unit.
When entering values for formats with major and minor units, enter them in the minor units. A format with miles 
as the major and feet as the minor unit, for example, would be entered in feet.



Provides a space for you to edit the built-in format or type a new format.



Removes the selected format.



Lists available formats.



Determines the number of pixels per unit of measure for the horizontal ruler.



Determines the number of pixels per unit of measure for the vertical ruler.



Wave Editor Overview
A waveform is a graphic representation of a sound, with time along the x-axis and volume along the y-axis. You 
can modify a Sound by altering its waveform using a variety of tools provided in the Wave Editor.
Some of the things you can do with your sound sample in the Wave Editor are:

change its volume level
change its sampling rate
convert from stereo to mono and vice versa
change the bit width of the sound (8 bits vs. 16-bits sound)
giving it interesting sound effects characteristics such as: echo, reverse, fade up, fade down.
editing and customizing it by using the select, undo, cut, copy, paste, delete and insert silence capability
monitor the sound and it changes by the playback and stop buttons



The sound waveform being edited is plotted in this window. Depending on the degree of magnification that you 
are using, you can see it in its entirety or a portion using the Zoom In/Out scroll bar. The sound sample starts 
from the left edge of the window and ends towards the right side.
When the entire length of the sound can not be displayed all at once within the width of the Wave Form View & 
Select Window, you can use this scroll bar to reach other parts of the sound that are not currently in view.



Indicates the starting and ending time of    a given selection of the sound waveform.



Shows the sample rate. Sample rates are measured in a unit called Kilo-Hertz (1 KHz = one thousand cycles per 
second). Generally, the higher the sample rate, the more accurate is the reproduction of a sound. Some of the 
popular sound sample rates used in sampling sound waveform s are 44KHz, 22KHz and 11KHz. Due to possible 
sound hardware limitations, software driver limitations or disk and memory storage limitations, one is forced to 
convert a sound sample rate from one to another.



Shows the bit width or the volume resolution of the sound sample and indicates whether the given sound sample
is a one channel (mono) sound or a two channel (stereo) sound.. For example, a given 8 bit sound has 2 to the 
8th power (or 256) units in volume level per sample and a 16 bit sound has 2 to the 16th power (or 65536) units 
in volume level per sample. The higher the bit width of the sound, the more accurate the volume change 
between samples can be reproduced, thus resulting in a higher and finer quality sound reproduction.



Click to playback an entire sound waveform or a selected portion of it.



Click to record a sound waveform. This feature will only work if sound-capturing hardware has been installed in 
your computer.



Click to halt the playback of sound waveform.



Click to pause the playback of the sound. To resume playing the sound, click the Play button.



Click to magnify the sound wave section you are viewing, providing a more detail view of the wave 
characteristics. Full editing capability is available under zoom mode.



Click to reduce the magnification and bring the entire waveform into view.



Drag to select a volume level for playback



Save command (File menu)
Updates the wave file in the Timelines dialog box to reflect any changes made in the Wave Edit window.







Repeat command (File menu)
Click to force a sound to replay continuously. Click again to stop the continuous replay.





Save command (File menu)
Click to save changes to the current file. If the file is a new one the Save As dialog box displays.



Save As command (File menu)
Click to name a new file, change the name of a file you are currently using or save a file with the current name in
a different location.



Stop command (File menu)



Exit command (File menu)
Quits the Wave Editor. If the sound waveform has been changed in any way, Wave Editor will automatically 
prompt you to save changes before closing the editing window.



Undo command (Edit menu)
Choose Undo to undo most operations within the Wave Editor.



Cut command (Edit menu)
Choosing Cut will first copy the selected section of waveform onto the Windows Clipboard, then the selected 
section will be removed from the Wave Editor immediately after the copy. 
To Cut a section of a sound, highlight the area by clicking the mouse down until an insertion line appears. Drag 
the mouse in either direction to select a section of the sound. Select Cut to move the selection to the Windows' 
Clipboard.



Copy command (Edit menu)
Copies the selected section of waveform onto the Windows' Clipboard.
To Copy a section of sound, highlight the area by clicking the mouse down until an insertion line appears. Drag 
the mouse in either direction to select a section of the sound. Select the Copy command to move a duplicate of 
the selection to the Clipboard.



Paste command (Edit menu)
Pastes a section of a sound from the Clipboard. To do so, click the mouse down in an area on the waveform 
where you want to insert the sound. An insertion line appears. Select Paste to insert the portion of the sound 
from the Clipboard into the waveform. The pasted portion of the sound will appear in the waveform. The size of 
the sound will change because you are adding to the sound.



Delete command (Edit menu)
Removes a section of a sound. To do so, highlight the area by clicking the mouse down until an insertion line 
appears. Drag the mouse in either direction to select a section of the sound. Select Delete to remove the 
selection. The selected portion of the sound will be removed.



Select All command (Edit menu)
Highlights the entire waveform and is the equivalent of dragging the mouse from the start of the sound 
waveform to the end.
Note
Most sound editing operations affect the entire sound if there is no selection. If you select part of the waveform, 
only that area is affected by the editing operation.







Change Characteristics command (Effects menu)
Use to adjust the quality of sound Corel PRESENTS sends to the sound card. The adjustments you make are 
saved with the waveform. If you don't want to save the adjustments with the waveform, make them in the 
Timelines dialog box (View menu) by clicking the sound object with the right mouse and clicking Output Device.



Wave Characteristics dialog box
Use this dialog box only when you need to adjust the quality of the sound PRESENTS sends to the sound card. 
The effect that these options have will vary depending on your system. You must experiment with these settings 
to achieve the type of output you want. 
The settings you choose are saved with the waveform. If you want do not want to alter the waveform, make the 
adjustments in the Timelines dialog box (View menu) by clicking the sound object with the right mouse and 
clicking Output Device.

Sample Rate
Controls how accurately the sound is reproduced. Sample rates are measured in a unit called Kilo-Hertz (1 KHz =
one thousand cycles per second). Generally, the higher the sample rate, the more accurate is the reproduction of
a sound. Some of the popular sound sample rates used in sampling sound waveform s are 44KHz, 22KHz and 
11KHz. Due to possible sound hardware limitations, software driver limitations or disk and memory storage 
limitations, one is forced to convert a sound sample rate from one to another.

Channels
Converts from stereo to mono and vice versa

Sample Size
Sets the bit width or the volume resolution of the sound sample and indicates whether the given sound sample is
a one channel (mono) sound or a two channel (stereo) sound.. For example, a given 8 bit sound has 2 to the 8th 
power (or 256) units in volume level per sample and a 16 bit sound has 2 to the 16th power (or 65536) units in 
volume level per sample. The higher the bit width of the sound, the more accurate the volume change between 
samples can be reproduced, thus resulting in a higher and finer quality sound reproduction.



Silence command (Effects menu)
Inserts intervals of silence into your sound waveform.



Fade In command (Effects menu)
Causes a sound to start relatively softly and end in a relatively louder volume. If you select a section of sound to 
apply this effect to, only the selected portion is affected.



Fade In Wave dialog box
Use to make the current selection or entire waveform start at a volume level of zero and increase to the 
Maximum Level. The maximum level is a percentage of the current level. The maximum level is between 0 and 
100 percent.



Fade Out command (Effects menu)
Causes a sound to start in a relatively louder volume and end in a relatively softer volume. If you select a section
of sound to apply this effect to, only the selected portion is affected.



Fade Out Wave dialog box
Use to make the current selection or entire waveform start at the current volume level and decrease to the 
Minimum Level. The minimum level is a percentage of the current level.



Amplify command (Effects menu)
Increases or decrease the volume of a selected section of the sound waveform. The entire sound is affected if a 
selection is not made.



Amplify Wave dialog box
Use to make the current selection or entire waveform increase to the Maximum Level. A value of 100% 
represents no change, values less than 100% make the sound quieter, values more than 100% make the sound 
louder.



Reverse command (Effects menu)
Choose the Reverse effect to cause a section of sound or the entire sound to play backward.



Echo command (Effects menu)
Choose the Echo effect to cause an echoing affect on the section of sound you are editing. If a selection is not 
made, the entire sound is affected.



Echo Wave dialog box
Create echo effects by replaying part or all of the waveform using time delays you define in Delay of. The value 
you type is the amount of time in milliseconds the copy of the selection is delayed before it plays. On the 
waveform, this is the distance that the selection is moved to the right on the waveform.



Output Device dialog box
Use this dialog box only when you need to adjust the quality of the sound PRESENTS sends to the sound card. 
The effect that these options have will vary depending on your system. You must experiment with these settings.
Basically these options allow you to choose options for the type of output you want.
Note
The settings you choose are NOT saved with the waveform. To save them with the waveform, click the sound 
object in the Timelines dialog box with the right mouse button, then click Properties. In the Wave Editor, click 
Effects, Change Characteristics and make the adjustments in the Wave Characteristics dialog box.



Experiment with these options only if you need to address skipping in your sounds. For example, if your sound 
card is missing portions of a sound, adjust these options as required. Try each of the following strategies: first, 
try using Mono 8 Bit, 11 Kh as the output format; next try increasing volume to full for each wave; finally reset all
sounds you are using to the same Output Format. Also, experiment with Play Buffer Length, Buffer Queue 
Length, and Queue Remix Delay options in this dialog box.



Check this option to let PRESENTS make a best guess choice on the sound output for you. PRESENTS makes this 
best guess based on all of the sounds in the presentation and the capabilities of the sound card.



Sounds are broken into buffers. Type how long (milliseconds) each buffer will play a part of the sound. Large 
values are useful when you have a small number of lengthy sounds. This gives each sound enough time to 
complete. Lower values are useful when you have a lot of short sounds to play. This helps ensure that all of the 
small sounds are played. For optimum settings, experiment with the options in this dialog box.



Type the number of buffers you want PRESENTS to prepare in advance while playing. Higher values are useful 
when you have a few lengthy sounds. Lower values are useful when you have many short sounds. This is 
because lower values help ensure that all of the short sounds are played. For optimum settings, experiment with 
the options in this dialog box.



Type the number of buffers you want PRESENTS to skip starting anew sound. A large number causes too much 
delay. A small number may cause skip because there is not enough time to play sounds completely. For optimum
settings, experiment with the options in this dialog box.



Click to return settings to their default value.



Shows the start and the end times of the selected    wave area (or the whole wave, if no area is selected), as well 
as information on the output device options chosen in the Wave Characteristics dialog box.



Shows the volume level of the wave. Drag the handle to the left to decrease the volume, or to the right to 
increase the volume.



Views



Slide view displays a single slide with any objects that are included on it. You can draw shapes, write text, add 
sound, video and OLE objects, and insert maps and charts. You can also print the presentation slides. Use the 
View menu to switch to other views.



Slide Sorter view displays all presentation slides as thumbnails in a scrollable window. You can change the order 
of slides, insert/delete slides, apply backgrounds and layouts to selections of slides, show/hide slides in the 
presentation, or proof a presentation before printing it or starting the screen show. Use the View menu to switch 
to other views.



Master Layout view displays the current master layout; the four different master layouts are: Title Slide Master, 
Slide Master, Handout, and Speaker Notes. When you choose a master layout to apply, all slides that follow have 
the same layout.
You can change the following attributes within the master layouts:

change text attributes
change bullet styles
move or size the frames

Use the View menu to switch to Master Layout view.



Speaker Notes view displays presentation slides in thumbnail form on a notes page, along with room for you to 
type key notes that you want to remember. You can print out the Speaker Notes and use them as a presentation 
aid when speaking to the audience. Use the View menu to switch to Speaker Notes view.



Handout view displays presentation slides as two slide thumbnails per notes page, along with room for you to 
add relevant text. Handouts make it easy for the audience to make notes during your presentation, and to 
remember key points later. You can print out the Handouts. Use the View menu to switch to Handout view.



Animation view displays the current slide you are working on, in animation mode. A VCR toolbar appears at the 
bottom of the screen. When you are in animation mode, you can select objects to animate, create multicel 
actors, sequence cels, assign paths, snap to key frames, advance the time, and play the animation. Use the View
menu to switch to Animation view.



Background view displays the background of the current slide you are working on. You can apply a new 
background from fills or the library, modify an existing background, draw objects, add text and insert graphics 
into the background. When you choose a background to apply, all slides that follow have the same background. 
Use the View menu to switch to Background view.



Outline view displays the text of all presentation slides. You can arrange the text of a slide in hierarchical order; 
rearrange the order of slides or bullets; choose the type of text, font or style; select basic effects such as bold, 
italic and underline; and display text in draft or preview mode. Use the View menu to switch to Outline view.



Handout Layout view displays the slide and text layout frames for handouts. You can change the following 
attributes within the master layout:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to Master Handout Layout view.



Speaker Notes Layout view displays the slide and text layout frames for Speaker Notes. You can change the 
following attributes within the master layout:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to Master Handout Layout view.



Frames



The Group frame contains objects that are grouped using the Arrange menu. An object group, while made up of 
several objects, is treated as one entity.



The MCI frame contains an .AVI video file. The video plays at the same size as the video frame on the slide. You 
can enable the check box in the Video Properties dialog box to show the video at the full screen size. Click with 
the right mouse button on the MCI frame and choose the Properties command to display the Video Properties 
dialog box.



The Notes Constrain Group frame contains the slide image on the Handout or Speaker Notes page.



The Sound Object frame contains a sound file. You can edit the sound file by double-clicking anywhere within the 
frame, launching the Wave Editor. You can sequence cels, select mono or stereo output, and create special sound
effects while in editing mode.



The thumbnail frame contains a miniature image of a slide or group of slides.



The Text Object frame contains text created in PRESENTS. You can add and manipulate text with ease, entering 
Artistic Text or Paragraph Text directly onto the screen. Text features include editing and formatting; selecting a 
font and setting its point size and attributes; adjusting character, word, line, and paragraph spacing; adding 
symbols; and proofreading.



The Template frame is empty until you double-click to insert the type of object you chose from the layout. For 
example, if you chose a chart layout, a chart appears when you double-click inside the empty frame.



The Title Object frame contains the slide title or subtitle master layout. You can do the following in the Title Slide 
Master layout:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to other Master Layout views.



The Body Text Object frame contains the body text master layout. This frame is available in Slide Master, 
Handout, or Speaker Notes master layouts. You can do the following in the body text frames:

change text attributes
change bullet styles
move or size the slide and text frames

Use the View menu to switch to Master Layout views.



The Header Text Object frame contains the header that appears on your slides. You can create a header by 
accessing File, Page Setup, Header/Footer. Headers can be created for slides, handouts and speaker notes. You 
can modify the size or location of the header frame on the Slide Master, Handout, or Speaker Notes master 
layouts, accessible from the View, Master Layouts command.



The Footer Text Object frame contains the footer that appears on your slides. You can create a footer by 
accessing File, Page Setup, Header/Footer. Footers can be created for slides, handouts and speaker notes. You 
can modify the size or location of the footer frame in the Slide Master, Handout, or Speaker Notes master 
layouts, accessible from the View, Master Layouts command.



The OLE Object frame contains objects that are linked or embedded from other applications. You can insert and 
OLE object onto your slide from the Insert, New Object command.



The Chart OLE Object frame contains a chart that is inserted into your presentation. You can double-click the 
chart to open the Chart server, which contains two principal tools: the chart-building screen, called Chart View, 
and an underlying spreadsheet program called the Datasheet. You can create custom charts and display them in 
PRESENTS.



The Map OLE Object frame contains a map that is inserted into your presentation. You can double-click the map 
to open the Map server. You can create custom maps and display them in PRESENTS.



The bitmap object frame contains a graphic object that you inserted, imported, linked, or embedded into the file.



The Rectangle frame contains a rectangle drawn using the Rectangle tool 
. 
You can change the shape, size, angle, rotation, outline, or fill; edit nodes, or zoom in or out on the rectangle.



The Ellipse frame contains an ellipse drawn using the Ellipse tool 
.
You can change the shape, size, angle, rotation, outline, or fill; edit nodes, or zoom in or out on the ellipse.



The Polygon frame contains a Polygon drawn using the Polygon tool. You can change the shape, size, angle, 
rotation, outline, or fill; edit nodes, or zoom in or out on the Polygon. To create a variety of star shapes, click on the 
Edit Nodes tool and drag the Polygon into the desired shape.



The Curve frame contains curve objects drawn using the Freehand tool.



The Artistic Text frame contains Artistic text created using the  tool. Use Artistic Text when you want to apply 
special effects such as shaping text to a path and creating extrusions or contours. You can add Artistic Text 
objects containing up to 32,000 characters.



Node Edit dialog box
The Node Edit Roll-Up allows you to change the characteristics of a path and its nodes. Doing this allows you to 
reshape an object. To edit the paths and nodes of an object, convert the object to curves using the Convert to 
Curves command in the Arrange menu. This step isn't necessary for objects drawn with the Freehand tool or 
Bezier tool because they are already curve objects.
Three special types of shaping don't require converting the object to curves:

rounding the corners of rectangles and squares
creating arcs and pie wedges from ellipses and circles
mirror editing objects created with the Polygon tool

Note
You cannot edit text after you convert it to curves.
You cannot convert groups of objects to curves.
When you use the Knife tool or the Eraser tool on an object, it automatically converts the object to curves.
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Adds a node at the spot along the segment that you click. Add nodes if you cannot shape a curve the way you 
want by moving the existing nodes and control points.



Deletes the selected node or segment. Use to remove surplus nodes from an excessively complex drawing and 
to smooth unwanted bumps along a curve.



Connects two nodes at the beginning or end of curve segments that are part of the same object. Use to close an 
open path or make two subpaths into a single continuous curve.
You can join nodes of different objects by first combining the objects with the Combine command in the Arrange 
menu.



Splits the curve into two or more subpaths. Useful for separating curves in a traced bitmap.



Deletes any nodes which can be deleted without significantly changing the shape of the curve. You can adjust 
the sensitivity of the Auto-Reduce feature in the Node Edit tool properties sheet.



Changes the selected line segment to a curve segment.



Changes the selected curve segment to a line segment.



Changes the selected node to a cusped node. This allows you to edit the line segments on either side of the 
node independantly. Use when you want to add a sharp bend to a curve.



Changes the selected node to a smooth node. This constrains the angle between the two control points to 180 
degrees, but allows you to vary the length of the control points independantly. Use when you want a smooth 
transition between line segments.



Changes the selected node to a symmetrical node. This constrains the angle between the two control points to 
180 degrees, and keeps both control points equal lengths. Use when you want the same curvature on both sides 
of the node.



Aligns selected nodes and their associated control points. Use to align the edges of objects that share a common
boundary such as regions of a map.
To align nodes of different objects, you must first combine the objects with the Combine command in the Arrange
menu.



Displays eight stretching/scaling handles that let you stretch and scale selected parts of a curve.



Displays eight rotating/skewing handles that let you rotate and skew selected parts of a curve.



Changes the way multiple-selected nodes move when dragged with the mouse. If left unchecked, all nodes move
by the same amount. When checked, nodes move in proportion to their distance from the base node (i.e., the 
node you are dragging). The end result is that the curve appears to behave like an elastic expanding and 
contracting in response to the movement of the mouse.



Allows you to draw a line between two unconnected nodes. Each node must be at the end of a path.



Allows you to separate a subpath from an object to create a separate path.



Allows you to switch between editing the width of the selected PowerLine and normal node editing.



Allows you to reduce the number of PowerLine nodes in a PowerLine.



Allows you to add a pair of PowerLine nodes to a PowerLine.



Allows you to remove a PowerLine node from a PowerLine.



Allows you to change a straight PowerLine segment to a curved PowerLine segment.



Allows you to change a curved PowerLine segment to a straight PowerLine segment.



Allows you to make a PowerLine segment Concave.



Allows you to make a PowerLine segment Convex.





Click to return to the previous window.



Click to advance to the next window.



Click to close the Wizard and apply the settings you selected.



Click to return to the presentation, without applying any changes from the settings you selected.



Click to close the dialog box and apply the settings you selected.



Click to apply the settings you selected without closing the dialog box.



Enable the button to display a preview of the selected item with the options or settings you selected.



Click to access the Contents menu of the online help.



Click to display a list of measurement systems, then click the one you want to use.
Click to remove all the items listed in the display box.



Click to apply the settings you selected and close the dialog box.



Click to display the property sheet's controls.





Toggles guideline visibility. When Show Guidelines is disabled, guidelines will not appear on the screen.



Toggles the guideline snap on and off. When Snap To Guidelines is enabled, objects dragged close to a guideline 
will fall into alignment with it.



Removes all existing horizontal, vertical, and slanted guidelines.



Click here to display an overview of this dialog box.
For Help on an item, click the question mark at the top of the dialog box, and then click the item.
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IDH_CDRUI_THREADLIST_CDRUI_THREADHELP (0x5400001E)



IDH_CDRUI_THREADLIST_CDRUI_THREADTITLE (0x5400001F)



IDH_ROLLUPPAGE_LEFTMOVEDOWN (0x54000064)



IDH_ROLLUPPAGE_LEFTMOVEUP (0x54000065)



IDH_ROLLUPPAGE_RIGHTMOVEDOWN (0x5400006E)



IDH_ROLLUPPAGE_RIGHTMOVEUP (0x5400006F)



IDH_CDRUI_TOOLPAGE_CDRUI_TB_NOITEMS



IDH_SETUP_GRID_CDRUI_SNAPTOFRAMES



IDH_SETUP_GRID_CDRUI_SNAPTOMARGINS



IDH_SETUP_GRID_SHOWMARGINS2



IDH_SETUP_GRID_SNAPTOFRAMES2



The units in which the current value is expressed.



The minimum increment. This is the amount by which the value will increase or decrease when you click one of 
the spin box arrows.



The units in which the increment value is expressed.



The highest value you can use.



The units in which the maximum value is expressed.



The lowest value you can use.



The units in which the minimum value is expressed.



Displays the roll-ups and roll-up groups that arrange to the left side of the screen.



Displays the roll-ups and roll-up groups that arrange to the right side of the screen.



Moves the current roll-up or roll-up group from the right list to the left list.



Moves the current roll-up or roll-up group from the left list to the right list.



Adds a new, empty roll-up group to the left list.



Adds a new, empty roll-up group to the right list.



The roll-up configuration that will appear on start up.



Resets the roll-up arrangements to their original configuration.



Removes the current roll-up group from the left list.



Moves the current group down.



Moves the current group up.



Removes the current roll-up group from the right list.



Moves the current group down.



Moves the current group up.



Opens the Customize dialog box, where you can change the configuration of your toolbar buttons.



Deletes a custom toolbar, or resets a built-in toolbar.



Displays the available toolbars. Enable the checkbox next to a toolbar to activate it. Click the toolbar's name tag 
to rename it.



Creates a new toolbar. Click Customize to add buttons to the new toolbar.



Enables large toolbar buttons.



Enables medium toolbar buttons.



Enables small toolbar buttons.



Displays the available commands. Double-click a command category to open it.



Displays the available commands. Double-click a command category to open it.



Gives a short description of    the selected command.



Resets the keyboard assignments to their original configuration.



Shows the new keyboard combination that you want to assign to the command. If you need to make a correction,
press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.



Shows the new keyboard combination that you want to assign to the command. If you need to make a correction,
press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.



Displays any commands assigned to the keyboard combination you typed. You cannot have the same 
combination for more than one command.



Displays any commands assigned to the keyboard combination you typed. You cannot have the same 
combination for more than one command.



Automatically resolves conflicts by erasing the old keyboard assignment, and prompting you to assign a new 
combination to the old command.



Displays any existing shortcut keys for the current command.



Displays any existing shortcut keys for the current command.



The name of the current keyboard assignment set.



The name of the current keyboard assignment set.



Assigns the new keyboard combination to the current command.



Deletes the selected shortcut keys.



Loads a new keyboard assignment table.



Saves the current keyboard assignment table.



Gives a short description of    the selected command



Displays the available commands. Double-click a command category to open it.



Adds the selected command to the menu.



Removes the selected command from the menu.



Adds a separating line to a menu below the current selection.



Adds a new menu.



Moves the current menu or menu entry up.



Moves the current menu or menu entry down.



Displays the current menu structure. Double-click a menu or sub-menu to open it.



Resets the menu assignments to their original configuration.



Gives a short description of    the selected command



Gives a short description of any toolbar button you click.



Displays the available command categories. Click a category to display its command buttons.



Displays the command buttons for the current command category. Click a button to see its description, or drag it 
to add it to any toolbar on the screen.



A command button. Click it to see its description, or drag it to add it to any toolbar on the screen.



Resets the toolbar assignments to their original configuration.



You can also open the color palette menu by right-clicking the palette border.



These controls let you change the appearance of the on-screen color palette.



The colors in the current palette. Right-click the palette border to open the Color Palette menu.



Shows and hides the color swatch borders.



Toggles between large and small color swatches.



Shows and hides the No Color swatch.



Specifies the number of rows of colors to be displayed while the color palette is docked.



Specifies the number of rows of colors to be displayed while the color palette is docked.



Specifies the number of rows of colors to be displayed while the color palette is docked.



These controls let you change the effect of right-clicking the color palette.



Changes the effect of right-clicking a color swatch on the palette.



Changes the effect of right-clicking a color swatch on the palette.



Determines the number of horizontal grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of horizontal grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of vertical grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of vertical grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the horizontal position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



Determines the horizontal position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



You can choose another unit of measure for the horizontal ruler from the units box. When you change units, you 
must specify the Grid Frequency you want to use with that unit.



Determines the vertical position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



Determines the vertical position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



You can choose another unit of measure for the vertical ruler from the units box. When you change units, you 
must specify the Grid Frequency you want to use with that unit.



Displays markers showing where the grid lines are.
The frequency of the grid marks is determined by the current view. When you use the Zoom tool to magnify the 
view, the frequency of the grid marks increases.



Forces objects drawn or moved close to a grid line into alignment with the grid. You can also toggle Snap To Grid 
using the Snap To Grid command in the Layout menu.



Opens the Drawing Scale dialog box where you can set a scale to your drawing other than one to one.



Represents the distance in your drawing that is equivalent to the World Distance value.



Displays the current Page Distance units. Click in this field to display a list of available units. The Page Distance 
value is automatically converted when you change units.



Displays the current World Distance units. Click in this field to display a list of available units. The World Distance
value is automatically converted when you change units.



Selects one of several pre-defined drawing scales. The Page Distance and World Distance values are updated to 
reflect your choice.



Represents the real distance, in inches, that is equivalent to the Page Distance in your drawing. 



Creates a slanted guideline at the position and angle you have specified.



The guideline definition method. You can define a slanted guideline using two points, or a single point and an 
angle. A guideline defined by the points (1,1) and (5,5) would follow the same path as a guideline starting at 
(1,1) with a 45-degree angle.



The guideline definition method. You can define a slanted guideline using two points, or a single point and an 
angle. A guideline defined by the points (1,1) and (5,5) would follow the same path as a guideline starting at 
(1,1) with a 45-degree angle.



The horizontal position of the guideline's origin point.



The horizontal position of the guideline's origin point.



The horizontal position of the guideline's first origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's first origin point.



The guideline's angle, or the horizontal position of the second origin point.



The guideline's angle, or the horizontal position of the second origin point.



The guideline's angle.



The horizontal position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The current guideline definition.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing slanted guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing horizontal, vertical, and slanted guidelines.



Moves the current guideline to the position and angle you have specified.



Creates a vertical guideline at the position you have specified.



The guideline position. Click Add to make a new guideline at this point, or Move to change the selected 
guideline's position.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing vertical guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing vertical guidelines.



Moves the current guideline to the position you have specified.



Creates a horizontal guideline at the position you have specified.



The guideline position. Click Add to make a new guideline at this point, or Move to change the selected 
guideline's position.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing horizontal guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing horizontal guidelines.



Moves the current guideline to the position you have specified.



Changes the current value.



Displays the roll-ups in this group. Click a roll-up to activate it, or drag it to another part of the screen to split it 
from the group.





Customize command
Opens the Customize dialog box, where you can customize your toolbars, menus, status bar information, 
keyboard shortcuts, and other properties of the Corel user interface.



To launch other installed Corel applications
1. Click Application Launcher.
2. Click the application you want to run.





Customizing keyboard assignments
Accelerator keys give you quick access to commands that you use frequently.
You can change built-in keyboard assignments, or assign an accelerator key combination to any command. You 
can create several sets of keyboard assignments to use for different types of operations, saving and loading sets 
as they are needed.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics



To assign an accelerator key to a command
1. Click Tools, Customize.
2. Click Keyboard.
3. In the Commands box, double-click the command category folder containing the command you want to 

customize.
4. Click the command.
5. Click the Press new shortcut key box.
6. Press the keyboard combination that you want to assign to the command. If you need to make a correction, 

press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.

Tip
To automatically resolve accelerator conflicts, enable the Go to conflict on assign option.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To remove an accelerator key from a command
1. Click Tools, Customize.
2. Click Keyboard.
3. In the Commands box, double-click the command category folder containing the command you want to 

customize.
4. Click the command.
5. In the Current shortcut keys box, select the key combination you want to remove.
6. Click Delete.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To restore all keyboard assignments to their original settings
1. Click Tools, Customize.
2. Click Keyboard.
3. Click Reset All.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To save a set of customized keyboard assignments
1. Click Tools, Customize.
2. Click Keyboard.
3. Click Save As.
4. Choose the Accelerator File in which you want to save your assignments.
Tip

To change the default settings, save your custom accelerator set over the file CDRDEF.ACL.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics



To load a set of customized keyboard assignments
1. Click Tools, Customize.
2. Click Keyboard.
3. Click Load.
4. Choose the Accelerator File you want to load.

{button ,AL(`cdrui_key_proc;;;;;',0,"Defaultoverview",)} Related Topics





Customizing menus
Your Corel menus are completely customizable. You can add commands to existing menus, or you can add new 
menus to the menu bar. You can change the order of the menus and their commands to give you quick, easy 
access to the functions you use most.
Note

When you customize your menus, keep in mind that the help topics referring to those menus do not 
change.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics



To change the order of menus and menu commands
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to move. Double-click to open a menu or sub-

menu.
4. Click Move Up or Move Down.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To add a command to a menu
1. Click Tools, Customize.
2. Click Menu.
3. In the Commands box, double-click the command category folder containing the command you want to add.
4. Click the command.
5. In the Menu box, click the menu or sub-menu where you want to add the command.
6. Click Add.
Tip

Use the Separator button to add organizational lines to your menus.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To remove a menu or menu command
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to remove. Double-click to open a menu or sub-

menu.
4. Click Remove.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To rename a menu
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to rename. Double-click to open a menu or sub-

menu.
4. Click the command's name tag, and type the new name.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change a menu command's accelerator key
1. Click Tools, Customize.
2. Click Menu.
3. In the Menu box, click the menu or menu command you want to rename. Double-click to open a menu or sub-

menu.
4. Click the command's name tag, and insert an ampersand (&) before the letter you want to use as an 

accelerator.
5. Remove all unnecessary ampersands.

{button ,AL(`cdrui_menu_proc;cdrui_key_proc;;;;',0,"Defaultoverview",)} Related Topics



To add a new menu
1. Click Tools, Customize.
2. Click Menu.
3. Click Add Menu.
4. Type a name for the new menu.
Tip

You can add a sub-menu to an existing menu by first double-clicking the existing menu.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics



To restore the original menu settings
1. Click Tools, Customize.
2. Click Menu.
3. Click Reset All.
Note

You will lose all changes to the menu settings.

{button ,AL(`cdrui_menu_proc;;;;;',0,"Defaultoverview",)} Related Topics





Customizing the on-screen color palette
Using the on-screen color palette is the easiest way to change colors in your objects. You can move the palette 
anywhere on the screen and edit the color order to make it easy to find your favorite colors.

{button ,AL(`cdrui_over;clt_palettes_for_clr;;;;',0,"Defaultoverview",)} Related Topics



To move the on-screen palette
1. Click the border of the palette.
2. Drag the palette to its new position.
Tip

To dock the palette, drag it towards the edge of the window until it changes shape.

{button ,AL(`cdrui_palette_proc;;;;;',0,"Defaultoverview",)} Related Topics



To resize the on-screen palette while it's floating
1. Move the mouse pointer to the edge of the palette.
2. Drag the edge until the palette is the size you want.

{button ,AL(`cdrui_palette_proc;;;;;',0,"Defaultoverview",)} Related Topics



To resize the on-screen palette while it's docked
1. Click Tools, Customize.
2. Click Color Palette.
3. Type a new value in the Display rows while docked box.
Note

The palette will display up to seven rows of colors.

{button ,AL(`cdrui_palette_proc;;;;;',0,"Defaultoverview",)} Related Topics



To move a color swatch on the on-screen palette
1. Click the color you want to move.
2. Drag the color swatch to its new position.
Note

You cannot move the No Color swatch.

{button ,AL(`cdrui_palette_proc;;;;;',0,"Defaultoverview",)} Related Topics



To remove a color swatch from the on-screen palette
1. Click the color you want to remove.
2. Right-click the palette border to bring up the palette menu.
3. Click Delete Color.

{button ,AL(`cdrui_palette_proc;;;;;',0,"Defaultoverview",)} Related Topics



To edit a color swatch on the on-screen palette
1. Click the color you want to edit.
2. Right-click the palette border to bring up the palette menu.
3. Click Edit Color.
4. Choose the new swatch color (See Related Topics).

{button ,AL(`cdrui_palette_proc;;;;;',0,"Defaultoverview",)} Related Topics







Customizing toolbars
Except for the toolbox and its flyouts, you have complete control over the commands on your toolbars. With 
simple mouse actions, you can dock, undock, resize, and move your toolbars anywhere on the screen.
You can also add and remove buttons to the built-in toolbars, or create your own toolbars containing only the 
commands you use most often.
Note

When you customize your toolbars, keep in mind that the help topics referring to those toolbars do not 
change.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics





Customizing toolbars
You have complete control over your toolbars. With simple mouse actions, you can dock, undock, resize, and 
move your toolbars anywhere on the screen.
The Toolbars dialog box to controls which toolbars are displayed on the screen at any given moment.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics





To move a toolbar
1. Click the border of the toolbar.
2. Drag it to its new location. Right-click to cancel the movement.
Tip

Double-click a toolbar's title or border to dock and undock it.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To resize a toolbar
1. Move the cursor to the edge of a floating toolbar.
2. Drag the edge until the toolbar is the correct size. Right-click to cancel the movement.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display an existing toolbar
1. Click View, Toolbars.
2. Click the check box next to the toolbar that you want to activate.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To create a custom toolbar
1. Click View, Toolbars.
2. Click New.
3. Type a name for the new toolbar.
4. Use the Customize command to add commands buttons to the new toolbar (See Related Topics).

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To add a button to a toolbar
1. Activate the toolbar you want to edit (See Related Topics).
2. Click View, Toolbars.
3. Click Customize.
4. In the Commands box, click the command category folder containing the command you want to add.
5. Drag the appropriate command button to the toolbar. Right-click to cancel the movement.
Tip

Click a button to see its description.
You can also hold down the CTRL and ALT keys and drag a button to copy it to another toolbar without 

opening the dialog box.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To remove a button from a toolbar
1. Activate the toolbar you want to edit (See Related Topics).
2. Click View, Toolbars.
3. Click Customize.
4. Drag the button off the toolbar. Right-click to cancel the movement.
Tip

You can also hold down the ALT key and drag a button off a toolbar to delete it without opening the dialog 
box.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To rename a toolbar
1. Click View, Toolbars.
2. Click the toolbar you want to rename.
3. Click the toolbar's name tag.
4. Type the new name.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To move a toolbar button
1. Activate the toolbar you want to edit (See Related Topics).
2. Click View, Toolbars.
3. Click Customize.
4. Drag the button to another toolbar, or to another spot on the same toolbar. Right-click to cancel the 

movement.
Tip

To add space between two toolbar buttons, drag the right-most button slightly further to the right.
You can also hold down the ALT key and drag a button to move it without opening the dialog box.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To delete a custom toolbar
1. Click View, Toolbars.
2. Click the custom toolbar you want to delete.
3. Click Delete.
Note

You cannot delete a built-in toolbar.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics



To restore the original configuration of a built-in toolbar
1. Click View, Toolbars.
2. Click the built-in toolbar you want to reset.
3. Click Reset.

{button ,AL(`cdrui_toolbars_proc;;;;;',0,"Defaultoverview",)} Related Topics





Navigating your document
The Navigator gives you a quick and easy way to move around in your documents. You can move to any    page in
your document with a single mouse click, or quickly add blank pages without interrupting your work.

{button ,AL(`smd01_pro2_cd;;;;;',0,"Defaultoverview",)} Related Topics



To add a page to the beginning of your document using the Navigator
1. Move to the first page of the document.
2. In the Navigator, click Add Beginning Page.

{button ,AL(`cdrui_navigate_proc;multipag_proc;;;;;',0,"Defaultoverview",)} Related Topics



To add a page to the end of your document using the Navigator
1. Move to the last page of the document.
2. In the Navigator, click Add Ending Page.

{button ,AL(`cdrui_navigate_proc;multipag_proc;;;;;',0,"Defaultoverview",)} Related Topics



To go to an existing page of your document using the Navigator
1. Scroll through the Navigator until you can see the page you want.
2. Click the Page icon that corresponds to the page you want.

{button ,AL(`cdrui_navigate_proc;multipag_proc;;;;;',0,"Defaultoverview",)} Related Topics



To go to the first page of your document using the Navigator
In the Navigator, click First Page.

{button ,AL(`cdrui_navigate_proc;multipag_proc;;;;;',0,"Defaultoverview",)} Related Topics



To go to the last page of your document using the Navigator
In the Navigator, click Last Page.

{button ,AL(`cdrui_navigate_proc;multipag_proc;;;;;',0,"Defaultoverview",)} Related Topics



To resize the Navigator
1. Move the mouse pointer to the right border of the Navigator.
2. Drag the border until the Navigator is the size you want.

{button ,AL(`cdrui_navigate_proc;;;;;',0,"Defaultoverview",)} Related Topics





Customizing the status bar
The status bar gives you constant, up-to-date information about your document. You can control the information 
it gives you so that you always know what you need to know about your work.

{button ,AL(`cdrui_over;;;;;',0,"Defaultoverview",)} Related Topics



To move the status bar
1. Right-click the status bar.
2. In the Status Bar menu, click Place at Top or Place at Bottom.

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the number of status bar display regions
1. Right-click the status bar.
2. In the Status Bar menu, click Number of Regions.
3. Click the number of regions you want displayed.
Tip

You can have up to six regions displaying different information on a small status bar. When you use a large 
status bar, you have space for double that amount (see Related Topics).

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change what the status bar displays
1. Right-click the area of the status bar you want to change.
2. In the Status Bar menu, click Show.
3. Click the type of information you want to display.
Tip

To clear the current region, click None.

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics



To resize the status bar
1. Right-click the status bar.
2. In the Status Bar menu, Click Large Status Bar or Small Status Bar.

{button ,AL(`cdrui_status_proc;;;;;',0,"Defaultoverview",)} Related Topics





Working with grids and rulers
Among its many powerful drawing aids, CorelDRAW allows you to display rulers at the edges of the Drawing 
window that help determine the size and position of objects in your drawing. CorelDRAW also provides an 
adjustable grid that lets you align these objects. Using these tools, you can give your drawing the precise look 
you want.
The Grid and Ruler Setup dialog box provides controls that let you set the grid and ruler parameters, including 
scale, units, and frequency. You can use rulers or a grid to help you align objects in your drawing.

{button ,AL(`guidelines_overview;;',0,"Defaultoverview",)} Related Topics





Drawing Scale dialog box
Use the Drawing Scale dialog box to set the scale for your drawing. For example, if you are drawing floor plans 
for your office, this feature allows you to specify how many units on your page (the Page Distance) are 
equivalent to a given number of units on the floor (the World Distance). 
Note

The units you specify in Page Distance are the units used by the Contour Roll-Up and Transform Roll-Up. 
These units are also the ones used for the rulers. However, if the Drawing Scale is set to its default values (where 1 
inch of Page Distance equals 1 inch of World Distance), the rulers use the units specified for Grid Frequency.

{button ,AL(`grid_and_ruler_overview;',0,"Defaultoverview",)} Related Topics





To set ruler parameters
1. Click Layout, Grid & Ruler Setup.
2. Click the Ruler tab.
3. In the Horizontal and Vertical Unit boxes, specify the unit of measurement you want displayed on the ruler.
4. Set the 0,0 point in the Horizontal and Vertical Original number boxes.

The 0,0 points determine the cursor and object position information you see in the Status Line. The coordinate 
values you specify in some dialog boxes are also based on the position of the 0,0 points.

5. Click OK.
Tip

You can drag the cross hairs onto the drawing window to set the Horizontal and Vertical origins.
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To change the units of measurement on the rulers
1. Click Layout, Grid & Ruler Setup.
2. Click the Ruler tab.
3. In the Horizontal Units box, choose the unit of measurement you want the horizontal ruler to use.
4. In the Vertical Units box, choose the unit of measurement you want the vertical ruler to use.
5. Click OK.
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To reposition the rulers
1. Hold down the SHIFT key and click the ruler you want to move.
2. Drag it to a new position.
Tip

To return a ruler to its previous position, hold down the SHIFT key and double-click it.
To move both rulers at once, hold down the SHIFT key and drag the intersection point of the two rulers.
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To display or hide the grid
1. Click Layout, Grid & Ruler Setup.
2. Click the Grid tab.
3. Enable or disable the Show Grid check box.
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To set grid parameters
1. Click Layout, Grid & Ruler Setup.
2. Click the Grid tab.
3. Under Grid Frequency, specify the number of Horizontal and Vertical grid lines you want per unit of measure.

The unit of measure corresponds to the unit set for the rulers.
4. Enable the Show Grid check box to display the grid in the drawing window. Enable the Snap to Grid check box 

to have objects snap to the grid.
Notes

When you change the ruler units, you must also specify a new grid frequency. Changing the grid frequency 
unit also changes the corresponding ruler unit. If the drawing scale setting is not 1:1, the Grid Frequency units 
appear grayed out and correspond to the drawing scale units.

To space the grid lines more than one whole unit apart, type a fractional value in the Grid Frequency field. 
If the unit of measure is set to inches, for example, you can specify 0.5 to space the grid lines two inches apart.

The Horizontal and Vertical field units are accurate up to two decimal places.
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Working with guidelines
Guidelines provide a useful and easy way to align objects. Guidelines are non-printing lines that you can place 
anywhere in the drawing window. You can create any number of guidelines and have CorelDRAW save them 
along with your drawing.
The Guidelines Setup dialog box provides controls that let you set up horizontal, vertical, and slanted guidelines.
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To move a horizontal or vertical guideline
1. Click Layout, Guidelines Setup.
2. Click the Horizontal or Vertical tab.
3. Choose the guideline you want from the list of guidelines. The guidelines are listed by location.
4. Specify the location you want relative to the 0 point on the guideline's ruler.
5. Change the unit of measure as required.
6. Click Move.
Tip

You can also move a guideline by dragging it. However, If you drag a horizontal or vertical guideline by the 
handles at the edge of the drawing window, it will convert to a slanted guideline, and cannot be converted back 
(see Related Topics).
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To move a slanted guideline
1. Click Layout, Guidelines Setup.
2. Click the Slanted tab.
3. Choose the guideline you want from the list of guidelines. The guidelines are listed by the coordinates of their 

endpoints.
4. Choose a two-point guideline or one that has an angle and one point.
5. Change the unit of measure as required.
6. Type the guideline's new endpoint coordinates in the four boxes provided; X1, Y1, X2, and Y2.
7. Click Move.
Tip

You can also move a guideline by dragging the handles where it meets the edge of the drawing window.
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To set up a horizontal guideline
1. Click Layout, Guidelines Setup.
2. Click the Horizontal tab.
3. Type the units and the location relative to the 0,0 point on the rulers.
4. Click Add.
Tip

You can also set up a horizontal guideline by pointing to the horizontal ruler and dragging into the drawing 
window.
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To set up a slanted guideline
1. Click Layout, Guidelines Setup.
2. Click the Slanted tab.
3. Type the units and endpoint coordinates (X1, Y1, X2, and Y2) relative to the 0,0 point on the rulers.
4. Click Add.
Tip

You can also set up a slanted guideline by creating a horizontal or vertical guideline, then dragging one of 
the handles until the guideline reaches the desired angle.
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To set up a vertical guideline
1. Click Layout, Guidelines Setup.
2. Click the Vertical tab.
3. Type the units and the location relative to the 0,0 point on the rulers.
4. Click Add.
Tip

You can also set up a vertical guideline by pointing to the vertical ruler and dragging into the drawing 
window.
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To delete a guideline
1. Click Layout, Guidelines Setup.
2. Click the tab that corresponds to the type of guideline you want to delete.
3. Choose the guideline you want to delete.
3. Click Delete.
Tip

You can also delete a horizontal or vertical guideline by dragging it off the drawing window.
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To position slanted guidelines using the rulers
1. If you don't see the horizontal and vertical rulers, click View and enable Rulers.
2. Point to the horizontal or vertical ruler.
3. Click and drag the guideline onto the drawing window.
4. Click and drag one of the guideline handles until it is at the desired angle.
Note

Once you have converted a horizontal or vertical guideline to a slanted guideline, you cannot convert it 
back.
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To position slanted guidelines using the Guidelines Setup box
1. Click Layout, Guidelines Setup.
2. Click Slanted Guideline.
3. Type the guideline angle relative to the 0,0 points on the ruler.
4. Click Add.
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(On the left or right side of the Navigator.) Adds a page to your document.



(In the bottom, left-hand corner of the window.) Helps you move through your document quickly.



(In the upper, right-hand corner of a roll-up.) Minimizes and maximizes the roll-up.



(On the right side of the Navigator.) Displays the last page of your document.



(On the left side of the Navigator.) Displays the first page of your document.



Jumps to the specified page of your document.



Launches installed Corel applications.



Removes the current fill or outline color.




